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Online Training Program Offered by CADCIM Technologies

CADCIM Technologies provides effective and affordable virtual online training on various software
packages related to Computer Aided Design, Manufacturing, and Engineering (CAD/CAM/CAE),
computer programming languages, animation, architeciure, and GIS. The training is delivered live’ via
Internet at any time, any place, and at any pace to individuals and the students of colleges, universities,
and CAD/CAM iraining centers. The main features of this program are:

Training for Students and Companies in a Classroom Setting

Highly experienced instructors and qualified Engineers at CADCIM Technologies conduct the classes
wnder the guidance of Proft Sham Tickoo of Purdue University Calumet, USA. This team has authored
several textbooks that ave rated “one of the best” in their categories and are used in various colleges,
universities, and iraining centers in North America, Europe, and in other paris of the world.

Training for Individuals
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the comfort of your home or work place, thereby relieving you from the hassles of traveling to training
centers.

Training Offered on Software Packages
We provide basic and advanced training on the following software packages:

CAD/CAM/CAE: ANSYS Workbench, CATIA, Pro/ENGINEER Wildfire, SolidWorks, Autodesk Incventor,
Solid Edge, NX, AutoCAD, AutoCAD LT, Customizing AutoCAD, EdgeCAM, and ANSYS

Computer Programming: C++, VB.NET, Oracle, AJAX, and fava
Animation and Styling: Autodesk 3ds Max, 3ds Max Design, Maya, and Autodesk Alias

Architecture and GIS: Autodesk Revit Architecture, AutoCAD Civil 3D, AutoCAD Reuvit Structure,
and AutoCAD Map 3D

For more information, please visit the following link:

http:/fuww.cadeim.com

Note

If you are a faculty member, you can register by clicking on the following link
to access the teaching resources: http:/fwww.cadcim.com/Registration.aspx. The
student resources are available at http:/www.cadcim.com. We also provide Live
Virtual Online Training on various software packages. For more information,
write us at seles@cadcim.com.
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+ Real-World Projects as Tutorials .
The author has used about 30 real-world mechanical engineering projects as tutorials
in this book. This will enable the readlers to relate the tutorials to the real-world models
in the mechanical engineering industry. In addition, there are about 13 exercises based
on the real-world mechanical engineering projects.

* Tips and Note‘s' ' . - . L _ -
The additional information related to various topics is provided to the users in the

form of tips and notes.

* Learning Objectives | A ‘
The first page of every chapter summarizes the topics that are covered in that

chapter.

+ Sel-Evaluation Test, Review Questions, and Exercises
Every chapter ends with a Self-Evaluation test so that the users can assess their
knowledge of the chapter. The answers to the Self-Evaluation Test are given at the
end of the chapter. Also, the Review Questions and Exercises are given at the end of
each chapter and can be used by Instructors as test questions and exercises.

Formatting Conventions Used in the Text
Please refer to the following list for the formatting conventions used in this textbook.

»  Names of tools, buttons, options, tabs, Example: The Extrude tool, the Save button,
toolbars, and windows are written in the Toolbox window, the Graph tab, and so
boldface. on.

¢ Names of Details windows, drop-downs, Example: The Details of “Revolve” window,
drop-down lists, edit boxes, selection the Geometry selection box, the Blend
boxes, areas, check boxes, dialog boxes drop-down of the Features toolbar, the OK
and radio buttons are written in boldface. button of the ANSYS Workbench dialog box,
the Millimeter radio button of the ANSYS

Workbench didlog box, and so on.

s Values entered in edit boxes are written ~ Example: Enter 5 in the Max Element Size
in boldface. edit box.

Names and paths of the files are written. ~ Example: C:ANSYS_WBIcO3\ w011
in italics. ¢03_ansWB_tui02, and so on

Naming Conventions Used in the Text

Tool
If a command is invoked on clicking an item, then that item is termed as tool.

For example:
To Create: Line tool, General tool, Extrude tool, Pattern tool, and so on.
To Generate: General tool, Horizontal tool, Vertical tool, and so on.

Preface .
xi

To Edit: Fillet tool, Extend tool, Replicate tool, and so on.
Action: Rotate tool, Pan tool, Box Zoom tool,

If on clicking on an item, the corresponding Details View window is displayed Just below the

Tree Outline, wherein you can set the parameters to create/edit an object, then that item is
also termed as tool, refer to Figure 1,

For example:
To Create: Revolve tool, Skin/Loft tool
To Edit: Slice tool, Chamfer tool

J- XYPlane s Iv}n ] Mone: e é_@l “ =/ Generate
| BBarude” ghiRevolve: R Sweep. g Skin/Loft | | % Slice
| @thin/suface | Q Biend v Chamfer §iBody Operation

Figure 1 Partial view of the toolbars haw'ﬁg different tools
Button

The item in a dialog box that has a 8d shape like a button is termed as Button,

For example,
OK button, Cancel button, Apply button, and so on. e

Dialog Box
The naming conventions for the components in a dialog box are mentioned in Figure 2.

Title Bar

Select desired lengthi anit:

Radio buttons

Radio buffons

T o [

ce_niiﬁiafzer-_ SRR lncr}_-" e

Ty

Wilimetsr

Micrometer -

S

Check boxes—i Al&*..rﬂyh.éée':prdjéctﬁriit .
I | Abways use selested unt
F_E;abie'iargé modelzupport <

Bution

Figure 2 The components in a dialog box
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Prop-down o
A drop-down is the one in which a set of common tools are grouped together. You can identify
a drop-down with a down arrow on it. These drop-downs are given a name based on the tools
grouped in them. For example, Blend drop-down, Mesh drop-down, Mesh Control drop-down,
Suppert drop-down, and so on; refer to Figure 3.

&1, Mesh Controb w |y Metric Gr’a-i
@ Method 10
B Mesh Group: .0

@.\, Sizing-.~
H, ContactSlzsng .
,ﬁ Refmemant 3

@ Mapped Face Mex?:mg
fg Match Controi
@ Pinch - -' R

% Blend ¥ & Chamfer
- . ; ¥ @ Mesh rot v Fle
& FrxecE Radios © = § .@i Mesh « &L Contra 1 ,,;h & wtiton
@ Vanabfe Radms i ’2 Generate Miesh {1 Shaep Angle -
i 4 Preview SurfaceM&sh TR :
M Ver‘t@c Biend ﬁ Preview. Snurce stid Target Mash & SepToal

Figure 3 The Blend, Mesh, and Mesh Control drop-downs

Drop-down List

A drop-down list is the one in which a set of options are grouped together. You can set various
parameters using these options. You can identify a drop-down list with a down arrow on it.
For example, Extents drop-down list, Color Override drop-down list, and so on; refer to
Figure 4.

On Proxm:ty and Curvature
On: Curvature

Qe Prosimity

| & Fined

il Rz{evante

%
[
L
I

:lectromagnetl(s
ko
Explict

Figure 4 The Physics Preference and Use Advanced Size Function drop-down lists

Options

Options are the items that are available in shortcut menu, Marking Menu, drop-down list,
dialog boxes, and so on. For example, choose the Select All option from the shortcut menu
displayed on right-clicking in the Graphics screen; choose the Concrete option from the
Assignment flyout; choose the Front option from the Orientation area, refer to Figure 5.

Preface xiii

Tnsert r
GoTo 4

43 Isometric View ' .

s 2

2 Restore Default W Aluminum A]foy

@, ZoomTofit .o e
Cursor Made, =0 Co;&;}erAﬂ SR Medium -

W \ GrayCastIrcm SR LoV e ‘
g VEEEEFERY s s L"{ i
% Magnestum jfl.llny : High

Figure 5 Options in the shortcut menu, the Assignment flyout, and the Smoothing drop-down list

Selection Box

Many operations in ANSYS Workbench require you to select entities in the Graphics screen
or from the Tree Outline. After you select the entities/features, you need to confirm the
selection in the selection box. For example, if you want to extrude a sketch, you need to select

the sketch and then confirm the selection in the selection box. A typical Geometry selection
box is shown in Figure 6.

= to Selection |

Figure 6 The Geometry selection box

Free Companion Website

It has been our constant endeavor to provide you the best textbooks and services at affordable
prices. The free Companion website provides access to all the teaching and learning resources
that are required during the course of this textbook. If you purchase this textbook from the
website www.cadeim.com, you can access the resources on the Companion website.

To access the files, you need to register by visiting the Resources section at www.cadcim.com.
The following resources are available for the faculty and students in this website:

Faculty Resources
* Technical Support
You can get online technical support by contacting fechsupport@cadcim.com.

* Instructor Guide
Solutions to all review questions and exercises in the textbook are provided in this file to
help the faculty members test the skills of the students.

¢ PowerPoint Presentations

‘The contents of the book are arranged in PowerPoint slides that can be used by the faculty
for their lectures.

» Part Files
The part files used in illustration, tutorials, and exercises are available for free download.
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Student Resources
* Technical Support

You can get online technical support by contacting techsupport@cadcim.com.

* Part Files
The part files used in illustrations and tatorials are available for free download.

If you face any problem in accessing these files, please contact the publisher at sales@cadcim.com
or the author at stickoo@purduecal.edu or tickoo525@gmail.com.

Introduction to FEA

* Understand. the _baszc concepts cm : genere
* Understand the ad
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INTRODUCTION TO FEA

The finite element analysis (FEA) is a computing technique that is used to obtain
approximate solutions to boundary value problems. It uses a numerical method called finite
element method (FEM). FEA invoives the computer model of a design that is loaded and
analyzed for specific results, such as stress, deformation, deflection, natural frequencies, mode
shapes, temperature distributions, and so on.

The concept of FEA can be explained through a basic example involving measurement of
the perimeter of a circle. To measure the perimeter of a circle without using the conventional
formula, divide the circle into equal segments, as shown in Figure 1-1. Next, join the start
point and the endpoint of each of these segments by a straight line. Now, you can measure the
length of straight line very easily, and thus, the perimeter of the circle by adding the length
of these straight lines.

Figure 1-1 The circle divided into small equal segments

If you divide the circle into four segments only, you will not get accurate results. For accuracy,
divide the circle into more number of segments. However, with more segments, the time
required for getting the accurate result will also increase. The same concept can be applied
to FEA also, and therefore, there is always a compromise between accuracy and speed while
using this method. This compromise between accuracy and speed makes it an approximate
method.

The FEA was first developed to be used in the aerospace and nuclear industries, where the
safety of structures is critical. Today, even the simplest of products rely on FEA for design
evaluation.

The FEA simulates the loading conditions of a design and determines the design response in
those conditions. It can be used in new product design as well as in existing product refinement.
A model is divided into a finite number of regions/divisions calied elements. These elements
can be of predefined shapes, such as triangular, quadrilateral, hexahedron, tetrahedron, and
so on. The predefined shape of an element helps define the equations that describe how the
element will respond to certain loads. The sum of the responses of all elements in a model
gives the total response of the complete model.

Introduction to FEA

General Working of FEA

A better kr}ow}edge of FEA helps in building more accurate models. Also, it helps in
understanding the backend working of ANSYS. Here, a simple model is discussed to give you
a brief overview of the working of FEA.

Figure 1-2 shows a spring assembly that represents a simple two-spring element model. In
this model, two springs are connected in series and one of the springs is fixed at the left most
endpoint, refer to Figure 1-2. In this figure, the stiffness of the springs has been represented
by the spring constants K, and K, The movement of endpoints of each spring is restricted to
the X direction only. The change in position from the undeformed state of each endpoint can
be defined by the variables X, and X,. The two forces acting on the end points of the springs
are represented by F, and F,.

Figure 1-2 Representation of a twoe-spring assembly

To fievelop a model that can predict the state of this spring assembly, you can use the linear
spring equation given below:
F =KX
where,
¥ = force applied,
X = displacement, and
K = spring constant

If you use the spring parameters defined above and assume a state of equilibrium, the following
equations can be written for the state of each endpoint:

Fz - XlKi + (Xg - Xl)K2 =0
Fo- (X, - XK, =0

Therefore,

Fo= (K + KX, + (K)X,
F, = (KX, + KX,

If the set of equation is written in matrix form, it will be represented as follows:

¥, _ K, +K, -K, X,
F, K, K, X,
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In the above mathematical model, if the spring constants (K, and K,) are known and the
deformed shapes (X, and X,) are defined, then the resulting forces (F, and F,) can be
determined. Alternatively, if the spring constants (K, and K,) are known and the forces (F and
F,) are defined, then the resulting deformed shape (X, and X,) can be determined.

Various terminologies that are used in the previous example are discussed next.

Stiffness Matrix
In the previous equation, the following part represents the stiffness matrix (K):

K + K 0

&, K,
This matrix is refatively simple because it comprises only one pair of springs, but it tarns
complex when the number of springs increases. '

Degrees of Freedom

Degrees of freedom is defined as the least number of independent cordinates required to
define the configuration of 2 system in space. In the previous example, you are only concerned
with the displacement and forces. By making one endpoint fixed, you will restrict all degrees
of freedom for that particular node. Which means that, there will be no translational or
rotational degrees of freedom for that node. But, there are two nodes still have some degrees
of freedom. As these two nodes are allowed o translate along the X axis only, they have 1
degree of freedom each considering that no rotationai degree of freedom exist in them.
The number of the degrees of freedom on free nodes in a model determines the number of
equations required to solve a mathematical model.

Boundary Conditions

The boundary conditions are used to eliminate the unknowns in the system. A set of equations
that is solvable is meaningless without the input. In the previous example, the boundary
condition X, = 0, and the input forces are F1 and F2. In either ways, the displacements could
have been specified in place of forces as boundary conditions and the mathematical model
could have been solved for the forces. In other words, the boundary conditions help you reduce
or eliminate the unknowns in the system.

Note
The solutions generated by using FEA are always approximate.

Eiements and Element Shapes
Before proceeding further, you must be familiar with the concepts of elements and element
shapes, because these are the building blocks of FEM. These concepts are discussed next.

Eiements

Element is an entity into which the system under study is divided. An element shape is
specified by nodes. The shape (area, length, and volume) of an element depends on the nodes
with which it is made. An element (triangular shaped) is shown in Figure 1-3.

Introduction to FEA 1-5

Node

Elemeant

Figure 1-3 A node and an element

Element Shapes

There are many types of element shapes that are further divided into various classes, depending
on their uses. The following are some basic element shapes:

Line Element

Aline element has the shape of a line or a curve. Therefore, a minimum of two nodes are
required to define it. There can be higher order elements that have additional nodes (at
the middle of the edge of an element). An element that does not have a node in between
its edges is called a linear element. The elements that have nodes in berween edges are
called quadratic or second order elements. Figure 1-4 shows some line elements.

—

Linsar or First Quadratic or Second
Order Line Element Order Line Elerment

Figure 1-4 Line elements
Area Element

An area element has the shape of a triangle or a quadrilateral; therefore, it requires

a minimum of three or four nodes to define it. Some area elements are shown in
Figure 1-5.

ale P

First Order or Second Order or .
Lingar Quadrilateral Quadratic Quadrilgtaral fgrst Oqud-er or Second Order or
inear Triengle Quadratic Triangie

Figure I-5 The area elements
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Volume Element
A volume element has the shape of a hexahedron (8 nodes), wedge (6 nodes),

tetrahedron (4 nodes), or a pyramid {3 nodes). Some of the volume elements are shown '

in Figure 1-6.
First order Linear Second order First order Linear Second order
Hexabhedran Quadratic Hexchedran Wedge Quadratic Wedge

Figure 1-6 The volume elements

General Procedure to Conduct Finite Element Analysis
To conduct the finite element analysis, you need to follow certain steps that are given next.

1. Set the type of analysis to be used.
2. Create model.
3. Define the element type.
4. Divide the given geometry into nodes and elements (mesh the model).
5. Apply material properties and boundary conditions.
6. Derive element matrices and equations.
7. Assemble element equations.
8. Solve the unknown parameters at nodes.
9. Interpret the results.

. .
The general process of FEA by using M
software 1s.dw1ded into three main pha.ses. (Goprete nobs, comarts, |
preprocessing, soéuuoa, and postprocessing, n batncary Pemsf‘){xds’ Prep
refer to Figure 1-7. ond data fila

FEA

P?epfocessor ma(tfizggfagzr:t?;?nr:zdgl Sotutlen
The preprocessor is a phase that processes Yo e ety

input data to produce output, which is used |
. “ 1 H Anclyze Resulis

as input in the subsequent phase (solution;. (isatay corves, ooumers.|  Postproceaser

Following are the input data that need to be daformod shapes)

given to the preprocessor:

Figure 1-7 FEA through software

1. "Type of analysis (structural or thermal,
static or dynamic, and linear or nonlinear)

2. Elemen: type ‘ .

9. Real constants for elements (Cross-sectional area, Moment of Inertia, Shell thickness, and
50 0n) . .

4. Material properties (Young’s Modulus, Poisson’s ratio, Spring Constant, Thermal
Conductivity, Coefficient of Thermal Expansion, and so on)

5. Geometric model (either created in the FEA software or imported from other CAD
packages)

Introduction to FEA 17

6. FEA model (discretizing the geometric model into Small elements)
7. Loading and boundary conditions (defining loads, pressures, moments, temperature,

conductivity, convection, constraints (fixed, pinned, or frictionless/symmetrical), and so
ox.

The input data are preprocessed for the output data and the preprocessor generates the data
files automatically with the help of users. These data files are used in the subsequent phase
(solution), refer to Figure 1-7.

. Solution

The solution phase is completely automatic. The FEA sofiware generates element matrices,
computes nodal values and derivatives, and stores the result data in files. These files are further
used in the subsequent phase {postprocessor) to review and analyze the results through the
graphic display and tabular listings, refer to Figure 1-7.

Postprocessor :

The output from the solution phase (result data files) is in the numerical form and consists of
nodal values of the field variable and its derivatives. For example, in structural analysis, the
output of the postprocessor is nodal displacement and stress in elements. The postprocessor
processes the result data and displays them in graphical form to check or analyze the result.
‘The graphical output gives the detailed information about the required result data. The

postprocessor phase is automatic and generates graphical output in the specified form, refer
to Figure 1-7.

FEA SOFTWARE

There are a variety of commercial FEA software packages available in the market. Every CAE
software provides various modules for various analysis requirements. Depending on your
requirernent, you can select a required module for your analysis. Some firms use one or more
CAE software and others develop customized version of commercial software to meet their
requirements.

Advantages and Limitations of FEA Software
Following are some of the advantages and limitations of FEA software:

Advantages

1. It reduces the amount of prototype testing, thereby saving the cost and time.

2. It gives the graphical representation of the result of analysis.

3. The finite element modeling and analysis are performed in the preprocessor and
solution phases, which if done manually would consume a lot of time and in some cases,
might be impossible to perform.

Variables such as stress and temperature can be measured at any desired point of the model.
It helps optimize a design.

It is used to simulate the designs that are not suitable for prototype testing.

It helps you create more reliable, high quality, and competitive designs.

O Gk
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Limitations

1. Tt does not provide exact solutions.

2. FEA packages are costly.

5. Aninexperienced user can deliver incorrect answers, upon which expensive decisions will
be based

4. Results give solutions but not remedies.

5. Features such as boits, welded joints, and so on cannot be accommmodated to a model. This
may lead to approximation and errors in the result.

6. For more accurate results, more hard disk space, RAM, and time are required.

KEY ASSUMPTIONS IN FEA

There are four types of key assumptions that must be considered while performing the finite

element analysis. These assumptions are not comprehensive, but cover a wide variety of situations
applicable to the problem. Moreover, by no means do all the following assumptions apply to
all situations. Therefore, you need to consider only those assumptions that are applicable for
your analysis problem.

Assumptions Related to Geometry

1. Displacement values will be smali so that a linear solution is valid.

2. Stress behavior outside the area of interest is not important. Therefore, geometric
simplifications in those areas do not affect the outcome.

3. Only internal fillets in the area of interest will be included in the solution.

4. Local behavior at the corners, joints, and intersection of geometries is of primary
interest, therefo;e, no special modeling of these areas is required.

5. Decorative external features will be assumed insignificant for the stiffness and
performance of the part and these external features will be omitted from the model,

6. Variation in the mass due to suppressed features is negligible.

Assumptions Related to Material Properties

1. Material properties will remain in the linear region and the nonlinear behavior of the
material property cannot be accepted.

2. Material properties are not affected by the load rate.

3. The component is free from surface imperfections that can produce stress
concentration.

4. All simulations will assume room temperature, unless otherwise specified.

5. The effects of relative humidity or water absorption on the material used will be
neglected.

6. No compensation will be made to account for the effect of chemicals, corrosives, wears,
or other factors that may have an impact on the long term structural integrity.

Assumptions Related to Boundary Conditions

1. Displacements will be small so that the magnitude, orientation, and distribution of
the load remains constant throughout the process of deformation.

2. Frictional loss in the system is considered to be negligible.

3. All interfacing components will be assumed rigid.
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4. The portion of the structure being studied is assumed as a separate part from the rest of
the system, so that any reaction or input from adjacent features is neglected.

Assumptions Related to Fasteners

1. Residual stresses due to fabrication, pre loading on bolts, welding,
or assembly processes will be neglected.

2. Allwelds between components will be considered as ideal and continuous.

3. The failure of fasteners will not be considered.

4. The load on the threaded portion of the part is supposed to be evenly distributed among
the engaged threads. :

5. TFh‘e 'stiffness of bearings, both in radial and in axial directions, will be considered as
infinite or rigid. :

or other manufacturing

TYPES OF ENGINEERING ANALYSES

You can perform different types of analyses using FEA software and these are discusses
next,

Structural Analysis

In structural analysis, first the nodal degrees of freedom (displacement) are calculated and
then the stress, strains, and reaction forces are calculated from nodal displacements. The
classification of structural analysis is shown in Figure 1-8.

Structural Analysis

Static Analysls  Dynamic Analyeis  Spactrum Buclding Explicht
lyakg Anolysia Dynamle
I Analysis

Modal Analysls  Harmenis Trenslent Dynamic
Analysls Anglysia

Figure 1-8 Bypes of structural analysis

Static Analysis

In static analysis, the load or field conditions do not vary with respect to time, and therefore,
it is assumed that the load or field conditions are applied gradually, not suddenly. The system
under this analysis can be linear or nonlinear. The inertia and damping effects are ignored in
structural analysis. In structural analysis, the following matrices are solved:

(Rix[X]=[F]

Where,
K = Stiffness Matrix
X = Displacement Matrix
F = Load Matrix
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"The above equation 1s called the force balance equation for the linear system. If the elements
of matrix [K] are the function of {X], the system is known as the nonlinear system. Nonlinear
systems include large deformation, plasticity, creep, and so on. The loadings that can be
applied in a static analysis include:

Externally applied forces and pressures ' '
Steady-state inertial forces (such as gravity or rotational velocity)
Imposed (non-zero) displacemf,fnts

Temperatures (for thermal strain)

Fluences {for nuclear swelling)

Otk L8 10—

The'oﬁiiputs' that can be expected from the FEA software are given next.

1. Displacements
2. Strains

3. Stresses

4. Reaction forces

Dynamic Analysis _ . .

In dynamic analysis, the load or field conditions vary with the time and are applied suddenly.
The system can be linear or nonlinear. The dynamic load includes oscillating loads, inpacts,
collisions, and random loads. The dynamic analysis is classified into the foliowing three main
categories:

Modal Analysis
It is used to calculate the natural frequency and mode shape of a structure.

Harmonic Analysis . ‘ .
It is used to calculate the response of a structure to harmonically time varying loads.

Transient Dynamic Analysis . _
It is used to calculate the response of a structure to arbitrary time varying loads,

In dynamic analysis, the following matrices are solved;

Tor the system without any external load:
[M] x Double Derivative of [X] + [KI x [X]= 0

Where,
M = Mass Matrix
K = Stiffness Matrix
X = Displacement Matrix

For the system with external load:
[M] x Double Derivative of [X] + [K] x [X]= [F]
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Where,
K = Stiffness Matrix
X = Displacement Matrix
F = Load Matrix

The above equations are called the force balance equations for a dynamic system. By solving
the above set of equations, you can extract the natural frequencies of a system. The load types
applied in a dynamic analysis are the same as that in 2 static analysis, The outputs that can
be expected from a software are Natural frequencies, Mode shapes, Displacements, Strains,
Stresses, and Reaction forces. All these outputs can also be obtained with respect to time.

Spectrum Analysis

This is an extension of the modal analysis and is used to calculate stress and strain due to the
response of the spectrum (random vibrations), For example, you can use it to analyze how
well a structure will perform and survive in an earthquake.

Buckling Analysis

This type of analysis is used to calculate the buckling load and the buckling mode shape. Slender
structures (that is thin and long structures) when loaded in the axial direction, buckle under
relatively small loads. For such structures, the buckling load becomes a critical design factor.

Explicit Dynamic Analysis
This type of structural analysis is available only in the ANSYS LS-Dyna program and is used to

get fast solutions for large deformation dynamics and complex contact problems, for example,
explosions, aircraft crash worthiness, and so on.

Thermai Analysis
The thermal analysis is used to determine the temperature distribution and related thermal

quantities such as: Thermal distribution, Amount of heat loss or gain, Thermal gradients,
and Thermal fluxes.

All primary heat transfer modes such as conduction, convection, and radiation can be simulated.
You can perform two types of thermal analysis, steady-state and transient.

Steady State Thermal Analysis

In this analysis, the system is studied under steady thermal loads with respect to time.

Transient Thermal Analysis
In this analysis, the system is studied under varying thermal loads with respect to time,

Fluid Flow Analysis

This analysis is used to determine the flow distribution and temperature of a fluid. The ANSYS/
FLOWTRAN program is used to simulate the laminar and turbulent flow, compressible and
electronic packaging, automotive design, and so on. The outputs that can be expected from
the fluid flow analysis are Velocities, Pressures, Temperatures, and Film coefficients
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Electromagnetic Field Analysis o
This type of analysis is conducted to determine the magnetic fields in electromagnetic devices.
The types of electromagnetic analyses are Static analysis, Harmonic analysis, and Transient
analysis

Coupled Field Analysis ,
This type of analysis considers the mutual interaction between two or more fields. It is
impossible to solve fields separately because they are interdependent. Therefore, you need a

program that can solve both the problems by combining them.

For example, if a component is exposed to heat, you may first require to study the thermal
characteristics of the component and then the effect of the thermal heating on the structural

stability.

Alternatively, if a component is bent in different shapes using one of the metal forming
processes and then subjected to heating, the thermal characteristics of the component will
depend on the new shape of the component. Therefore, first the shape of the component has
to be predicted through structural simulations. This is called as the coupled field analysis.

IMPORTANT TERMS AND DEFINITIONS

Some of the important terms and definitions used in FEA are discussed next.

Strength o
When a material is subjected to an external load, the system undergoes a deformation. The
material, in turn, offers resistance against this deformation. This resistance is offered by virtue
of the strength of the material.

Load

The external force acting on a body is called load.

Stress
The force of resistance offered by a body against the deformation is called stress. The stress
is induced in the body while the load is being applied on the body. The stress is calculated as
load per unit area.

p=FA

Where,
p = Stress in N/mm?*
F = Applied Force in Newton
A = Cross-Sectional Area in mm?

The material can undergo various types of stresses, which are discussed next.
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Tensile Stress .

1f the resistance offered by a body is against the increase in the length, the body is said to be
under tensile stress.

Compressive Stress

If the resistance offered by a body is against the decrease in the length, the body is said to be
under compressive stress. Compressive stress is just the reverse of tensile stress.

Sheaf Stress

"The shear stress exists when two materials tend to slide across each other in any typical plane
of shear on the application of force parallel to that plane.

Shear Stress = Shear resistance (R) / Shear area (A}

Strain .

When a body is subjected to a load (force), its length changes. The ratio of change in the
length of the body to its original length is called strain. If the body returns to its original shape
on removing the load, the strain is called elastic strain. If the body remains distorted after

removing the load, the strain is called plastic strain. The strain can be of three types, tensile,
compressive, and shear strain,

Strain (e) = Change in Length (dl) / Original Length (])

Elastic Limit

The maximum stress that can be applied to a material without producing the permanent
deformation is known as the elastic limit of the material. If the stress is within the elastic Hmit,
the material returns to its original shape and dimension on removing the external stress.

Hooke’s Law
It states that the stress is directly proportional to the strain within the elastic limit.

Stress / Strain = Constant (within the elastic limit)

Young’'s Modulus or Modulus of Elasticity
In case of axial loading, the ratio of intensity of the tensile or compressive stress to the
corresponding strain is constant. This ratio is called Young’s modulus, and is denoted by E.

E = ple

Shear Moduius or Modulus of Rigidity
In case of shear loading, the ratio of shear stress to the corresponding shear strain is constant.
This ratio is called Shear modulus, and it is denoted by C, N, or G.

Ultimate Strength

The maximum stress that a material withstands when subjected to an applied load is called
its ultimate strength.
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Factor of Safety

“The ratio of the ultimate strength to the estimated maximum stress in orci?nary use (design
stress) is known as factor of safety. It is necessary that the design stress 1s well bel?w the
elastic limit. and to achieve this condition, the ultimate stress should be divided by a “factor

of safety’.

Lateral Strain ‘ -
If a cylindrical rod is subjected to an axial tensile load, the length () of the rod will increase

(d]) and the diameter () of the rod will decrease (d@). In short, the XOngitudinlal stress wi.ll
not only produce a strain in its own direction, but will also produce a lateral straim. The ratio
dl/l is called the longitudinal strain or the linear strain, and the ratio de/o iscalled the lateral

sirain.

Poisson’s Ratio o M
The ratio of the lateral strain to the longitudinal strain is constant within the elastic limit. This

ratio is called the Poisson’s ratio and is denoted by 1/m. For most of the metals, the value of
the ‘m’ lies between 3 and 4.

Poisson’s ratio = Lateral Strain / Longitudinal Strain = 1/m

Bulk Modulus . T
If a body is subjected to equal stresses along the three mutually perpendicular directions, the
ratio of the direct stresses to the corresponding volumetric strain is fount} to be constant for
a given material, when the deformation is within a certain limit. This ratio is called the bulk

modulus and is denoted by K.

Stress Concentration |

"The value of siress changes abruptly in the regions where the. cross-section or Qroﬁle of 2
structural member changes abruptly. The phenomenon of this abrupt §hange in stress is
known as stress concentration and the region of the structural member that is affected by stress
concentration is known as the region of stress concentration. The region of stress concentration
needs to be meshed densely to get accurate results.

Bending

When a non-axial force is applied on a structural member, the stlructural_ membex: starts
deforming. This phenomenon is known as bending. In case of bending, strains vary linearly
from the centerline of a beam to the circumference. In case of pure bending, the \‘faiue 9f
strain is zero at the centerline, The plane section of the beam is assumed to remain plain
even after the bending.

Bending Stress : . _
When a non-axial force is applied on a structural member, some compressive and tensile
stresses are developed in the member. These stresses are known as bending stresses.

Introduction to FEA

Creep o

At elevated temperature and constant load, many materials continue to deform but at a slow
rate. This behavior of materials is called creep. At a constant stress and temperature, the
rate of creep is approximately constant for a long period of time. After a certain amount of
deformation, the rate of creep increases, thereby causing fracture in the material. The rate of
creep depends highly on both the stress and the temperature.

Classification of Materials

Materials are classified into three main categories: elastic, plastic, and rigid. In case of elastic
materials, the deformation disappears on the removal of load. In plastic materials, the
deformation is permanent. A rigid material does not undergo deformation when subjected to
an external load. However, in actual practice, no material is perfectly elastic, plastic, or rigid.
The structural members are designed such that they remain in the elastic conditions under

the action of working loads. All engineering materials are grouped into three categories that
are discussed next.

isotropic Material
In case of Isotropic materials, material properties do not vary with direction, which means

they have the same material properties in all directions. Material properties are defined by
Young’s modulus and Poisson’s ratio.

Orthotropic Material

In case of orthotropic materials, material properties vary with direction and are specified
in three orthogonal directions. Such materials have three mutually perpendicuiar planes of

material symmetry. Material properties are defined by separate Young’s modulus and Poisson’s
ratios along each axis.

Anisotropic Material
In case of Anisotropic materials, material properties vary with direction, but there is no plane
of material symmetry. This means they do not behave in the same way in all directions.

Aspect Ratio

Aspect ratio is defined as the ratio of the longest side to the smallest side of an element.

Axisymmetry

Model that can be defined by rotating its cross-section by 360-degrees about an axis is known
as axisymmetry model.

Degrees of Freedom (DOF)

Degrees of freedom is defined as the freedom of a given point to move in any direction in
space.

"There are six DOFs for any point in 3-dimensional (3D) space:

3 translational DOFs {one each in the X,Y, and Z directions) and
3 rotational DOF's (one each about the X, Y, and 7 axes).
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Answer the following questions and then compare them to those given at the end of this

chapter:

1. FEA simulates the loading conditions of a model and determines its response under those
conditions. (T/F)

9 A linear line element has a maximum of two nodes. (T/F}

3. A quadratic line element has a node in the middie. {1I/F)

4. An area element should always be triangular in shape. (T/F)

5. You cannot import an external geometry file into an FEA software. (T/F)

6. The nodes define the shape of an element. (T/F)

7. A minimum of nodes are required to define a line element.

8. A minimum of nodes are required to define an area element.

9. A minimum of nodes are required to define a volume element.

Answer the following questions:

L.

2.

[y

The Finite Element Method gives exact solutions to problems. {T/¥)
In FEM, the geometry is discretized into small parts, known as elements. (T/F)
In space, a rigid body has six degrees of system. (T/F)

In dynamic analysis, the boundary conditions are a function of

Modal analysis is used to caiculate the frequencies of a model.
Hooke’s law states that stress is directly proportional to within elastic
limit.

Answers to Self-Evaluation Test
1.T.2.T.3. T, 4. F 5.F, 6. T, 7. two, 8, three, 9. four

Chapter 2

lntroduction to ANSYS

Workbench

After completing this chapter, you wn’l be able to:
* Undérstand the types of systems. '

* Understand different types of cells.

* Understand the Gmpkzc User Interface of the Workbench window.

* Start a new project in ANSYS Workbench window.

* Add the first and subsequent analysis systems to a project.
*-Set units for project.
* Use ANSYS Workbench Help.
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INTRODUCTION TO ANSYS Workbench

Welcome to the world of Computer Aided Engineering (CAE) with ANSYS Workbench. If you
are a new user, you will be joining hands with thousands of users of this Finite Element Analysis
software package. If you are familiar with the previous releases of this software, you wiil be able
to upgrade your designing skills with tremendous improvement in this latest release.

ANSYS Workbench, developed by ANSYS Inc., USA, is a Computer Aided Finite Element
Modeling and Finite Element Analysis tool. Tn the Graphical User Interface (GUI) of ANSYS
Workbench, the user can generate 3-dimensional (3D) and FEA models, perform analysis,
and generate results of analysis. You can perform a variety of tasks ranging from Design
Assessment to Finite Element Analysis to complete Product Optimization Analysis by using
ANSYS Workbench. ANSYS also enables you to combine the stand-alone analysis system into
a project and to manage the project workflow.

The following is the list of analyses that can be performed by using ANSYS Workbench:

Design Assessment
Electric

Explicit Dynamics
Fhaid Flow (CFX)
Fluid Flow (FLUENT)
Harmonic Response
I.C. Engine

Linear Buckling

. Magnetostatic’

10. Modal

11. Random Vibration
12. Response Spectrum
13. Rigid Dynamics

14. Static Structural

15. Steady-State Thermal
16. Thermal-Electric

17. Transient Structural
18. Transient Thermal

SYSTEM REQUIREMENTS

The following are minimum system requirements to ensure smooth functioning of ANSYS

Workbench on your systen:

¢+ Operating System: Windows 64-bit (Windows XP 64 SP2, Windows Vista 64 SP1, Windows
7, Windows HPC Server 2008 R2), Windows 32-bit (Windows XP SP2, Windows Vista SP1,
Windows 7)

o Platform: Intel Pentium class, Intel 64 or AMD 64 _

+  Memory: 1 GB of RAM for all applications, 2GB for running CFX and FLUENT.

+  DVD drive: For installing the software.

»  Graphics adapter: Should be capable of supporting 1024x768 High Color (16-bit).

»  Microsoft Internet Explorer 6.0 or higher
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STARTING ANSYS Workbench 14.0

To start ANSYS Workbench 14.0, choose Start > Programs/All Programs > ANSYS 14.0 >
Workbench 14.0 from the Taskbar, refer to Figure 2-1. Alternatively, you can start AN.SYS
Workbench by double-clicking on the Workbench shortcut icon displayed on the desktop of
your computer. After the necessary files are loaded and licenses are verified, the Workbegch

*;_indow2aéong with the Getting Started window will be displayed on the screen, as shown in
igure 2-2, 7

_:4'&'5_?2!"%’&‘&‘;&*{{’,‘ R Tty ot ML BT T
42 Windows Madia Center

|G| Windows Media Playar

&} Windows Update

<& XPS Viewer
Accessories
4 ANSYS 140
A Mechanical APDL (ANSYS) 14.0
A\ Mechanicsl APBL Product Launche
A Uninstall 14.0
A Workbienghd g oo T
i AMSYS Clidv/Licensing
XM
Fluid Dynarnics
S Help
B Meshing
3 Utilities
ANSYS, Inc, License Managar
ArcSoft Magic-i Visual Effects 2
ArcSoft WebCam Companion 3

1 Back

[ Szarch programs and files

T %{

Figure 2-1 Starting ANSYS Workbench using the Taskbar

?"he Gettin.g Started window guides you to use the interface of ANSYS Workbench effectively.
To close this window, choose the OK button.

Note

If you do not want the Getting Started window to be displayed the next time you start ANSYS
Workbench, clear the Show Getting Started Message at Startup check box displayed at the
bott.om of the Getting Started window. In case, you need o display the Getting Started window
while starting a new ANSYS Workbench session, choose Tools > Options from the Menu bar;
the OPtz’ons dialag box will be displayed. Choose Project Management from the left pane 0}’
the dialog box, if it is not chosen by defuwlt. Next, scroll down in the right pane and select the

Show Getting Started Dialog check box and choose the OK button to save the changes and
exit the dialog box.




2-4

" Victcomms te ANSYS Waoritbenahl
T M you'rs new 1 ANSYS Workbanch, vie strangty er eotrage
o 10 take Jusk 2 Few plalies bo vl some gz,

1F yas avcder 10 get started mmodictely:

1. Saleet your desired analyls system frem the Toolbox (2t
Jeft), g It dnin the Projuct Schemale (et right), 2 Grop B
- 3aside e highttghveed rectangte.

- 2 Rghtdice on it Gaumatry el o ereate b new coorratry o
;oF fmpan existing goomery, .

T 3. Condnug working through the system fram top 1o battom.
: Right-dick mnd seect Tdit on 3 it 20 start tha sppropsiste
;_Innrattve and dafing bha Aails D that mavk af Hha sn:

T ammese

97 29
1 fearrtrrdarutoir
s ERENER Y
U Sxsgmrtpatinia

Figure 2-2 The Workbench window along with the Getting Started window

The Workbench window helps streamline an entire project to be carried out in ANS}’S
Workbench 14.0. In this window, one can create, manage, and view th‘e workﬁo?v of the c_entlre;-
project created by using standard analysis systems. The.Workbench vac.low mainly consists o
Menu bar, Standard toolbar, the Toolbox window, Project Schem?nc wmdow,' and the Status
bar, refer to Figure 2-3. Various components of the Workbench window are discussed next.
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Toolbox Window _
The Toolbox window is located on the left in the Workbench window, The Toolbox window lists
the standard and customized templates or the individual analysis componenis that are used to

on a particular analysis or component system in the Toolbox window to add it to the Project
Schematic window and to create the project.

Note

The double-click action atways adds new system to the project, wheveas dragging and dropping
the system. from the Toolbox window engbles you to specify location of the new System in the
Project Schematic window. Based on the specified location, you can create daty sharing uith
the existing systems. You will learn more about sharing data between different systems in the
Project Schematic window in luter chapters.

The Toolbox window comprises four toolboxes: Analysis Systems, Component Systems,
Custom Systems, and Design Exploration. The components of these toolboxes are discussed
next.

Analysis Systems Toolbox

"The Analysis Systems toothox is dis played expanded in the Toolbox
window, by default. It contains predefined templates for different | ;
types of analyses that can be carried out in ANSYS Workbench 14.0. @ elecic

Each predefined template consists of ail the components that are g E:@Lf:“*;:{;*

. . Fluid Apuer {Cx
used to perform a particular type of analysis. For example, the &) Avicsion (=Lusnn)
Static Structural analysis system of the Analysis Systems toolbox g emaalcRezpass
. . . ngine
15 used to carry out the Static Structural analysis. When you add B tinearbucking

this system in the Project Schematic window, it contain all the {%L’Zj’;f‘“ﬁ‘
components that are necessary to carry out the Static Structural ) ~ondom vibraton

analysis. Figure 2-4 shows the Analysis Systems toolbox with g; sf;:";:;;jf’““
different types of analysis systems available in ANSYS Workbench. g st smetury

N ' N E’B Stuady-State Thermal

These analysis systers are discussed next, B Hemt

Transient Structyral

Design Assessment Tesosient Thermal

g . . . , B, Companent Systems -

This analysis system is used to perform a combined solution 8, Lustom Systams.

or static and transient structural analyses. It also performs B Deslon Eoloraten
post-processing through a script using additional data
associated with the geometry.

Figure 2-4 The Analysis
Systems toolbox displaying
Electric ;)?:z;zous analysis systems
This analysis system is used to analyze steady-state electric

conduction,

Explicit Dynamics

This analysis system is used to identify the dynamic response of a component under
stress wave propagation, or time-dependent loads or impacts. It is also used for modal
mechanical phenomena that are highly non-linear.
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id Flow (C . - '
'?;;sd system( amfs users to carry out flow analysis of compressible and incompressible

fuids. Tt is also used to analyze heat transfer in fluids.

id Flow (FLUENT) ] ,
g;:idmuid lg“iow (CFX), Fluid Flow (Fluent) system is also used to carry out fluid flow

analysis of compressible and incompressible fiuids and their heat transfer analysis.

Harmonic Response B . -
Harmonic response is the response of a system under a sustained cyclic load. Harmonic

Response analysis system is used to analyze a system working under periodic or smusc}ndal
Joads. This analysis helps in determining whether a partlculaz‘" structure will be able to
withstand resonance, fatigue, and other effects of forced vibration.

IC Engine . ‘ .
This analysis system helps determine the performance of the whole system ofan1C e?gm{:.
Tt takes into consideration the various fluid properties, moving components, and electric
and electronic components inside an engine.

Linear Buckling _ '
This analysis system is used to evaluate the buckling strength of a system under external

loads.

Magnetostatic _ B
Thif analysis system is used to analyze the magnetic field developed due to the presence
of a temporary or permanent magnet.

Modal : _ o
Modal analysis is the study of dynamic properties of a model, _subjected to v1b§at1ons.
Modal analysis system in ANSYS Workbench helps in determining the frequencies and
mode shapes of a model.

Vibration
?g;dgglysis is carried out to determine the reaction of a structure _c;}r‘a‘comp%r‘le}ntaiz
changing frequencies of vibrations. Many components experience vibrations which
random in nature. This analysis system is used to determine the responses of structures
that are exposed to such varying or random vibrations.

Response Spectrum . . . .
Response Spectrum analysis system is similar to Random Vibration analysis system and
is used after a transient analysis is done.

Rigid Dynamics . . o ’
Rigid Dynamics analysis system is used to determine the response of a rigid body or a
mechanism consisting of rigid bodies. Response of a robot mechanism is an example of
rigid body analysis.
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Static Structural

The Static Structural analysis system is used to determine the response of a structure
subjected to static loading conditions. The loads in this case are assumed to produce
20 or negligible time based loading characteristics. Using this type of analysis,

displacement, stresses, and deformations of structures under static loading conditions
can bhe determined.

Steady-State Thermal

Steady-state thermal analysis system is used to determine the temperature, thermal
gradient, heat flow rates and heat fluxes under the influence of thermal loading which
remains constant with time and are static in nature.

Thermal-Electric
Thermal-Electric analysis system is used to simulate thermal and electric fields,

Transient Structural

‘Transient Structural analysis system is used to determine responses of structures under

the action of time dependent variables. Using this analysis, time-varying displacement,
stresses and strains can be determined.

Transient Thermal

"Transient Thermal analysis system is used to determine the temperature and other thermal
variables of a structure that vary over time.

Component Systems Toolbox

By default, the Gomponent Systems toolbox is displayed in collapsed state in the Toolbox
window. To expand the Component Systems toolbox, click on the plus sign {+) located on
the left of the Component Systems title bar. The components displayed in the Component
Systems toolbox are the basic blocks of a project and form only a part of the analysis system,
such as Geometry (used to create a model for analysis), Mesh (used to generate FEA model),
Results (used to visualize the results of analysis in the desired form), and so on. Figure 2-5
shows the Components Systems toolbox with various components displayed in it.

B, Analysls Systemet
B fomponentSystems .ot
@ CFX

@ Engineering Data

r;'[- External Conrection

Exteraal Data

(D) Finke BlementModaler

B3 ruumer

@ Geamnetsy

A\ Mechanical APDL

§ Mechenical Modd

G Mesh

B¥ Microsuft OfficeExcel

& Resvits

System Coupling

[@. costomystens
L8 DesignBrfotat

Figure 2-5 The Component
Systems toolbox
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Custom Systems Toolbox
By default, the Custom Systems toolbox is also displayed in collapsed state in the Toolbox.

To expand this node, click on the plus sign (+) displayed on the left of the Custom Systems
title bar, refer to Figure 2-6. The systems in the Custom Systems toolbox are used to carry
out standard coupled analysis, in which the mput and output data of one analysis are used
as input for the next analysis. For example, the Pre-Stress Modal system is used carry out
Static Structural analysis followed by a Modal analysis. Similarly, the FSI: Fluid Flow (CFX)
- Static Structural custom system is used to carxy out a Fluid Flow analysis in CFX followed

by a Static Structural analysis.

To add a custom system Lo the Project Schematic window, double-click on it in the Custom
Systems toolbox in the Toolbox window. Figure 2-7 shows FSI: Fluid Flow (CFX) -> Static
Structural custom system added to the Project Schematic window. This figure iflustrates two-
different systems sharing the same geometry. This type of sharing is done if a single project
requires various analysis types for the same geometry. You will learn about adding systems to
the Project Schematic window later in this chapter.

t T
] 1@ Geometry v ‘\ 3 & EngineeringDate v 4
: 3 & Mesh v 4l H 3 = Geometry v 4

“F s Fluld Fiow (CRO -5 Stalic Stradtural - A B setup =1 P & Model &
::::i:tl:fsr::.égfLumn-ssaat:csuu:tu 5 <8 Solution - “____._____ﬂjs @‘ sebup EM
Raadom Yibraton L6 Results -2 16 Solation 2
B S © Fuid How (0P 7 @resis P
i@u,.‘!ﬁ‘?f‘ pinraion: | Statie Strictural
Figure 2-6 “The Custom Figure 2-7 The FSI: Fluid Flow (CFX) -> Static Structural
Systems toolbox custom system added to the Project Schematic window

Design Exploration Toolbox

By default, the Design Exploration toolbox is displayed in collapsed state in the Toolbex
window. Expand this toolbox by following the procedure discussed earlier. The options in
the Design Exploration toolbox are used to explore a component, 5o that the design of
the component can be further optimized by changing the design variables based on the
performance of the product, refer to Figure 2-8.

You can control the display of elements in the Toolbox. [EJ GesignExpiardion - T 1
To do so, choose the View All / Customize... button @Goaz Drw - !C.}.t;.\.éimi.z mg
displayed at the bottom of the Toolbox window; the parameters Correlation

Toolbox Customization window will be displayed, as Responss Surfars

shown in Figure 2-9. In this window, some of the check Eﬂ sixSiama Analysis

boxes are selected, indicating that the corresponding ' )
element will be displayed in the Toolbox window. Clear  Figure 2-8 The Design Exploration
the check box corresponding to those elements that  o/box

you do not want to be displayed in the Toolbox

window.
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Figure 2-9 The Toolbox Customization window

Project Schematic Window

Th(la Project Schematic window helps manage an entire project. It displays the workflow of
entire .analysm project. To add an analysis system to the Project Schematic window, drag the
analysis system from the Toolbox window and drop it into the green-colored box di;,piayed in
the Project Schematic window, as shown in Figure 2-10 and 2-11. Alternatively, double-click
on an analysis system in the Toolbox window to include it in the Project Schematic window.
You can also add an analysis system to the Project Schematic window by using the shortcut
menu dzsplayed on right-clicking in the Project Schematic window. The procedure of adding
an analysis system by using the shortcut menu is discussed later in this chapter,

l £ Analysis Sysoan,
B4 Design hysesmmert

§4 DesigaAssessmunk

(8 #eeric ' £ Beane

g ?'féi&'}l?x'f {5 eeplicitbyramics
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B vrarmasicpesponse £ Harmaric Respanse

i cEngine . R i engire

S Lingar Buckfis: S

% I;::q;f;ij‘_:q Y tinearBuciding

] Medsl ) Meagnerostae
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i) Randoard

Eg R“;n:‘“‘;’;ﬁ"“ {@j Randam Vibratan U oo
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Figure 2-10 Dragging the Static Structural  Figure 2-11 The Static Structural analysis

@;j{ysz’s system into the Project Schematic system open in the Project Schematic window
window
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In the Project Schematic window, when you click on the down arrow ava;iabl.e at Ithe tog
right corner, a fiyout is displayed with various options to close, float, restore, minmmize, an

’ . . ' .
maximize the Project Schematic window, refer to Figure 2-12,

Dok Sehds

Figure 2-12 Partial view of the Project Schematic window with the flyout displayed

Fach time you drag and drop an analysis system or an item into the Project Scbema:;gk‘zilgﬁx
a system is formed. Each system, consists of cells‘whlch are .used to catry out \‘zagousb o
a system. You can add more than one systems in the Project S(;hematlc X;n o*gd'y S gtge mgz
and dropping them from the Toolbox window, as per the reqr'nremct:nt.h texila fl:fe i Lems
to the Project Schematic window, you can share the data available in ; e cells Oharin ysame
with the corresponding cells of another system. A common example o S};t;;m $ g

kind of data among various cells of different systems is shown in Figure 2-13.

I—————- Systems —-——l

Projedt Sciiémat

W2w @ Enginaering Data
3G Geometry
Cells 416 vodel ] o ‘@4
- 5088 Sewp 5 & setup P
5_5.: G Solution VB Salution E’ A;
7 Resuls o @ Resu}ts _,, ‘
StEHdY'Stﬁta'ﬂ'IErmal (ANSYS) . Static Structurs! {ANSYS)
—Links

Figure 2-13 Partial view of the Project Schematic window showing sharing of
cells among two different analysis systems

Note _ N o
You will learn about the Project Schematic window, systems, and cells in detail later in this

chapter.

Menu Bar

Menu bar is located on the top of the Workbench
window and contains various options such as File, View,
Tools, and so on. These options enable you to control e W
and manage the files of the current project. Figure 2».14 Figure 2-14 The Menu bar
shows the Menu bar in the Workbench window. 'I“h'e . o

options available in various menus will be discussed in detail Jater in this chapter.

File . Viey _ 'UI'IITS---_.HEIF\'

Standard Toolbar . |
The Standard toolbar is a collection of the frequently used tools in ANSYS Workbench 14.0
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and is shown in Figure 2-15. The tools available in the Standard toolbar are also available in
the Menu bar, ‘

P Mew pFopen... (& save &l save as. . l@]}mport... lé”c_pReconnect & Refrash Project # Update Project {@Project &3 Compact Mode
Figure 2-15 The Standard toolbar

The various tools available in the Standard toolbar are New, Open, Save, Save As, Import,
Reconnect, Refresh Project, Update Project, and so on. You can use these tools to create
new projects, open existing ones, save a project, save a project to a different location with a
different name, import a project from another source, refresh project status after changes are
made to it, update a project to its Jatest status and so on,

Shortcut Menu
In ANSYS Workbench, you can invoke most of the s
tools by using a shortcut menu displayed on  5[@
. N . . lew Geomelry..
right-clicking. The shortcut menus displayed are ]S Model R

Ty . . T = port Gesmatry >
context sensitive, that is, the context in the shorteut 21 sew P
menus will change depending upon the place j i‘:’;‘i‘;" | rensier Dota From e »
where you right-click to invoke it. You can = ¥ satiestann | Tt DataTonew
right-click anywhere in the Workbench window to T
display a shortcut menu. Some of the options in a B Ravesh
shortcut menu display an arrow on their right. This Reset
arrow indicates that one more menu will be B2 nename
displayed on choosing this option. Figure 2-16 bl
shows the shortcut menu that is displayed by JDudktieh

right-clicking on the Geometry cell of the Static " .
Structural system in the Project Schematic Fzgqre 2',16. The shortcut men dzsplayed
. by right-clicking on the Geometry cell in the
window. ; Co
Project Schematic window

WORKING ON A NEW PROJECT

o start working on a new project, you need to add an appropriate analysis or component
system to the Project Schematic window.

Adding a System to a Project
After starting a new project, it is necessary to define the tasks to be carried out in ANSYS
Workbench 14.0. To start a new analysis, you need to add an analysis system to the Project

Schematic window, as shown in Figure 2-17. There are many ways to add a system to a project.
They are discussed next.

Adding a System by Drag and Drop

1o add a system to a project by dragging and dropping, pick the required system template
from the Toolbox window and then drag the cursor to the Project Schematic window; the
green rectangular area of dash lines will be displayed, representing the location where the
picked analysis system can be dropped, Move the cursor over the green rectangular area; the
green rectangle will convert into a red rectangle of solid lines, refer to Figure 2-17. Drop the

system in the red box; the system will be added to the project and will be displayed in the
Project Schematic window.
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Figure 2-17 Adding an analysis system by drag and drop

Note ‘

After adding the first analysis system into the Project Schematic window, when you drag the
next analysis system from the Toolbox window to add iv the Project Schematic window, more
then one green rectangular areas of dash lines will be displayed, representing the possible locations
where you can drop analysis.

Adding a System by Double-clicking

You can also add an analysis system by double-clicking the left mouse button. To do so,
double-click on the system that has to be added to the project; the system will be automatically
added to the Project Schematic window.

Note
If an analysis system already exists in a project and then you double-click to add a new system,
it will be added below the existing one.

Adding a System Using the Shortcut Menu

You can also add an analysis system by using the shortcut menu. To do so, right-click on the
Project Schematic window; a shortcut menu will be displayed. Using this shortcut menu, you
can add analysis, component, and custom systems to the Project Schematic window. To add an
analysis system, choose the New Analysis Systems option from the shortcut menu; a flyout will
be displayed. Choose the desired analysis system from the flyout to add it to the project.

To add a new component system in the project, choose the New Component Systems option
from the shortcut menu; a flyout will be displayed. Next, choose the desired component system
from the flyout to add to the Project Schematic window, refer to Figure 2-18.
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Similarly, to add a new custom system or a new design exploration system into the Project
Schematic window, choose the New Custom Systems or New Design Exploration option

respectively from their respective shortcut menu. Next, choose the desired option from the
flyout to add to the Project Schematic window. '

%  Aeconnect
i@ Refresh Projact
¥ Update Project
Claar Aff Gerwrated Data
Add to Custom .
-7 e Adalysis Sygtans SR ’ B Desion Assessment
New Companent Systems B Blecic
New Custom Systems » B Exolicit Oynamics
New Design Exploration Y R Fiud Fow €R0
Show Connections fundied Fluld Fiow (FLUENT}
Show Systam Coordinates @5 Harmonic Response
Fit % IC éngine
EB Linear Butlding
{0  Magnetostane
Eﬁ Modat
§§  random vibration
@B Rasponse Spectrum
BH  Rigid Dynamics
] sticsucunal o]
8 Steady-State Ther
@ Themal-Slectic
B, Transient Structural
@ Transient Thermat

Figure 2-18 Choosing the Static Structural
Analysis System from the shortcut menu

RENAMING A SYSTEM

A X Refrash
After a system is added to the Project Schematic window, Uodate
its name will be highlighted at the bottom of the system. I i
Specify a name for the system and press ENTER. You can [y = Dwiete
also rename an existing project by double-clicking on the  "TTd  Replsewih
name of the current project. Alternatively, click on the black 5" Clear Generated Data
down-arrow displayed at the upper left corner of the ‘:,:x Delete

analysis system; a flyout will be displayed. Choose the @ Remamen. . o)
Rename option from this flyout, refer to Figure 2-19; the t [P —

name of the system wili be highlighted. Specify a name to ,
the system. Figure 2-19 Choosing the Rename

option from the shortcut meny

Wy
Prapertias B
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DELETING A SYSTEM FROM A PROJECT

To delete a system from the Project Schematic window, right-click on its name displayeq in
the title bar; a shortcut menu will be displayed, refer to Figure 2-20. Choose Delete option
from the shortcut menu; the ANSYS Workbench message box will be displayed, as shown in
Figure 2-21. Choose the OK button from this message box; the selected system will be deleted
from the project. Alternatively, click on the down-arrow disp}ayed at the' upper left corner of
the system; a flyout will be displayed. Choose the Delete option from this flyout 1o delete the

system from the project.

Refrash
2 @ Engines . update
3| 8 ceomet] .
; Duplicate
& B vode! _
5|8 sewp | Reptace With » . . :
2 & solutor Clear Generated pata — " This opecation wil delete any'unsha'r_e.ddata' inthe sél_echeé:i AR
71D Resuis| B oDelete . Systams:: . : ST
swicy O Rename
Propertes

Figure 2-20 Cﬁoosing the .Delete option Figure 2-21 The ANSYS Workbench message box

Jrom the shortcut menu

DUPLICATING A SYSTEM IN A PROJECT

. To duplicate a system, select the down arrow available at the top left corner of the
= selected system; a fiyout is displayed, refer to Figure 2-20. Choose the Duplicate option
from the flyout to duplicate it.

Note
While duplicating a system, all the cells will be duplicated excepi the Result cell.

SAVING THE CURRENT PROJECT

; Whenever you start a new analysis project, the title bar of the Workbench wilndov.w
e displays Unsaved Project - Workbench. This indicates that the current project is
not saved yet. To save the current project, choose the Save button from the Sjandard toglbar.
Alternatively, choose the Save option from the File menu; the Save As dialog box w111’be
displayed, as shown in Figure 2-22. You can also invoke the Save As cfaalog box by pressing
the CTRL and S keys together. In this dialog box, browse to the location where you want to
save the current project and then specify its name in the File name edit box. Next, choose the
Save button; the project will be saved at the specified location. After saving the project, the
title bar of the Workbench window will display the name that you have specified while saving
the project.
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Note

If you hawe already saved the project, the Save As dialog box will not be displayed on choosing
the Save bution.

If you want to save an opened project with a different name or at a different location, choose
the Save As button from the Standard toolbar; the Save As dialog box will be displayed, refer
to Figure 2-23. Specify a new name and then choose the Save button from this dialog box; the
same project will be saved with the new name and will become the current project.

OPENING A PROJECT

To open an existing project, choose the Open button from the Standard toolbar;

the Open dialog box will be displayed, as shown in Figure 2-23. Browse to the
location where the project file is saved, select the * wbpj file, and then choose the Open button
from this dialog box. The selected project file will be opened and its name will be displayed
on the title bar of the Workbench window. Alternatively, choose the Open option from the
File menu.

ARCHIVING THE PROJECT DATA

If you want to move the project data from one system to another, you can archive all project
related data in a single zip file. This zip file contains all files and folders necessary to run the
project on another computer, such as project file (*.wbpy) and project folder (name_files). To
archive a project, choose File > Archive from the Menu bar; the Save Archive dialog box
will be displayed, refer to Figure 2-24. By default, name is displayed as the name of the file in
the File name edit box, where, name is the project name of the current project. If you want to
assign a different name to the archive file, specify it in the File name edit box.
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Figure 2-24 The Save Archive dialog box

Next, specify the location where you want to save the archive ﬁie and chogse the Save button
from the Save Archive dialog box; the Archive Options dialog box will }?e displayed, as
shown in Figure 2-25. If you do not want to include the result and the solution file or some
imported file that has not been created in the project, clear the respective ch'eck box from
the Archive Options dialog box. Next, choose the Archive button frqm 'th1s dialog box; the
zipped archive file will be created at the specified location. Transfer this zip file to any system
and restore the project files.
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Extracting the Archive File :
'Io extract project files from the archived zip file, :
choose File > Restore Archive option from the
Menu bar; the Select Archive to Restore dialog
box will be displayed. Select the archive file to
be restored and then choose the Open button
from this dialog box; Save As dialog box will
be displayed. Specify the name of the project
and the location where you want to save the
archive file and then choose the Save button
from the Save As dialog box. On doing so, the
archived files will get extracted with the
specified name of the project to the specified location. Also, you will notice that the extracted
project file (*.wdpj) is open in the Workbench window.

UNITS IN ANSYS Workbench

In ANSYS Workbench, you can use any of the following predefined unit systems:

Figure 2-25 The Archive Options dialog box

1. Metric (kg,m,s,"C,A,N,V) Unit System

Mass = Kilogram (kg) Temperature = Degree Celsius (°C)
Length = Meter (m) Current = Ampere (A)
Time = Second (s) Force = Newton (N)

Voltage = Volts (V)

2. Metric (tonne,mm,s,’C,mA,N,mV) Unit System

Mass = Tonne Temperature = Degree Celsius (°C)
Length = Millimeter (mm) Current = Milliampere (mA)
Time = Second (s) Force = Newton (N)

Voltage = Millivelt (mV)

3. U.S8. Customary (lb,in,s,°FA,Ibf,V) Unit System

Mass = Pound (ih) Temperature = degree Celsius (°C)
Length = Inch (in) Current = Ampere (A)
Time = Second (s) Force = Pound (Ibf)

Voltage = Volts (V)

4. ST (kg,m,s,K,A,N,V) Unit System

Mass = Kilogram (kg} Temperature = Kelvin (K)
Length = Meter (m) Current = Ampere (A)
Time = Second (s) Force = Newton (N)

Voltage = Volts (V)

5. U.8. Engineering (Ib,in,s,R,A,Ibf,V) Unit System

Mass = Pound (Ib) Temperature = Renkine (R)
Length = Inch (in) Current = Ampere (A)
Time = Second (s) Force = Pound {Ibf)

Voltage = Voits (V)
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Metric (kg,m,s,"C,A,N,V) unit system is the default unit system that is assigned to a project.
4l ) :
However, y:)u,c;n éhange the unit system for the current project or set the default unit system,
? -
to be assigned to any new project.

ANSYS WORKBENCH DATABASE AND FILE FORMATS

When you save a project, a project file is created with a name mme.wbpj, where name can be
an usZr specified name. In addition to the project file, a folder is also (:'reat(?ci with a naéné
nm);ze - files pAll other files relevant to the project are automatically saved in this folder undex
various sub folders such as, dp0, user_files, and so on.

; : 1 wi i file extensions. To view all files
khench, various files are created thh‘ddferent : ‘ .
izsi\(l:\if:;icsi XE the current project, choose View > Files from the Menu bar; the Files window
will be displayed, as shown in Figure 2-26.

Figure 2-26 The Files window

The Files window lists all files of the current project. The information displayed in the File
window includes the following:

1. Name and extension of the files. .
2. The reference of the analysis component cell with
which the file is associated.

3. The file size and its location.

Vo File Type i
ANSYS Projact File
Engineering DatzFile

ChecktoDisplay.

Geometry File
Mechanical Database.

To open a folder containing the selected files,
right-click on the corresponding cell and then
choose the Open Containing Folder option from the
shortcut menu displayed. To filter in any parqcular
type of file extension, right-click on any cell to dxs.piay
a shortcut menu. Next, choose the File Type Filter
option from the shortcut menu; thff: Type Filter
dialog box will be displayed, as shown in Figure 2-27.

Deasign Point File
CAEReD File

dat

&y

PCS

ANSYS Result File

EMKMKWWNQH

Seiect the check boxes displayed on the left of the . ‘
desired file type from the Type Filter dialog box; the Figure 2-27 The Type Filter dialog box
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list displayed in the File window will chan
Type Filter dialog box. After selecting th
Type Filter dialog box to exit.

ge dynamically based on the selection made in the
¢ desired file types, choose the Ok button from the

The following are some of the main file extensions used in ANSYS:

“wbpj = ANSYS Workbench project database file
*.engd = Engineering Data

*.agdh = DesignModeler file

*fedb. = FE Modeler files

*cmdb = Meshing file

*.mechdb= Mechanical file

*rsx = Mesh Morpher

*ad = ANSYS AUTODYN

*dxdb = Design Exploration

*.bgd = BladeGen

*db = Mechanical APDL database file
*.cas, *.dat, *.msh = FLUENT files

*.cfe, *.def, *res, *andef, and * mres = CFX les
*.cmdb = CFX-Mesh files

CHANGING THE UNIT SYSTEMS

You can change the unit system being used in the current project. To do s0, choose the Units
menu from the Menu bar; a menu with various options will be displayed. Select the desired

unit system from the menu; a tick mark will be displayed on the lef: of the selected unit system,
refer to Figure 2-28.

P R

Figure 2-28 The Units meny

In addition to the unit systems displayed in the Units menuy, you can customize to add some

more unit systems by using the Unit Systems dialog box. To invoke this dialog box, choose

Units > Unit Systems from the menu bar; the Unit Systems dialog box will be displayed,

as shown in Figure 2-20. All unit systems supported by ANSYS Workbench will be displayed
under the Unit System column in the Unit Systems dialog box. If you select a unit system
n this colurnn, the units used for measuring various quantities will be displayed on the right
pane in this dialog box.
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Figure 2-29 The Unit Systems dialog box

ANSYS Workbench supports fifteen standard unit systems. However, by default only five
standard unit systems are displayed under the Units menu. This is because the rest of the unit
systems are suppressed in the Unit Systems dialog box, by default. To unsuppress a unit syster,
clear the corresponding check box under the Suppress column in the Unit Systems dialog
box. Now onward, the unsuppressed unit system will be displayed in the Units menu.

You can change the default unit system that is assigned to a new project. To do so, select the
radio button corresponding to the desired unit system, in the Default column in the Unit
Systems dialog box. Now onward, the specified unit system will become the default unit system
for new projects. Select the radio button corresponding to the desired unit system undez the
Active Project column to make it the unit system for the current project.

If the standard unit systems given in ANSYS Workbench do not suit your requirement, you
can customize a unit system according to your requirement by using the Unit Systems dialog
box. To do so, select the unit system that closely fits your requirement under the Unit System
column and then choose the Duplicate button from the Unit Systems dialog box; a new unit
system will be added under the Unit System column with the default name Custom UnitSystent.
Rename this system. Select the newly defined unit system; the corresponding measuring units
will be displayed on the right pane. Click on the down-arrow displayed on the right of the
units under the Unit column; a drop-down list will be displayed with all feasible units for the
quantity to be measured. Select the desired units from this drop-down list. You can also export
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custom units for the use of other users or import an already saved unit system by using the
Export or Import button, from the Unit Systems dialog box. The imported or exported unit
system files are saved in .xml format. To delete the selected customized unit system, choose
the Delete button from the Unit Systems dialog box.

COMPONENTS OF A SYSTEM

An item that is added from the Toolbox window to the Project Schematic window is known
as system and the constituent elements of the system are known as cells. Each cell of a system
plays an important role in carrying out a project and are discussed next.

Engineering Data Geometry Model/Mesh
Setup Solution Results

Engineering Data Cell

The Engineering Data cell is used to define the material to be used in the analysis. To define
the material, double-click on the Engineering Data cell; the workspace corresponding to
this the Engineering Data cell will be displayed, as shown in Figure 2-30. Alternatively, you
can also invoke the Engineering Data workspace to specify the material by right-clicking
on the Engineering Data cell and then choosing the Edit option from the shortcut menu
displayed.
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Figure 2-30 The Engineering Data workspace

Note

When you right-click on Engineering Data cell, the Edit option will be highlighted in the
shortcut menu. This indicates that this is the most suitable action that can be taken. You can
select an option from the shortcut menu as per the requirement. However, when you double-click
on the Engineering Data cell, the most sustable action will be initiated directly.
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Geometry Cell _ ‘
The Geometry cell is used to create, edit, or import the geometry that is E;sed for analysis. To
create a geometry for analysis, double-click on the Geometry cell; the DesignModeler window
will be displayed. Alternatively, right-click on the Geometry ce%i and then choosc? the New
Geometry option from the shortcut menu displayed, refer to Figure 2-3‘2. Some rmportant
options in the shortcut menu that are specific to the Geometry cell are discussed next.

S
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Figure 2-31 The shortcut menu displayed
on right-clicking on the Geometry cell

The New Geometry option in the shortcut menu is used to start the DesignModeler window,
where you can create geometry. This option will only be available if you have not defined a
geometry. The Import Geometry option is used to import any existing geometry to the current
analysis system. You can also import the geometry created in other CAD packages. The Edit
Geometry option will only be displayed if a geometry is already associated w1th.{he current
analysis system. When you choose this option, the geometry opens in the DesignModeler
window for modification. The Replace Geometry option is used to replace the existing
geometry that is associated with the analysis system with another geometry.

Note
o exit the DesignMeodeler window, choose File > Close DesignModeler from the Men bar;
the Workbench window will be displayed.

Model Cell

The Model cell will be displayed for mechanical analysis systems and is used to discretize
geometry into smal} elements, apply boundary and load conditions, solve the analysis, and so
on. On double-clicking on this cell, the Mechanical window will be displayed. In other words,
this cell is associated with the Mechanical window.
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Mesh Celi

The Mesh cell will be displayed for fluid flow analysis systems and is used to miesh the geometry.
On double-clicking on this cell, the Meshing window will be displayed. In other words, this
cell is associated with the Meshing window.

Setup Cell

The Setup cell is used to define the boundary conditions of an analysis system, such as loads
and constraints. This cell is also associated with the Mechanical workspace.

Solution Cell

The Solution cell is used to solve the analysis problem based on the conditions defined in the
cells above the Sotution cell. This cell is also associated with the Mechanical workspace.

Results Cell

‘The Results cell is used to display the results of the analysis in the user specified formats. This
cell is also associated with the Mechanical workspace.

STATES OF A CELL IN AN ANALYSIS SYSTEM

All cells display some visual symbols on their right to indicate their current status. This
helps the user understand the next step in the analysis process as well as understanding the

overall status of an analysts, refer to Figure 2-32. The explanation of these symbols is given
in Table 2-1.

—27 @ Engineering ata ‘:
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Figure 2-32 Symbols for cell status

Table 2-1 Symbols and their meaning

Symbol Meaning Function
=3 Attention required indicates an immediate requirement of
symbol action for a cell and a user cannot proceed
further without fixing the cell
= Unfulfilled indicates that the previous cells do not
" have sufficient or appropriate data
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. Up w0 date indicates that the cell is up-to-date an
v b the data in the cell is ready to be shared
with other cells

Refresh required indicates that the data of the previous
cells has been changed since last updat-e
and you need to refresh the cell with this
symbol, refer to Figure 2-35
Input changes pending | indicates that the data of the current cell |
will change on updation, if changes are
done in the previous cells ‘
z Update required indicates that the input data of the cell has
been changed and the output data needs
to be updated :
Refresh failed indicates that the last refresh process for
the cell has failed

3 Update failed, update | indicates that the last update process for
e needed the cell has failed and you need to update
it again
Update failed, attention | indicates that the last update process
needed has failed and the cell needs immediate
attention.

L

Figure 2-33 shows an analysis system in which the geometry of the analysis rnpdel has beep
changed after performing the complete analysis. Therefore, the refresh required symbol is
displayed against the Model cell.

2 ngineering Dal

L3 Geometry ¥ 4
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5| setup @ i — Refresh required
& Solution 2 -‘i

T @resds T

static Structural .

Figure 2-33 The Static Structural analysis
system with the refresh required symbol annotated

REFRESHING AND UPDATING A PROJECT

Refresh is a process in which ANSYS Workbench reads the entife modified
data. To refresh the entire project, choose the Ref?esh Project button
from the Standard toolbar. Alternatively, choose Tools > Refresh Project from the Menu
bar.
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Note

When you refresh the entire project, the output data will not be recaleulated based on the
modifications made in the project.

Update is a process in which ANSYS Workbench refreshes the input data
and recalculates the output data. To update the entire project, choose the

Update Project button from the Standard toolbar. Alternatively, choose Tools > Update
Project from the Menu bar.

You can also refresh or update a particular cell by choosing the respective option from the
shortcut menu that is displayed on right-clicking on that particular cell. These options will
only be available in the shortcut menu if that particular cell needs refreshing or updating.

If you refresh a particular cell, you can get information about its effect on the cells below the
specified cell, and if needed, you can make the required changes before updating the cell.

Refreshing a cell before updating is useful in complex analysis systems, where updating can
take more time compared to refreshing.

ADDING SECOND SYSTEM TO A PROJECT

The second or the subsequent system can be added in the Project Schematic window in two
ways, either as a stand-alone system or as a connected system that shares data with the existing
analysis system. In a project, multiple stand-alone systems are preferred in case of performing
analysis for various components of an assembly. In this way, analysis of all components of an
assembly can be kept and managed in a single analysis project. The connected analysis systerns

are preferred more for conducting coupled analysis, where data from the first analysis system
can be used or shared with the next analysis system.

As discussed earlier, to add a stand-alone system, double-click on the analysis system template
in the Toolbox window; the new analysis system will get added in the Project Schematic window
below the existing analysis system, as shown in Figure 2-34. Alternatively, use the shortcut

menu or the drag and drop method to add a stand-alone system to the Project Schematic
window.

Adding Connectors

There are two ways in which you can add connectors between cells of different systems in the
Project Schematic window. In the first method, drag the cell from one system and drop it in
the corresponding cell of another system; connectors will be added between the systems, which
indicates that the data is shared. In the second method, drag the system from the Toolbox
window to the Project Schematic window and move the cursor over the cell of the existing
systern with which you want to share the data; a red rectangle will be displayed on the right of
the existing system with text written inside the rectangle. The text will give you information
about the cells with which the data will be shared by the new system, as shown in Figure 2-35.
Drop the selected analysis system over the desired cell of the existing analysis syster; the new
systemn will be added to the right of the existing analysis system and will share data from the
specified cells. Figure 2-36 shows a new analysis system, the Linear Buckling analysis system,
dropped over the Solution cell of the Static Structural analysis system. Note that the new
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system will automatically shaze the

necessary data from the cells that are above the cell over

which you dropped the new analysis system.
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Figure 2-34 Two stand-alone
systems added in the Project
Schematic window
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Creating a Geometry

When a new system is added in the Project Schematic window, the next stefs is to create the

geometry, To create a new geometry, rig

ht-click on the Geometry cell of the system; a shortcut

menu will be displayed, refer to Figure 2-37. Choose New Geometry from the shortcut menu;

the status bar will display the mes
the DesignModeler window along with
the ANSYS Workbench dialog box
will be displayed. Specify the unit of
length in the ANSYS Workbench
dialog box and then choose the OK .
button to close it. After the ANSYS
Workbench dialog box is closed, the
DesignModeler window will be
activated, refer to Figure 2-38.

Next, in the DesignModeler window,
create a model according to your
design requirements by using the
tools available in this window. These
tools will be discussed in detail in later
chapters. After creating the model,
close this window. On doing so, the
model will be automatically saved in
the ANSYS Workbench database. Also,
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Figure 2-37 The shorcut meny dzlspiayed .oﬁ"ﬁght.wclz;cking
on the Geometry cell

a green color check mark will be displayed on the right of the Geometry cell of the analysis
systetn in the Project Schematic window, indicating that the geometry requirement is satisfied

for the current system.
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Figure 2-36 The Linear Buckling analysis system added as a connected system
to the Static Structural analysis system

SPECIFYING A GEOMETRY FOR ANALYSIS

In ANSYS Workbench, geometry can be specified in two different ways. In the first method,
you can import a geometry created by using any other solid modeling software. In the
second method, you can create a new geometry in the DesignModeler application of ANSYS
Workbench. The procedure to create a new geometry is described next,
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Figure 2-38 A typical DesignModeler window
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After the geometry is specified for the analysis, you need to fulfil the requirement of other
cells in the system. The cell types in the system are context specific and are solely dependent

on the type of system selected.

In a system tree, you need to update the cells from top to bottom. For example, in a Static
Structural analysis system, you need to satisfy the requirement of the Geometry cell before

you move to the Model cell.

Note _ . ' ‘
The detailed procedure of working through analysis component cells in an analysis system 13

given in later chapters.

USING HELP IN ANSYS WORKBENCH

In ANSYS Workbench, there are different ways in which you can access help. These methods
are discussed next.

ANSYS Workbench Help

i i i i iSYS Workbench. To access
You can get online help and documentation while working on ANSYS ‘
the helpg, choose ANSYS Workbench Help from the erlp menu of the Menu bar; the
ANSYS 14.0 Help window will be displayed, as shown in Figure 2-39.
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Figure 2-39 The ANSYS Help window

The ANSYS 14.0 Help window is divided into two parts: .Navigation pane {(left pane) and
Document pane (right pane). The Navigation pane consists of the Contents, Index, and
Search tabs and the Document pane contains the information related to the topic selected in
the Navigation pane. When the Contents tab is selected, the list of topics covered in ANSYS
Help is listed in the Navigation pane of the ANSYS 14.0 Help window. When a particular
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topic is selected in the left pane, the corresponding information or help is displayed in the
Document pane. You can open multiple help documents in the Document pane. To do so,
choose the plus sign (+) displayed on the last tab in the Document pane; a new tab will be
added in the Document pane, refer to Figure 2-39. Now, open a new document related to
your topic of interest in this tab.

Apart from the ANSYS 14.0 Help window, ANSYS Workbench offers two more ways Lo access
help and they are discussed next.

Quick Help

Quick Help is available for all the cells of an analysis or component system in the Project
Schematic window. Click on the blue inclined arrow at the bottom right corner of any cell; a
flyout will be displayed with a short description on the current status of the cell. This flyout
contains some relevant links that when clicked, will directly open the related document in the
ANSYS Help window, refer o Figure 2-40.

Context Sensitive Help

Context sensitive help lists the help topics of the ANSYS Help window, related to the currently
active option. To open the ANSYS Help window, choose Help > Show Context Help from the
Menu bar; the Sidebar Help window will be displayed on the right of the Project Schematic

window, as shown in Figure 2-41. Alternatively, press the F1 key to open the Sidebar Help
window.

Choose from the
following general
topics:

2@ Engineering Data 4 Building a System
131§ Geometry i Engineering Data
L4 [0 Mode : Geonetry
g
&
7

AN

ST e Either no data has been Model/Meash
5 specified, or the model Setup
25| contains errors in Selution
7@ Resitd pagignModeler. Right-click the Results
sutic 5| Geometry cell and choose Tutorials
Import Geometry to load an
axisting geometry, choose
New Geometry to apen
DesignModeler and create &
new geornetry, or choose Edit
to open the current geometry
in DesignModeler to correct
the error.

& Solubiod

Or choose from the
following analysis
types:

Steady-Siate
Thermal

Geometry Properties otatic Structural

Systems and Cells ANSYS Workbench
Help
«.' En .
ANSYS Workbench ANSYS.com

Figure 2-40 The Quick Help Figure 2-41 The Sidebar Help window
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EXITING ANSYS WORKBENCH

" i pench window, choose File > Exit from the Menu bar. If the current
g(;o;;{clt{ izhxfoyiaoxfrd or if you have made any changes after the project was larst saved, ;hen or*1
choosing the Exit option, the ANSYS Workbench message box will be displayed, as Csi o.wn; 1}:
Figure 2-42. Choose the Yes button from this message box to save the change_&s‘mz ehm e
current project and exit the Workbench window. Choose the No button to d}scar c ar;bges
and close the ANSYS Workbench window. Choose the Cancel button from this message box

to cancel the exit process.

Figure 2-42 The ANSYS Workbench message box

TUTORIAL

IﬂL;; tuto;"iai, yéu will start ANSYS Workbench and add a new Static Structural an.alysis system
to the Project Schematic window. After adding the analysis system, save the project with t.he
name ¢02 ansWB tut01 at the location CANSYS_WBic02\TutO1. (Expected time: 15 min)

The following steps are required to complete this tutorial:

a. Create the project folder.

b. Start ANSYS Workbench 14.0. ‘ o

Add the Static Structural analysis system to the Project Schematic window.
d. Save the project and exit the ANSYS Workbench session.

s

Creating the Project Folder _ ‘ . .
Beforég you start ANSYS Workbench, you need to create a project folder in which you will

save all your projects.

I, Create a folder with the name ANSYS_WB at the location C:\.

You will save all your projects in the folder ANSYS_WB.
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Starting ANSYS Workbench 14.0
First, you need to start ANSYS Workbench and then add the analysis system to the project.

L. Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the Start menu; the
Workbench window along with the Getting Started window is displayed.

The Getting Started window is displayed when ANSYS Workbench is started. The Getting
Started window gives information about the procedure to be used for carrying out an analysis,
When the ANSYS Workbench session is started, the Getting Started window is displayed by
default. To stop this window from display the next time you start a new session of ANSYS

Workbench, clear the Show Getting Started Message at Startup check box from the Getting
Started window.

2. Choose OK in the Getting Started window 10 close the window.

3. Choose the Save button from the Standard toolbar; the Save As dialog box is
displayed.

4. Browse to the location C:IANSYS_WB and then create a folder with the name c02.

5. Now, create another folder with the name Tut01 under the ¢02 folder and then open the
newly created folder by double-clicking on it.

6. Enter c02_ansWB_tut01 in the File name edit box and then choose the Save button from
the Save As dialog box; the project is saved with the specified name.

Adding Static Structural Analysis System to the Project
Next, you need to add the Static Structural analysis system to the project.

1. Double-click on the Static Structural option displayed in the Analysis Systems toolbox in
the Toolbox window; the Static Structural system is added to the project and is displayed
in the Project Schematic window.

Note

The Static Structural analysis system can also be added by dragging it from the Toolbox window
and then dropping it on the Project Schematic window. You can also add it by using the options
in the shortcut menu that is displayed on right-clicking in the Project Schematic window.

2. Once the project is added to the Project Schematic window, its name is highlighted at the

bottom of the analysis system in blue. If it is not highlighted, double-click on the name
and enter c02_ansWB_tut01, as shown in Figure 2-43. The analysis system is renamed.
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Figure 2-43 The Static Structural analysis system added to the project

Saving the Project and Exiting ANSYS Workbench

1.

2.

Now, you need to save the project and exit ANSYS Workbench.
Choose the Save button to save the project with the name ¢02_ansWB_jut01.

Choose Exit from the File menu; the current ANSYS Workbench session is closed.

Answer the following questions and then compare them to those given at the end of this

chapter:

1. You can add an analysis system to the Project S;:hematic window by double clicking on
the desired component in the Analysis Systems toolbox. (1I7F)

9. The geometry for an analysis can not be imported from an external software package. (T/F)

. The Results cell is used to display the contents of an analysis system. (T/F)

4. Ifyou choose an option that has 3 dots (...) on its right then a dialog box corresponding
to that option is displayed. (T/F)

5. The archived project files are saved in format.

6. To view all files related to the current project, choose from the Menu bar.

7. Press the key to open the Sidebar Help window.

8. Inthe Workbench window, you can change the units by using the options available in the

menu,
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Answer the following questions:

1.

To create a connected system for cou

the Toolburn (/B pled analysis, double-click on an analysis system in

%; )*.wbpj file is the default extension for the project files in ANSYS Workbench 14.0

A project consists of systems and a system consists of cells. (T/F)
You can specify a unit system from the Menu Bar. (T/F)

g}; }Engmeermg Data cell is used to define the geom’etry to be used in an analysis project.
Which one of the following unit systems is assi
(a) Metric (kg,m,s,°C,A,N,V)

(b) SI (kg,m,s,K,A,N.V)

(¢) U.S. Engineering (Ibm,in,s,R,A,Ibf,V)

(d) U.8. Customary (1bm,in,s,"F,A,1bf,V)

gned to a project by default?

An ANSYS project file is saved with extension.

The environment is used to create the geometry to be used in an analysis

‘The customized analysis systems are added under the

window. toolbox in the Toolbox
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EXERCISE

Start ANSYS Workbench and add a new thermal analysis system to the pt‘OJf;’Ct
as shown in Figure 2-44. Save the project with the name ¢02_exr01 at the location
C:\ANSYS _WB\cO2\Exr. (Expected time: 10 min)

Hint: Use the Thermal-Stress analysis system displayed under the Custom Systems toolbox
in the Toolbox.

5]
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Figure 2-44 The Thermal-Stress analysis system added to the Project
Schematic window

Answers to Seif-Evaluation Test
1.7T, 2. F, 3. F, 4. T, 5. *.zip, 6. View > Files, 7. 1, 8. Units

Chapter 3

Part Modeling - I

After completing this chapter, you wi" be able to:
* Understand the DeszgnModeler Workspace

* Draw sketches. _ .
* Convert sketches into 3D models. e :
* Understand views of the model in 3D space
* Apply constraints and relations. e

* Create new skefching planes.
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INTRODUCTION TO PART MODELING

For conducting an FEA analysis, a part model is mandatory. In ANSYS Work.bench, the next
step after defining the material properties is to define the geometry to which the material
properties will be applied. Like most of the other CAD modeling packages, the part models
created in ANSYS Workbench are parametric and feature based. The parameric nature of an
application is defined as its ability to use the standard properties or parameters (d1mens;o1zs}
in determining the shape and size of the geometry. You can also modify the shape and size
of the model using these parameters. Feature is defined as the smallest building block of the

model that can be modified individually.

Most of the 3D models created using ANSYS Workbench are a combination of sketched and
placed features. The placed features axe created without drawing a sketch, but the sketci}e‘d
features require a sketch to be drawn first. Generally, the base feature of any 3D model is
a sketched feature and is created using a sketch. Therefore, while creating any design, you
first need to draw the sketch for the base feature. Once you have drawn the sketch, you can
convert it into the base feature and then add the other sketched and placed features to it to

complete the 3D model.

In general terms, a sketch is defined as the basic contour for the feature. For example consider
the spanner shown in Figure 3-1. It is created using a single sketch drawn on the XY plane,
as shown in Figure 3-2.

Figure 3-1 Base feature of the spanner Figure 3-2 Shetch for the base feature of the
spanner

INTRODUCTION TO DesignModeler WINDOW

In ANSYS Workbench, the part models and their sketches are defined in the DesignModeler
window, You can define part models either by importing the CAD model created in some
other CAD applications such as Pro/E, SolidWorks, and so on, or by creating the model in the
DesignModeler window of ANSYS Workbench 14.0.

In any system, the DesignModeler window is associated with the Geometry cell. The Geometry
cell can be added to any analysis project as a standalone component system or as a part of any
mechanical analysis system. Figure 3-3 displays system A as a standalone component system. In
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system B, the standalone system A is used as a part of an analysis system. In analysis system C,
the modei will be defined in the DesignModeler window that is associated with the Geometry
cell of the same system. -

o
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Figure 3-3 Project Schematic window displaying various standalone systems in it

'To open the DesignModeler window, double-click on the Geometry cell in an analysis system;
the DesignModeler window along with the ANSYS Workbench dialog box will be invoked.
Alternatively, right-click on the Geometry cell of any analysis system and choose the New
Geometry option from the shortcut menu displayed.

The ANSYS Workbench dialog box is the startup dialog box that is displayed along with the
DesignModeler window. When this dialog box is opened, you are prompted to specify the unit
to be used for creating the models. Select the radio button corresponding to the desired unit
of length. To always use the unit specified in this dialog box, select the Always use selected
unit check box. However, you can also use the unit system specified for the project in the
Workbench window by selecting the Always use project unit check box. Note that only one
check box can be selected at a time. After specifying the units and your preferences, choose
the OK button from the ANSYS Workbench dialog box; the DesignModeler window will be
activated, as shown in Figure 3-4.

Note

i 1. Ifyou select the Alweys use project unit check box or the Abways use selected unit chech
box then the ANSYS Workbench dialog box will not be displayed along with the DesignModeler
window. However, if you want to display the ANSYS Workbench dialog box at the start of new
DesignModeler session, choose Tools > Options from the Menw bar in the DesignModeler
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' ; ' ' ' DesignModeler node from the
dow; the Options dialog box will be displayed. Expand the Jesign. . :
?;]?p(;:e of thep()ptz'ons dialog box and select the Units sub option, the com:espondmg options
will be displayed n the right pane. Click on the Display Units Pop-up Window option from
the right pane; a drop-down list will be displayed on the right of this aption. Select the Yes option

from this drop-down list.
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Figure 3-4 The DesignModeler window

The DesignModeler window can be used in two basic modes that are discussed nex.

Sketching Mode

i ode is used to draw 2D sketches. Later on, these sketches can be converted xpto
ggenﬁigzgi?nxg the Modeling mode. To invoke the Sketching mode,.choase the §kftchlzg
tab from the DesignModeler window, refer to Figure 3-4. The Sketching mode‘ disp aysdt e
Sketching Toolboxes window which contains five toplboxes. These toolboxes are used to
create, modify, and dimension the sketches, refer to Figure 3-5.

ling Mode .
g??&ﬁdeiigg mode is used to generate the part model using the s_ketches drawn 151 the
Sketching mode. By default, the Modeling mode is active when the DesignModeler window is
invoked. If not, choose the Modeling tab from the DesignModeler window, rgfer tp Figure 3‘—4.
In the Modeling mode, the Tree Outline is displayed on the left of the-Graphzcs w1nd?w wh;}ch
contains three default planes. Apart from three default planfzs, thfa list of all operations that
are used to create a model in the Modeling mode will be listed in the Tree Outline in the

sequence they are performed, refer to Figure 3-6.
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P YZPlane
B 0 Parts, 0 Bodies

Figure 3-6 The Tree Outline

SCREEN COMPONENTS OF THE DesignModeler
WINDOW

The various screen components of the default DesignModeler window and important terms
related to this window are discussed next.

Figure 3-5 The Sketching Toolboxes window

Tree Outline

In ANSYS Workbench three planes XYPlane, YZPlane, and ZXPlane corresponding to the
XY, YZ, and ZX planes of cartesian coordinate system are created by default and are displayed

in the Tree Outline. These planes are used as sketching planes for drawing the sketches to be
used for generating the part model.

Asketchisa collection of 2D drawing entities which is used é
for generating the features of a part model. The sketch

can be created on any one plane. However, a single
plane can have multiple sketches associated with it. The
plane for creating the sketch can be specified by
selecting it from the Tree Outline. When you click on a
plane in the Tree Qutline, it is displayed in the Graphics
window. Figure 3-7 shows the plane that will be displayed
on selecting XYPlane from the Tree Qutline.

Note

1. The last sketching plane you worked on will act
as the active plane for any future operation, unless
and until you change the plane by selecting it from the Tree Outline.

Figure 3-7 The XY plane displayed when
XYPlane is selected in the Tree Outline
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2. Apart from these three default planes, the user can also create new planes at the specified
location and orientation in the Graphics window. The method of creating new planes will be
discussed in detail in the later chapters.

3. Ty start a new shetch, choose the New Sketch tool from the Active Plane/Shetch toolbar.
On doing so, a new sketch instance will be added under the desired plane in the Tree Outline.
Alternatively, you can select the desired plane in the Tree Outling and then switch to the Sketching
mode and draw a sketch. On doing so, a sketch instance will automatically be added under the

selected plane.

Details View Window
Thie Details View window located near the Graphics window

is contextual in nature and changes its content according to |82
the selection made in the Tree Outline. Figure 3-8 shows the | F%_ e
Details View window which is displayed when the Extrudel meﬁ:n FETT TR —
is selected in the Tree Qutline. You can also modify the selected Direction vecior | Mone (Narmal. -
entity by editing its parameters in the Details View window. Direction Normal

T R S Extent Type Fixed

. SRR TR " 1501, Depth (>0 [t m
Model View/Print Preview xa Thin/Surfaca? |No
The Model View and the Print Preview tabs are located heerge Topalogy? | Yes

at the lower left corner of the Graphics window, refer to |

Figure 3-4. By default, the Model View tab is chosen in the . o
DgusignModeifer window. Subsequently, the sketches and the F znge 3-8 The Details View
part model are displayed in this interface. To preview the winaow
current view of the model, choose the Print Preview tab. After previewing the model, choose
File > Print from the Menu bar to print it. Note that the option to print the model will be
available only in the Print Preview mode.

Ruler

The Ruler is displayed at the bottom of the Graphics window, refer to Figure 3-9. The Ruler
helps the user to visualize and compare the actual size of the model with the size of the
model displayed. The number displayed at the end of each block in the Ruler represents the
cumulative length of the blocks on the left of the number. The quantity shown in brackets at
the extreme right of the ruler represents current unit of the length, To toggle the display of
the Ruler in the Graphics window, choose View > Ruler from the Menu bar.

Triad

The Triad is displayed at the lower right corner of the Graphics window, refer to Figure 3-10.
Triad helps the user to visualize the X, Y, and Z directions in the Graphics window. To toggle
the display of the Triad in the Graphics window, choose View > Triad from the Menu bar.
Move the cursor to any axis, its name will be displayed attached to the cursor. Moving the
cursor in the negative direction of the three orthogonal axis system displays the temporary
view of the axis and its name with a negative symboi (-). If you click on any axis system, the
view will get oriented normal to the selected axis. Click on the ISO ball (cyan color) displayed
at the center of the triad to orient the model in the Isometric view.
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Figure 3-9 The Ruley Figure 3-10 The Triad
Status Bar

The Status bar is Jocated at the bottom of the screen, refer to Figure 3-4. The instructions for
the currently active tool and its status are displayed on the left of the Status bar. The middle
portion of the Status bar displays the information about the currently selected object. The

right portion of the Status bar displays the current unit system and the coordinate value of
the cursor location.

TUTORIALS

In this tutorial, you will create the I-section solid model shown in Figure 3-11. The dimensions

of the model are shown in Figure 3-12. Save the project with the name ¢03_ansWB_ut01 at
the location C:IANSYS_WBl03\ Tui0] (Expected time: 30 min)

!

S0

P i
: 3

50 40 ;4XR1 o S0
Vo y .
20 25
ol P
120
Figure 3-11 Model for Tutorial 1 Figure 3-12 Dimensions of the I-section

The following steps are required to complete this tutorial:

a. Start ANSYS Workbench 14.0 and add the Geometry component system.
b. Create the sketch for the outer loop of the I-section.
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Apply constraints to the sketch.
Generate dimensions and edit them to achieve the required size of sketch.
Create the base feature.
Create the second feature.
Sreate the blend feature.
Rotate the view of the model dynamically.
Save the project and exit the ANSYS Workbench session.

moEog The o O

Starting ANSYS Workbench and Adding the Component System
First you need to start ANSYS Workbench and then add an analysis system to the Project

Schematic window.

1. Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the Start menu to start the
ANSYS Workbench session; the Getting Started window is displayed with the Workbench
window. .

9. Choose the OK button to close the Getting Started window.

Note

1. If you do not want the Getting Started window to be displayed the next time you start a new
session of ANSYS Workbench, clear the Show Getting Started Message at Startup check box
located at the bottom of the Getting Started window and then close it.

2. If you want the Getting Started window to be displayed at the startup of a new ANSYS
Workbench session, choose Tools > Options from the Menu bar; the Options dialog box will
be displayed. Next, choose Project Management from the left pane of the Options dialog box,
if not chosen by default. Seroll down in the right pane and select the Show Getting Started
Dialog check box. :

3. Double-click on Geometry displayed under the Component Systems toolbox in the
Toolbox window; the Geometry component system is added and displayed in the Project
Schematic window, refer to Figure 3-13.

After the Workbench window is displayed and an analysis system is added to the Project
Schematic window, the first step in any analysis is to define the geometry. There are two ways to
define a geometry: by creating a new geometry and by importing an already created geometry
from any solid modeling software. The DesignModeler window is used to create and edit
geometries which are used in ANSYS Workbench. In ANSYS Workbench 14.0, a standalone
system known as Geometry component system, is available to create geometries. Figure 3-13
shows a Geometry component system added to the Project Schematic window.

Now, you need to save the project.

4. In the Workbench window, choose the Save button from the Standard toolbar; the Save
As dialog box is displayed.
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Figure 3-13 The Geometry component system added to the
Project Schematic window

5. Browse to the location CVANSYS_WA.

6. Create a folder with the name ¢03 in the ANSYS WB folder and then then double-click
on the newly created ¢03 folder to open it. Next, create a sub folder with the name Tut01
under the ¢03 folder and then choose the Open button from the Save As dialog box.

7. Enter c03_ansWB_tut01 in the File name edit box and choose the Save button from the
Save As dialog box; the project is saved with the name specified.

Creating the Sketch

You now need to invoke the DesignModeler window to create the sketch.

1. Right-click on the Geometry cell of this component system to display a shortcut menu.
Next, choose New Geometry from the shorteut menu; the Starting DesignModeler
message 1s displayed in the status bar, After sometime, the DesignModeler window is
displayed along with the ANSYS Workbench dialog box.

2. In the ANSYS Workbench dialog box, select the Millimeter radio button and accept the

default settings for other check boxes. Next, choose the OK button to close the dialog
box.

Next, you need to select the piane in which you want to create the sketch for the
tutorial.

3. Select XYPlane in the Tree Outline that is displayed in the left pane of the DesignModeler
window.

The Tree Outline in the DesignModeler window lists all the operations that are carried out
on the model. The Tree Qutline for Geometry component system is shown in Figure 3-14.

Note that the operations in the Tree Outline are listed in the sequence in which they were
created.
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Figure 3-14 The Tree Outline
displayed in the DesignModeler
window

4. Choose the Sketching tab available at the bottom of the Tree Outline to display all the
tools available for creating sketches. A

Since the XY plane has already been selected for drawing the skgtch, as shown in
Figure 3-15, you need to orient the plane normal to the viewing direction.

5. Right-click anywhere in the Graphics window and choose the Look At ool from /0
the shortcut menu; the view is oriented as required, refer to Figure 3-16.

. M&\ y 60,06 érarn)

Figure 3-16 XY plane afier choosing Look At
tool from the Graphics toolbar

Figure 3-15 The defoult Isometric view of
the XY plane

The Look At tool is used to orient the plane on which the sketch | P i% i ® I )1

is drawn, normal to the viewing direction. You can invoke this tool :

from the Graphics toolbay, refer to Figure 3-17. Alternatively, Figure 3-17 The Graphics
invoke this tool from the shortcut menu which is displayed on  ¢oolbar

right-clicking anywhere in the Graphics window.
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Next, you need to create the sketch, refer to Figure 3-18. For ease of cre

ating the sketch,
the entities of the sketch have been numbered, refer to Figure 3-18.

6. From the Draw toolbox, choose the Line tool which is displayed by default; the Status bar
displays the message Line - Click, or Press and Hold, for start of line.

7

10 3

1

12 ' 2

1
Figure 3-18 Shetch for Tutorial 1

Aline is defined as the shortest distance between two points. A line is one of the basic sketching
entities available in the DesignModeler window. To draw a line, choose the Line tool from
the Draw toolbox in the Sketching Toolboxes window. On doing so, you will be prompted to
specify the start point of the line. Click anywhere in the Graphics window to specify the start

point; you will be prompted to specify the end point of the line. Next, click to specify the end
point of the line; a line will be created.

After specifying the start point of the line, if you realize that the specified start point is
wrong, right-click in the Graphics window and choose the Back option from the shortcut

menu displayed. As a result, the specified start point will get nullified without exiting the
Line tool.

7. Move the cursor close to the origin in the Graphics window and click to specify the start
point of the line when the symbol of Coincident Point constraint (P) is displayed, refer to
Figure 3-19.

After specifying the start point of the line, if you move the cursor horizontally, an H symbol
will be displayed on the line. This symbol indicates that if you specify the end point of the
line at the current location, a horizontal line will be drawn. Similarly while drawing a line
close to an existing line, if C symbol is displayed, it indicates that the end point specified at
the current Jocation of the cursor will be coincident with the existing line.
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§ Coincident constraint
i symbal
Coincident Point

constraint syrabal Horizontal constraint

symbol \

[

QOrigin

Figure 3-19 Specifying the start point of the Figure 3-20 Specifying the end point of the
line fine ~

Table 3-1 List of auto constraints

Auto Constraint | Symbol | Description

Name

Horizontal H Makes the entity horizontal

Vertical v Makes the entity vertical

Parallel i Makes the entity parallel to another entity

Perpendicular ! Makes the entity perpendicular to another entity

Tangent T Makes the entity tangent to another entity

Equal Radius R Makes the entity equal to another entity

Coincident C Makes the end point of an entity coincident with
another entity

Coincident Point P Makes the end point of the current drawing entity
coincident with a point.

8. Move the cursor toward right to some distance and click to specify the end point of line
when the symbol of Horizontal constraint {(H) is displayed, as shown in Figure 3.20.
Line 1 is created and its blue color indicates that the line is fully constrained, refer to
Figure 3-21.

9. Next, move the cursor close to the end point of line created in the last step; the symbol of

Coincident Point constraint (P) is displayed. Click to specify the start point of the second
line, refer to Figure 3-91.

10. Move the cursor vertically upward; the symbol of Vertical constraint (V) is displayed. Click
to specify the end point of the line; line 2 is drawn, as shown in Figure 3-22.

11. Now, move the cursor close to the end point of line 2 created in the last step; the symbol

of Coincident Point constraint (P) is displayed. Click at that point to specify the first point
of line 8, as shown in Figure $-23.
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Figure 3-21 Specifying the startpoint of line 2 Figure 3-22 Specifying the endpoint of line 2

12. Move the cursor toward left to some distance; the symbol of Horizontal constraint (H) is
displayed. Next, Click to specify the end point of ling 3, as shown in Figure $-24.

13. Move the cursor close to the end point of line3; the symbol of Coincident Point constraint (P)
is displayed. Click at that point to specify the start point of line 4, as shown in Figure 3-25,

Figure 3-23 Specifying the startpoint of the Figure 3-24 Specifying the endpoint of line 3
line 3

14. Move the cursor upward to some distance; the symbol of Vertical constraint (V) is displayed
along the cursor. Click to specify the end point of line 4, refer to Figure 3-26.

i
i
. L
|

Figure 3-25 Specifying the staripoint of the line 4 Figure 3-26 Specifying the endpoint of line 4

i
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15. Similarly, draw all the lines specified in the
sketch. The sketch drawn is just a representation
of the final sketch to be drawn based on
dimensions. The final sketch before applying
the constraints and dimensions is shown in

Figure 3-27.

Note ‘ o jl!
1. The sketch shown n Figure 3-27 1s just &
for reference and is not created based on

dimensions.

2. While drawing the sketch, some of the
constraints like Horizontal, Vertical and Figure 3-27 The sketch drawn using
Coincident are automatically applied. You can qutomatic constraints

also apply constraints manually after drawing

the sketch, by choosing the desived constraint tool from the Constraints toolbox.

Applying Constraints to the Sketch .
After a sketch for the model is drawn, refer to Figure 3-27, you need to constrain the
entities of the sketch to restrict some degrees of freedom.

1. Expand the Constraints toolbox in the Sketching Toolboxes window.

9. Choose the Horizontal tool from the Constrains toolbox; the Horizontal
-- Select line or ellipse for horizontal constraint message is displayed in
the Status bar indicating that the Horizontal constraints can be applied to entities of the
sketch. :

o Horizontal

Horizontal constraint is used to make a line or the major axis of an ellipse horizontal.

%. Select lines 1, 3, 5, 7, 9, and 11 one by one to make them horizontal, if not already
horizontal, refer to Figure 3-20.

4, Next, choose the Vertical 1ol from the Constrainis toolbox; the Vertical --
Select line or ellipse for vertical constraint message is displayed in the
Status bar indicating that you can now apply vertical constraints to entities.

1] Vertical

Vertical constraint is used to make a line or the major axis of an ellipse vertical.

5. Select the lines 2, 4, 6, 8, 10, and 12 one by one to apply vertical constraints to them; ail
these lines become vertical now, refer to Figure 3-28.

The next step is to apply Equal Length constraints to lines which are equal in length.

6. Choose the Equal Length tool from the Constraints toolbox of the Sketching  r£qual Lengtn
Toolboxes window. Use the down arrow available next to the Settings
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toolbox tab to scroll down and view the Equal Length tool, if it is not visible by default;
you are prompted to select the first line to apply Equal Length constraint.

7. Move the cursor close to line 1; a rectangular box is attached to the cursor, which means

that you can now select the line to apply Equal Length constraint. Select line 1; it turns
yellow and you are prompted to select the second line.

8. Select 7; the Equal Length constraint is applied and both the lines become equal in
length.

9. $imi§arly, apply Equal Length constraint between the lines 2 and 12, 6 and 8, and 2 and
6 to make these lines equai. In addition, make the lines 8, 5, 9, and 11 equal in length.

10. Next, apply Equal Length constraint to lines 4 and 10.

Applying Dimensions to the Sketch

Now you need to apply dimensions to the sketch. To apply dimensions to the sketch, you
need to invoke the desired tool from the Dimensions toolbox tab.

1. Choose the Dimensions toolbox from the Sketching Foolboxes window to expand it,

2. Choose the General tool from the expanded Dimensions toolbox; the Details View

window is displayed. Also, you are prompted to select first point or 2D edge for applying
Horizontal dimension.

The General tool is used to create dimensions depending upon the entities selected. After
the General tool is invoked, select an entity from the Graphics window to dimension i,

3. Move the cursor close to ine 1; a rectangle is attached to the cursor. Select the line 1; the
cursor changes to pencil shape. Click to place dimension. As the line is horizontal, H1 is
placed above the line 1.

Note

In DesignModeler, the dimensions are placed as symbols. For example, when you invoke the
Horizontal tool from the Dimensions toolbox and then dimension an entity, the dimension that
would be placed is HI. The values of all the placed dimensions in the sketch can be changed

by changing the corresponding dimensional values under the Dimensions node in the Details
View window.

4. Similarly, select the line 8 and place dimension V2 to the left of the line.
5. Select line 9, and place dimension H3 below the line.

6. Select line 10 and place dimension V4 below V2, as shown Figure 3-28,
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5

ot e

- Hi 3
Figure 3-28 Sketch after applying dimensions

Note '
1. When line 11 s selected for dimensioning, the Geometry - DesignModeler warning message

box is displayed, as shown in Figure 3-29. This message states that placing this dimension will
over-constrain the sketch and you can edit and place this dimension as a reference. On choosing
the OK button from the warning message box, the dimension of line 9 will turn ved, indicating
that the skelch is over-constrained, as shown in Figure 3-30.

2. If you want to place the vver-constrained dimension, place it on the skeich, as shown in
Figure 3-31.

£ Warning: New dimension makes maodel over-constrained, Use Cancel
ﬁ{au.‘fa) or Unda to restore, or Edit the dimension and set as Reference

Pigure 3-29 Warning messege

To undo changes, click anywhere in the Graphics window and then press CTRL+Z keys;
over-constrained dimensions will vanish.
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Figure 3-30 Ouer-constrained sketch Figure 3-31 Placing dimension on sketch

Assigning Dimensional Values to the Sketch

5.

After dimensions are assigned to the sketch, you need to change their values to get the
exact dimensions.

In the Tree Outline, choose the Modeling tab to view the Tree Outline. On doeing so, the
Details View window is also activated with various nodes active in it.

Expand the Tree Outline, if it is not already expanded and then expand the XYPlane node
to view Sketch1. Select Sketchl; the Details View window with corresponding parameters
is displayed.

Expand the Dimensions node in the Details View window, if it is not already expanded.

There are four dimensions present under this node : H1, H3, V2, and V4. These dimensions
refer to the dimensions of lines 1, 9, 8, and 10, respectively.

1o assign a different dimension, click on the edit box to the right of H1; the corresponding
dimension is highlighted in yellow in the sketch. Enter 120 as the new dimension value
and then press ENTER; the lengths of lines 1 and 7 are changed.

Note

1. As you specify the dimensional values to a dimension in the Details View window, the length
of the entily is changed and the length of the entities which are constrained along with this entity
are also modified.

2. While changing the dimensions, the complete skeich may not fit in the screen of your 4
computer. 1o fit the shetch i the screen, choose the Look At tool from the Graphics
toolbar.

Next, in the Details View window, click on the edit box next to H3; the corresponding
dimension is highlighted in the sketch. Enter 30 as the new dimension value and then
press ENTER; the length of lines 3, 5, 9, and 11 is changed.
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i i I ; ing di ion is highlighted in
6. Click on the edit box on the right of V2; the corresponding dimension is highlightec
ye;iow in the sketch. Enter 20 in the edit box and then press ENTER; the length of lines

9. 6, 8, and 12 is changed in the sketch.

; i i ; ' i ion is highlighted in
7. Click on the edit box on the right of V4; the corresponding dimension is hig
yellow in the sketch. Enter 50 in the edit box and then press ENTER; lines 4 and 10 are

modified.

You will notice that as soon as H1, V2, H3, and V4 are modiﬁe‘d in t}:ze Details Vigw
window, the whole sketch is modified. Therefore, changing the é;megsmn of one entity
will ens’ure that the dimensions of all other entities which are equal in length are also

modified.

Extruding the Sketch ‘ _‘ N
After creating the sketch of the outer profile of the I-section, you need to convert it into
the base feature by using the Extrude tool. The Extrude tool is used to add or remove

material from the specified sketch along a straight line in the specified direction.

1. Click on the ISO ball placed at the bottom right in the Graphics window; the view is
changed to Isometric, as shown in Figure 3-32.

9. Choose the Extrude tool from the Features toqlbar; the pre.view ‘of the
extruded feature with default values is displayed in the Graphics window, :
as shown in Figure 3-33. Also, Extrudel is added under the three default planes in the

Tree QOutline, as shown in Figure 3-34.

Figure 3-32 The Isometric view of the sketch Figure 3-33 The preview of feature
after choosing the Extrude tool

Note _
1. The sketch plane on which you worked last acts as an active plane for any future operation,
until you change the plane.

2. To remove material from a feature, you need to have the base feature. Therefore, you cannot
use the Extrude tool for material removal before you create the base feature.
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The default parameters used for generating the preview of the extruded feature are displayed
in the Details View window. To get the required shape of the base feature, you need to edit
parameters specified in each node of the Details View window, The Both-Symmetric option
is used to add material on both the sides of the sketch with same depth of material.

3. Based on the design requirements, the material should be added normal and symmetrically
on both sides of the sketch. To add material to the extrusion, click on Direction; a down
arrow is displayed on the right of Direction in the Details View window. Next, click on
the down arrow and select the Both-Symmetric option from the list displayed, as shown
in Figure 3-35. The preview of the extruded feature is changed in the Graphics window
and now it displays the same amount of materiai added on both sides of the sketch.

Extrude Extrudel
; Base Object Siceteid,
& ﬂg_ﬁi‘ A 'I-sectlon Opesation Add Material
E"3¥))§‘ XYPlarie Ditection Vecter | None (Normal]

b 78 Sketchl

[FDL, Depth (>0
As Thin/Surface? 3
Merge Tapology? | Yes

Figure 3-34 The Tree Outline with  Figure 3-35 Selecting the Both-symmetric option from
Extrude 1 added to 1t the Direction drop-down listin the Detail View window

The Reversed option in the Direction drop-down list is used to reverse the direction of material

addition. The Both-Asymmetric option is used to add material on both the sides of sketch
with different values of the depth of material addition.

Next, you need to specify the depth of material addition.

4. Enter 25 in the FD1, Depth (>0) edit box of the Details View window, refer to
Figure 3-36.

Netails of Extrude),

Extrude Extrudel

Base Qbject Sketchi
Operation Add Material
Direction Vedtar tlone Parmaf
Riraction Bath - Symmetric
Extent Type Fined

[ SR 75 mm

As Thin/Surface? No

Merge Topoiogy? | Yes

Figure 3-36 Specifying the depth of material addition in the
Details View window
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The total depth of material addition is 50 mm, but the material will be added symmetri‘caiiy
by the same depth on both the sides of the sketeh. Therefore, 25 mm has been specified

as the depth value.

After all the parameters in the Details View window are specified, the preview of the
extrude feature is displayed in the Graphics window. To create the solid ﬂ}odel, you nr?ecl
to generate the extrude feature. Also, notice the thundferbolt symbol dispiayed before
Extrude 1 in the Tree Outline, which indicates that the feature needs to be generated.

Next, you need to complete the extrusion process with the specified values.

5. Choose the Generate tool from the Features toolbar; the base feature is created
with the specified seteings, refer to Figure 3-37, Also, the thunderbolt symbol
is changed to green tick mark indicating that the feature is updated.

‘The Generate tool is available in the Features toolbar and is used to update the model‘afte‘r
any changes ave made in it. This tool can also be invoked from the shortcut menu which is
displayed on right-clicking anywhere in the Graphics window.

Creating the Second Feature _ ‘ i
Next you need to create a rectangular cutout in the I-section, refer to 1*1gur§ 3-11.7To
create a rectanguiar cutout, you will draw a sketch on the XY plane. Next, you will remove
material by extruding he sketch.

1. Select XYPlane from the Tree Outline; the XY plane becomes the active plane.

2. Choose the New Sketch tool from the ActivePlane/Sketch toolbar; the new entry
with the name Sketch? is added under the XYPlane node in the Tree Outline,
refer to Figure 3-38.
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The New Sketch tool is available in the Active Plane/Sketch toolbar located just above the
Graphics window. This tool is'used to create new sketches for the models.

Notice that the Sketch 1 and the dimensions are still displayed in the Graphics window.
Since this sketch is not required, you can hide its display.

3. Right-click on Sketch1 in the Tree Qutline and then choose the Hide Sketch option from
the shortcut menu displayed, refer to Figure 3-39.

Note

If needed, you can display the sketch and its dimensions again. To do so, right-click on Sketchl in
the Tree Outline and then choose the Show Sketch option from the shoricut menu displayed.
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Figure 3-38 The Tree Outline with Figure 3-39 Hiding Sketchl by selecting the
Sketch2 added to it Hide Sketch option from the shortcut menu

4. Select Sketch 2 from the Tree Outline and then choose the Sketching tab displayed at
the bottom of the Tree Outline to invoke the Sketching mode.

5. Choose the Look At tool from the Graphics toolbar; the sketching plane is oriented
normal to the viewing direction. Orienting the sketching plane enables you to easily
draw the sketch.

6. Choose the Rectangle tool from the Draw toolbox; the cursor changes
into the Draw cursor and you are prompted to specify the first corner
point of the rectangle.

In the DesignModeler window, there are two methods of drawing rectangle: by specifying
two diagonally opposite points of the rectangle and by specifying the three corners of the
rectangle The rectangle created by using the first method can be either horizontal or vertical.
The rectangle created by the second method is placed at an orientation specified by the user.
You can use any of the two methods for drawing the rectangle using the Draw toolbox.

7. Specify the first corner point, refer to Figure $-40; the preview of the rectangle is attached

to the cursor and you are prompted to specify the diagonally opposite corner point of the
rectangle.
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8. Click to specify the second point of the rectangle, refer to Figure 3-40; the rectangle is
created, refer to Figure 3-41.

First comer

point of
rectangle Second

comer point of

rectangie

Figure 3-40 Specifying the first and second Figure 3-41 The rectangle created
corner points of the rectangle

9. Press the ESC key to exit the Rectangle ool

After creating the rectangle, you need to generate its dimensions so that you can specify
the size of the rectangle and place it at the desired location.

10. Expand the Dimensions toolbox in the Sketching Toolboxes window.

11. Choose the General tool from the Dimensions toolbox, if not chosen by
default.

12. Select Line 1; the preview of dimensional constraint attached to the cursor is displayed.

13. Click below the Line 1 to place the dimension; the dimension is generated and its value
is displayed on the dimension line.

Next, you need to generate a dimension between Line 4 and the Y axis.

14. Move the cursor near the lower end point of Line 4 and click when the cursor changes
into the Point selection cursor.

15. Click on the Y axis; the preview of the dimension is attached to the cursor.
16. Move the cursor downward and click to place the dimension, refer to Figure 3-42,
17. Similarly, generate other two dimensions, refer to Figure 3-42.

After the dimensions are placed on the sketch, you need to specify their exact vaiues in
the Details View window.

18. Edit the value of the first dimension Hb to 40 in the Details View window; the length
of the line is changed to 40 mm and is displayed in the Graphics window, refer to
Figure 3-42.
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19. Click on the edit box next to-the second dimension L5 and specify the dimensional value
as 40; the dimension of the line is changed to 40, refer to Figure 3-42.

20. Similarly change the dimensional values of V7 and V8 dimensions to 25 and 40, respectively.
Figure 3-42 shows the final sketch of the cutout feature.

Figure 3-42 Final shetch of the cutout feature

Note

The name of the dimension displayed on the Details View window may be different in your
system.

21. Choose the Modeling tab displayed at the bottom of the Sketching Toolboxes window
to switch to the Modeling mode; the Tree Outline is displayed.

After you exit the Sketching mode, the sketching plane still remains normal to the viewing
direction. To proceed further with the feature creation operation, it is advised that you
change the view of the sketching plane to Isometric view.

22. Right-click in the Graphics window, and then choose the Isometric View option from the
shorteut menu displayed; the sketch is displayed in the Isometric view.

Figure 3-43 The Triad with the IS0 ball
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After the sketch is created, you need to cut the material from the sketch to create the
cutout feature. You will use the Extrude tool to cut the material.

23, Select Sketch? from the Tree Quitline and then choose the Extrude tool
from the Features toolbar; the preview of the extruded feature with default
values is displayed in the Graphics window. Also, a node for the extruded feature with
the name Extrude? is added below the Extrudel node in the Tree Qutline.

The default parameters used for generating the preview of the extruded feature are
displayed in the Details View window. You need to edit values in the Details View window
to get the desired shape of the cutout.

in this tutorial, material should be removed in the normal direction and symmetrically
from both sides of the sketch.

24. Select the Cut Material option from the Operation drop-down list in the Details View
window, refer to Figure 3-44; the preview of the material to be removed from the existing
base feature is displayed in the Graphics window.

25. Select the Both-Symmetric option from the Direction drop-down list in the Details View
window, refer to Figure 3-45; the same amount of material is removed from both sides of
the sketch.

- iy 4
Sl < E:i Details of Extrade? ‘
= :}:t::j:‘of P2 Extrudes ) adrude Extruda2
Geomehtry Sketchz. Geometyy Sketehd
A Add Material Qperation Add Materia!
Qirédionﬁe&o: . Add niaterial irection\lﬁctof Nona (Normal
Direction Impri:ﬁ.t Facee i
Extent Type Sice Material Tl
TTFDL, Depth (>0) 1Add Frozen [JFOL, Depth (>0} JTHELR
K; Thin/Surface? Mo As ThinfSurface? Roth - Asymmetr g 3
Merge Topotogy? | ves Merge Topology? | Yes
=1 Geometry Selection: 1 = Geomelry Sslection: 1
Sketch ISketenz Sketch [Sketanz o o
Figure 3-44 Selecting the Cut Material Figure 3-45 Selecting the Both—Symmetric option
option from the Operation drop-down list from the Direction drop-down list

Next, you need to select the method to specify the depth of material removal,

26. Select the Through All option from the Extent Type edit box in the Details View window,

refer to Figure 3-46.

The Through All option is used to remove material throughout the model in the specified
direction. Instead of selecting this option, you can also select the Fixed option and then specify
the exact depth of material removal, as you did for the base feature.

Notice the yellow thunderbolt symbol displayed at the upper-right corner of the Extrude 1
node in the Tree QOutline, which indicates that the feature needs to be generated.
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27. Next, to complete the process.of material removal, choose the Generate tog]

Figure 3-46 Selecting the Through All
option from the Extent Type drop-down Iist cubout

from the Features toolbar; the cutout feature is created, as shown in Figure 8.47, =z
Also, the yellow thunderbolt symbol is changed to green check mark, indicating
that the feature is updated.
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Figure 3-47 The model afler creating the

Note
In Figure 3-45, the display of plane has been turned off to see the cutout feature elearly.

In the Tree Outline, certain symbols are displayed on the upper right corner of each
feature node. These symbols and their meanings are given in Table 8-2.

Table 3-2 Various symbols and their meaning

Symbeol Meaning

+  Green tick mark The feature creation succeeded and can be used for

further processes.

% Yellow thunderbolt mark The feature has been modified and it needs to be
updated.

+ Yellow tick mark The feature has been generated, but some warnings

are associated with it

@ Red exclamation mark The feature has failed to generate and you may need
to redefine the feature,

% Blue cross mark The feature is suppressed and has no influence on

the final model.

Creating the Biend Feature

Next you need to create the blend feature (fillet) with the radius of 10 mm at the sharp
corners of L-section, refer to Figure 3-11. You will create the fillet on the four edges of
the model by using the Fixed Radius option from the Blend drop-down in the Features
toolbar.
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1. Choose the Fixed Radius tool from the Blend drop-down in the Features toolbar, refer
‘ to Figure 8-48; FBlendl1 is attached to the Tree Outline. Also, you are prompted to select

the edges to be blended.

The Blend tool is used to remove sharp edges in a 3D model. The Fixed Ra@ius option is
used to create blends with a radius that is constant throughout the edge on which the blend

is applied.
[ del, refer to Figure 3-49. You can
. Press the C'TRL key and select the four edges of the model, e 3 :
: uzzsshe tools availzz’ble in the Graphics toolbar to rotate the model to view Its respective
edges.

Note . ,
To select the edges of a model without rotating it for generating the blend feature, change the

7} [ ] ; de, choose the
display mode to wireframe. To change the display of the model to wireframe mode,
I;%'ef{ame option from the View menu. To change the display of the model‘back to the shafied
mode, choose the Shaded Exterior and Edges or Shaded Exterior option from the View

menie,

Fdges to
ba sefected Edges ove
§: Blend v R Chamifer selacted
H = = [}
@ Variable Radius. -
Ve tiend
Figure 3-48 Choosing the Fixed Radius Figure 3-49 Edges to be selected for creating

option from the Blend drop-down the blend feature

3. Choose the Apply button from the Geometry selection box in the Detai}s View window
to accept the selection of the edges to be blended, as shown in Figure 3-50.

4, Enter 10 in the FD1, Radius (>0) edit box to specify the radius of the blend feature.

5. Next, choose the Generate tool from the Features toolbar to finish qreating i
the blend with the specified radius. The final model after creating the Lfiiisas

blend is shown in Figure 3-51.
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Note :
If you select a face for creating blend, all the edges of the selected Jace will be blended.

etafls of Filendl
Fived-Radius Blend |FBlengl

{1 FDi, Ragi {=0) |3 mm

| ;
Figure 3-50 Choosing the Apply button Figure 3-51 The model after generating
from the Details View window the blend feature

Rotating the View of the Model Dynamically
You can rotate the view of the model dynamically in 3D space so that it can be viewed
from all directions. This allows you to view all features clearly.

1. Choose the Rotate tool from the Graphics toolbar; the cursor changes into the
Rotate cursor. Alternatively, right-click in the Graphics window and then choose
the Gursor Mode > Rotate option from the shortcut menu displayed.

The Rotate tool is used to rotate the view of the model freely in the Graphics window. You can
voke this tool from the Graphics toolbar of the DesignModeler window. Like other tools of
the Graphics toolbar, the Rotate tool is also a transparent tool, implying that the Rotate tool
can be invoked even when you are using some other tools.

2. Next, press and hold the left mouse button and drag the cursor to rotate the model in 3D
space.

3. Choose the Rotate tool from the Graphics toolbar to exit it.

After rotating the model dynamically, you can restore the Isometric view again by clicking on
the I1SO ball (¢cyan color) in the Triud.

4. Exit the DesignModeler window; the Workbench window is displayed.

Note

You can close the DesignModeler window even without saving the project. However, in this
case, the model will be saved automatically but the project will remain unsaved. You need to save
the project by choosing the Save button from the Standard toolbar of the Workbench window.
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If the project is saved then its name is displayed on the title bar of tfw Workbench wz’nd.ow.
Otherwise it will display Unsaved Project on the litle bar afier closing the unsaved project.
Also, the model data that was saved awtomatically will be lost forever

Apart from freely rotating the model, you can also view it using the sta‘ndarfl ortht;lgrixfg.k'u;
projections, To view the model in the ortho_graphlc direction, move the curs::;x‘ c};{ver the Tria :
on any axis, the name of the axis will be displayed attached to the cursor. Click on 3ny axis;
the view will be oriented normal to the selected axis. Move the cursor in the negative ;recélgrl
of the three orthogonal axes, the system will display the terporary v1ew_.of the axis anf 11qts
name with a negative symbol {-). You can also use t'hese negative axes to orient the leew Od t;; e
model. Table $-3 lists the various orthographic views and axes that need to be selected for
achieving the corresponding view and the shortcut key to get it.

Tuble 3-3 Various orthographic views and axes that are selected

Orthographic Views Triad Shortcut Key (Num pad)
Right View +X 3
Left View -X 7
Top View +Y 8
Bottom View Y 2
Front View +Z 1
Back View -Z 9
Default Isometric ISO ball (cyan color) | 5

Saving the Project and Exiting ANSYS Workbench

After visualizing the model and restoring the default Isometric view, you need to save the
project and exit ANSYS Workbench.

1. Choose the Save button from the Standard toolbar; the project is saved.

2. Close the Workbench window to close the ANSYS Workbench session.

Note _

1. Instead of creating the I-section with cutout as threg separate features, you cam create it as
single feature. To do so, create the sketch as shown in Figure 3-52 afwf extrude i symmetrically
by 25 mm on both sides. If the shetch consists of some closed lqops inside the outer loop, they will
automatically be subtracted from the cuter loop while extruding.

2. In this tutorial, the model has been created as three separate features to explain th_a UGTIONS
tools and aptions available in the software. Also, creating the model consisting of various small
features makes the editing work easier in case any changes are to be made in the design at later
stages.
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Figure 3-52 The shetch for creating the complete
‘model as single feature

i R

In this tutorial, you will create the solid model of the Spring Plate shown in Figure 3-58. The
dimensions of the model are shown in Figure 3-54. Thickness of the Spring Plate is 2mm,
Save the project with the name c03_ansWB_qui02 at the location CAANSYS 141031 Tut02)

(Expected time: 30 min)

Figure 3-53 Model for Tutorial 2 Figure 3-54 Sketch and dimensions for Tutorial 2

For the ease of creating the model, the sketch has been divided into small se

gments, as shown
in Figure $-55.

The following steps are required to complete this tutorial:

Start ANSYS Workbench and add the Geometry component.
Create the sketch.

Apply constraints to the sketch.

Apply dimension to the sketch.

Extrude the sketch.,

Save the model.

o e e o



3-30 ANSYS Workbench 14.0: A Tutorial Approach
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Figure 3-55 Various entities of the sketch

ACS e ing 4

Starting ANSYS Workbench and Adding Geometry Component System
In: this section, you need to start ANSYS Workbench and then add a component system

to the project.

1. Choose All Programs > ANSYS 14.0 > Workbench from the start menu; the Workbench
window is displayed.

Note .
If the Getting Started window is displayed along with the Workbench window, you need 10

close it by choosing the OK button.

After invoking the Workbench window, you have to add appropriate analysis system or
the component system to the Project Schematic window. In this tutorial you will create a
solid model using the Geometry component system.

2. Right-click in the Project Schematic window and A
choose New Component Systems > Geometry from :
the shortcut menu displayed; the Geometry ‘
component system is added to the Project Geometry
Schematic window, as shown in Figuz‘e 3-56. Figure 3.56 The Geometry component

system added to the project

By adding the Geometry component system to the

Project Schematic window, you can have a stand-alone system for the model to be analyzed.

When any change is made on the geometry using the Geometry component system, the

changes are displayed in all analysis systems with which the geometry is shared.

2 i@ Geametry P

Note

A component system can also be added by dragging it from the toolbox and then .droppmg itin
the Project Schematic window or by double-clicking on the Geometry option dzspiayed under
the Component Systems toolbox in the Toolbox window. But in this tutorial, you will use the
method mentioned in Step 2.
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3. Double-click on the name field of the Geometry component system and enter Spring
Plate to rename it )

Note
Once the Geometry component system is added to the Project Schematic window, JOU Can
rename i when the name field gets highlighted at the bottom of the component system. in blue.

4. Choose the Save button from the Standard toolbar; the Save As dialog box is
displayed.

5. Browse to the location C:\ANSYS WBic03 and then create a sub folder with the name
Tut02 in the ¢03 folder

6. Enter c03_ansWB_Tut02 in the File name edit box in the Save As dialog box and then
choose the Save button in it; the project is saved with the specified name.

Creating the Sketch

After the component system is added to the project, you need to create the sketch for
the Spring Plate model. To do so, invoke the DesignModeler window and perform the
following steps to complete the sketch.

1. Right-click on the Geometry cell of the Spring Plate component system; a shortcut menu
is displayed.

2. Choose the New Geometry option from the shortcut menu; the DesignModeler window
along with the ANSYS Workbench dialog box is displayed.

3. Select the Millimeter radio button to specify the unit of length and then choose the OK
button; the dialog box is closed and you are directed to the DesignModeler window to
proceed with the modeling.

The Millimeter radio button is selected to specify the unit of length as millimeter.

4. In the Tree Outline, expand the A: Spring Plate node, if not already expanded; the
components of the Tree Outline are displayed.

5. Select XYPlane from the Tree Outline; the XY plane becomes the active plane.
6. Choose the New Sketch tool from the Active Plane/Sketch toolbar; the new entry

with the name Sketchl is added under the XYPlane node in the Tree Outline,
refer to Figure 3-57.

7. Right-click on Sketchl node under the XYPlane node to display a shortcut menu.

8. Choose the Look At tool from the shortcut menu displayed; the sketching plane is ihx,
oriented normal to the viewing direction.
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Figure 3-57 The Tree Outline with
Sketchl added to it

9. Choose the Sketching tab from the bottom of the Tree Qutline to switch to the Sketching
mode. :

10. Next, click on the Draw toolbox to expand it, if it is not already expanded. ~

11. In the Draw toolbox, choose the Line tool; you are prompted to specify the start point of
the line. Also, the cursor is replaced with Draw cursor.

12. Move the cursor close to the origin; the symbol of Coincident constraint (P) is displayed,
as shown in Figure 3-58,

13. Click on the origin to specify the start point of the line; you are prompted to specify the
end point of the line.

14. Move the cursor upward along the axis such that the symbol of Vertical constraint (V) is
displayed along the path of the cursor. Move the cursor to some distance along the Y axis
and then click to specify the end point of line, as shown in Figure 3-59. The line is created
and is displayed in blue color indicating that it is fully constrained.

7

] \ Second Point
M
Coincident Paint
consirain symbaol
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\— Origin

Figure 3-58 Specifying the start point of the Figure 3-59 Specifying the end point of the
line line

After Line 1 is created, you now need to create the arc, Arc 1 (refer to Figure 3-55 for
naming conventions used in this tutorial).

15. Now, invoke the Arc by Tangent tool from the Draw toolbox.
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The Arc by Tangent tool is used to.create an arc tangent to a line. Choose the Arc by Tangent
tool from the Draw toolbox and specify a point on any existing sketched entity, the arc to be
created will maintain tangency with the specified point. Also, the symbol of Tangent constraint
{T) is displayed when you move the cursor close to the line. Next, specify the second point to
define the end point of the arc.

16. Move the cursor close to end point of Line 1; the symbol of Point Coincident (P) is displayed.
Next, click to specify the start point for arc 1, as shown in Figure 3-60.

17. Move the cursor toward right to some distance and click to specify the end point of arc
1; the arc is created, as shown in Figure 3-61.

Note
In case the arc is created in a direction opposite to the desired direction, right-click to display a
shorteut menw and then choose Reverse from it.

W 0\
\__ First point sefected for
creating an are
b i
Y [N WO s teerm ey seen
Figure 3-60 Specifying the start point of the Figure 3-61 Specifying the endpoint of the
are are

18. Now you need to create a line tangent to the arc 1. Invoke the Tangent Line tool from the
Draw toolbox and move the cursor close to the end point of arc 1; the symbols of Tangent
constraint (T) and the Point Coincident constraint (P) are displayed. Click to specify the
start point of the line 2, as shown in Figure 3-62.

19. Specify the end point for line 2, as shown in Figure 3-63.

/”‘”\,‘? //-‘\\
F
G BRIt e e o et D Rreana o nse s asss
Figure 3-62 Specifying the startpoint of the Figure 3-63 Specifying the endpoint of ihe
line : line
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You can create a tangent line by using the Tangent Line and Line by 2 Tangents tools. To
create a tangent line using the Tangent Line tool, choose this tool from the Draw toolbox;
the cursor will change to the Draw cursor. Next, select a curved sketch; the preview of the line
will be displayed attached to the Draw cursor. Next, specify the end point of the line to define
the length of the line, refer to Figure 3-61. You can also create lines by using the Line by 2
Tangents tool. To do so, invoke this tool from the Draw toolbox and select two existing curve
sketched entities; the tangent line will be created. In case more than one tangent locations are
available on the selected entities, the tangent line will be generated using the tangent iocation
nearest to the point of selection. '

Note .
The lines created using the Tangent Line tool may not always be vertical. They can be made
vertical by applying Vertical constraints. ‘

Now, you need to create an arc.

920. Invoke the Arc by Tangent tool from the Draw toolbox of the Sketching tab; you are
prompted to specify the start point of the arc 2.

91. Move the cursor close to the end point of line 2; the symbol of Coincident constraint (P)
sign is displayed. Click to specify the start point of arc 2, as shown in Figure 3-64.

992, Move the cursor to the right till the symbol of Equal Radius constraint (R) is displayed.
Then click to specify the end point of arc 2; arc 2 is created, as shown in Fgure 3-65.
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Figure 3-64 Specifying the sturt point of the Figure 3-65 Specifying the end point of the

arc aGre

Now you need to draw the line 5.

23. Invoke the Tangent Line tool from the Draw toolbox; you are prompted to specify the
start point of line. Move the cursor close to the end point of arc 2 and dlick to specify the
start point of line 3 when the symbols of Tangent constraint (T) and Point Coincident
constraint (P) are displayed, as shown in Figure 3-66.

924. Move the cursor upward to some distance. While moving the cursor, the symbol of Vertical
constraint {V) is displayed along with the preview of the line. Click to specify the end point
of line 3, as shown in Figure 3-67.
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23, Next, invoke the Arc by Tangent tool; you are pr tec )
of a line. e y prompted to select a 2D edge or end point
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Figure 3-6G Specifying the start point of the Figure 3-67 Specifying the endpoint of the

line 3 line 3

26. Select the end point of line 3, as shown in Figure 3-68; you are prompted to specify the
end point of arc 4. '

27. Move the cursor toward right till the symbol of Equal Radius constraint (R) is displayed.
Click to specify the end point of arc 4, as shown in Figure 3-69.

oy Ay

a

Figz;re 3-68 Specifying the startpomnt of the Figure 3-69 Specifying the endpoint of the
arc arc 4

Next, you need to draw the line 4 and arc 4 to finish the sketch.

28. Invoke the Tangent Line tool from the Draw toolbox; you are prompted to specify the
start point of the line.

29. Move the cursor close to end point of arc 3; the symbols of Tangent constraint (T) and
the Point Coincident constraint (P) are displayed attached to the cursor.

30. Select the end point of arc 3 to specify it as the start point of line 4, as shown in Figure 3-70,
Also, you are prompted to specify the end point of line 4.

31. Move the cursor downward; the preview of the line will be displayed. Also, the symbol
of Vertical constraint ( V') gets attached to the preview. After moving the cursor to some
distance, click to specify the end point of line; line 4 is drawn, as shown in Figure 3-71.
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Figure 3-70 Specifying the start point of the
line

Figure 3-71 Specifying the endponi of the
line

Now, you need to draw the arc 4 to complete the sketch. Note that the arc to be drawn
should be made with an angle of 270 degrees.

; ted to select an
39, Invoke the Arc by Tangent tool from the Draw toolbox; you are prompte ;
edge or end point of line to specify the start point of arc. Select the end point of line 4 as
the start point of arc 4, as shown in Figure 8.79,

33, Next, move the cursor toward right and then create an arc similar to the one shown in

Figure 3-73.

Figure 3-72 Specifying the start point of arc 4

Applying Constraints to the Sketch

SN

Figure 3-73 Final sketch after the arc 4 is drawm

After the sketch is drawn, you need to apply constraints to the entities.

1. Expand the Constraints toolbox from the Sketching Toolboxes window.

9. Choose the Equal Length tool from the Constraints toolbox; you are prompted to select

the first line on which Equal Length constraint is to be applied.

The Equal Length tool is used to force two linear entities to maintain the same length.

3. Select line 2; you are prompted to select second line for equal constraint.

4. Select line 3; line 2 and line 3 become equal in length.
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As the Equal Length tool is still active, select line $ and then line 4; both the fines become
equal in length. :

Now you need to apply the Equal Radius constraint between all the arcs.

Choose the Equal Radius tool from the Constraints toolbox; you are prompted to select
the first arc or circle to apply the constraint.

The Equal Radius tool is used to force two circular entities to become equi-radius,

7.

8.

9.

Select arc 1; you are prompted to select the second arc to apply the Equal Radius constraint.

Select arc 2; arcs 1 and 2 become equal in radius.

Similarly, apply the Equal Radius constraint between arcs 2 and 3 and then between arcs
8 and 4; all the arcs become equal in radius.

Assigning Dimensions to the Sketch

Figure 3-74 Placing the dimension of line 1

After the sketch is drawn and the constraints are applied, you need to assign dimensions
to the entities.

Choose the General tool from the Dimensions toolbox; you are prompted to select a 2D
edge or line that you want to dimension.

Select line 1; the shape of the cursor changes to Draw cursor. Also, the preview of the
dimension is attached to the cursor.

Click on the left of line 1 to place the dimension, as shown in Figure 5-74,
Place all other dimensions to their respective places, as shown in Figure 3-75,
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Figure 3-75 Sketch afler all the dimensions
are placed

You need to place only three dimensions in the sketch, remaining dimensions will be
applied automatically as the Equal Radius and Equal Length constraints have been applied
to them earlier in this tutorial. After the dimensions are placed, you need to assign values
to each of them,
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5. Choose the Modeling tab located at the bottom of the Sketching Toolboxes window; the
Modeling mode becomes active.

6. Expand the XYPlane node in the Tree Qutline, if not already expanded.

7 Select Sketchl under the expanded XYPlane node; the corresponding Details View
window is displayed.

8. In the Details View window, expand the Dimensions node if not already expanded.

The Dimensions node in the Details View window displays the dimensions that are placed
on the sketch in the Graphics window.

9. Click on the R1 edit box in the Details View window and enter 5; the radius of all arcs is
changed to 5 mm instantaneously. .

Note _
When you click on any edit box under the Dimensions node in the Details View window, the

corresponding dimension in the Graphics window is highlighted in yellow color.

10. Next, click on the V1 edit box and then enter 50; the length of Linel is changed.
11. Similarly, modify dimension V2 to 30.

Figure 3-76 shows the Dimensions node of the Details View window.

= Data?i-s of'S“E:cetchl . s
Sketch Sketchl
Sketeh Wisibility Show Sketeh
Show Constraints? { Mo

(1| Dimensions: 3
IR 77915 mm &
vl - 151,366 mm
[Jvz 33,186 mm

Figure 3-76 The Dimensions node in the Details View window

Creating the Extrude Feature
After the sketch is fully constrained and dimensions are applied, you now need to add
material to the sketch. This is done by using the Extrude tool.

1. Choose the Extrude tool from the Features toolbar; Extrudel is aitached to the Tree
Outline. Also, the preview of extrusion is displayed in the Graphics window.

9. Click on the ISO ball available on the bottom right corner of the Graphics window; the view
is changed to isometric. Figure 3-77 shows the ISO ball with the Triad and Figure 3-78 shows
the Isometric view of the model.
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Figure 3-77 The Triad with the ISO ball ~ Figure 3-78 The Isometric view of the model

Now, you need to set the parameters for extrusion. The parameters of extrusion are set
in the Details View window.

3. Select Geometry in the Details View window to display the Apply and Cancel buttons,
if not already displayed.

4. Choose the Apply button in the Geometry selection box to specify the sketch as the sketch
to be extruded.

5. In the Operations drop-down list in the Details View window, select Add Material if it is
not already selected.

6. In the Directions drop-down list, select Both - Symmetric; the material is added to both
sides of the plane.

7. In the FDI, Depth (>0) edit box, enter 10 as the depth of extrusion.

8. Inthe As Thin/Surface? drop-down list, select Yes; the FD2, Inward Thickness (>0) and
FD3, Outward Thickness {>0) edit boxes are activated.

The Thin/Surface tool is used to create surface out of sketches or create shell features in
models.

9. Click on the FD2, Inward Thickness (>0) edit box and enter 1 as the value of thickness
in the inward direction.

10. Click on the FD2, Outward Thickness (>0) edit box and enter 1 as the value of thickness
in the outward direction.

11. After specifying all the parameters in the Details View window, choose
the Generate tool from the Features toolbar; the geometry is extruded,
as shown in Figure 3-79.
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The final model for Tutorial 2 is shown in Figure 3-80. The axes and the sketch have been
turned off for a better visibility.

Figure 3-79 The generated feature Figure 3-80 The final model for Tutorial 3

12. Close the DesignModeler window; the Workbench window is displayed.

Saving the Model

After the model is created, you now need to save your work.
1. Choose the Save button from the Standard toolbar to save the model.

2. Exit the Workbench window.

AR

In this tutorial, you will create the solid model of the clamp shown in Figure 3-81. The
sketch of the model and its dimensions are shown in Figure 3-82. Save the project with the
name ¢03_ansWB_tut03 at the location CANSYS_WBie031Tut03. (Expected time: 30 min)

Figure 3-81 Model for Tutorial 3
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Figure 3-82 Dimensions of the clamp

The following steps are required to complete this tutorial:

Start ANSYS Workbench 14.0.

Add the Geometry component system to the project.
Start DesignModeler window and specify unit system.
Draw the sketch for the base feature on the XYPlane.
Create the base feature,

Create the circular cutout.

Create the blend feature.

Save the project and exit the ANSYS Workbench session.

Starting ANSYS Workbench and Adding Geometry Component System

First, you need to start ANSYS Workbench 14.0 and then add a component system to the
project.

Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the Start menu; the
Workbench window along with the Getting Started window is displayed.

Choose the OK button in the Getting Started window to close it.

After invoking the Workbench window, you have to add appropriate analysis system or
a component system to the Project Schematic window. In this tutorial, you will create a
solid model using the Geometry component system.

Right-click in the Project Schematic window and choose New Component Systems >
Geometry from the shortcut menu displayed, as shown in Figure 3-83; the Geometry
component system is added to the project and is displayed in the Project Schematic
window.
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Figure 3-83 Choosing the Geometry option from the shortcut menw displayed
on choosing the New Component System option

4. Once the Geometry component system is added to
the Project Schematic window, the name field at
the bottomrof the coraponent systex is highlighted
in blue. Ifit is not highlighted, double-click on the
name field and enter Clamp, refer to Figure 5-84.
The component system is renamed as Clamp.

Figure 3-84 The Geometry component
system added to the project

The blue question mark on the right of the Geometry cell indicates that an immediate
action is required for this cell and the user cannot proceed further without fixing this cell.

5. In the Workbench window, choose the Save button from the Standard toolbar; the Save
As dialog box is displayed. '

6. Browse to the location CAANSYS_WBlc03 and then create a sub folder with the name
Tut03 in the ¢03 folder and then choose the Open button from the Save As dialog box.

7. Lnter c03_ansWB_Tut03 in the File name edit box in the Save As dialog box and then
choose the Save button in it; the project is saved with the specified name.

Starting DesignModeler Window and Specifying Unit System
To define the geometry, you need to start the DesignModeler window associated with this
cell.

1. Double-click on the Geometry cell in the Clamp component system; the
DesignModeler window along with the ANSYS Workbench dialog box
is invoked.
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The ANSYS Workbench dialog box is used to specify the unit system for creating the
model. :

Note

You can also mvoke the DesignModeler window by choosing the New Geometry option Jrom

the shorteut menw that is displayed by right-clicking on the Geometry cell of an analysis system
a7 component system.

2. Choose the Millimeter radio button and then choose the OK button frem the ANSYS
Workbench dialog box to accept the specified unit system.

Drawing the Skeich for the Base Feature

You need to create the sketch for the base feature on the XY plane which is the default
plane. Therefore, you need not specify the plane.

1. Choose the Sketching tab displayed in the lower left corner of the Tree Outline to invoke
the Sketching mode.

Note

1. 1o select a plane other than the default plane (XY), select it from the New Plane drop-down
list in the Active Plane/Sketch toolbar

2. To insert a skeich instance or create a new sketch on a plane other than the default plane, you
can right-click on the plane node in the Tree Ouiline to display a shortcut menu. Next, choose
Insert Sketch Instance from it; a sketch instance will be displayed under the desired node.

Now, you need to orient the sketching plane normal to the viewing direction, so that g
you can easily draw the sketch on the specified plane.

2. Choose the Look At tool from the Graphics toolbar to orient the model normal to the
viewing direction.

Note

You can also orient a plane normal to the viewing divection by choosing the Look At tool from
the shortcui menu displayed on right-clicking on the sketch instance.

3. Choose the Circle tool from the Draw toolbox; you are prompted to specify
the center of the circle.

In DesignModeler, you can draw circles by using two different methods. In the first method,
specify the center point of the circle and then define its radius. In the second method, you
need to specify the three existing drawing entities in the Graphics window with which the
new circle to be created must maintain the tangency relation. This type of circle is known as
tri-tangent circle. You can choose any of the two methods for drawing circles,
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4. Move the cursor close to the origin in the Graphics window and click; the symbol of
Coincident Point constraint (P) is displayed. After specifying the center point of the circle,
the preview of the circle is displayed attached to the Draw cursor. Also, you are prompted
to specify the radius of the circle.

Move the cursor away from the center and click; a circle is created, as shown in
Figure 3-85.

(611

6. Press the ESC key to exit the Circle tool.

After creating the first entity of any sketch, it is better to generate its dimensions first.
This gives you a fair idea about the graphics space required to complete the sketch. Also,
it helps you decide the comparative size of other sketched entities to complete the‘outer
profile. Now, you will generate the radius dimension of the circle that you created in the
previous step and change its value to 50mm.

7. Expand the Dimensions toolbox in the Sketching Toolboxes window.

8. Choose the Radius tool from the Dimensions toolbox; you are prompted to select the
entity to place the dimension.

The Radius tool is used to generate dimensions for circles, arcs, or ellipses. When you select
an arc for dimensioning, the radius dimension is generated, and when you select an ellipse,
the major and minor dimensions are generated.

9. Move the cursor over the circle and select it; the preview of dimension is attached with
the cursor.

10. Move the cursor away from the circle and click to ptace the dimension. The dimension is
generated and its name is displayed on the dimension line.

Other details of the dimension are displayed in the Details View window.

11. In the Details View window, click in the edit box displayed on the right of the dimension
name (R1) under the Dimensions: 1 node.

Note

The name of the dimension displayed on the dimension line can be different in different sysiems.
1o avoid such confusion and to facilitate the proper explanation, refer to the corresponding
screen captures of the dimensions.

12. Enter 50 in this edit box and press the ENTER key; the radius of circle changes to 50 mm
and is displayed in the Graphics window, refer to Figure 3-86.
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Now, you need to complete the remaining part of sketch for the base feature.
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Figure 3-85 Specifying the radius of the Figure 3-86 The circle after editing the
circle dimension value

13. Click on the Modify toolbox in the Sketching Toolboxes window; the Modify toolbox
expands.

The Modify toolbox contains various tools such as Fillet, Chamfer, Trim, Extend, $plit, and
so on. These tools are used to edit sketched entities in the Sketching mode.

14. Scroll down the Moedify toolbox to display other tols, refer Figure 3-87.
Next, choose the Offset tool from the Modify toolbox; you are prompted to
select the line or arc to offset.

The Offset tool is used to draw multiple parallel lines, parallel polylines, concentric circles,
concentric curves, concentric arcs, and so on. When you choose the Offset tool from the
Modity toolbox, you will be prompted to select the entities to be offset, The entities selected
for offsetting must be connected end to end and should form open or closed profile.

15. Select the circle and right-click in the Graphics window; a shortcut menu is displayed.

16. Choose the End selection / Place offset option from the shortcut menu; the preview of
the entity to be offset is displayed attached to the cursor.

Note

If you have made a wrong selection by mistake, then choose the Clear Selection aption from the
shortcut menu and select again the correct entity to be offset.

17. Move the cursor inside the circle and click to specify an offset distance, refer to
Figure 3-88.

18. Right-click in the Graphics window and choose the End option from the shortcut menu
displayed; the Qffset tool is deactivated.

After editing the sketch, if you want to exit the current selection and select other entity to
offset, choose the Clear Selection option from the shortcut menu.
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Figure 3-87 Tools in the Modify toolbox Figure 3-88 Specifying the offset distance
After the circular entities are created, you need to create the linear entities.

19. Expand the Draw toolbox and invoke the Polyline tool; you are prompted
to specify the start point of the line.

You need to define the start point and end point of the line, each time you want to create a
line using the Line tool. But if you want to create a continuous connected line where the start
point of the next line is automatically defined as the end point of the previous line, choose
the Polyline tool from the Draw toolbox. Specify the start and end points of the first line;
the first line will be created and the preview of another line whose start poiat is the end point
of the first line will be attached to the Draw cursor. Specify the third point; the second line
will be created and the preview of the third line whose start point will be the end point of the
second line will be displayed attached to the Draw cursor. Keep on specifying the points to
create continuous lines. To stop creating the polyline and exit the Polyline tool, right-click in
the Graphics window and choose the Open End option from the shortcut menu.

20. Move the cursor near the circumference of the outer circle and click when the symbol of
Coincident constraint (C) is displayed, refer to Figure 3-89,

21. Move the cursor toward left and click to draw a horizontal polyline.
92, Draw the vertical second entity of the polyline and then draw the horizontal third entity
of the polyline. Make sure that the end point of the third entity is coincident with the

inner circle, refer to Figure 3-90,

23. After drawing the three entities of the polyline, right-click in the Graphics window and
choose the Open End option from the shortcut menu displayed.

24. Press the ESC key to exit the Ployline tool.
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Figure 3-89 Creating the first entity of the Figure 3-90 Skelch after creating the third
polyline - entity of the polyline

Next, you need to create a similar sketch on the other side of the X axis such that this
sketch becomes the mirror copy of the sketch already created.

25. Expand the Modify toolbox and choose the Replicate tool; you are
prompted to select points or edges to replicate.

The Replicate tool is used to copy entities from an existing sketch and paste them wherever
required.

26. Select the three entities of the polyline created in the previous steps and right-click in the
Graphics window; a shortcut menu is displayed, as shown in Figure 3-91.

27. Choose the End / Use Plane Origin as Handle option from the shortcut menu, refer to

Figure 3-91; the preview of the entities to be replicated along with the paste handle is
displayed, refer to Figure 3-92.

The paste handle is used to set a reference point while replicating entities. This reference
point is used while placing the entities to be replicated. To replicate the entities, select the
entities and then right-click to display a shortcut menu. This shortcut menu contains options
such as Clear Selection, End/Set Paste Handle, End/Use Plane Origin as Handle, and End/
Use Default Paste Handle.

The Clear Selection option is used to deselect the entities that were selected to replicate earlier.
The End / Set Paste Handle option is used to specify the paste handle by specifying a point
in the Graphics window. The End/ Use Plane Origin as Handle option is used to specify the
origin of the sketching plane as the paste handle. The End / Use Default Paste Handle
option is used to specify a system specified point of the selected entity as the paste handle.

Since the entities to be replicated are the mirror copies of the selected entities, you have
to flip them about the X axis.
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28. Next, select the origin; you are prompted to specify the location to paste the entities, as
shown in ¥igure 3-83.

29. Right-click in the Graphics window and choose the Flip Vertical option from the shorecut
menu displayed, refer to Figure 3-92; the preview of the flipped entity is displayed, as
shown in Figure 3-93 displayed.

After specifying the location of paste handle, instead of replicating the entities directly, you
can rotate them by the desired angle, scale them by desired scale factor, and flip them along
the horizontal and vertical directions. Place the entities at the desired locations, by using the
options from the shortcut menu. '

“To rotate the selected entities before replicating them, enter the required angle of rotation in
the r edit box, displayed on the right of the Replicate tool. Right-click in the Graphics window
to display the shortcut menu, refer to Figure 3-94. Next, choose the Rotate by r Degrees or
Rotate by -r Degrees option from the shortcut menu.

To scale the selected entities before replicating them, enter the required value for scale factor
in the f edit box, displayed on the right of the Replicate tool. Next, choose the Scale by
factor f or Scale by factor 1/f option from the shortcut menu according to the requirement,
refer to Figure 3-94.

30. Move the paste handle to the origin and click when the symbol of Coincident Point
constraint (P) is displayed, refer to Figure 3-95; the mirror copies of the selected entities
are replicated at their required locations, refer to Figure 3-96.
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31. Press the ESC key to exit the Replicate tool.

Next, you need to trim the unwanted portion of the sketch using the Trim tool from the
Modify toolbox.

32. Choose the Trim tool from the Modify toolbox; you are prompted to select
edges to trim.

TheT Trim tool is used to trim the objects that extend beyond a required point of intersection.
While creating a sketch, there are a number of places where you need to remove the unwanted
and extending edges. Choose the Trim tool from the Modify toolbox; the Draw cursor will
be displayed and you will be prompted to select the edges to be trimmed. Select the sketched

entity to be trimmed,; the selected sketched entity is trimmed to its nearest point of intersection
with any other sketched entity or axis.

33. Select the Ignore axis check box displayed on the right of the Trim tool and click on the

segments one by one, marked in Figure 3-97; the selected segments is trimmed and you
get the sketch shown in Figure 3-98,
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The Ignore axis check box is selected to ignore the Intersection of the segment of circles with
the X axis while trimming.
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Applying Geometric Constraints and Dimensions to the Sketch
The entities of the sketch should be fully specified in terms of size, shape, orientation,
and location. This is achieved by setting geometric constraints and dimensions.

Geometric constraints are the logical operations that are performed to add relationship (such
as tangent or perpendicular) between the sketched entities, planes, axes, edges, or vertices.
The constraints applied to the sketched entities are used to capture the design intent. By
using constraints in a sketch, you can reduce the number of dimensions that are reqmrec.:l in
that sketch. The geometric constraints are applied using the tools available in the Constraints
toolbox.

1. Expand the Constraints toolbox and choose the Equal Length tool
from it; you are prompted to select lines to apply the constraints.

2. Select any one of the two vertical lines from the sketch; you are prompted to select the
lines to apply the Equal Length constraint,

3. Select the second vertical line from the sketch; the Equal Length constraint is applied to
the two vertical lines and you are prompted to select the first line for applying the Equal
Length constraint.

4. Select the top most horizontal line of the sketch and then select the bottom most horizontal
line of the sketch to make them equal in length.

5. Select the Symmetric tool from the Constraints toolbox; you are prompted
to specify the axis of symmetry. Select the X axis; you are prompted to
select a point or edge to apply the Symmetric constraint.
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'The Symmetric tool is used to make entities symmetric about a centerline. After this too] is
invoked, select a centerline and then select the entities which are to be made symmetric.

6. Select the horizontal line from the sketch that is just above the X axis; you are prompted
to select the second point or edge to apply the Symmetric constraint.

7. Select the horizontal line from the sketch that is just below the X axis; the two horizontal
lines become symmetric about the X axis.

8. Choose the Concentric tool from the Constraints toolbox and select the
two circular arcs from the sketch; the selected arcs become concentric.

The Concentric tool is used to force two circular entities share the same center.

Next, you need to generate the dimensions and edit their values to get the sketch of
desired size.

9. Expand the Dimensions toolbox from the Sketching Toolboxes windows
and then choose the General tool.

10. Generate all dimensions shown in Figure 3-99 and edit the value of dimensions in the
Details View window, refer to Figure 3-100.
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Figure 3-99 Dimensions to be generated for Figure 3-100 Value of dimensions in the
the sketch of base feature Details View window

Note

The names of the dimensions displayed in the Details View window can be different in your
systemnt.

After applying the required geometric constraints and generating the dimensions, the
color of the sketch will change to blue indicating that the sketch is fully constrained and
is ready to be used for feature creation operations.

After completing the sketch, you need to exit the Sketching mode.
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i1. Choose the Modeling tab located at the bottom of the Sketching Toolboxes win.dow; the
Sketching mode is activated and the Tree Outline is displayed. Also, Sketch 1 is added
under the XYPlane node.

After exiting the Sketching mode, the sketching plane is still normal to the viewing
direction. To proceed further with the feature creasion operation, it is advised to change
the view of the sketching plane to Isometric view.

12. Right-click in the Graphics window, and then choose the Isometric View option from the
shortcut memnu displayed; the sketch is displayed in Isometric view.

Creating the Base Feature
Next, you need to create the base feature using the Extrude tool from the Features

toolbar.

1. Choose the Extrude tool from the Features toolbar; the preview of the
extruded feature with the default values is displayed in the Graphics window.
Also, a node for the extruded feature with the name Extrude 1 is added below the three
default planes in the Tree Outline.

The default parameters used for generating the preview of the extruded feature are displayed
in the Details View window. To get the required shape of the base feature, you need to edit
the values in the Details View window.

As per the.requirement of this tutorial, the material should be added normal to and
symimetrically on both sides of the sketch.

9. Select the Both-Symmetric option from the Direction drop-down list.
$. Enter 10 in the FD1, Depth (>0) edit box of the Details View window.

The complete depth of material addition is 20mm, but the material will be added
symmetrically by the same depth on both the sicdes of the skeich. Therefore, 10mm is
specified as the depth value. '

4. Choose the Generate tool from the
DesignModeler toolbar; the base feature is
created with the specified settings, refer to
Figure 3-101.

By default, the sketch is displayed only when the
plane on which it is created is the active plane.
Since the XY plane is the current active plane,
the sketch and the dimensions of the Sketchl are
still displayed in the Graphics window. You can

M . . -O S
I;;;iz gtl(; il;ec;:;g 2@; “Ehe sketch and its dimension Figure 5101 The base fature
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5. Right-click on the Sketch1 in the Tree Qutline and choose the Hide Sketch

option from
the shorteut menu displayed.

Note

If needed, you can again display the sketch and its dimensions. To do so, right-click on the Sketchl
in the Tree Outline and choose the Show Sketch option from the shortcut menu displayed.

Creating the Circular Cutout
Next, you need to create the circular cutout on
the two rectangular flanges of the base feature.
The sketch for this feature should be created
on the rectangular flange. As the three default
planes do not pass through the surface on
which the cutout has to be created, these
planes cannot be used for drawing the sketch.
Therefore, you have to define a new plane on
the top fat face of the rectangular flange and
draw the sketch for the circular cutout. Figure 3-102 Selecting the flat face for

defining the Sketching plane
1. Select the top face of the rectangular flange, refer to Figure 3-102.

You can use the tools available in the Select toolbar to select an edge, face, vertex, and so on
in a geometry, refer to Figure 3-103. For example, the Edge tool is used to select an edge, the
Face toolis used to select a face, and so on. Alternatively, right-click in the Graphics window to

display a shortcut menu and then choose the desired tool from the Selection Filter cascading
menu, as shown in Figure 3-104.

2. Choose the New Plane tool from the Active Plane/Sketch toolbar; Plane4 is added He.
to the Tree Qutline.

3. Choose the Generate tool available in the Features toolbar to generate the

new plane.
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Figure 3-103 The Select toolbar Figure 3-104 Choosing a selection mode from

the Selection Filter cascading menu
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4. Choose the Sketching tab available under the Tree Outline; the Sketching mode is
invoked.

5. Choose the Look At tool from the Graphics toolbar. /9
The Look At tool is used to orient the view normal to the screen.

6. Choose the Circle tool from the Draw toolbox and draw a circle as shown in
Figure 3-105.

7. Expand the Dimensions toolbox. The General tool is chosen by default in this toolbox.

i i i i i in the Details View window,
: ate the dimensions of the circle and specify their values in t |
° Sg;: l;o Figure 3-106. The sketch gets fully-defined and is ready to be used for feature

creation.
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IFigure 3-105 Creating circle on the defined Figure 3-106 Generating the dimensions of
shetching plane the sketch for cutout feature

9. Invoke the Modeling mode by choosing the
Modeling tab displayed below the Sketching | @&-(8] A Clamp
Toolboxes window. The sketch of the cutout B leasf;; .
feature is created on Plane4 and is displayed as N };;:Z)(Piane

Sketch2 in the Tree Outline, as shown in v
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window.

added in the Tree Outline
After drawing the sketch, you need to remove the material from the base feature using
the Extrude tool.

11. Choose the Extrude tool from the Features toolbar; th-e preview of t.he
extruded feature with the default values is displayed in the Graphics

window.
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Also, the Tree Outline is activated and Extrude? is added below Extrudel in the Tree
Qutline. )

12. Select the Cut Material option from the Operation drop-down list.

The Cut Material option is used to create cutouts, holes, and so on in an existing
components.

As per the design requirements, the material should be removed starting from the flat face
on which the sketch is created and up to the bottom most face of the second rectangular
flange.

13. Select the To Surface option from the Extent Type drop-down list, refer to Figure 3-108;
the Target Faces selection box is added in the Details View window.

To extrude a sketch to a desired face of an existing model, choose the To Surface option.

14. Click on the Target Faces selection box; the Apply and Cancel buttons are displayed in
the Target Faces selection box and you are prompted to select faces to create extrude.

13. Select the bottom face of the second flange, refex to Figure $-109; the material is removed
up to the specified surface.

Note

While selecting the target face, you need to rotate the view of the model. The process of dynamically
rotating the model has been discussed in detail in the previous tutorial.

16. Choose the Apply button from the Target Face selection box to accept the specified
face.

17. Choose the Generate tool from the Features toolbar; the cutout feature is
created, refer to Figure 3-110.

B Details of Extrudel
Extrude Extruged
Base Ohjact Sketch2
Cperation Cut Material
Diraction Vedtor MNgne [Normal)

Rirection Reversed
; ; 3 B Jv’ 3 Fixad
"IFDI, Depth (0} [Fixed

£5 Thinfsurface? E’ﬁ;ﬁh Al
Target Bodies

To Faces
Merge Topology?

SRR e e

Figure 3-108 Selecting the To Surface Figure 3-109 Specifying the face up to
option from the Extent Type drop-down which the material will be removed
list in the Details View window
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Creating the Blend Feature o
To remove the sharp edges from the clamp, you need to create fillets of radius 5 mum at

the vertical edges of the clamp. The fillet will be created on four vertical edges of the
model using the Fixed Radius option of the Blend tool

1. Choose the Fixed Radius tool from the Blend drop-down in the Features
toolbar; you are prompted to select edges to blend.

9. Press the CTRL key and select the four vertical edges of the model, refer to
Figure 3-111.

Note o
1. In Figures 3-110 and 3-111, the display of planes has beer turned off for better visualization.

As per the need, you can turn on or off the display of planes by choosing the Diﬁ)l&y Plane
button from the Graphics toolbar.

2. To fucilitate the selection of edges without rotating the model and for generating the blend
feature, change the display mode to wiregframe. The procedure to change the display mode has
been discussed in the previous tutorial.

3. Click on the Geometry selection box in the Details View window; the.App.iy anc.1 Cancel
buttons are displayed. Next, choose the Apply button from the Details View window to
accept the selected of edges to be blended.

4. Enter 5 in the FD1 Radius (>0) edit box as the radius of the edit box.

5 Choose the Generate tool from the Features toolbar; the blend feature is
created. Figure 3-112 shows the final model.

Edgestobe
selected for
creating blend

feature

Figure 3-110 Model after creating the
cireular cutout

Figure 3-111 Edges to be selected for creating
the blend feature
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6. Close the DesignModeler window; the Workbench window is displayed.

Saving the Project and Exiting ANSYS Workbench
After visualizing the model and restoring the default Isometric view, you need to save the

project and exit ANSYS Workbench. This saved project will be used in later chapters for
analysis..

1. In the Workbench window, choose the Save button from the Standard toolbar; the
project is saved with the name ¢03_ansWB_tut03.

2. Choose File » Exit from the Workbench window to exit the ANSYS Workbench
session.

Answer the following questions and then compare them to those given at the end of this
chapter:

L. In the DesignModeler window, the P symbol represents the Coincident Point constraint.
(T/F)

2. The Extrude tool can be invoked from the Create menu of the Menu bar {(T/F}

3. In the DesignModeler window, none of the constraints are automatically applied while
drawing a sketch. (T/F)
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4. The Horizontal too! in the Constraints toolbox can be used to make a linear entity
horizontal. (T/F)

5. You can change the view type to isometric by using the ISO ball present in the Triad.

(T/F)

6. You can switch to the Modeling mode by choosing the Modeling tab available at the
bottom of the Sketching Toolboxes window. (T/¥)

7. The Arc by Tangent tool can be invoked from the toolbox.

8 The tool is used to make two entities equal in length,

9. You can invoke the Offset tool from the toolbox.

10. You can hide or show a sketch anytime by using the

Answer the following questions:
1. The options in the Details View window are contextual in nature. (T/F)

9. You can create patterns of entities by using the Replicate tool available in the Modify
toolbox. (F/F)

3. Youcan change the direction of extrusion by using the options in the Direction drop-down
list in the Details View window. {T/I}

4. On choosing any tool from the Draw toolbox, the normal arrow cursor changes to Draw
cursor. (1/F)

5. Like other tools in the Graphics toolbar, the Rotate tool is also a wansparent tool. {T/F)

6. You can create line segments tangent to arcs by using the tool from the
Draw toolbox.

7. In the DesignModeler window, user actions are recorded in the
window.

8. You can switch to the Sketching mode by choosing the Sketching tab available at the
bottom of the Tree Outline window.

9. Inthe DesignModeler window, you can change the dimension of the entities by specifying
the new values in the window.

10. In DesignModeler, the Vertical constraint is represented by symbol.
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EXERCISES

(ql.reate‘the model shown in Figure 3-113. The dimensions of the model are shown in
Figure 3-114. (Expected time: 30 min)

R19.00 R13.00
#2000 $10.00

i
- 22i00 ~

f 158.00 .|

Uniferm thickness = 12mm

Figure 3-113 Model for Exercise 1 Figure 3-114 Dimensions of the model for
Exercise 1

Qreate the model shown in Figure 3-115. The dimensions of the model are shown in
Figure 5-116. (Expected time: 45 min)

126 BCD

HIH ? T Tt
A .
[
I
o

42,004 - Bv27.00
bmb 548 00
Figure 3-115 Model for Exercise 2 Figure 3-116 Dimensions for Exercise 2
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Create the model shown in Figure 3-117. The dimensions of the model are shown in
Figure 3-118, {Expected time: 45 min)

Figure 3-117 Model for Exercise 3
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Figure 3-118 Dimensions of the model for Exercise 3

Answers to Self-Evaluation Test
1L T2.E3.F4.T 57T 6.7, 7. Draw, 8. Equal Length, 9. Modify, 10. Tree Outline

Chapter
Part Modeling- II
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Starting ANSYS Workbench and Adding the Geometry Component
System

TUTORIALS

5 Y S

In this tutorial, you will create the line body for a beam having the C cross-section, as shown

in Figure 4-1. For dimensions, refer to Figure 4-2.

s

i

E
e

o

(Expected time: 45 min)

1069248

Before you start with the tutorial, you need to specify the project folder in which you need
to save all the related files.

Create a folder with the name c04 at the location CAANSYS WB.
Create a folder with the name Tut02 at the location CAANSYS_WB\c04.

You wiil save all the work rejated to this tutorial in this folder.

Now, you need to start ANSYS Workbench and then add a component system to the
project.

3. Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the start meny; the
Workbench window is displayed along with the Getting Started window.

4. Choose the OK button from the Getting Started window; the Getting Started window is
closed and the Workbench window is displayed.

5. In the Workbench window, choose the Save button from the Standard toolbar; the Save

S0 o As dialog box is displayed.
|1
P - 8. In this dialog box, browse to the location C:VANSYS_WBIcO4\Tut01 and save the project

4o = with the name c04_ansWB_tut01.

1000
| S e After the project directory is specified, you need to add the Geometry component systen
50 T to the Project Schematic window.

7. Double-click on Geometry displayed under the Component Systems toolbox in the

Yrrsrers Toolbox window; the Geometry component system is added to the Project Schematic
- window.

Cross seclion

Sceie 1110 8. Once the Geometry component system is added to the Project Schematic window, its

name is highlighted at the bottom of the component system in blue. If not, double-cltick
on the default name and rename it to C-Section Beam.

C i A . . A PR
MNote: All Dimensions cre in millimeters {mm}

Figure 4-2 Dimensions of the beam with C-section

Drawing the Sketch for the Beam

The following steps are required to complete this tutorial: To create the C-section beam model, first you need to start the DesignModeler window

and create the sketch for the beam.

Start ANSYS Workbench and add the Geometry component systern.

Draw the sketch for the beam. .

Generate the dimension of the line and change its value to 1000 mm.
te the line body from the drawn sketch. i |

gzgil‘;‘atﬁe cross—sectiozl of the line body. 2. Select the Millimeter radio button and then choose the OK button from the ANSYS

View and rotate the cross-section as per your requirement. Workbench dialog box to accept millimeter as the unit of length.

Save the project and exit the ANSYS Workbench session.

1. Double-click on the Geometry cell in the C-Section Beam component system; the
DesignModeler window along with the ANSYS Workbench diafog box is displayed.

gy B a0 TR
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Next, you need 1o create the sketch of the model. To do so, you need to specify the plane
on which you want to create the sketch and then create the sketch on the selected plane.

5. Select XYPlane from the Tree Outline; the selected plane is displayed in the Graphics

window.

4. Choose the Sketching tab displayed below the Tree Qutline to switch to the Sketching
mode.

5. Choose the Look At tool from the Graphics toolbar; the plane is oriented normal to
the viewing direction.

6. Choose the Line tool from the Draw toolbox; the cursor changes to the Draw
CUFSOT.

7. Move the cursor near the origin in the Graphics window and click once the symbol of
Coincident Point constraint (P} is displayed attached to the cursor, refer to Figure 4-3.

8. Next, you need to specify the end point of the line. Move the cursor toward right in
such a way that the symbol of Horizontal constraint (H) is displayed over the line and
symbol of Coincident constraint (C) is displayed at the end point of the line, as shown in
Figure 4-4.

Coincident constraint
symbot
Comcicent Point
consraint symbcl Harizonta) constraint
. sy‘mho;\
¢
Origin
Figure 4-3 Specifying the origin as the Figure 4-4  Specifymg the end point of the
start point of the line line

9. Click to specify the end point of the line; the line is created. Now, press the ESC key to
exit the Line tool.

Generating Dimension
Now, you need to create the dimension of the line that was created in the previous step
and edit its value to 1000 mm,

1. Click on the Dimensions toolbox in the Sketching Toolboxes window; the Dimensions
toolbox is expanded.

2. Choose the General tool from the Dimensions toolbox, if it is not chosen
by default.
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3. Move the cursor over the line and select it; preview of the dimension is displayed attached
to the cursor. )

4. Move the cursor and click at the location where you want to place the dimension; the
dimension is generated and its name is displayed on the dimension line.

5. In the Details View window, click in the edit box displayed on the right of the dimension
name (H1) under the Dimensions: 1 node and then enter 1000 in it; the length of line
instantaneously changes to 1000 mm and is displayed in the Graphics window, as shown
in Figure 4-5.

Note

T fit the drawn skeich in the Graphics window, choose the Zoom to Fit teol from the Graphics
toolbar: :

\\

Generating the Line Body from the Drawn Sketch

Now, you need to convert the drawn sketch to a line body feature.

. Choose the Lines from Sketches tool from the Concept menu of the Menu bar; you
are prompted to select the base object to convert it into a line body feature. Also, =5
Linel is added below the three default planes in the Tree Qutline, as shown in Figure 4-6.
A yellow thunderbolt is also displayed attached to Linel in the Tree Outline indicating
that the feature needs to be generated.

58] At C-Section Beam
] -y H X¥Pane
4 P e Sketchl

, 0 Bodies

Figure 4-5 The dimension of the line Figure 4-6 Line 1 added to the Tree Outline
representing the line body feature

2. Select the line drawn earlier and then choose the Apply button from the Base Objects
selection box of the Details View window.

The Lines from Sketches tool is used to create line bodies based on the object like faces and
planes,

3. Choose the Generate tool from the Features toolbar; the yeliow thunderbolt
symbol is changed to a green check mark, indicating that the feature is
updated.

4. Right-click in the Graphics window and choose the Isometric View option from the
shortcut menu displayed; the view is changed to Isometric, as shown in Figure 4-7.
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Figure 4-7 The generated line body feature
in Isometric view

Defining the Cross-section of the Line Body . -
After defining the line body, you need to define the cross-section of the line body.

1. Choose Concept > Cross Section > Channel Section from the Menu bar; the
channel section is displayed in the Graphics window along with its dimensions.
Also, a new node with the name 1 Cross Section is added in the Tree Outline.

The cross-sections are assigned to the kine body to define the properties'of the beam and are
associated with some standard dimensions. The values of these dimensions can be changed

to control the shape of the cross-sections.

2. Change the dimensions value in the Details View window, refer to Figure 4-8. The final
cross-section should be same as shown in Figure 4-9.

| = Details of Channeil - g
Sketch Channef. # i

Show Constraints? [ No
& Dimensions: §
L]ws 30 mm . I
[iw2 30 mm
50 mm

4 mm : ' : - d.

Figure 4-8 The values to be entered in the Figure 4-9 The channel section afler changing
Details View window the values
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3. Expand the 1 Part, 1 Body node and select the Liné Body displayed under it, as shown in
Figure 4-10; the details of the selected line body are displayed in the Details View window.
Note that the Cross Section property is highlighted in yellow indicating that you need to
define the cross-section.

4, In the Details View window, select Cross Section; it turns yellow and a down arrow is
displayed.

5. Click on the down-arrow and then select the Channell option from the drop-down list
displayed. The defined cross-section is assigned to the selected line body. Also, the Offset
Type drop-down list is added in the Details View window.

6. Select the Centroid option from the Offset Type drop-down list, if it is not already selected.

The options available in the Offset Type drop-down list are: Centroid, Shear Center, Origin,
and User Defined.

The Centroid option is selected by default and is used to center the cross-section on the edge
according to the centroid of the cross-section.

Viewing and Rotating the Cross-section
Next, you need to view the cross-section assigned to the line body and change its orientation
as per your requirement.

1. Choose the Cross Section Solids option from the View menu; the cross-section is displayed
in the Graphics window, as shown in Figure 4-11,

- 88 A C-Section Beam
[1‘._]‘,;-,},, X¥Plane
{0 ey Sketehl
‘,}}a ZXPiane
,,}I\ YZPlane
B e Linet
E,]',é} 1 Cross Section
D i B Channed
i}]«@‘ 1Part, 1 Body

b Mo Line Bod;\‘

Figure 4-10 Selecting Line Body from the Figure 4-11 The cross-section displayed in
Tree Outline the Graphics window

Note
Note that the coordinate system for the tine body is different from that of DesignModeler. This
difference in the coordinate system does not affect the final analysis resulls.

2. Choose the Edges tool from the Select toolbar; the cursor changes to the Edge
selection cursor.
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The tools available in the Select toolbar help you select points, edges, faces, bodies, and so
on. There are various tools available in the DesignModeler window to facilitate selection of
entities or parts. These tools can be accessed from the shortcut menu displayed, when you
right-click in the Graphics window.

3. Select the line body from the Graphics window; the details of the selected line body are
displayed in the Details View window.

4. Click on the Rotate edit box in the Details View window and enter 90 in the edit box; the

model is rotated by 90 degrees, as shown in Figure 4-12. Figure 4-13 shows the zoomed
partial view of the model.

e
LELRGIG

Figure 4-12 Final rotated model of ihe beam Figure 4-13 Zoomed partial view of the
with C-section . beam with C-section

5. Close the DesignModeler window; the Workbench window is displayed.

Saving and Exiting ANSYS Workbench
Now, you need to save the project and exit ANSYS Workbench.

1. in the Workbench window, choose the Save button from the Standard toolbar; the
project is saved with the name c04_ansWB_tut01.

2. Choose File > Exit from the Menu bar to close the Workbench window and exit the
ANSYS Workbench session.

own: in Figure 4-14. The
sketch of the model and its dimensions are shown in Figure 4-15.  (Expected time: 45 min)
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180 200 300

Figure 4-15 Sketch and dimensions for the revolve feature
The following steps are required to complete this tutorial:

Start ANSYS Workbench and add the Geometry component system.
Draw the sketch.

Apply constraints and generate dimensions.

Create the revolved feature.

Create the hole feature.

Create the pattern feature.

Save the model and exit Workbench.
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Starting ANSYS Workbench and Adding the Geometry Component

System
Before creating the model, you need to start the Workbench window and then add a
component system to the Project Schematic window.

1. Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the Start menu to display
the Workbench window.

9. In the Workbench window, choose the Save button from the Standard toolbar; the Save
As dialog box is displayed.

3. 1In this dialog box, browse to the folder CAANSYS WB\e04 and créate a sub folder
Tut02. ‘

4. Browse to the Tit02 foider and then save the project with the name c04_ansWB_tut02.
Next, you need to add the Geometry component systerm to the Project Schematic window.
5. Double-click on the Geometry component system displayed under the Component Systems

toolbox in the Toolbox window; the Geometry component system is added to the Project
Schematic window.

Prawing the Sketch
To create the revolved feature, you need to start the DesignModeler window and create
the sketch of the base feature.

1. Double-click on the Geometry cell in the Geometry component system; the DesignModeler
window along with the ANSYS Workbench dialog box is invoked.

9. Choose the Millimeter radio button and then choose the OK button: from the ANSYS
Workbench dialog box to accept millimeter as the specified unit system,

%. Select the XYPlane from the Tree Outline to specify the plane on which you want to create
the sketch for the model; the XY plane is displayed in the Graphics window.

4. Choose the Sketching tab displayed below the Tree Outline; the Sketching mode is
invoked.

5. Choose the Look At tool from the Graphics toolbar; the sketching plane is oriented
normal to the viewing direction.

6. Choose the Line tool from the Draw toolbox; the shape of the cursor changes to
the Draw cursor.

Next, you need to create a line along the Y axis,
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7. Move the cursor near the origin in the Graphics window and then move it to some distance

along the Y-axis and click while the symbol of Coincident constraint (C) is still displayed
refer to Figure 4-16. ,

8. Move the cursor upward in such a way that the symbol of Vertical constraint symbol (V)

is displayed over the line and the symbol of Coincident constraint (C) is displayed at the
end point of the line, as shown in Figure 4-17.

i

\ Specifying the end peint
. y of line
1’;
{
4 |
§\Starzpoinz of the Line
{l- ................... B cistrninssssanssis e TR ST S,
Figure 4-16 Specifying the start point of the Figure 4-17 Specifying the end point of the
line line

9. Click to specify the end point of the line; the line is created. Now, press the ESC key to
exit the line tool.

Similarly, create all the remaining entities. The final sketch of the model after ail entities
are created is shown in Figure 4-18.

...... é................u.w.,m

Figure 4-18 Final sketch of the model

Applying Constraints and Generating Dimensions
After the rough sketch is drawn, you need to apply required dimensions to the sketch.

1. Apply all the required constraints to the sketch,
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9. Generate all the dimensions of the sketch, refer to Figure 4-19, and change the
corresponding values in the Details View window. For values of the dimensions, refer to
Figure 4-15,

Note
Note that you need to apply constrainis to the skeich to fully define it.

Figure 4-19 Sketch after the dimensions ave generated

Note

The names of the dimensions displayed in the Graphics window may be different from the
ones given in this textbook. If you want to change the names according to Figure 4-19, select a
dimension in the Graphics window and then right-click on it to display a shorteul menu. Choose
the Edit Name/Value option from the shoricut menu; the Geometry - DesignModeler dialog
box will be displayed. Enter the required name in the Name edit box of this dialog box and then
choose the OK button to save ihe changes made and close the dialog box.

Creating the Revolve Feature
Now, as the sketch is ready, you need to create the revolved feature, which is also the base
{eature.

1. Change the view to isometric by using the ISO tool from the Graphics toolbar. ié_‘f

9. Choose the Revolve tool in the Features toolbar; Revolvel along with a yellow G Revolve
thunderbolt symbol is added in the Tree Outline. Also the options :
corresponding to Revolvel are displayed in the Details View window.

3. Click on the Geometry selection box in the Details View window; the Apply and Cancel
buttons are displayed. Click on Apply to assign the selected geometry for creating the
revolve feature. Also, the color of the sketch in the Graphics window turns green indicating
that it is already selected.
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Note

If the desired sketch is selected by default in the Graphics window, you need not select it to salisf
a parameter in the Details View window. If the sketch is not selected by default or there mi
multiple sketches in the Graphics windouw, select the vequired sketch and then choose the Appl

bution in the corresponding selection box in the Details View window. ’

4. Next, click on the Axis selection box; the Apply and Cancel buttons are displayed.

6.

5. Select the X axis that is displayed on the model, as shown in Figure 4-20, and then choose

the Apply button in the Axis selection hox to specify the X axis as the axis of revolution;
the preview of the feature is displayed in the Graphics window.

S AM.«“

St e

Figure 4-20 Selecting the X Axis that is displayed on the model

In the Tree Outline, right-click on Revolutionl to display a shortcut menu, as shown in

Ti‘igure 4-2]. Choose the Generate option from this shortcut menu; the revoived feature
is created, as shown in Figure 4-22,

EB"“&':?@ Iy 'Géometf)}
J‘;}E X¥Blane
s ¥ ZXPlane

JJ

gl Rename

Figure 4-21 The shorteut menu displayed Figure 4-22 The revolved feature
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Creating the Hole Feature
After the revolve feature is created, the next task is to create the holes for accommodating

the fasteners in the Car Brake Disc Rotor. To create the holes on the base feature, you
first need to create the sketch for the hole feature on the inner face of the Car Brake Disc

Rotor.

1. Choose the Faces tool from the Select toolbar.

9. Next, select the inner face of the base feature, as shown in Figure 4-23.

Figure 4-23 The inner face of the base feature selected

3. Choose the New Plane button available in the Active Plane/Sketch toolbar to
create the sketch of the hole on the selected face; the preview of the new plane is =
displayed in the Graphics window. Also, Planed is added to the Tree Outline.

4. Choose the Generate tool; the new plane is created. Also, a green tick
mark is placed before Plane4 in the Tree Outline indicating that you can ===
start creating the sketch for the hole feature.

5. Next, choose the Look At tool in the Graphies toolbar; the model will be oriented 1y
normal to the new plane, refer to Figure 4-24. '

6. Choose the Sketching tab available below the Tree Outline and then invoke (= Circle
the Circle tool from the Draw toolbox to create a circle. o

7. Move the cursor to a point, as shown in Figure 4-24, and then click when the Coincident
Point constraint symbol (P} is displayed to specify the center of the radius.

8. Next, move the cursor away from the center of the circie and then click at a random point
to create a circle, as shown in Figure 4-25.

9. Next, specify the diameter of the circle as 20.

10. Change the view to Isometric by using the ISO tool from the Graphics toolbar. =
wifs
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Figure 4-24 Specifying the center point of  Figure 4-25 The circle created on the face of the
the circle model

11. Invoke the Extrude tool from the Features toolbar; Extrudel is added t -
the Tree Qutline. © Extrude

12. Click on the Geometry selection box to display the Apply and Cancel buttons, if they are

not already displayed. Choose the Apply button to specify the circle as the geometry for
extrusion.

13. Next, in the Details View window, select the Cut Material option from the Operation
drop-down list, as shown in Figure 4-26, ‘

i4. Next, select the Reversed option from the Direction drop-down list, as shown in Figure 4-27.

Betalls of Extrrdel e | Details of Extrudel

Extrude Fxtrude] Extrude Extrudel
Geometry Sketchd Geometry Sketchd
S Movaenat s::::ii:{;eﬁer ;ﬁt o
Direction Vectar  [Add I an (Normall

]

o

Directian ; Mozl v

e

Extent Type by
RS ESRE o

L] FDL, Depth (0} oo™ Symmetri

As Thin/surface? Eoth - Asymmetric

mprint s
Extent Type Slice Material
[T1FD1. Dewth (>0 Add Frozen

Figure 4-26 Selecting the Cut Material option  Figure 4-27 Selecting the Reversed option from
[from the Operation drop-down list the Direction drop-down list

15. Select the Through All option from the Extent Type drop-down list, as shown in
Figure 4-28.

"The Through All option is selected when you need to create a cutout through the overall
thickness of the feature.
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16. Next, choose the Generate tool from the Features toolbar to generate the
hole, as shown in Figure 4-29.

=l| Details of E“;gud&i

Extrude Fxtrudel
Geometry Sketchd
Cperation Cut Material
Drection Vector None (Normal)
Direction Reversed

e Fixed v

[ FD1, Depth (>0) {Eixed
TR

As ThinsSsurface? To I‘tlext

Target Badies To Faces

To Surface

terae Tnnnloov?
Figure 4-28 Selecting the Through All option Figure 4-29 The hole created
from the Extent Type drop-doun list

Creating the Pattern of the Hole Feature
Now, after the hole feature is created, you need to pattern the hole to create three more
instances of hole on the face of the rotox.

1. Invoke the Pattern tool from the Create menu in the Menu bar; Patternl is Patrern
attached to the Tree Cutline. Sl

The patterns are defined as the sequential arrangement of the copies of the selected entities.
By using the Pattern tool, you can create the patterns in a rectangular or a circular mode.

9. Next, in the Pattern Type drop-down list, select the Circular option to specify the nature
of the pattern as circular, as shown In Figure 4-30.

Circular patterns are the patterns created around the circumference of a circle.
3. Choose the Face tool from the Select toolbar.
4. Next, click on the Geometry selection box to display the Apply and Cancel buttons.

5. Select the circular face of the hole created earlier in this tutorial, as shown in Fgure 4-31,
and then choose the Apply button in the Geometry selection box to confirm the selection.

6. Next, click on the Axis selection box; the Apply and Cancel buttons are displayed.

7. Next, click on the XYPlane in the Tree Qutline and then move the cursor to the X-axis
in the Graphics window; the X-axis gets highlighted, as shown in Figure 4-32.
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Face_s to be selected 1oy
arazling the patlem taature

£lrtilllon

Geometry . . - |Linear _
Direction . RN
wt_lfecttcn___ o TRectangust

[TFDL, Offset 38 mm

[} FD3, Copies (~0) |1

Figure 4-30 Selecting the Circular option from  Figure 4-31 Partiol view showing the selection of
the Pattern Type drop-down list Jace of the circular hole

8. Click on the X-axis; it tarns yellow.

9. Next, move the cursor to the Axis selection box and then choose Apply to select the X-axis
as the axis for creating the pattern.

10. Next:,, you need to specify the number of holes to be patterned. Enter 3 in the FD3,
Copies (>0) edit box in the Details View window.

11. Next, choose the Generate tool 1o generate the pattern. The model after
creating the pattern feature is shown in Figure 4-33.

Figure 4-32 Selecting the X-axis as the axis of ~ Figure 4-33  Model after the hole feature is
circular patiern patterned

12, pr, close the DesignModeler window by choosing the close (k834) button; the Workbench
window is displayed.
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Saving the Model and Exiting ANSYS Workbench

After the model is created, you need to save the project and exit the session.

1. Choose the Save button available in the Standard toolbar; the project is saved EM]
with the name ¢04_ansWB_tul02. )

9. Next, choose File > Exit from the Menu bar to close the Workbench window.

Iﬁ &ﬂs tﬁtoxial, you will create the revolved feature of the piston model, shown in Figure 4-34.

The sketch of the model and its dimensions are shown in Figure 4-35. .
(Expected time: 45 min)

Section A

Figure 4-34 Model of the piston for Tutorial 3 Figure 4-35 Dimensions of the model for Tutorial 3

The following steps are required to complete this tutorial:

Start ANSYS Workbench and add the Geometry component system.
Draw the sketch.

Create the revolve feature,
Save the model and exit ANSYS Workbench.

oo

Starting ANSYS Workbench and Adding the Geometry Component System
Before starting the project, you need to start ANSYS Workbench and then add a component
system to the project.

1. Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the start menu; the
Workbench window is displayed.

Note
In case, the Getting Started window is visible, choose the OK button fo close it.

2. In the Workbench window, choose the Save button from the Standard toolbar; the Save As
dialog box is displayed.
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3. In this dialog box, browse to.the folder C/IANSYS_WBIc04 and create a subfolder Tut03.

4. Next, browse to the location C:IANSYS_WBlc04\Tut03 and save the project with the name
c04_ansWB_tut03.

Next, you need to add the Geometry component system to the project.

5. Double-click on Geometry displayed under the Component Systems twolbox in the

Toolbox window; the Geometry component system is added to the Project Schematic
window,

6. Once the project is added to the Project Schematic window, its name gets highlighted in blue.
It it is not highlighted, double-click on the default name and rename it to Piston.

Drawing the Sketch

To create the revolved feature, first you need to start the DesignModeler window. Here
create the sketch of the base feature. Then, revolve the sketch to create the base feature,

1. Double-click on the Geometry cell in the Piston component system; the DesignModeler
window along with the ANSYS Workbench dialog box is displayed.

2. Select the Millimeter radio button and then choose the OK button from the ANSYS
Workbench dialog box to accept millimeter as the specified unit system.

3. Select the XYPlane from the Tree Outline window; the XY plane is displayed in the
Graphics window. Now, all the sketches are created in the XY plane.

Note

1. In the DesignModeler window, the XY plane is selected by defundt. To create a shetch on this
plane, go to the Sketching mode and use the tools available in this mode.

2. To create a skeich on a plane other than the XY plane, select the desired plane and then switch
to the Sketching mode.

4. Choose the Sketching tab displayed below the Tree Qutline; the Sketching Toolboxes
window is displayed, indicating that the Sketching mode is enabled.

5. Choose the Look At tool from the Graphics toolbar to orient the plane normal o ks
the viewing direction.

6. Create the sketch by using the tools available in the Draw toolbox, refer to Figure 4-36.

7. Add the required constraints by using the tools in the Constraints toolbox, refer to
Figure 4-36,
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4. Next, choose the Apply button in the Geometry selection box in the Details View window;

Sketchl is displayed in the Geometry selection box, indicating that the geometry is
specified for the revolve operation.

WWM

25EaET

5. Next, click on the Axis selection box; the Apply and Cancel buttons are displayed.

6. In the Graphics window, select the Y axis, as shown in Figure 4-39; the preview of the
revolve feature is displayed in the Graphics window, as shown in Figure 4-40.

7. Choose Apply from the Axis selection box; Y axis is specified as the axis of revolution.

Note that in the Details View window, you need to specily the sketch to be revolved and the
axis of revolution. You need not change other parameters in the Details View window.,

Figure 4-36 Shetch created on the XY plane -
v Rii

8. Similarly, add the required dimensions by using the tools available in the Dimensions
toolbox, refer to Figure 4-36.

Creating the Revolved Feature
To create the revolved feature, you need to exit the Sketching mode and then switch to
the Modeling mode.

1. Choose the Revolve tool in the Features toolbar; the Modeling mode is GhiRevolve
invoked and Revolvel is added to the Tree Quiline, refer to Figure 4-37. :
Also, the options corresponding to the Revolvel node are displayed in the Details View

window. S Figure 4-39 Selecting the Y-axis as the axis Figure 4-40 Preview of the revolve feature
S of revolution

2. Click on the Geometry selection box in the Details View window; the Apply and Cancel

buttons are displayed, as shown in Figure 4-38. & 8. Choose the Generate tool from the Features toolbar; the revolved feature is created, as
o shown in Figure 4-41.

3. Select the Sketchl node under the XYPlane in the Tree Qutline, as shown in
Figure 4-37.

etalls of R
1 Revalve Ravolvel
e , - - Kpply © | Cancel
E']v*;’}’* X’Y’Pl‘a[!e fais. o Mot sefected - ..
»ﬂiﬂ SELi Oparation Add Material
g P ZXPlane S Direction Mormal

I FO1, Angle (»0) {360 =

b e P YZPlane

_ As Thin/Surface? Mo
: f;ﬁ; Resolye Merge Tapology? |Yes
e S O Parts, 0 Bodies [51; Geometry Salection: 1 ;
W Ero Iskete Figure 4-41 The revolved feature ereated

Figure 4-37 Selecting the sketch from the Tree Figure 4-38 The Geometry edit box with the 9. Exit the DesignModeler window; the Workbench window is displayed.

Outline Apply and Cancel button
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Saving the Model and Exiting ANSYS Workbench

After creating the model, you need to save the project and exit ANSYS Workbench session.

1. In the Workbench window, choose the Save button from the Standard toolbar; the
project is saved with the name c04_ansWB_tut03.

9. Next, choose File > Exit from the Menu bar to close the Workbench window.

Bas BElD S ss
n this tutorial, you will create a 5 m .
create a sketch on the top surface of the base feature and then generate a surface on it. For

dimensions, refer to Figure 4-43,
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Figure 4-42 Model of the surface body for ~ Figure 4-43  Dimensions of the surface body for
Tutorial 4 Tutorial 4

The following steps are required to complete this tutorial:

Start ANSYS Workbench and add the Geometry component system.
Start the DesignModeler window and draw the sketch of the base feature.
Create the extrude feature.

Create a plane on the front face of the model.

Create a surface on the front face.

Save the project.

mooon T

Starting ANSYS Workbench and Adding the Geometry Component

System )
First, you need to start ANSYS Workbench and then add a component system to the

project.

1. Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the Start menu; the
Workbench window is displayed.
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2. In the Workbench window, choose the Save button from the Standard tootbar; the Save
As dialog box is displayed. -

3. Inthis dialog box, browse to the folder C:VANSYS WhIc04 and create a subfolder with the
name Tut04.

4. Next, browse to the 7itt04 folder and save the project with the name c04_ansWB_tut04.

After invoking the Workbench window, add an appropriate analysis or component system
to the Project Schematic window. In this tutorial, you will create a surface body using the
Geometry component system.

5. Expand the Component Systems toolbox, if it is not already expanded. Double-click
on the Geometry component system; the Geometry component system is added to the
Project Schematic window.

6. Rename the added component system to Surface Bod’yq

Creating the Sketch
Before you create the model, you need to start the DesignModeler window session and
then specify the plane on which you want to create the sketch for the base feature.

1. Double-click on the Geometry ceil in the Surface Body component system; the
DesignModeler window along with the ANSYS Workbench dialog box is invoked.

2. Select the Millimeter radio button and then choose the OK button from the ANSYS
Workbench dialog box to specify millimeter as the unit of length. On doing so, the
DesignModeler window is activated.

3. Choose the Sketching tab displayed below the Tree Outline of the DesignModeler window;
the Sketching mode is invoked. Also, note that the default plane XY is displayed in the
Graphics window.

4. Choose the Look At tool from the Graphics toolbar; the sketching plane is oriented
normal to the viewing direction.

5. Choose the Circle tool from the Draw toolbox and draw a circle with its
center at the origin.

6. Invoke the General tool from the Dimensions toolbox and generate the
diameter dimension of the circle,

7. Edit the value of the dimension to 100 in the Details View window; the circle is modified
according to the specified value and is displayed in the Graphics window, as shown in
Figure 4-44.
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Note
Change the display settings of dimension to Value as explained in previous tutorials. You may

S alse meed to zoom and pan the sketch to fit it into the Graphics window.

8 Invoke the Circle tool and draw two concentric circles such that their centers are coincident
with the X-axis, refer to Figure 4-45.

Figure 4-44 The circle of diameler 100mm Figure 4-45 Two concentric circles .wz'ih
their center coincident with the X-axis

After creating two concentric circles, you now need to make the center point of these
circles lie on the circumference of the circle of diameter 100 mm.

9. Invoke the Coincident tool from the Constraints toolbox and then select
the center point of the concentric circles and the circumference of the
circle of diameter 100 mm,; the center of the concentric circles will get coincident with the
circumference of the circle of diameter 100 mm, refer to Figure 4-46.

“The Coincident tool forces two points, or a point and line, to coincide.

10. Invoke the Trim tool from the Modify toolbox and trim the undesired portions
of the sketch, refer to Figure 4-47.

0,030
~.

Figure 4-46 The two concentric circles after Figure 4-47 Sketch after irimming the
applying the coincident constraint undesired portion
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11. Invoke the General tool from the Dimensions toolbox and generate the dimensions of
the concentric arc and circle.

12. Edit the dimensions of the sketch, as shown in Figure 4-48.

Next, you need to create five more instances of the concentric arc and circle at an angle
of 60 degrees to each other. These instances can be created by using the Replicate tool.

13. Invoke the Replicate tool from the Modify toolbox and select the concentric
arc and circle as the entities to be replicated.

14. Right-click in the Graphics window and choose the End / Use Plane Origin as Handle
option from the shortcut menu displayed; the preview of the entities to be replicated is
displayed attached to the paste handle, refer to Figure 4-49.

MEs
i

O

Figure 4-48 Sketch displaying various dimensions Figure 4-49 Preview of the
entities to be replicated

15, Enter 60 and 1 in the r and fedit boxes respectively, displayed on the right of the Replicate
tool in the Modify toolbox, refer to Figure 4-30.

16. Right-click in the Graphics window and choose the Rotate by r Degrees option from the
shortcut menu displayed; the preview of the selected entities is rotated by 60 degrees,

refer 1o Figure 4-51.

§° = N 3t
Figure 4-50 The r edit box Figure 4-51 Preview of the entilies to be
replicated after rotating them by 60 degrees
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17. Right-click in the Graphics window and choose the Paste at Plane Origin opticn from
the shorteut menu displayed; a similar instance of the selected entity will be replicated at

an angle of 60 degrees, refer to Figure 4-52.

18, Similarly, create four more instances of the selected entities. Figure 4-53 shows the sketch
after creating all the instances.

DU
hN

Figure 4-52 Sketch after replicating the Figure 4-53 Sketch afler replicating il
frrst instance of the selected entity instances of the selected entity

19. Invoke the Trim tool from the Modify toolbox and trim the undesired portions
of the sketch, refer to Figure 4-54.

Note

There is o possibility that even after trimming all entities you may not get the desired sketch,
as shown in Figure 4-54. This may happen because the exiension lines of diameter dimension
100 mm are displayed on the locations wheve you have trimmed the entities. In such o case you
need to delete the diameter dimension of value 100 mm and create the radial dimension for any
one of the ares.

20. Invoke the Symmetry tool from the Constraints toolbox and make the
center points, shown in Figure 4-55, symmetric about both X and Y axes.

R15.903

=S

\ “;}3 a0
N /

Figure 4-54 Sketch after trimming the Figure 4-55 The center poinis to be made
undesired portions of the sketch symmeiric about both X and Y axes

The canterpoints to be
@ made Symmetnc abou both ® \
XandY axes

The Symmetry tool is used to create symmetrical features about an axis. To create symmetries,
invoke the tool and then select the axis about which you want to create the symmetry. Next,
choose the required point or edge to apply Symmetry constraint.

Part Modeling - II . 4-27

21. Invoke the General tool from the Dimensions toolbox and generate the dimension between
the Y axis and the Center point A, refer to Figure 4-56. All sketched entities turn blue,
indicating that the sketch is fully defined.

As the sketch for the surface body is complete and fully defined, you need to exit the
Sketching mode.

22. Choose the Modeling tab displayed below the Sketching Toolboxes; the Modeling mode
is invoked.

Creating the Extrude Feature
After creating the sketch, you need to extrude the sketch using the Extrude tool.

1. Right-click on the Graphics window and then choose the Isometric View option from
the shortcut menu displayed; the view of the sketch becomes Isometric.

Note

You can also use the tools available in the Graphics toolbar to adjust the view of the model to
Isometrie.

2. Choose the Extrude tool from the Features toolbar; the contents of the Details View
window are changed. Also, Extrudel is added to the Tree Outline and you are prompted
to select the skeich to extrude,

3. Select Sketchl from the Tree Outline; the sketch in the Graphics window is highlighted
in yellow.

4. Choose the Apply button from the Geometry selection box in the Details View window;
the sketch is now selected to be converted into a body.

5. Enter 5 in the FD1, Depth (>=0) edit box to specify the depth of extrusion.

6. Choose the Generate tool from the Features toolbar; the sketch is extruded,
as shown in Figure 4-57.
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Figure 4-56 Final sketch for generating the Figure 4-57 The extruded feature

model
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Creating a Plane on the Front Face of the Model
The next step is to create a surface on the front face of the model.

1. Choose the New plane tool in the Active Plane/Sketch toolbar; Plane4 is attached e
to the Tree Outline. Also, the contents of the Details View window are changed.

2. In the Details View window, select From Face from the Type drop-down list; the Base
Face selection box is displayed in the Details View window.

3. Click on the Base Face selection box to display the Apply and Cancel buttons.

4. Choose the Face tool from the Select toolbar and then select the front face of the
model, as shown in Figure 4-58.

5. Choose the Apply button from the Geometry selection box; Selected is displayed in the
Geometry selection box.

6. Choose the Generate tool from the Features toolbar; the new plane is
created on the front face of the model, refer to Figure 4-59.

Figure 4-58 The front face of the model selected Figure 4-59 The new plane generated
Jfor creating the plane

Creating a Surface on the Solid Mode!
After the base feature is created, it is important to create a surface on the front face in such
a manner that a different region can be created on it. To create a region on the model,
follow the procedure given next:

1. Choose the Look At tool from the Graphics toolbar; the front view of the model is oriented,
as shown in Figure 4-60.

2. Choose the New Sketch tool in the Active Plane/Sketch toolbar; Sketch2 is  _«
added under the Planed node in the Tree Outline, as shown in Figure 4-61. #=

3. Choose the Sketching tab; the Sketching mode is invoked.
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Figure 4-60 Front v:iew_of the model Figure 4-61 Sketch2 attached to the

Planed nede in the Tree Outline

Next, you need to create an intersecting surface from sketched entities. To do so, you need
to create the sketch of two circles.

4. Invoke the Circle tool from the Draw toolbox in the Sketching Toolboxes window; the
cursor changes to the Draw cursor. Also, you are prompted to specify the center of the circle.

5. Click on the origin to specify the center point of the circle.

6. Move the cursor away from the origin and click at a point such that the radius of the circle
is smaller than the radius of the surface on which it is created, refer to Figure 4-62.

7. Similarly create another circle with a radius smaller than the radius of the circle created
previously, refer to Figure 4-62.

8. Next, you need to specify the dimensions of the circles created. To do so, invoke the
General tool from the Dimension toolbox in the Sketching Toolboxes window.

9. Next, click on the outer circle and then place the dimension such that it does not interfere
with any other entity, refer to Figure 4-63.

10. Similarly, select the inner circle and place the dimension, refer to Figure 4-63.

1i. In the Details View window, specify the outer and inner diameters as 75 and 55
respectively.

a3

Figure 4-62 Tuo circles created on the new plane Figure 4-63 Dimensioned shetches
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Next, you need to create 2 surface inside the sketch in such a way that a new region is
created in the model.

12. Change the view of the model to Isometric by using the 18O tool.

13. Invoke the Surface From Sketches tool from the Concept menu of the menu bar;
SurfaceSkl is added in the Tree Qutline.

The Surfaces From Sketches tool is used to create surface bodies by using sketches. The
sketches to be used for creating the surface should form a closed loop and the entities must
not intersect each other at any point of time. The edges of the sketches are to be considered
as the boundaries for the surface creation.

14. Click on the Base Objects selection box in the Details View window; the Apply and Cancel
buttons are displayed in it.

15. Select Sketeh2 from the Tree Qutline.

16. Choose the Apply button from the Base Object selection box; Sketch2 is specified as the

base object. Also, 1 Sketch is displayed in the Base Objects selection box.

17. Choose the Generate tool from the Features toolbar;
the surface is created on the model, as shown in
Figure 4-64.

18. Exit the DesignModeler window; the Workbench
window is displayed.

Saving the Project and Exiting ANSYS
Workbench

After creating the model, you need to save the project
and exit ANSYS Workbench. This saved project willbe Figure 4-64 Model with the newly
used in later chapters for analysis. created shelch

1. Choose the Save button from the Standard toolbar; the project is saved with the name
c04_ansWB_tui04.

2. Choose the Exit option from the File menu of the Workbench window to close the ANSYS
Workbench session.

Answer the following questions and then compare them to those given ai the end of this
chapter:

1. The DesignModeler application is associated with the Geometry component cell. (T/F)
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2. A system cannot be added to the Project Schematic window by dragging it from the
Toolbox window. (T/F)

3. Inthe DesignModeler window, the XY, YZ, and ZX planes are displayed by defauls, (T/F)
4. In ANSYS Workbench, you can create L and I sections along with Channel sections. (T/E)
5. You cannot cut material from an existing feature by using the Revolve tool. (T/F)

6. You can cut material from an exis;ing feature by using the Extrude tool. (T/F)

7. You can use the plane origin as the Paste Handle while using the Replicate tool. (T/F)
8. In the DesignModeler window, you can save the sketch with a different name. (T/F)

9. Which of the following Auto constraint symbols is used to make the end point of the
current drawing entity coincident with a point?

(a) C ()R
" @T

10. You can create circular patterns using the
Menu bar.

tool from the Create menu of the

Answer the following questions:

1. In any system displayed in the Project Schematic window, you need to double-click on
the desired cell to open the corresponding workspace. (1/F)

2. You can change the dimension of a sketch by using the options available on right-clicking
on the particular dimension. (T/F)

3. When the Zoom tool is active, you can drag the cursor up and down to zoom in and out. (T/F)
4. You cannot create a pattern of a hole around a circular axis. (T/I))

5. The Exirude tool can also be used to remove material from the existing entity. (T/F)

6. You can also use the Replicate tool to scale and flip a sketched entity while replicating it. (T/F)

7. Before extruding any sketch, you need to choose the
feature.

tool to create a

8. If the sketched entity is displayed in blue, it represents that the sketch is
defined.
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9. The tool is used to orient the sketching plane perpendicular to the viewing
direction.
10. The option in the Extent Type edit box of the Details View window for the

Extrude tool is used to add material to the specified surface.

11. Which one of the following is displayed as dimension by default?

{(a) Dimension Value {b) Dimension Name
() Both (d) None
EXERCISE

: cis
Create the model shown in Figure 4-65. The dimensions are given in Figures 4-66 through
4-68. (Expected time: 45 min)
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Figure 4-66 Top view of the model
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Figure 4-67 Side view of the model Figure 4-68 Front view of the model

Answers to Self-Evaluation Test
1.T,2.E8.T1,4.,5.E6.T7.T, 8. T, 9. ¢, 10. Pattern

Chapter

* Create loft features g

Part Modeling- I
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In the previous chapter, you learnt to work with various part modeling tools. In this chapter,
you will learn to work with some more tools used in part modeling.

Draw the sketch for the base feature.

Create the base feature.

Create the cut feature.

Create the pattern of the cut feature.

Create revolved cut feature for the nut hole.

Create pattern of the nut hole.

Create revolved feature for the rim.

Create the blend feature,

Save the project and exit the ANSYS Workbench session.

TUTORIALS

In this tutorial, you will create the solid model of the Rinr} shovyn in F}gure B-1.The din}ensigns
of the model are shown in Figure 5-2. Assume the missing dimensions. Save the project with
the name ¢05_ansWB_tut01 at the location CUANSYS_14105\Tut01. '

: (Expected time: 40 min)

S Eam e oo

Starting ANSYS Workbench and Adding the Geometry Component
System :

To create the model, you need to start ANSYS Workbench and then add a component
system to the project.

1. Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the Start menu; the
Workbench window is displayed along with the Getting Started window.

2. Choose OK from the Getting Started window to close it.
After invoking the Workbench window, you have to add appropriate analysis system or

the component system to the Project Schematic window. In this tutorial, you will create
a solid model] using the Geometry component system.

3. In the Workbench window, expand the Component Systems toolbox in the Toolbox
- f window and drag the Geometry component system to the Project Schematic window; a
: i green colored rectangular boundary will be displayed, refer to Figure 5-3.
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Figure 5-3 Prospective location for adding component system
Section A-A
Figure 5-2 Dimensions for the model in Totorial 1 & The green colored rectangular boundary indicates the prospective location where the analysis
igure 5-2 Dimensions for the mode

or the component system can be added.
1 j lete this tutorial: . .
The following steps are required to complete this tutorl 4. Drag the cursor over this rectangular boundary; the green color will change to red, refer
Start ANSYS Workbench and add the Geometry component system. to Figure 5-4. Next, drop the component system over this rectangular boundary; the

12;- Stait DesignModeler window and specify unit system. Lt Geometry component system is added to the Project Schematic window.
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Figure 5-4 Adding the component system to the Project Schematic window

5. Once the component system is added to the Project Schematic window, rename it
as Rim.

6. Choose the Save button from the Standard toolbar; the Save As dialog box is displayed.

7. In this dialog box, browse to the location C:\ANSYS_WB and then create a folder with the
name ¢05.

8. Browse to the ¢05 folder and then create a sub folder with the name TutQ1.

9. In this folder, save the project with the name c05_ansWB_tut01,

Starting DesignModeler Window and Specifying Unit System
After the Geometry component system is added to the Project Schematic window and
the project is saved, you now need to open DesignModeler to create the model.

t. Double-click on the Geometry cell in the Rim component system; the DesignModeler
window along with the ANSYS Workbench dialog box is displayed.

9. Select the Millimeter radio button and then choose the OK button from the ANSYS
Workbench dialog box to specify millimeter as the unit of length and then close the dialog
box.

Drawing the Sketch for the Base Feature
Now, you have to specify a plane on which you want to create the sketch for the base
feature. In this tutorial, the sketch for the base feature will be created on the XY plane,
which is the default plane in DesignModeler. Therefore, you do not need to specify the
plane for sketching. The sketch will now be drawn on the XY plane.

1. Choose the Sketching tab displayed at the lower left corner of the Tree Outline to invoke
the Sketching mode.
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Now, you need to orient the sketching plane normal to the viewing direction so that you
can easily draw the sketch on the specified plane.

2. Choose the Look At tool from the Graphics toolbar; the plane is oriented normal to iE
the viewing direction. -

3. Choose the Line tool from the Draw toolbox; you will be prompted to specify the start point
of the line.

4. Draw an inclined line in the fourth quadrant, refer to Figure 5-5.

5. Choose the General tool from the Dimensions toolbox and generate the A
dimensions of the inclined line, as shown in Figure 5-5.

To generate the angular dimension using the General tool, select the inclined line and
right-click in the Graphics window to display a shortcut menu. Next, choose the Angle option
from the shortcut menu, refer to Figure 5-6. Now, select the Y axis; the angular dimension
will be displayed attached to the cursor. If the displayed angle is not the one that is required,
right-click in the Graphics window and choose the Alternate Angle option from the shorteut
menu displayed; the alternate angle will be displayed. Keep on choosing the Alternate Angle
option from the shortcut menu until you get the angle of the desired quadrant. Now, place
the dimension at the desired location. Alternatively, you can use the Angle tool from the

Dimensions toolbox and then select the two lines between which you want to measure the
dimension.

e c-:J——-i jﬁ
w-’““""’""ﬂ T
i aﬂ/
Figure 5-5 The inclined ling along with Figure 5-6 Choosing the Angle option from the
its dimensions shortcut menu

6. Use the Line and Arc by 3 Points tools to create the remaining sketch for the base
feature and then generate its dimensions, refer to Figure 5-7.

The Arc by 8 Points tool is used to create arcs by specifying three points in the Graphics
window. The first two points of the arc specify the start and end points of the arc, whereas the
fast point specifies the radius of the arc.

Choose the Modeling tab displayed at the bottom of the Sketching Toolboxes window; the
Sketching mode is exited and the Modeling mode is invoked. Also, Sketch 1 is displayed
under the XYPlane node.
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Figure 5-7 Complete sketch for the base feature

After exiting the Sketching mode, the sketching plane will still be normal to the viewing
direction. Therefore, to proceed further with the feature creation operation, it is advised
to change the view of the sketching plane to [sometric view.

8. Right-click in the Graphics window and choose the Isometric View option from the
shortcut menu displayed; the view is changed to Isometric.

Creating the Base Feature
After creating the sketch, revolve the drawn sketch about the X axis to create the base
featare of the model.

1. Choose the Revolve tool from the Features toolbar; you will be prompted
to select the base object. Also, Revolvel is added below the three default
planes in the Tree Outline,

The Revolve tool is used to create circalar features like shafts, couplings, pulleys, and so on.
You can also use this tool for creating cylindrical cut features. A revolved feature is created by
revolving the sketch about an axis. You can use any straight 2D sketch edge, 3D model edge,
or plane as axis. The default parameters for the revolve feature are displayed in the Details
View window. You need to edit the values in the Details View window to get the required
shape of the base feature.

9. Select Sketchl from the Tree Outline and click on the Apply button in the Geometry
selection box of the Details View window; the sketch to be revolved is now selected.

3. For this model, the material should be added by revolving the sketch about the X axis.
Select the X axis from the Graphics window, refer to Figure 5-8. Figure 5-9 shows the
preview of the revolved feature after the axis is specified.

6. Choose the Generate tool from the Features toolbar; the base feature is
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Note

If there 1s a disjoint line in-the shetch of the revolve Jeature, @ will be selected as the default axis
of revolution.

4. Chqose the Apply button from the Axis selection box in the Details View window; Selected
Is displayed in the Axis selection box indicating that the axis for revolution s specified.
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Figure 5-8 Selecting the X axis from the
Graphics window

Figure 5-9 Preview of the revolved feature
after specifying the axis of revolution
5. Next, we need to specify the angle of revolution. Enter 360 in the FD1, Angle (>0) edit

box of the Details View window, if it is not already specified; the sketch will be revolved
by the angle specified in this edit box,

created by revolving the sketch about the X axis by 360 degrees, refer to
Figure 5-10.

7. Right-click on the Sketchl in the Tree Outline and choose the Hide Sketch option from

the shortcut menu displayed.

Figure 5-10 The base feature created

Note

In Figure 5-10, the display of planes has been turned off for better visthility of the model. You

cmzbtum off the display of the plomes by choosing the Display Plane iool from the Graphics
toolbar.
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Creating the Cut Feature . .
After creating the base feature, you need to remove material from it to generate the spoke

of the rim. The cut feature will be created using the Extrude tool. The sketch for the
extrude feature will be created on the YZ plane.

1. Select YZPlane from the Tree Quiline.

2. Choose the Sketching tab displayed below the Tree Outline; the Sketching mode is
activated. .

%. Choose the Look At tool from the Graphics toolbar; the sketching plane is /9
oriented normal to the viewing direction. :

4. Choose the Arc by Center tool from the Draw toolbox. Next, click to
specify the center of arc at the origin, and draw the arc, as shown in
Figure 5-11.

The Arc by Center tool is used to create arcs by specifying the center of the arc. After this tool
is invoked, click to specify the center of the arc. Next, move the cursor to specify the radius
of the arc. The point specified for the circie also acts as the start point of the arc. Move the
cursor to specify the end point of the arc.

5. Choose the Polyline tool from the Draw toolbox and draw the two line
segments as shown in Figure 5-12.

Figure 5-11 The arc created using the Figure 5-12 The lines created using the
Are by Center tool Polyline tool

6. Expand the Constraints toolbox and choose the Symmetry tool. Next,
make the two inclined lines symmetric about the Y axis.

2 2

7. Expand the Modify toolbox and choose the Fillet tool.

Filleting is the process of rounding the sharp corners of a sketch. This is done to reduce the
stress concentration in the model. Using the Fillet tool, you can round the corners of the
sketch by creating an arc tangent to both the selected entities,
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8. Enter 15 as fillet radius in the Radius edit box displayed on the right of the Fillet tool.

9. Select the intersection point of the two inclined line segments of the polyline; the fllet is
created, as shown in Figure 5-13. Next, exit the Fillet tool.

10. Expand the Dimensions toolbox and choose the General tool, if it is not
chosen by default.

11. Apply the dimensions to the sketch and edit their values, as shown in Figure 5-14.

#700.003

Bt e

Figure 5-13 The fillet created at the intersection  Figure 5-14 The final skeich afer the dimensions
of two line segments are applied

Now, the sketch is ready to be used for creating the cut feature.

12. Exit the Sketching mode by selecting the Medeling tab displayed below the Sketching
Toolboxes window.

18, Choose the ISO tool from the Graphics toolbar; the view is changed to fii'
Isometric. —

After drawing the sketch, you need to remove the material from the base feature using
the Extrude tool to create the spoke of the rim.

14. Choose the Extrude tool from the Features toolbar; the preview of the
extruded feature with the default values is displayed in the Graphics window.
Also, Extrudel is added below Revolvel in the Tree Qutline.

The default parameters used for generating the preview of the extruded feature are
displayed in the Details View window. You need to edit the values in the Details View
window to get the cutout.

15. Select the Gut Material option from the Operation drop-down list.

'The Cut Material option is used to remove material from an existing feature.

To create the model for this tutorial, the material should be removed from both the sides
of the sketch and through all the features that are normai to the sketch.
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16. Select the Both - Symmetric option from the Direction drop-down list in the Details View
window, refer to Figure 5-15.

The Both - Symmetric option is used to perform an extrusion operation on both sides of the
sketch, equally.

17. Select the Through All option from the Extent Type drop-down list in the Details View
window, refer to Figure 5-15.

The Through All option is used to perform the extrusion operation through the total thickness
of the existing feature.

18. Choose the Generate tool from the Features toolbar; the cut feature is created, refer to
Figure 5-16.

]| Details of Extrudel

Extrude Extrudal

Base Gbject Spetehd I
Operation Cut Matarial

Direction Vector |Mohe (Narmaf v
Direction #oth - Symmetric

Extent Type Thiough All

Ag Thin/Suface? [No

Target Bodies All Bodies

Marge Topology? | Yas

Figure 5-16 The cut feature created using
the Extrude tool

Figure 5-15 The Details View window
with the options selected for extrude operation

Note
For better visibility, the display of the planes in ihis figure has been turned off

19. Right-click on Sketchl in the Tree Outline and choose the Hide Sketch option from the
shortcut menu displayed.

The Hide Sketch option is used to make any sketch temporarily invisible in the Graphics
window. To hide a sketch, right-click on the sketch instance in the Tree Outline and then
choose Hide Sketch from the shortcut menu displayed.

Creating the Pattern of the Cut Feature
Next, you need to create seven more similar instances of the cut feature on the hase feature
to get the final shape of the spoke.

1. Choose the Pattern tool from the Create menu, refer to Figure 5-17; you are prompted
to select a geometry to create the pattern. Also, Pattern 1 is added in the Tree Outline.

The Pattern tool is used to create multiple instances of the selected faces along a linear direction
or along a circular path. The patterns are defined as the sequential arrangement of the copies
of the selected entities. You can create the patterns in rectangular or circular fashion.

4. Inthe Details View window, cheose the Apply
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Figure 5-17 Partial view of the
Create menu

You have to select the faces of the cut feature that need to be patterned.

2. Choose the Face tool from the Select toolbar; the cursor will change to Face selection

Cursor.
The tools in the Select toolbar are used to apply Point Edga
filters while selecting entities from the Graphics
window, refer to Figure 5-18, For example, if you Setect Mode Face
want to select only the edges of the model, you :
. ’ Bel
can use the Edge tool to filter the edges. It will e Eemml I—E‘je«:ﬁy

enable you to select the edges only, and will i
disallow selection of any other entity of the
model. These tools are also available in the
shortcut menu that is displayed by right-clicking
in the Graphics window.

Figure 5-18 The tools in the Select toolbar

3. Press the CTRL key and select the three faces of the cut feature to be patterned, refer to
Figure 5-19.

Note

While selecting the faces, you have to rotate the
view of the model. The process of dynamically
rotating the model has been discussed in detail
in the previous tutorial.

Tivee faces of the cut
feaiure salacted to be

patterned
button from the Geometry selection box to
accept the specified faces; 3 Faces is displayed
in the Geometry selection box in the Details

View window. Figure 5-19 Faces of the cut feature

selected to be patterned



5-12 ANSYS Workbench 14.0: A Tutorial Approach

5. Select the Circular option from the Pattern Type drop-down list in the Details View
window.

The Circular option will enable you to create the pattern of the cut feature in a circular
manner about the specified axis. The Linear option in the Pattern Type drop-down list is
used to create the pattern of the selected feature along the specified linear direction. The
Rectangular option in this list is used to create the pattern of the selected feature along two
specified linear directions, so that the final pattern results in a rectangular form.

Notice that the Axis selection box in the Details View window is highlighted in yellow
indicating that you have to still specify the axis about which the pattern will be created.

6. Click on the Axis selection box; you are prompted to select an axis to create the pattera.

7. Select XYPlane from the Tree Outline; the XY plane is displayed in the Graphics
window.

8. Click on the X axis, refer to Figure 5-20; the
selected axis is highlighted in yellow.

9. Choose the Apply button from the Axis
selection box; the selected axis is specified
as the axis for creating the circular pattern.

After specifying the axis of the circular
pattern, you need to specify the angular value
between two consecutive instances of the
pattern feature. In this tutorial, all instances :
of the circular pattern should be equally Figure 5-20 Selecting the axis about which the
spa(;ed and arranged in 360 degrees,‘ ctreular paltern will be created

10, Make sure Evenly Spaced is displayed in the FD2, Angle edit box in the Details View
window. However, if this option is not displayed in this edit box, enter 0 in the FDZ, Angle
edit box; Evenly Spaced will be displayed in it.

The Evenly Spaced option is used to specify same distance between the instances of a pattern
feature.

Aftter specifying the angle between two consecutive instances of the pattern feature, you
need to specify the number of instances in the pattern. In this tutorial, you need to create
seven more instances of the feature to be patterned.

11. Enter 7 in the FD3, Copies (>0) edit box. Figure 5-21 shows the Details View window
with ali parameters that you have specified.

The FD3, Copies (>0) edit box is used to specify the number of instances required in a
pattern.
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12. Choose the Generate tool from the Features toolbar; the circular pattern
is geperated by creating seven more instances of the cut feature about the
X axis, refer to Figure 5-22.

Creating Revolved Cut Feature for the Nut Hole
Next, you need to create a nut hole on the rim. This nut hole is used to assemble the rim
v‘mh the driving shaft. The nut hole can be created by removing material from the base
feature. You will use the Revolve tool to remove the material. The sketch for the revolve
feature will be created on the XY plane.

1. Sek?cr: XYPlane from the Tree Ou'tline and choose the New Sketch tool from the
Active Plane/Sketch toolbar; Sketch3 is added under the XYPlane.

i Bretails of Patternl

Pattern Patternt

Pattarn Type Cireutar

Geomatry 3 Facas

Axis Selacted

CYED2, Angle Evenly Spaced

sk B

Figure 5-21 The Details View window with Figure 5-22 Model afier patterning the cut
parameters for creaiing the circular patiern feature

2. Select Sketch3 from the Tree Outline and invoke the Sketching mode. Also, orient the
view of the sketching plane parallel to the screen.

3. Draw the sketch with the dimensions shown in Figure 5-23.

4. Choose the Modeling tab to switch to the Modeling mode and then change the view to
Isometric,

5. Choose the Revolve tool from the Features toolbar; you are prompted to
select the axis of revolution. Also, Revolve2 is added to the Tree Outline.

Note

Stnce there is only one sheich in the Sketching mode, it s automatically highlighted in the Graphics
window. In case it is not highlighted, you may need to select Sketch3 from the Tree Outline and
then choose the Apply button from the Geometry selection box in the Details View window.

6. Select the longest horizontal line of the sketch as the axis for the revolved feature, refer

to Figure 5-24.

7. Choose the Apply button from the Axis selection box in the Details View window; the

line is specified as the axis for the revolve feature,
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Figure 5-23 Sketch for the revolved nul
hole feature

8.

10.

il.

the revolve feature

"To remove material from the base feature, select the Cut Material option from the
Operation drop-down list in the Details View window.

Enter 860 in the FD1, Angle (>0) edit box, if it is not specified by default.

Choose the Generate tool from the Features toolbar; the revolved cut
feature is created by revolving the sketch about the specified line by 360
degrees, refer to Figure 5-25.

Right-click on Sketch3 in the Tree Outline and choose the Hide Sketch option from the
shortcut menu displayed; the sketch is not displayed in the Graphics window.

Creating the Pattern of the Hole

1.

Next, you need to create four more instances of the hole feature on the base feature. This
can be achieved by creating circular pattern of the revolved cut feature that was created
garlier.

Figure 5-25 The model after creating the
revolved cut feature

Choose the Patiern option from the Create menu; you are prompted to select a geometry
to pattern. Also, Pattern2 is added in the Tree Outline.

Now, you need to select the faces of the revolved cut feature that need to be patterned.
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9.

Choose the Face tool from the Select toolbar; the cursor is changed to Face selection
cursor :

Press the CTRL key and select the faces of the cut feature to be patterned, refer to
Figure 5-26.

Choose the Apply button from the Geometry selection box to accept the specified faces;
3 Faces is displayed in the Geometry selection box.

In the Details View window, select the Circular option from the Pattern Type drop-down
list. '

Notice that the Axis selection box in the Details View window is highlighted in yellow color,
indicating that you still need to specify the axis about which the pattern will be created.

Click on the Axis selection box; the Apply and Cancel buttons are displayed. Also, you
are prompted to select an axis to create the circular pattern.

Select XYPlane from the Tree Outline; the XY plane is displayed in the Graphics
window.

Click on the X axis, refer to Figure 5-27; the selected axis is highlighted in yellow indicating
that the X axis can now be specified as the axis of the circular pattern.

Choose the Apply button from the Axis selection box; the axis is specified.

10. By default, Evenly Spaced is displayed in the FDZ, Angle edit box. However, if this option

is not displayed in the FD2, Angle edit box, then enter 0 in it.

Figure 5-26 Faces of the revolved cut  Figure 5-27 Selecting the axis about which
Jeature selected to be patterned the circular pattern will be ereated

11. Enter 4 in the ¥D3, Copies (>0) edit box. Figure 5-28 shows the Details View window

12. Choose the Generate tool from the Features toolbar; the circular pattern

with all parameters that you have specified.

is generated by creating four more instances of the cut feature about the
X axis, refer to Figure 5-29.
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Pattern Fattarn?

Pattern Type Chrculdr. oo i o
Geometry FFaCes L
Aotis Sefecett :

{71 FD2, Angle Evenly Spaced

"] FO3, Copies (>0) |4

Figure 5-28 The Details View window Figure 5-29 Model after patterning the cut
displaying parameters for creating the circular Jeature
pattern

Creating Revolved Feature for the Rim
Next, you need to create rim around the spokes. The Revolve tool can be used to create
the rim. The sketch for the revolve feature will be created on the XY plane.

1. Select the XYPlane from the Tree QOutline and choose the New Sketch tool from
the Active Plane/Sketch toolbar; Sketch4 is added under the XYPlane node.

9. Select Sketch4 from the Tree Outline and invoke the Sketching mode. Next, orient the
view of the sketching plane parallel to the screen using the Look At tool.

8. Draw the sketch for the revolved feature using the dimensions given in Figure 5-30.
Note

You need to apply geometric constraints, such as horizontal, vertical, equal length, and so on
to fully define the sketch.

4. Choose the Modeling tab and change the view to Isometric.

5. Choose the Revolve tool from the Features toolbar; you are prompted to
select the axis for the revolve feature. Also, Revolve3 is added in the Tree
Qutline.

6. Click on the Geometry selection box in the Details View window to display the Apply
and Cancel buttons.

7. Asthere is only one sketch in the Graphics window, it is automatically highlighted for the
revolve operation. Choose the Apply button from the Geometry selection box to specify
the recenily created sketch as the sketch for the revolve feature.

8. Click on the Axis selection box and then select the X axis from the Graphics window; the
selected axis is highlighted in yellow color and the preview of the revolved feature is displayed.

9. Choose the Apply button from the Axis selection box.
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10. Make sure that the Add Material option is selected in the Operation drop-down list. Also,

make sure that the angle of revolution is specified as 360 degrees in the FD1 Angle, (>0)
edit box.

11. Choose the Generate tool from the Features toolbar; the revolved feature
is created by revolving the sketch about the X axis by 360 degrees, refer
to Figure 5-31.

M’”’"'UWMM ’ o
g
1839 b legm;&rﬁ’ Ty
Figure 5-30 Sketch for the revolved feature Figure 5-31 Model after creating the revolved
of the rim Jeature for the rim

Creating the Blend Feature

Now, to remove the sharp edges from the rim, you need to create the blend feature (fillet)
with radius of 10 mm, 5 mm, and 3 mrn at the vertical edges of the base feature.

1. Choose the Fixed Radius tool from the Blend drop-down in the Features

toolbar; you are prompted to select 3D edges, faces, or edit an existing
blend.

2. Press the CTRL key and select the two edges shown in Figure 5-32 for creating a blend of
radius 10 mm.

3. Choose the Apply button from the Details View window to accept the selection of edges
to be blended, .

4. Enter 10 in the FD1 Radius (>0) edit box to specify the radius of the blend feature.

5. Choose the Generate tool from the Features toolbar; the blend feature is
created.

6. Similarly, create two blend features of radius 5 mm and 3 mm respectively. Refer to
Figure 5-32 for the edges to be selected.

The final model of the Rim is shown in Figure 5-33.

7. Close the DesignModeler window; the Workbench window is displayed.
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Edgestobe
salected for
creating blend of
radius 14 mm

Edgesto be
selected for
creating blend
of radius 3 mm

Marked edge
and gimitar edge
SN the oppasile
face to be
selectad for
creating blend of
radius Smao

Figure 5-32 Edges to be selected for creating Figure 5-33 The final model of the rim
the blend feature
Saving the Project and Exiting ANSYS Workbench

After the DesignModeler window is closed, you need to save the project and exit ANSYS
Workbench.

1. Choose the Save button from the Standard toolbar; the project is saved with the name
c05 _ansWB_tut01.

2. Choose the Exit option from the File menu to exit the current ANSYS Workbench
session.

ik AR R R S, B

In this tutorial, you will create the model of the Basket Ball Hoop by using the Sweep tool.
You will also use the Extrude and Fillet tools to add required support to the hoop. Figure 5-34
shows the model of the hoop and Figure 5-35 shows the major dimensions for creating
the model. (Expected time: 40 min}

Figure 5-34 Model of the Basket Ball Hoop
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Figure 5-35 Major dimension of the hoop

The following steps are required to complete this tutorial:

Start ANSYS Workbench.

Add the Geometry component system to the Project Schematic window.
Draw the sketch.

Create the sweep feature.

Create the clamp feature as the second feature.

Create the blend feature.

Save the project and exit the ANSYS Workbench session.

gy ™Mo oD TR

Starting ANSYS Workbench and Adding the Geometry Component

System
To start the tutorial, you first need to start ANSYS Workbench and then add a component
system to the project.

1. Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the Start menu; the
Workbench window is displayed.

Next, you need to add the Geometry component system to the Project Schematic
window.

2. Double-click on the Geometry option displayed under the Component Systems toolbox in
the Toolbox window; the Geometry component system is added to the Project Schematic
window.

3. Once the system is added to the Project Schematic window, its name gets highlighted at
the bottom of the component system in blue. If it is not highlighted, double-click on the

default name and rename it to Basket Bail Hoop.

4. Choose the Save button from the Standard toolbar; the Save As dialog box is displayed.
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Browse to the location CAANSYS WBIc06 and then create a folder with the name Tut02.

6. Browse to the Tut02 folder and then save the project with the name c06_ansWB_tut02.

Drawing the Sketch

After adding the component system and saving the project, you need to create the profile
of the circular feature of the Hoop in DesignModeler.

Double-click on the Geometry cell in the Basket Ball Hoop component system; the
DesignModeler window along with the ANSYS Workbench dialog box is invoked.

Select the Millimeter radio button and then choose the OX button from the ANSYS
Workbench dialog box to accept millimeter as the unit of length. ‘

Next, you need to create the sketch for the sweep feature. To do so, first you need to
specify the plane on which you want to create the sketch. Select the XYPlane from the

Tree Outline; the XY plane becomes the active plane. Now, you can create sketch on this
plane.

Choose the Sketching tab displayed at the bottom of the Tree Outline; the Sketching
mode is invoked.

Choose the Look At tool from the Select toolbar to orient the plane normal to L
screen.

Invoke the Circle tool from the Praw toolbox; the cursor is changed to Draw cursor.
Move the cursor close to X axis; the symbol of Coincident Constraint (C) is displayed.

Move the cursor toward your left to some distance and click while the symboll of.(]oinciden‘t
Constraint is still displayed; the center of the circle is specified, as shown in Figure 5-36.

Next, move the circle away from the center point of the circle and click again to specify
the radius and then create the circle, as shown in Figure 5-37.

- -

Figure 5-36 Specifying the center for the Figure 5-37 Creating the civcular
circular profile profile
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10. Expand the Dimensions toolbox to display the tools available in it.

11

12.

3.

14

16.

17.

18

19.

20.

21

Choose the General 100l and then place
the dimension of the circular profile, as |
shown in Figure 5-38.

In the Details View window, click on the e
DI edit box and change the dimension |
of the circular profile to 30,

Invoke the Horizontal too! from the
Dimensions toolbox; you are prompted
to specify the start point or edge for
placing the horizontal dimension.

Figure 5-38 Placing the dimension

Select the center point of the circular profile; you are prompted to select the second point
or edge for horizontal dimensioning.

- Next, click on the Y axis to specify the horizontal dimension and then place the dimension

anywhere on the screen, refer to Figure 5-38,

In the H2 edit box in the Details View window, specify 225 as the distance between the
origin and the center of the circular profile.

Choose the Zoom to Fit button in the Graphics toolbar to fit the complete sketch
in the Graphics window. —_—

Next, click on the Modeling tab at the bottom of the Sketching Toolboxes window to
switch to the Modeling mode.

Change the view to Isometric by using the ISO tool.
Next, right-click on the ZXPlane in the Tree Outline; a shortcut menu is displayed.

Choose Insert Sketch Instance from the shortcut menu, refer to Figure 5-39; Sketch? is
added under the ZXPlane node.

[ I83] A: Basket Bali Hoop
g_]",;;}“ KYPlane
b, (8 SicabchZ

Figure 5-39 Choosing the Insert Sketch Instance option from the shorteut menu
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22.

23.

24,

25,

26.

27.

28.

29,

30.

Choose the Sketching tab displayed under the Sketching Toolboxes window to switch to
the Sketching mode.

Choose the Look At tool to orient the sketching plane normal to the viewing (a
direction.

Choose the Circle tool from the Draw toolbox and create a circle with origin as the center
of the circle, as shown in Figure 5-40.

Figure 5-40 Circle created on the ZX plane

Choose the General tool from the Dimensions toolbox. &P General
Next, generate and place the diametric dimension of the circle in the Graphics screen.

Enter 450 as the diameter of the circle in the D1 edit box in the Details View window:
the size of the circle changes.

Choose the Zoom to Fit tool in the Graphics toolbar to fit the compiete sketch in
the Graphics window. T

Choose the Modeling tab at the bottom of the Sketching Toolboxes window to switch to
the Modeling mode.

Change the view 1o Isometric by using the 18O tool.

Creating the Sweep Feature

After the sketch of the profile and the path are drawn, it is now required to sweep the
profile along the path.

Choose the Sweep tool available in the Features toolbar; Sweepl is attached to the Tree
Outline with a yellow thunderbolt symbol attached, indicating that immediate action needs
to be taken to create the sweep feature.

In the Details View window, click on the Profile selection box; the Apply and Cancel
button are displayed.
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3. Click on Sketchl under the XYPlane node in the Tree Outline; the sketch of the Circular
profile is selected in the Graphics window. Next, choose the Apply button displayed in
the Profile selection box; Sketch1 is displayed in the Profile selection box.

4. Next, click on the Path selection box in the
Details View window; the Apply and
Cancel buttons are displayed.

5. Select Sketch? under the ZXplane node
in the Tree Outline and then choose the
Apply button in the Path selection box.

After the profile and the path are
specified for the sweep feature, you now
need to generate the sweep feature.

[y 1000 20,50 (eh
p—’

6. Choose the Generate tool from the R—rT i
Features toolbar; the sweep feature is . .
created, as shown in Figure 5-41. Figure 5-41 The sweep feature

Creating the Second Feature
Next, you need to create the second feature of the model, which is the clamp.

1. Choose the New Plane tool available in the Active Plane/Sketch toolbar; Plane4
gets attached to the Tree Outline. Also, the corresponding options are displayed
in the Details View window.

e

2. Inthe Type drop-down list of the Details View window, select the From Plane option.

3. Next, click on the Base Plane selection box in the Details View window; the Apply and
Cancel buttons are displayed.

4. Select YZPlane in the Tree Outline and then choose the Apply button in the Base Plane
selection box to specify YZ plane as the base plane.

5. Inthe Transform 1 drop-down list, choose the Offset Z option; the FD1, Valuel edit box
is displayed.

6. Enter 250 in this edit box to specify the offset distance of the new plane from the default
YZ plane.

7. Choose the Generate tool to create the new plane.

8. Switch to the Sketching mode by choosing the Sketching tab at the bottom of the Tree
Outline.
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9. Choose the Lock At tool to orient the new plane normal to the viewing direction, 09
refer to Figure 5-42.

Note '
When you choose the Look At tool, the orientation of the plane may be different from the one

shown in Figure 5-42. You can use the options available in the Graphics toolbar to erient the
plane normal to the Graphics window with the Y axis upward.

10. Choose the Rectangle tool from the Draw toolbox; the cursor changes to 1] Rectangle
the Draw cursor. : L

11. Draw a rectangle such that the horizontal axis lies in the middle, as shown in Figure 5-43.

Figure 5-42 The new plane oriented normal to Figure 5-43 The rectangular sketch

the viewing direction

12. Invoke the General tool from the Dimensions toolbox and place the horizontal and
vertical dimensions for the rectangle, refer to Figure 5-44.

13. In the Details View window, click on the H1 edit box and enter 25 as the width of the
rectangle.

14. Similarly, click on the V2 edit box and then enter 100 as the length of the rectangte.
15. Invoke the Symmetry tool from the Constraints toolbox; you are prompted to select a
line to specify as the axis of symmetry.

16. Select the vertical axis to specify the axis of symmetry, as shown in lFigure 5-4.14; you are
prompted to select the first point or 2D edge to apply the Symmetric constraint.

17. Select the left vertical line of the rectangle as the first edge to apply Symmetric constraint;
you are prompted to select the second point or 2D edge to apply Symmetric constraint.

18. Select the right vertical line as the second edge; the sketch is adjusted symmetrically about
the vertical axis, as shown in Figure 5-45.
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Figure 5-44 Selecting the axis of symmetry  Figure 5-45 The seich afler the vertical lines are
' made symmetric

Now, you need to apply symmetric constraint between the top horizontal line and the
bottom horizontal line of the rectangle. -

19. Choose the Symmetry tool from the Constraints toolbox; you are prompted to select the
axis of symmetry.

20. Click on the horizontal axis, as shown in Figure 5-46, as the axis of symmetry; you are
prompted to select a point or a 2D edge to apply Symmetric constraint.

21. Select the top horizontal line of the rectangle as the first line to apply symmetry; you are
prompted to select the second point or 2D edge to apply Symmetric constraint.

22. Select the bottom horizontal line of the rectangle as the second line; the horizontal lines of the
rectangular sketch are now symmetrical about the horizontal axis, as shown in Figure 5-47.

After the dimensional and symmetric constraints are applied to the sketch, the rectangular
sketch becomes fully constrained, refer to Figure 5-47.

Figure 5-46 Sele.c.tz'ng the horizontal axis
for applying Symmetric constraint

Figure 5-47 The sketch after the horizontal
lines are made symmetric

23. Next, choose the ISO tool from the Graphics toolbar; the view is changed to m{ion
Isometric.
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24.

25

26,

27.

28.

29.

30.

31

32,

338.

Choose the Extrude tool from the Features toolbar; Extrudel 1_'15 attached [ Extrude
to Tree Outline. Also, the options in the Details View window are

changed.

In the Details View window, select the Geometry selection box to display the Apply and
Cancel buttons, if they are not already displayed.

.S.élec.t Sketch3, available under the Plane4 node in the Tree Outline, and then click on
the Apply button in the Geometry selection box in the Details View window; the preview
of extrusion is displayed in the Graphies window.

Select the Add Material option from the Operation drop-down list if it is not already
selected, as shown in Figure 5-48,

Next, from the Direction drop-down list, select the Both-Asymmetric option, as shown
in Figure 5-49; the Extent Type2 drop-down list and the FD4, Depth 2 (>0) edit box are
added to the Details View window.

In the Extent Type2 drop-down list, select the Fixed option, if it is not already selected.

In the FDI1, Depth (>0) edit box, enter 21 and then press ENTER; the changes will be
displayed in the preview of the extruded feature.

In the FD4, Depth 2 (>0) edit box, enter 36, if it is not already specified, and then press
ENTER,

Choose the Generate tool from the Features toolbar; the extruded feature is
created,

Bretails of Extrudel 3 Details of Extrudel

m oo

Extrude Extrudel . Extrude Extrudel

Geameatry Sketchd - Geametry Sketchd.
e 70 Add Material v Operation Add Materiai
2 Direction Vector Neone (Normai): -

Directi

e Cl Materialg e Al S
fitedion Imprint Fages Pl ] Bath - Asymme,,, v i
fxtent Type slice Material Extent Type go\:n:ai 4 g
i everse i
11701, Depth (-0) |Add Frozen LIFOL, Depth 0O |gomr - Symmetric
As Thin/Surfaca? Mo Extant Typf_g______ = ,-

Merge Topoiogy? | Yes
El| Geometry Selection: 1
Sketch [Sketeha . .

Figure 5-48 Selecting the Add Material
option from the Operation drop-down list

I FD4, Oepth 2 (~01 {30 mm
As Thin/Surface? Mo
Marge Topology? ey

Figure 5-49 Selecting the Both-Assymetric
option from the Direction drop-down list

Click on the New Plane tool available in the Active Plane/Sketch toolbar; Planeb
is attached to the Tree Outline, Also, the options in the Details View window are
modified.
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34.

35.

36.

37.

38.

39,

40.

41.

42.

In the Details View window, select the From Face option from the Type drop-down list:
the Base Face selection box is displayed.

Click on the Base Face selection box; the Apply and Cancel buttons are displayed. Also,
you are prompted to select the base face required for the plane creation.

Choose the Face tool from the Select toolbar. @

Select the top face of the first extruded feature,
as shown in Figure 5-50. Next, click on the
Apply button available in the Base Face
selection box in the Details View window.

Choose the Generate tool from the Features
toolbar; the extruded feature is generated.

After creating the new plane on the required
face, you are required to create the sketch for

the second extruded feature. Figure 5-50 Selecting the top face of the first

] extruded feature
Choose the Look At tool to orient the new ided f

plane normal to the viewing direction.
Note that Plane5 is the current plane and you need to create a sketch on this plane.

Choose the New Sketch tool from the Active Plane/Sketch toolbar; a new sketch
with the name Sketchs is added under the Planes node.

Note

In your case, a different name may be displayed under the Planes node in the Tree Outline. To
edit this name, specify a new name in the Sketch edit box in the Details View window. Note
that this window will be displayed when the shetch is selected from the Tree Outline.

Next, click on the Sketching tab to switch to the Sketching mode.

Create a sketch for the second extruded feature by using the Polyline tool, as shown in
Figure 5-31.

Figure 5-51 Partial view of the model with the newly created sketch on Plane5
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43. Next, click on the Extrude tool from the Features toolbar; Extrude? is
attached to the Tree Outline, Also, the Details View window is displayed

with various options.

44, Click on the ISO tool available in the Graphics toolbar; the view is changed to isometric.

45. Next, click on the Geometry selection box in the Details View window; the Apply and
Cancel buttons are displayed.

46. Expand the Planeb node in the Tree Outline and then select Sketchb in it

47, Click on the Apply button in the Geometry selection box to specify Sketch5 as the sketch
to be extruded. .

48. Select the Both - Asymmetric option from the Direction drop-down list, as shown in
Figure 5-52; the Extent Type 2 drop-down list along with the FD4, Depth 2 (>0) edit box
is added to the Details View window.

49. Click on the FD1, Depth (>0) edit box and enter 50 as the distance for extrusion.

50. In the Extent Type 2 drop-down list, select the To Surface option, as shown in Figure 5-55;
the Target Face 2 selection box is displayed under the Extent Type 2 drop-down list and
is highlighted in yellow.

Operat;:;n Add Material e
Direction Vector | None {Normal) s
Gl Normal e [1FDL, Depth (>0} |30 mm
Extent Type gg;?rid ERnmie o Fived )
[1FDL, Depth (>0} Both - [ End, ‘Depthéggg] Fixed
As Thin/Surface? e R ] - - Through All
Wierae Tapoloar? 3 - As Thin/Surface? Ta Hexdt
£1| Geometry Setection: 1 Merge Topology? ~ iToFaces |
Sketch [Sketens w.; & Geometry Selection: ll‘ &SR w |
Figure 5-52 Selecting the Both-Asymmetric Figure 5-53 Selecting the To Surface option
option from the Direction drop-down list [from the Extent Type 2 drop-down list

51. Click on the Target Face 2 selection box; the Apply and Cancel buttons are displayed in
it. Also, you are prompted to select the surface to extrude the sketch to.

52. Next, select the bottom face of the first extruded feature, as shown in Figure 5-54.
53. Next, click on the Apply button displayed in the Target Face 2 selection box in the Details

View window; Selected is displayed in the Target Face 2 selection box indicating that
selected face is specified as the extent of extrusion in that direction.
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54. After all the parameters are specified, choose the Generate tool; the
extruded feature is generated, as shown in Figure 5-55.

Figure 5-54 Selecting the bottom face of the Figure 5-55 Model with the extruded feature
furst extruded feature

Creating the Blend Feature :
After the second feature is created, you need to remove the sharp edges.

1. Choose the Fixed Radius tcol from the Blend drop-down in the Features €. Fixed Radius
toolbar; FBlendl is attached to the Tree Outline. Also, the options in the
Details View window are changed.

2. Choose Wireframe from the View menu in the Menu bar; the view is changed to Wireframe
and only the second feature is visible.

3. Select the Geometry selection box; the Apply and Cancel buttons are displayed in it.

4. Next, select the edges to apply blend, refer to Figure 5-56. Use the CTRL key to select
both the edges at the same time.

5. Choose Apply to specify the selected edges for blending; 2 Edges is displayed in the
Geometry selection box,

6. In the FD1, Radius (>9) edit box, enter 15 to specify the radius of the blend and then
press ENTER.

7. Choose Shaded Exterior and Edges from the View menu to change the view from
Wireframe to Shaded.

8. Choose the Generate tool; the blend feature is created, as shown in
Figure 5-57.

9. Close the DesignModeler window.
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First edge
\—Second acge
Figure 5-56 Selecting the edges to apply Figure 5-57 Model with the blend Jeature
blend

Saving the Project and Exiting ANSYS Workbench . .
After the blend feature is created, you need to save the project and exit ANSYS

Workbench.

1. Choose the Save button from the Standard toolbar; project is saved with the name
05 _ansWB_tut02.

9. Choose the Exit option from the File menu to exit the current ANSYS Workbench session.

.In this tutorial, you will create the model of a Helical Gear, as shown in Figure 5-58. For
dimensions of the model, refer to Figure 5-59. You will use the Revolve and Loft tools for creatmg
this model. (Expected time: 45 min)

The following steps are required to complete this tutorial:

Start ANSYS Workbench. .

Add the Geometry component system to the Project Schematic window.
Draw the sketch. :

Create the revolved feature.

Create the extruded feature.

Create the sketches for the loft feature,

Create the loft feature.

Save the project.

Treg Th o O oW

Starting ANSYS Workbench and Adding the Geometry Component

System
Before you create the model, you first need to start ANSYS Workbench and then add 2
component system to the project.

1. Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the Start menu; the
Workbench window is displayed.
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The plane for drawing the
second section i5 ot an

Lot with 3 gketohes offset of 45 units from the first

size 100%, 75%, 50% skatch. Plane for the thicd

with rolotion ongle of sketeh fs ot ¢n offset of

15 between each skeich 93 units from the first sketeh
Figure 5-58 Model for Tutorial 3 Figure 5-59 Dimensions for the model

2. Double-click on the Geometry component system displayed under the Component Systems

toolbox in the Toolbox window; the Geometry component system is added to the Project
Schematic window.

3. Once the project is added to the Project Schematic window, its name gets highlighted at
the bottom of the component system in blue. If it is not already highlighted, double-click
on the default name and rename it to Lofted Feature,

Now, you need to save the project.

4. Choose the Save button from the Standard toolbar; the Save As dialog box is
displayed.

5. Browse to C:IANSYS_WBI05 folder

6. Create another subfolder with the name Tut03 under the £05 foider and then choose the
Open button from the Save As dialog box.

7. Enter ¢c05_ansWB_tut03 in the File name edit box and choose the Save button from the
Save As dialog box; the project is saved.

Drawing the Sketch

You now need to start the DesignModeler window and then create the sketch for the
revolve feature.

L. Double-click on the Geometry cell in the Lofted Feature component system; the
DesignModeler window along with the ANSYS Workbench dialog box is invoked.

2. Select the Millimeter radio button and then choose the QK button from the ANSYS

Workbench dialog box to accept millimeter as the unit of length.
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3. Select the XYPlane from the Tree Outline; the XY plane becomes the active plane. Now,
you need to create the sketch for the base feature.

4. Choose the Sketching tab displayed at the bottom of the Tree Outline to switch to the
Sketching mode; the Sketching Toolboxes window is displayed.

5. Choose the Look At tool to orient the plane normal to the viewing direction. 15

6. Use the Polyline and Arc tools from the Draw toolbox to draw the sketch for the revolved
feature, as shown in Figure 5-60,

7. Apply required constraints and dimensions to the sketch to make it fully constrained. For
dimensions, refer to Figure 5-59,

| T —
A —

Figure 5-60 Sketch for the revolved feature

Creating the Revolved Feature

1. Choose the Revolve tool available in the Features toolbar; Revolvel is
added to the Tree Outline. Also, the respective options in the Details View
window are displayed.

@ Revolve

By default, the Geometry selection box displays the Apply and Cancel buttons.

2. Click on the Apply button to confirm the sketch as the geometry for the revolved feature.
Figure 5-81 shows the geometry and the axis to be selected for the revolve operation.

3. Next, click on the Axis selection box; the Apply and Cancel buttons are displayed.

4. Next, click on the X axis; the preview of the revolved feature is displayed in the Graphics
window, as shown in Figure 5-62.

3
B
Gaomstry ‘)\ T

Figure 5-61 The geometry and the axis to Figure 5-62 Preview of the revolved feature
be selected
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5. Choose the Generate ool in the Features toolbar; the revolved feature is
created, as shown in Figure 5-63.

Creating the Extrude Feature

1. After creating the revolve feature, you need to create the extrude feature, refer
to Figure 5-58. To do so, choose the Faces tool in the Select toolbar and then click @
on the flat face of the revolve feature, as shown in Figure 5-64.

2. Choose the New Plane tool available in the Active Plane/Sketch toolbar; Plane4 is added
to the Tree Outline.

3. Choose the Generate button in the Features toolbar; the new plane is

generate, Also, the new plane is displayed on the selected face in the
Graphices window.

4. Choose the Look At tool in the Graphics toolbar; the plane is oriented normal to the
screen.

Figure 5-63 Revolved feature created Figure 5-64 Selecting the flat face of the revolved
Jeature

5. Draw a sketch for the extruded feature on the new plane, as shown in Figure 5-65.

6. Apply the required constraints and dimensions to the sketch, as shown in Figure 5-66.

Figure 5-65 The sketch draum on the new Figure 5-66 Skeich of the extruded
plane feature along with the dimensions
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After the sketch is drawn, it is now important to create a pattern around the circular face.
To do so, use the Replicate tool.

7. Choose the Replicate tool available in the Modify toolbox of the Sketching Toolboxes
window; the r and f edit boxes are displayed next to the Replicate tool. Also, you are
prompted to select the edges to replicate.

8. Enter 30 in the r edit box and 1 in the £ edit box.

Note
The r edit box in the Replicate tool is used to rotate the object about certain angle, whereas the

f edit box is used to scale the selected object by o certain fraction.

9. Next, select the sketch drawn for the extruded feature, as shown in Figure 5-67.

10. Right-click in the Graphics window to display a shortcut menu. Next, choose the End /
Use Plane Origin as Handle option from the shortcut menu.

11. Orient the view of the plane normal to the screen. Next, right-click and choose Rotate by
r Degrees option from the shortcut menu displayed.

12. Right-click again and choose Paste at Plane Origin to create an instance of the pattern,
as shown in Figure 5-68.

Figure 5-67 The sketch selected for creating Figure 5-68 Creating instance of the
a pattern around the circular edge shetch

13. Similarly, create 10 more instances of the sketch, as shown in Figure 5-68.

14. Next, choose the Extrude tool from the Features toolbar; Extrudel is added to the Tree
Outline. Also, the preview of extrusion is displayed on the model.

15. Change the view to [sometric.

16. Select the Reversed option from the Direction drop-down list in the Details View window,
as shown in Figure 5-70.
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17. In the Extent Type drop-down list, select the To Faces option, as shown in Figure 5-71;

you are prompted to select the face for extent. Also, the Target Faces selection box is
displayed in yellow in the Details View window.

{74 Detaiis of Bxirudel

Extruda Extrudel
Geometry Sketeh?
Operation Add Material
Direction Vector Mone (Mormal)
e Mormal »

Extent Type
[} FDHL, Drepth (=0}

Nermal
LAl

- Both - Symmets
As Thin/Surface? Both - Asymmetric

Figwfe 5-69 Fatiern created using the Figure 5-70 Selecting the Reversed option
Replicate tool from the Direction drop-down list

18. Rotat(f: the moglel to the position, as shown in Figure 5-72. Next, click on the Target Faces
selection box in the Details View window; the Apply and Cancel buttons are displayed
in it.

19. Next, select the face shown in Figure 5-72,

Geometry Sketeht [
Operation Add Material o
Direction Vector | None [Normaly -+ "
Direction Raversed

TR To Fages M
Target Fages Fixed

s ThinySurtaces (1o oudn Al

Nerge Tapolegy? B
Al Geometry Sefectio
| [Sketen |Sketond i

T L T R T

Figure 5-71 Selecting the To Faces option from Figure 5-72  Selecting the face as the
the Extent Type drop-down list extent

20. Next, choose the Apply button in the Target Faces selection box; the selected face turns
cyan. Also, the value corresponding to the selection box is changed to 1.

21. Choose the Generate tool from the Features toolbar; the extrude feature is created, as
shown in Figure 5-75.
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Creating the Sections for the Loft Feature

10.

il

After the extrude feature is created, it is now required to create the three sections for the
loft feature, refer to Figure 5-72,

Select the front face of the model and then choose the New Plane tool in the
Active Plane / Sketch toolbar; Planeb is added to the Tree Qutline. e

Choose the Generate tool in the Features toolbar; the new plane is created
and displayed on the selected face, as shown in Figure 5-74,

Choose the Look At tool in the Graphics toolbar to orient the model normal to the viewing
direction, refer to Figure 5-74.

Switch to the Sketching mode.

Choose the Circle tool from the Draw toolbox. (= Checle

Figure 5-73 Extruded feature created Figure 5-74 Model afier being oriented

Draw a circle with the origin of the new plane as the center. Change the diameter of the
circle to 100.

Create a line at an offset from the horizontal axis, as shown in Figure 5-75. For dimensions,
refer to Figure 5-75.

Choose the Are by 3-Points tool from the Draw toolbox and then draw an arc, as shown
in Figure 5-76. For dimensions and placement of the are, refer to Figure 5-59.

Apply dimensions and constraints to the arc created, refer to Figure 5-76.

Click on the Modify toolbox in the Sketching Toolboxes window to display the tools in
it.

Invoke the Replicate tool from the Modify toolbox and then select the arc, as shown in
Figure 5-77.
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12,

15.

14.

16.

17.

18.

19,

Figure 5-75 A line created at an offset Figure 5-76 The arc created

Right-click in the Graphics window to display the shortcut menu and then choose End /
Use Plane Origin as Handle from the menu displayed.

Right-click in the Graphics window again and choose the Flip Horizontal option from
the shortcut menu displayed.

Right-click and then choose Paste at Plane Origin to create a mirror of the entity across
the Y axis, refer to Figure 5-78.

- Right-click again and then choose End from the shortcut menu displayed to end the

operation.

Figure 5-77 The selected arc Figure 5-78 The complete sketch

Invoke the Replicate tool again and then select the two arcs and the line created at an
offset, refer to Figure 5-79,

Enter 60 in the r edit box corresponding to the Replicate tool.

Right-click in the Graphics window and then choose End / Use Plane Origin as Handle
from the shortcut menu displayed.

Right-click and then choose Rotate by r Degrees option from the shortcut menu
displayed.
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90. Right-click again and then choose the Paste at Plane Origin option from the shorwcut
menu displayed; one instance of the sketch is created at an angle of 60 degrees.

21. Similarly, create other instances by using the Steps 15 through 17. The instances of the
sketch created are shown in Figure 5-80.

Entities to be selected

Figure 5-80 Instances of the sketch after being

Figure 5-79 Selecting entities of the sketch
replicated

22. After all the instances are created, you need to trim the unwanted entities by using the Trim
tool, The sketch after the unwanted entities are removed will appear as shown in Figure 5-81.

p
f 1

/{EWW

R

- ~
T

h i

N

p—

Figure 5-81 Shetch after trimming unwanted entities

25, Switch to the Modeling mode and then choose the New Plane tool from the Active ?iane
/ Sketch toolbar; Planeé is attached to the Tree Outline. Also options related to this tool
are displayed in the Details View window.

94. In the Transforml drop-down list, select the Offset Z option; the FD1, Valuel edit box
is activated.

25. Enter 45 in the ¥D1, Valuel edit box.
26. Next, choose the Generate tool; the plane is created.

27. Expand the Planeb node in the Tree Qutline and then select Sketch3; Sketch3 becomes
the active sketch.

:
E
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28. Invoke the Sketching mode by choosing the Sketching tab.

29. Select the Box Select option from the Select Mode drop-down list in the [% Bo Seieit
Graphics toolbar. &
30. Select the sketch on plane 5; the sketch turns yellow.

31. Next, expand the Modify toolbox in the Sketching Toolboxes window; the tools in this
toolbox are displayed.

32. Choose the Copy tool; you are prompted to select the entities to copy. Next, right-click
in the Graphics window; a shortcut menu is displayed.

33. Choose the Use Plane Origin as Paste Handle option from the shortcut menu displayed;
the center of the sketch gets selected as the reference point for the copy object.

34. Choose the Modeling tab displayed at the bottom of the Sketching Toolboxes window;
the Modeling mode is activated.

35. Select Planeb in the Tree Outline; Planet becomes the active plane.

36. Invoke the Sketching mode by choosing the Sketching tab from the bottom of the Tree
Outline.

37. Expand the Modify toolbox; the tools in it are displayed.

38. Choose the Paste tool available in the Modify toolbox; the r and fedit boxes are displayed
next to the Paste tool. Also, you are prompted to paste the sketch copied from Plane5 on
the Graphics window.

39. Enter 15 in the r edit box and 0.75 in the f edit box.

40. Right-click in the Graphics window to display a shortcut menu. Now, choose Rotate by r
Degrees from the shortcut menu.

41. Right-click again and then choose Scale by factor f from the shortcut menu.

On choosing the Rotate by r Degrees option from the shortcut menu, the sketch rotates by
an angle specified in the r edit box. Similarly, the Scale by factor f option scales the object
by a factor specified in the f edit box.

42. After the copied sketch is rotated and scaled, paste it on the origin. To do se, right-click
in the Graphics window and then choose Paste at Plane Origin from the shortcut menu
displayed; the modified sketch section is pasted on Plane6, as shown in Figure 5-82.

Note that the new sketch is rotated and scaled as it is pasted on the origin of the new
plane.
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43. Create another plane at an offset of 99 from the XY plane.

Figure 5-82 Sketch copied on Plane6

44 Next, copy the sketch from Plane6 and then rotate and scale it by following the procedure
described in steps 34 through 40. Figure 5-83 shows the copied sketch which has been
rotated about 15 degrees, and scaled to a fraction of 0.5.

Figure 5-83 Three sections created for the loft
Jeature

Note '
The view of the model has been adjusted for a better visibility of the sections.

Creating the Loft Feature
After creating the three sketches, you are required to create the loft feature 1o complete
the model.

1. Choose the Skin/Loft tool in the Features toolbar; Skinl with a yellow
thunderbolt symbol is added to the Tree Outline. Also, the corresponding
options of the Skin/Loft tool are displayed in the Details View window.

& Skin/Loft

2. The Select All Profiles option is selected by default in the Profile Selection Method
drop-down list in the Details View window. Select the Select Individual Profile option
from this list, as shown in Figure 5-84; Profiles is attached below the Details of Skini
node in the Details View window.
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Figure 5-84 Selecting the Select Individual
Profile option from the drop-down list®

3. Click on the Profile 1 selection box, highlighted in yellow; the Apply and Cancel buttons
are displayed in it.

4. Inthe Tree Outline, expand the Planeb node and then select Sketch3 under the XYPlane
node. '

5. Next, choose the Apply button displayed in the Profile 1 selection box under the Profiles
node in the Details View window.

6. Click on the Profile 2 selection box available below the Profile 1 selection box; the Apply
and Cancel buttons are displayed.

7. Next, in the Tree Qutline, expand the Planeb node and then select Sketch4 displayed
under this node.,

8. Choose the Apply button in the Profile 2 selection box to select this sketch as the second
section for the loft feature.

9. Right-click on the Profile 2 selection box and then choose the Add Profile option from
the shortcut menu displayed; the Profile 3 selection box is added under the Profiles node
in the Details View window.

10. Click on the Profile 3 selection box; the Apply and Cancel buttons are displayed.

11. In the Tree Qutline, expand the Plane7 node and then select Sketch5 from it.

12. Choose the Apply button from the Profile 3 selection box to specify the sketch for the loft

feature; a guide line connecting the vertices of the sketches is displayed in the Graphics
window.

Note
| After the selection of profiles is completed, ANSYS generates a guide line automatically. If the
generated guide line (path} is not the one that is required, you can change it manually.

A guide line is the curve that connects corresponding vertices of the sections being used for the
Skin/Loft operation. As soon as the selection of profiles for feature creation is done, a guide
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line is displayed in the model. It is very easy to create a guide line in a simple loft feature.
However, it is quite challenging to create a guide line in a twisted loft, where it passes through
various points in the profiles under consideration. In case, the default path viewed in ANSYS
is not the required one and you need to change it, you can do so by using the Fix Guide Line
option from the shortcut menu, which is displayed on right-clicking in the Graphics window,
as shown in Figure 5-85. Figure 5-86 shows three profiles {sections) selected for creating a
loft feature. The corresponding vertices through which the guide line passes is shown in
Figure 5-86. In this figure, three rectangles are used to create a loft feature. Figure 5-87 shows
the corresponding loft created using the guide line. :

3z, Contirue Sketch $Etaction -
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i Select Al

=} Generate

Figure 5-85 Choosing the Fix Guide
Line option from the shortcut menu

Figure 5-86 Guide line for a lofi feature Figure 5-87 Loft feature created using the
guide line

You can also modify a guide line. To do so, you need to change the vertices that define it. To
do so, right-click after you specify the sketches for the loft feature in the Details View window;
a shorteut menu will be displayed. Choose the Fix Guide Line option from it; you will be
prompted to select a line or a vertex to change the loft path.

Based on the requirement, you may need to select lines, points, edges, and so on to define
the required guide line. To select points on the profiles, right-click again in the Graphics
window to display a shortcut menu and then choose Selection Filter > Point. Next, you will
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select a particular vertex or point through which the guide line would pass. In this way you
can alter the path of the loft feature, By comparing Figures 5-86 and 5-88, you can observe
that guide line has been modified using the Fix Guide Line option. The corresponding loft
feature created after the guide line is modified is shown in Figure 5-89.

Figure 5-89 Loft feature created using the
modified guide line

Figure 5-88 Modified guide line

MNote

As in this case the guide line generated does not connect to the corresponding points of different
profiles, you need to modify the path of the guide line by reallocating the points using the Fix
Guide Line option. Figure 5-90 shows the sketched created for the loft feature with various
points annotated.

Figure 5-90 Sketch created for the loft feature with various poinis annotated

13. Right-click in the Graphics window to alter the guide line; a shortcut menu is displayed.
Choose the Fix Guide Line option from the shortcut menu displayed; you are prompted
to select lines, edges, or vertices to alter the guide line,

14. Since the guide line passes through points in different profiles, you need to select points to
alter the guide fine. To do so, right-click again in the Graphics window; a shortcut menu
is displayed. Next, choose Selection Filter > Point from the shortcut menu displayed.
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15. Select point 1 in the first profile.

16. Similarly, select point 1 of the second and third profiles; the path of the guide line changes,
as shown in Figure 5-91.

17. Next, choose the Generate tool in the Features toolbar; the changes are applied and the
loft feature created, as shown in Figure 5-92.

Figure 5-92 Loft feature created using
the modified guide line

Figure 5-91 Modified guide line

18. Exit the DesignModeler window; the Workbench window is displayed.

Saving the Project and Exiting ANSYS Workbench
[. Inthe Workbench window, choose the Save button from the Standard toolbar; the project
is saved with the name ¢05_ansWB_tui03.

2. Next, choose the Exit option from the File menu to exit the current ANSYS Workbench
session.

Answer the following questions and then compare them to those given at the end of this
chapter:

1. You cannot create circular pattern of features by using the Pattern tool. (T/F)

2. To create a revolved feature, choose the Revolve tool from the Create menu of the Menu
bar. (T/F)

3. The Revolve tool is used to revolve a sketch only around the horizontal axis. (T/F)

4. While creating a sweep feature, you cannot confirm the selection of the profile in the
Details of “Sweep” window. (1T/F)

5. By using the Revolve tool, you can add as well as cut material from a feature. (T/F)
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6. You cannot create a loft feature between sketches in two different plane. (I/F)

7. To cut material from a model, you need to choose the tool from the Peatures
toolbar.

8. Which of the following tools is used to create a pattern of a sketch?

.(a) Replicate (b) Generate
(c) Body Operation {d) New Plane

9. Which of the following tools is used to view the sketching plane at a right angle?

(a) New Plane {b} Look At
(¢} Imprint (d) Display Plane

10. Which of the following tools is invoked to perform a mirror operation?

{a) Imprint (b) Boolean
{c} Body Operation (d) Freeze

Answer the following questions:

1. You can use the tools available in the Modify toolbox of the Sketch tab to modify sketches.
(1/F)

2. You can turn on the display of sketching planes by using the Display Plane tool. (1/F)

3. You can turn off the display of the model in the Graphics window by choosing the Display
Model tool. (T/F)

4. To delete an unwanted face, you need to choose the Face Delete tool. (T/F)
5. The Generate tool is used after most of the operations are performed. (T/F)
6. To create a new sketch, you first need to specify the sketching plane. (T/F)

7. You can use the middle mouse button to rotate the model freely in the Graphics window.
(1/F}

8. To create the projection of a sketch on a model, you need to use the
tool.

9. You can share a geometry of the Geometry component system with the
cell of any other component or analysis system.
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10. Which of the following options is chosen by default in the Operation drop-down list in
the Details View window.

(a) Add Material (b} Cut Material
(¢} Add Frozen (d) Imprint Faces

EXERCISE

Create the model shown in Figure 5-93. The dimensions of the model are shown in
Figures 5-94 through 5-97. {Expected time: 45 min)

Figure 5-94 Top view of the model with the
hidden lines suppressed for elarity

220

P65

B86 ¥22
B225 -~ Section A-A
Figure 5-95 Left side view of the model with Figure 5-96 Sectioned view of the model

the hidden lines suppressed for clarity

Answers to Self-Evaluation Test
1.7.2. T 8. T, 4.F 5. T, 6. F, 7. Extrude, 8. Replicate, 9. Look At, 10. (¢)

Chapter

Defining Material
Properties

After: compietmg this chapter, you will be able to:
s Understand the Engineering Data workspace

* Assign different materials to geomemes E

* Work with ANSYS libraries.

¢ Create and add new materials in the ANSYS hbmmes

* Add new materials to the Engineering Data_ workspace.
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INTRODUCTION TO ENGINEERING DATA WORKSPACE

For performing an analysis, you need to define
the material properties of a model. You can do so
by using the Engineering Data workspace of
ANSYS Workbench. The Engineering Data
workspace can be invoked by using the Engineering
Data cell of an analysis system. The Engineering
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Data cell is added to almost all the analysis systems [ saution 7 Update
where material properties are required to be |7|@ rets | Refish
defined. To define material properties, right-click” " “garic structural | B8 Rename
on the Engineering Data cell in the analysis or . Propects
component system and then choose the Edit . quikvep

option from the shortcut menu displayed, as ) N N o
s%}fown in Figure 6-1. On doing so, the Project Figure 6-1 Choosing the Edit option from

Schematic window will be replaced by four default the fiyout o
windows, as shown in Figure 6-2. These windows are collectively known as the Engineering
Data workspace.
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Figure 6-2 Imitial screen of the Engineering Data workspace

The default windows displayed in the Engineering Data workspace are: Outline of
Schematic A2: Engineering Data, Properties of Qutline Row3: Structural Steel,
Table of Properties Row 2: Density, and Chart of Properties Row 2: Density. When the
Engineering Data workspace is invoked, the contents of the Toolbox window get changed.
When you expand a toolbox displayed in the Toolbox window, various material properties
are displayed in it. You can use the options available in the toolboxes 1o assign properties to
any newly created material.
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Note
1. The name Outline of Schemuatic A2: Engineering Data window changes according to the
analysis system which was used for invoking it. Hereafler, it is called Outline window,

2. Similarly, the name of Properties of Outline Row3: Structural Steel window (will be
called Properties of Outline window) may vary depending on the material selected in the
Outline window.

3. Depending on the property selected in the Properties of Outline window, the name and
contents of the Tuble of Properties Row 2: Density (hereafier, called Table of Properties
window) and the Chart of Properties Row 2: Density (hereafier, called Chart of Properties
window) will change. -

By default, when you invoke the Engineering Data workspace, the Structural Steel material
will be available in this workspace. Figure 6-3 shows the Structural Steel material selected in
the Outline window and Figure 6-4 shows the corresponding Properties of Outline window,
displaying the properties of the selected Structural Steel material.

B

7 | axp | Fetgue Data Bt 2ero mean stress comes from 1933 ASME BRV Cade,
% structurat steal B 12 soctons, O 2, Toble 51105

Clizk here to add a naw material

Figure 6-3 Structural Steel material selected in the Outline window

fﬂ Density
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‘150 |m [ straindife Parameters
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25 T Compressive Yield Strength 2.58403 Pa
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- T specfcHeat 43 ThgheL CML Fimi|

Figure 6-4 The Properties of Outline window displaying properties of the selected
Structwral Steel material

As discussed earlier, when the Engineering Data workspace is invoked, the contents of the
Toolbox window get changed and display various material properties that can be assigned to
a material, refer to Figure 6-5. In the Toolbox window, all the material properties are grouped
together as per their category into various toolboxes. Tor example, the Strength toolbox
contains properties pertaining to the strength of a material such as Tensile Yield Strength,
Compressive Yield Strength, and so on. Similarly, the Physical Properties toolbox contains
Density, Damping Factor, and so on.
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CREATING AND ADDING MATERIALS

ANSYS Workbench 14.0 contains almost all the standard
materials in its libraries. You can select the required
material from the libraries and assign it to your project.
Apart from using the materials from the libraries, you can
create a new material as per the requirement and useit. In B ©
ANSYS Workbench, you can create a new material either Isotropic Instantanzous Coefficient of :
!
&

|53 Physical Properties oo

rthetropic Secant Coefficent of Therr

\ . . f . Grthatropic Instantaneous Coefficient
in the Qutline or Eng:neer1ng D-ata'Sources wmdgw. The Constant Damping Corffidnt
procedure of creating new material in both these windows Damping Factor ()

is discussed next. & Damping Fscter ()
|8, Lineat Elastic... -

Creating a New Material in the Outline -

T8 Orthotropic Elastidly
Window AnisotropicElastidy
As discussed earlier, you can invoke the Engineering Data B Viscoslasti :
workspace by double-clicking on the Engineering Data [ Sxperimantal Stress Strain Data
cell of a component or analysis system. By default, the
Engineering Data workspace consists of four windows.
You can create a new material in the Outline window and
specify its properties in the corresponding Properties of
Outline window, refer to Figures 6-3 and 6-4.

By default, Structural Steel is displayed in the Outline
window. If you do not add any other material to the Outline
window of the Engineering Data workspace, then only
Structural Steel material will be available to be applied to '

. o Tsai-Wu Constants
any geometry. To create a new material, specify its name T puck Constants
in the Click here to add a new material edit box in the LaRe3/04 Constants
Outline window, refer to Figure 6-3. The material isadded @ gasket... 0o
to the Outline window with a question symbol.displayed in & viermatetr.. ... .
front of the name. Also, the Properties of Outlinewindow [F - viéw alj Custonize... |
is displayed with no material properties. After specifying
the name of the material in the Outline window, you need
to add its properties in the Properties of OQutline window.
To add a property to the newly created material, expand the corresponding toolbox in the
Toolbox window and double-click on the property to be added to the material; it will be added
under the Property column in the Properties of Outline window. You can specify a value for
the property in the corresponding Value column. Similarly, to specify a desired unit for the
property, select it from the drop-down list available in the Unit column in the Properties of
Qutline window.

Qrthotropic Stress Limits
Qrthotropic Strain Limis

it |

Figure 6-5 Partial view of the
Toolbox window

Creating a New Material in the Engineering Data Sources

Window

(& As discussed earlier, you can also create material in the Engineering Data Sources

2 | window. To do so, right-click on the Engineering Data cell and then choose Edit from
the shortcut menu displayed; the Engineering Data workspace is invoked, refer to
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Figure 6-2. Next, choose the Engineering Data Sources toggle button available in the Standard
toolbar; the Engineering Data Sources window will be added to the Engineering Data
workspace, as shown in Figure 6-6. The Engineering Data Sources window has four columns
as: Data Source, Edit Library, Location, and Description, as shown in Figure 6-7. All these
columans are discussed next.
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Figure 6-7 Components of the Engineering Data Sources window

Data Source
The Data Source column consists of various libraries such as Favorites, General Materials,
General Non-linear Materials, Explicit Materials, and so on. The Favorites library

contains most frequently used materials. The contents of a library are displayed in the
Outline window.
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Edit Library

If you want to make changes to a particular library displayed in the Data Source column,
then you need to select the check box corresponding to that library in the Edit Library
column.

Location ‘
The Location column displays the location of a particular library in your system.

Description
The Description column displays the descriptions provided for various libraries.

Once the Engineering Data Sources window is displayed with its four columns, select the
check box from the Edit Library column, corresponding to the library in which you want
to add the material. On doing so, the contents of the selected library are displayed in the
Outline window. Note that the name of the Outline window changes according to the library
name selected in the Data Source column. Figure 6-8 shows the Outline window displayed on
selecting the General Materials library from the Engineering Data Sources window. Specify
a pame in the Click here to add a new material edit box in the Qutline window to create a
new material in the selected library.
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Figure 6-8 The contents of General library

After you specify a name for the new material in the Outline window, you need to assign its
properties in the Properties of Outline window. After the material properties are assigned to
the material, you need to make it ready to use. To do so, clear the check box selected earlier;
the Save dialog box will be displayed. Choose Yes from this dialog box to save the changes
made in the library. As a result, the newly created material will be added to the library. Next,
you need to choose the (44 button, located next to the newly created material in the Outline

window, refer to Figure 6- 8. On doing so, a book icon (& ) is added in the G sub-column of
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the Outline window indicating that the new material is added to the Engineering Data, Now,
choose the Engineering Data Sotirces toggle button again to turn off the display of Engineeriné

Data Sources window. Note that, the newly created material is displayed in the Outline
window.

TUTORIALS

pi

In this tutorial, you will open the file ¢c03_ansWB _tut03 from C:\ANSYS WB\c03\Tut03
and then save it with the name c¢06_ansWB_tut01. Figure 6-9 shows the model for
the tutorial. Next, you will add the Static Structural analysis system to the Project
Schematic window and then assign Steel material to the model. The properties of
the Steel material are given next. (Expected time: 30 min)

Properties of Steel:

Density: 8100 Kg/m3
Young’s Modulus: 1.9E+11 Pa
Poisson’s ratio: 0.27

Tensile strength:  2.1E+8 Pa

Figure 6-9 Model for Tutorial 1
The following steps are required to complete this tutorial:

Open an existing project and save it.

Add an analysis system and share geometry from the existing project.
Create a new material.

Apply the material to the model.

Save the project.

oo o
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Opening an Existing Project and Saving it

6.

7.

Before starting the tutorial, you need to open an existing project and save it with a different
name. Next, you need to add the Static Structural analysis system to the Project Schematic
window.

Start ANSYS Workbench to display the Workbench window.

In the Workbench window, choose the Open button from the Standard toolbar; the Open
dialog box is displayed.

Browse to the folder C:IANSYS WBic03\Tit03 and then double-click on ¢03_ansWB_tut03;
the ¢03_ansWB_tut03 is opened in the Workbench window.

In the Workbench window, choose the File > Save As from the Menu bar; the Save As
dialog box is displayed.

Browse to C:IANSYS_WB folder and then create a new folder with the name c06.
Browse to C-IANSYS _WB\c06 and then create a folder with the name Tut01.

Next, browse to the Tut01 folder and save the project with the name c06_ansWB_tut01.

Adding the Static Structural Analysis System and Sharing Geometry

Notice that in the Workbench window, the Clamp component system is already displayed.
You need to share the geometry created in the Clamp component system with an analysis
system to assign material to it.

Double-click on the Static Structural analysis system in the Analysis Systems toolbox
in the Toolbox window; the Static Structural analysis system is added to the Project
Schematic window. Note that a green tick mark is displayed in the Engineering Data cell
in the Static Structural analysis system, indicating that this cell is satisfied.

Next, click and drag the Geometry cell of the Clamp component system; two cells:
Geometry and Model are highlighted with a green outline, as shown in Figure 6-10,
indicating that the existing geometry can be shared with the Geometry cell or with the
Model cell of the Static Structural analysis system.

Drag and drop the Geometry cell from the Clamp component system to the Geometry cell
of the Static Structural analysis system, refer to Figure 6-11; the geometry is shared.
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Figure 6f1 0 The Static Structural analysis  Figure 6-11 Sharing the geometry with the Geometry
systein with the Geometry and Model cells  cell of the Static Structural analysis system

highlighted
Creating a New Material

The default material that is available in ANSYS Workbench is Structural Steel, In this
section, you will create a new material.

1. Double-click on the Engineering Data cell in the Static Structural analysis system; the
Engineering Data workspace is invoked, refer to Figure 6-2.

2. In the QOutline window, click on the Click here to add a new material edit box and enter

Steel as the name of the new material.

3. Press ENTER to confirm the name; row 4 is created and displays the Steel material along

with a qgestion symbol attached to it under the Contents of Engineering Data column of
the Engineering Data, as shown in Figure 6-12. Also, the Properties of Outline window
for the Steel material is displayed.

4. Expand the Physical Properties toolbox in the Toolbox window to display the physical

properties of materials,

5. Double-click on Density under the Physical Properties toolbox, refer to Figure 6-18;

Density is added to the Properties of Outline window that is displayed for the Steel
material.

@ Orthstrapic% Density E’f icient ol
Isotropic InstaRCERES TS Coeffid

Orthotropic Instantanecus Cosfl
Constant Damping Cosffident
ﬁ|ﬁ—] Damping Factor {B}

W Structural Stes!

e steel

R Chiek hure 18 adrj"a new matarial

Figure 6-12 Steel material added to the Outline window  Figure 6-13 Choosing Density from
the Physical Properties toolbox
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Figure 6-14 Choosing Isotropic Elasticity
from the Linear Elastic toolbox

10,

11,

12,

13,

Next, expand the Linear Elastic toolbox in the Toolbox window; the physical properties
under this toolbox are displayed.

Double-click on the Isotropic Elasticity under the Linear Eiast.ic toglbox, refer o
Figure 6-14; Isotropic Elasticity is added to the Properties of Outline window.

Expand the Strength toolbox in the Toolbox window; all the properties available under
this toolbox are displayed in it.

Double-click on the Tensile Yield Strength property under the Strength too‘ibox, as sho.wn
in Figure 6-15; the Tensile Yield Strength node is added to the Properties of Outline

window,

. Compressive Yied Strength
Tensile Ultimate Strength
T3 Compressive Ultimate Strength

Qrthotropic Elasticks
Anisatropic Elastidty

Figure 6-15  Choosing the Tensile Yield
Strength from the Strength toolbox

Note that all the properties that are added in the Properties of Outline w'md_ow have a
question symbol attached to them indicating that the values for such properties are yet
to be specified.

Click on. the Valué field corresponding to the Density property in the Properties of
Outline window and then enter 8100. :

Note _ .
1. If the Value field is blank, 1 is highlighted in yellow. When a correct value is entered in the

Value field, the color turns white.

2. You can select the desired unit as the value for the properties from the Unit drop-down list
under the Unit field in the Properties of Qutline window.

Expand the Isotropic Elasticity node under the Property field 'm. t%le Properties of
Outline window; five more rows are added under the Isotropic Elasticity node.

Click on the down arrow in the Value field corresponding to the Derive from property;
a drop-down list is displayed.

Select Young’s Modulus and Poisson’s Ratio from the drop-down list, if it is not already
selected, as shown in Figure 6-16.
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"This option is selected so that the [sotropic Elasticity property
of steel can be derived by usiag the Young’s Modulus and
the Poisson’s ratio. Note that the values for Young’s Modulus
and the Poisson’s ratio are given in the tutorial description
at the beginning of this tutorial.

14,

16.

. Enter0.27 in the Value field corresponding tothe Poisson’s | Bulk Madulus and Young's Modulus +

Enter 1.L9E+11 in the Value field corresponding to the : W’ e )
Young’s Modulus property in the Properti i Youngs Modulus.aid Poissons Rafd
¢ “;g 5 Mo property | perties of Outline | Shear Modulus and Poissen's Rat
window. Bulk Modulus and Poissons Reio |
Shear Moduius and Young's Madulus

Ratio property; the corresponding values of the Bulk {BulkModulusand Shear Modulug
Modulus and Shear Modulus properties are updated ;
in the Value field of the Properties of Qutline window. Figure 6-16 Selecting the Young’s

Modulus and Poisson’s Ratio
In the Properties of Outline window, enter 2,1E+11 option the drop-down list

i the Value field corresponding to the Tensile Yield
Strength property; the question symbol placed before Steel in the Outline window is
vanished, indicating that the Steel material can be used.

Applying the Material to the Model

After creating the new material in the Engineering Data workspace, you need to assign
this material to the Clamp model.

Choose the Return to Project button from the Standard toolbar, as shown in Figure 6-17,

the Project Schematic window is displayed with the Geometry component systern and
the Static Structural analysis system.

Fle  Edit  View . Tosls  Units Hely © .
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:‘m Ol ar Rt st R .v.\ e e
Figure 6-17 Choosing the Return to Project button from the Standard toolbar

After creating the new material, you need to apply this material to the model.

In the Workbench window, choose the Refresh Project button from the Standard toolbar
to refresh the project

Double-click on the Model cell of the Static Structural analysis system; the Mechanical
window is displayed.

In the Tree Outline, select the Solid node.

Next, click on the right arrow on the right of Assignment; a drop-down list is displayed,
as shown in Figure 6-18.

Select the Steel option from the drop-down list, refer to Figure 6-17; the new material is
assigned to the model.
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7. Close the Mechanical window; the Workbench window is displayed.

Graphics Properties
=1 Definition
7] suppressed Mo
Stiffness Behaviar Fiexible
Coordinate System Default Coor..,
Reference Temperature | By Environment
[ Materiat .
:‘Fr f”fw Structural .. ¥
Woniinear £ffacts Yes

Thermal Strain Effects  |Yes

Figure 6-18 Selecting the Steel option from the
drop-down list

Save the Project and Exit ANSYS Workbench
After assigning material to the model, you now need to exit the ANSYS Workbench session.

1. Choose the Save button available in the Standard toolbar in the ANSYS [& save
Workbench window to save the changes made to the project. o

2.  Choose File > Exit to exit the Workbench window and close the ANSYS Workbench session.

In this tutorial, you will create the beam structure, as shown in Figure 6-19. The dimensions
of the model are given in Figure 6-20. After creating the model you will assign it an
existing Stainless Steel material from the library. (Expected time: 30 min)

Figure 6-19 Model for Tutorial 2
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(b) Right View . (¢) Front View

Figure 6-20 Views and dimensions of the skeich of the model

The following steps are required to complete this tutorial:

Create the model.

pooe

Start ANSYS Workbench session and add the Static Structural analysis system.

Add Stainless Steel material to the Engineering Data.
Assign the material to the model.

Starting ANSYS Workbench and Adding the Static Structural Analysis

System

Before you start the tutorial, you need to start ANSYS Workbench. Next, you need to add

Static Structural analysis system to the Project Schematic window.

1. Start the ANSYS Workbench session.

2. Add Static Structural analysis system to the Project Schematic window, refer to

Figure 6-21,

Figure 6-21 The Static Structural analysis system

Enginesring Data
¥ Model B
SEtUp Wf A
B Solution -
b -= ==
(7149 Resulls ¥ o4

Static Structural

3. Choose the Save tool from the Standard tooibar; the Save As dialog box is displayed.
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4.

5.

In this dialog box, browse to the location CAANSYS W8 1c06 and then create a folder with
the name Tut02.

In the Tit02 folder, save the project with the name c06_ansWB_tut02.

Creating the Model

7.

After adding the Static Structural analysis system to the Project Schematic window, you
now need to create the model.

In the Static Structural analysis system, double-click on the Geometry ceil to open the
DesignModeler window along with the ANSYS Workbench dialog box.

Select the Millimeter radio button from the ANSYS Workbench dialog box. Next, choose
the OK. button to specify millimeter as the unit of length and exit the dialog box.

Next, in the Tree Outline of the DesignModeler window, select XYPlane to make it the
active plane.

Choose the Lock At tool in the Graphics toolbar; the XY plane is oriented normal to the
viewing direction.

Draw the sketch shown in Figure 6-20 according to the dimensions given.

Extrude the sketch to create the model by using the Extrude tool from the Features
toolbay, refer to Figure 6-19.

Exit the DesignModeler window; the Workbench window is displayed.

Adding Material to the Engineering Data

After a new project is created, you need to add material to it.

In the Workbench window, double-click on the Engineering Data cell in the Static
Structural analysis system; the Engineering Data workspace is displayed.

Choose the Engineering Data Sources toggle button; the Engineering Data Sources
window is added to the workspace.

In the Engineering Data Sources window, click on the General Materials library in the
Data Source column; the materials in this library are displayed in the Outline window,
refer to Figure 6-22.

In the Outline window, select Stainless Steel from the Contents of Engineering Materials
cofumn; the properties of Stainless Steel material are displayed in the Outline window.

Click on the plus (k) sign displayed in the B column displayed under the Add column
in the Outline window, refer to Figure 6-23; the material from the Generals library is
added to the Engineering Data. Also, a book icon (@) is displayed in the G column
under the Add column in the Outline window.
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Figure 6-22 Partial view of the Engineering Data workspace displaying various
materials in the General Materials library

6. Next, choose the Engineering Data Sources toggle button to close the Engineering Data

Svurces window; Stainless Steel row is added to the Outline window in the Contents of
Engineering Data section, as shown in Figure 6-24.

el Copper Moy

o | % sy

9 Magnesiim Alloy:.

ST % Sl steel T
a2 Titmaum Alloy e e L

Figure 6-23 Choosing the plus sign from the B column
of the Outline window

7. Chqose t%}e Return to Project button in the Standard toolbar; the W]

Engineering Data workspace disappears and the Project Schematic
window with the Static Structural analysis system is displayed.
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After the material is added to the Data Source, you now need to apply this new material
to the model,

@ starless Stee! ]

i

1 4§

% Shuchus! Stes! o Fatgue Oatz atlzere magn siress comes from 1998 ASME 3PV Code, Sectian 8, Oiv

2, Table 5-110.
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Figure 6-24 The Outline window displaying the newly added Stainless Steel material
Assigning Material to the Model

You now need to assign the material to the model.

1. Double-click on the Model cell in the Static Structural analysis systern; the Mechanical
window is displayed.

2. Select Solid from the Tree Qutline, as shown in Figure 6-25; the corresponding options
are displayed in the Details of Solid window.

3. In the Details of “Solid” window, click on the right arrow displayed on the right of
Assignment; a drop-down list is displayed, as shown in Figure 6-26.

= Project ;
Iél _____ Model [A4} 6] (;;aphics Properties
T v [=1; Definition
B '/% Geamuf T} Suppressed Ho
{r"{ & e Stiffness Behavior Flexibie
-, Coording] "Fystems Coordinate System Default Coardinat,.,
: A8 Mash Reference Temperature | 8y Environment
S Static Structural {A5) | Material
b Y Analysia Settings | PR
E]?@ Solution (A6) Nonlinear Effect
v Soiution Information Thermal Strain Effects
; F: Bosnding Box

Figure 6-25  Selecting Solid from the Tree  Figure 6-26 Selecting the Stainless Steel option
Outline from the drop-down list

4. Select Stainless Steel from the drop-down list; the material is applied to the model.

5. Exit the Mechanical window; the Workbench window is displayed.

Assigning Material to the Model
You now need to save the project and exit the ANSYS Workbench session.

1. Choose the Save button from the Standard toolbar; the project is saved with
the name ¢06_ansWB_tut02.

2. Choose File > Exit to close the Workbench window and exit the ANSYS Workbench session.
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A

In this tutorial, you will download the ¢06_ansWB_Tut03.zip file from www.cadeim.com. After
downioading, you will extract it and then import the ¢06_ansWB_tut03.igs file into ANSYS
Workbench. Next, you will apply different materials to different components of the assembly.
Figure 6-27 shows the imported assembly. After importing the assembly, rename the components
of the assembly in DesignModeler, refer to Figure 6-28. Note that the Base, Slider Guide,
Spindle Screw, Handle, and Knob are made of Grey Cast Iron, whereas the Slider and the
Slider Base are made up of Miid Steel. The properties of Mild Steel and Gray Cast Iron are
given next. (Expected time: 45 min)

Properties of Mild Steel:

Density: 7850 Kg/M®
Tensile Yield Strength: 231.94 MPa
Compressive Yield Strength:  407.7MPa

Properties of Gray Cast Iron:

Density: 7200 Kg/M?
Young’s Modulus: I.IE+10
Poisson’s Ratio: 0.28

Bulk Modulus: 8.33E+ 10

Spingdle
Screw

Siier
Guide Knob

Figure 6-27 Bench Vice Assembly

Figure 6-28 Various components of the Bench
Vice assembly

The following steps are required to complete this tutorial:

Download the part file and import it to ANSYS Workbench.
Add materials to the Engineering Data workspace.

Assign materials to components.

Save the project.

pooow
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Pownioading the Part File and Importing it into the Workbench

You need to download the part file from wwuw.cadcim. corn.
1. Create a folder with the name Tut03 at the location CAANSYS_WEB\C06.

9. Download the ¢06_ansWB_ut03.zip file from www.cadcim.com. The compiete path of the
file is: '

Textbooks > CAE > ANSYS > ANSYS Workbench 14.0: A Tutorial Approach > Input Files

After downloading, extract it to save the c06_ansWB_tut03.igs to the folder
CAANSYS_WBie06\Tit03.

%. Open ANSYS Workbench 14.0.
4.  Add the Static Structural analysis system to the Project Schematic window.

5. Right-click on the Geometry cell of the Static Structural analysis system; a shortcut menu
is displayed.

6. From this shortcut memy, choose Import Geometry > Browse; the Open dialog box is
displayed.

7. Browse to C:\ANSYS _WBlc06\Tut03 and then select c06_ansWB_tut03.igs. Next, choose
the Open button from the Open dialog box; the file is imported into ANSYS Workbench.
Also, a green tick mark is placed before the Geometry cell in the Static Structural analysis
system.

Adding Materials to the Engineering Data Workspace
Before generating a mesh for the model, you need to define the materials for the different
components of the assembly. In case, you need a material that is not already included in
ANSYS Workbench materials libraries, then you need to create that material.

1. Double-click on the Engineering Data cell in the Static Structural analysis system in the
Project Schematic window; the Project Schematic window is replaced by the Engineering
Data workspace.

2. Choose the Engineering Data Sources toggie button from the Standard toolbar;
the Engineering Data Sources window is added to the Engineering Data
workspace.

%. Inthe Engineering Data Sources window, click on the General Materials under the Data
Source column; the materials included in the General Materials library are displayed in
the Outline window.
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In the Outline window, click on the plus (s}) button available on the right of Gray Cast
Iron under the Contents ‘of General Materials column; the material is added to the
Engineering Data and is available to be used.

Repeat step 4 to add the Stainless Steel material to the Engineering Data.

Notice that Mild Steel material is not available in the library. You need to create a new

material in the General Materials library, assign it the desired properties, and then name
it as Mild Steel.

Select the check box displayed on the right of General Materials under the Edit Library
column; a new field Click here to add a new material is added to the Outline window,
as shown in Figure 6-29.

% Magnesium Aloy
Q@ Polyathylans
T Stainiess Steet
Q@ Tisriuen Aloy
% iﬁi:g;op\c
W Mid stact

Clizk here to add 2
e material

Figure 6-29 The new field displayed in the

Outline of General Materials window
Click on the Click here to add a new material field and then enter Mild Steel in it;
Mild Steel material with a question symbol is attached to it added under the Contents of

General Material column in the Outline window. The question symbol indicates that the
properties for this material have not been specified.

In the Toolbox window, expand the Physical Properties toolbox, if it is not already
expanded.

Double-click on Density in the Physical Properties toolbox; Density is T Density
displayed in the Properties of Outline window.

Expand the Strength toolbox if it is not expanded.

Add Tensile Yield Strength and Compressive Yield Strength properties to the new
material.
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12. In the Properties of Outline window, specify the values of the parameters as follows:
Density: 7850 Kg/M* Tensile Yield Strength: 231.94 MPa
Compressive Yield Strength: 407.7 MPa

13. After the properties are specified, clear the check box corresponding to the General
Materials library under the Edit Library column; ANSYS Workbench message box is
displayed with the message Modifications have been made to this library. Do you want to
save it?

14. From this message box, choose Yes to include the newly created material Mild Steel in
the General Materials library.

15. Click on the plus (:=) button available on the right of Mild Steel under the Contents of
General Materials column; the material is added to the Data Source.

“To view the material in the Engineering Data, choose the Engineering Data Source toggle
button from the Standard toolbar; the Engineering Data Sources window disappears and
the material is displayed in the Outline window.

Notice that Gray Cast Iron, Structural Steel, Stainless Steel and Mild Steel materials
are added to the Outline window, as shown in Figure 6-30.

S GravCas%Ifﬂn. Y

Fatigua Dats at 2ero mean srass comes
from 1998 ASME BPY Code, Section 8, Div 2,
Table 5-110.1

Y struchural Staef

+§

Stainless Steet
Gray Castlron 2

Click here to add 8 new
material

e e

53 vensity 735G 7}
Tansile Yisld Strength ‘ 231948408  |Pa =
{Eﬂ} Corpressive Yield Strength 4,077E+08 Pa e

Figure 6-30 The Qutline window with the Mild Steel material properties
displayed in the Properties window

16. Choose the Return to Project button from the Standard toolbar; you {3 Return.to Project:
are directed to the Project Schematic window.
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Assigning Material to Components

The Assignment drop-down list displays all the materials that
added to the Engineering Data.

5.

After all the materials are created and added to the Outline window, you now need to
assign the materials to different components.

Double-click on the Model cell in the Static Structural analysis system; the ANSYS
Workbench message box is displayed with the message Upstream daia has been modified
since it was last read. Would you like to read the upstream data?, as shown in Figure 6-31.
Choose the Yes button from this message box; the Mechanical window is displayed.

- ANSYS Workbanch

Upstream data has besn modified since it was last read. Would you like
o read the upstream dats?

Figure 6-31 The ANSYS Workbench message box

Expand the Geometry node in the Tree Outline; all the components available in the
assembly are displayed under the Geometry node.

Select both Slider Guides and the Base from the Qutline
window, refer to Figure 6-32; the Details of “Multiple
Selection” window is displayed with the options related to
these geometries.

s 5 Handla

In this window, select Gray Cast Iron from the Assignment T g ggf i Scre
drop-down list to assign the material to the selected y
components, as shown in Figure 6-33.

Figure 6-32  Selecting the
components from the Outline

L ) . . window
Similarly, select all instances of Serew from the Tree Outline

and then apply Stainless Steel material to them, refer to Figure 6-33.

Next, select Slider, Spindle Screw, and Handle from the Tree Qutline and apply Mild
Steel material to them.

Select all instances of the Knob in the Tree Outline and then apply Mild Steel material
to them,

Exit the Mechanical workspace; the Project Schematic window is displayed.

Choose the Update Project button from the Standard toolbar to update the [ tpdate project
project. -
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8. You can access the material libraries by choosing the tooale
Graphics Properties _ = button available in the Standard toolbar. 88
| Definition

[} suppressed Mo . - . )

Sifimess Betmior [Flenioie 9. All the common materials are included in the library.

Coordinate System Default Coordinate System

Referente Temperature | By Envirenment
=1 Material

SHERLIEE S VR Structural Steet %, Answer the following questions,

Nonlinear Effacts Yoy T I d-"- N

Thermal Strain Effacts |Yes 5_“‘““_ s tee.E_ e . .
| Bounding Box - o Mild Staet L. 'To make changes in a library, you first need to select the check box corresponding to the

‘ ' libra d it Li
Figure 6-33 Selecting the Gray Cast Iron option from the drop~down list vy under the Edit Library colutun. (T/F)

Saving the Model ‘ 2. The Structural Steel material can be found in the General Materials library. (T/F)
After assigning materials to different components of the assembly, you need to save th
model. Follow the steps given next to save the model. 3. You can add frequently used materials under the Favorites library. (T/T)
1. Choose the Save button from the Standard toolbar; the Save As dialog box is [ . ’ 4. You can create duplicates of a material available in the library. (T/F)
displayed. - ——-—
5. When you double-click on the Engineering Data cell, the workspace is
2. Browse to the location C:\ANSYS_WB\c06 and create a folder with the name Tut03. displayed.
3. Browse to the folder C:IANSYS_WB\c06\Tut03 and then save the project with the name 6. New material properties can be added to the existing materials using the
e06_ansWB_tuti)3. window.
4. Exit the Workbench window to close the session. :_"1.; 7. The values of material properties are displayed in the window,

EXERCISE
XEercise

Create r:h_e model shown in Figure 6-34. Its dimensions are given in Figures 6-35 through'S-B’i .‘
Next, assign the Aluminium Alloy material from the library to the model.

(Expected time: 45 min)

Answer the following questions and then compare them to those given at the end of this
chapter:

i. The Engineering Data component system is a standalone system. (T/F)

2. Youcanadd a new material even without accessing the libraries available in the Engineering
Data Sources window of the Engineering Data workspace. (T/F)

3. The default material available in ANSYS Workbench is Mild Steel. {T/F)

4. The Engineering Data cell can be shared with other standalone systems by selecting it

|
and then dragging it to the respective cell of a system. (T/F)

Y
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|
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|
: T
Lo TA0D \rf%

5. You can change the name of a material at any point of time during the project. (T/F)

6. Inany system, when the upstream data is updated, you can update the project using the

button. . ,

uton Figure 6-34 Model for Exercise 1 Figure 6-35 Top view of the model

7. You can insert the Engineering Data standalone system by using the shortcut menu
displayed when you right-click in the window.
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Figure 6-36 Side view of the model Figure 6-37 Front view of the model Gen er a t, n g M es h - ’

Answers to Self-Evaluation Test
1. T, 2.7, 3. F, 4. T, 5. T, 6. Refresh Project, 7. Project Schematic, 8. Engineering Data
Sources, 9. General Materials
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INTRODUCTION

A mesh is the discretization of a component into a number of small elernents of defined size.
As discussed in Chapter 1 of this book, finite element analysis would divide the geometry into
various small number of elements. These elements are connected to each other at points called
nodes. Each node may have two or more than two elements connected to it. A collection of
these elements is called a mesh. Figure 7-1 shows a solid model and Figure 7-2 shows mesh

created on the solid model.

Figure 7-1 A Solid model Figure 7-2 Mesh created on the solid model

Meshing is a very important part of pre-processing in any FEA software. In ANSYS Workbench,
there are many tools and options available to help you create an effective mesh. An effective
mesh is the one that requires less computational time and gives maximum accuracy. In ANSYS
Workbench, you can generate mesh with the default settings available when you start the
software. Default settings are the ones that are provided by the system based on the geometry
to be meshed. You can also set parameters as per your requirement to generate a mesh.

The default mesh generated in the software may produce coarse mesh. Therefore, you need
to use the advanced settings to produce a finer mesh. Figures 7-3 and 7-4 show a model with
coarse mesh and finer mesh respectively.

Figure 7-4 Model with fine mesh

Figure 7-3 A model with coarse mesh

In ANSYS Workbench, you can generate a mesh either in the in the Mechanical window (which
will be discussed later)or in the Meshing window. The Meshing window can be invoked by
double-clicking on the Mesh cell of the Mesh component system, refer to in Figure 7-5. To

invoke the Mechanical window, double-click on the Model cell of the analysis system, refer

to Figure 7-6.

Generating Mesh - I
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Figure 7-5 The Mesh component Figure 7-6 The Model cell highlighted in
system the analysis system

The Meshing window and its components are shown in Figure 7-7.
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Figure 7-7 The Meshing window with various components annotated

Various toolbars in this window will be discussed later in this chapter. The options available
in the Mechanical window are similar to the ones available in the Meshing window. However,
in Mechanical window, along with the meshing tools, analysis tools are also available, which
can be used for carryoing out various analyses in ANSYS Workbench.

The accuracy of the results of an analysis depends a lot on the mesh quality of the model.
Ideally, the results obtained from a finite element analysis get more accurate with increased



7-4 ANSYS Workbench 14.0: A Tutorial Approach

number of elements. However, increased number of elements also increase the process time
required to run an analysis. ‘Therefore, it is always advised to find a balance between the
accuracy of results and the process time required to run the analysis.

Figure 7-8 shows a model consirained around its
circumference and loaded centrally. Total
Deformation of the model can be determined
after the Static Structural analysis is carried out
on it. Refer to the model in Figure 7-3 with coarse
mesh quality. After performing a Static Structural
analysis on this model, the corresponding Legend _
and the deformed model will be as shown in Figure 7-8 Applied consiraints and loads
Figures 7-9 and 7-10, respectively.

Similarly, refer to the model Figure 7-4 with fine mesh. After performing a Static Structural
analysis on this model, the corresponding Legend and the deformed model are shown in
Figures 7-11 and 7-12, respectively.
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4,44242-6

3,887 Lle-6
3.3318e-6
2,7785%e-6
2.2212e-6
LG65%e-6
Lil0ge-6
5.59528e-7

0 Min

Figure 7-9 Total deformation contours

Figure 7-10 Total deformation on the model

5.0055¢e-6 Max
4.4424e-8
3.887Le-g
3.3318e-6
2,77652-6
2.2212e-6
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5.5529e-7
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Figure 7-11 Total deformation confours Figure 7-12 Total deformation on the model

To understand the importance of generating a mesh which gives better results, compare
Figures 7-9 and 7-11. You will observe that the maximum value of Total Deformation in
Figure 7-9 is 4.98E-6, whereas in Figure 7-11, the maximum value of Total Deformation is

Generating Mesh - 1 7.5

5E-6. Notice that the Total deformation obtained in the model with the finer mesh is more
compared to the model with coarse mesh. To understand the importance of generating an
effective mesh, you can further reduce the size of the elements, carry out the analysis, obtain
the results, and compare the data. Improving the mesh quality is important in the cases where
the result obtained are of significance.

Refining the Mesh

After generating mesh for any model, you can increase the number of elements by using various
tools and options available in ANSYS Workbench. There is an option available in the Details
of “Mesh” window, called Relevance, which can be used for changing the mesh type from
coarse to fine and vice-versa. By default, the relevance set in ANSYS Workbench is 0. But it
can be-changed by specifying a value between -100 to 100 in the Relevance edit box displayed
in the Details of Mesh window, as shown in Figure 7-13. The number of elements increases as
the relevance increases from -100 to 100. This means a relevance of -100 would produce coarse
elements, whereas 100 would produce finer or smaller elements. Finer the mesh, more will be
the computational time. To find out about the number of elements created after generating
a mesh, you need to expand the Statistics node in the Details of “Mesh” window, as shown
in Figure 7-14. Figure 7-15 shows a model meshed with three different relevance values. You
will learn about other tools used for generating a mesh later in this chapter.
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Figure 7-14 The Details of “Mesh”
window displaying the number of elements

Figure 7-13 The Details of ‘Mesh’
window displaying the Relevance edit box

fa) Mesh with 0 relgvance (b} Mesh with -100 relevance fe) Mesh with 100 relevance

Figure 7-15 Meshes created with varying relevance
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The Decision Making to Find Optimum Results

To achieve optimum results in an analysis, you need to discretize the model into the required
number of elements. To do so, decide the rumber of times upto which a mesh has to be refined
to reduce the element size. The decision is very difficult and is based on the experience of
the design engineer. For a real complex model, where time is not the primary constraint but
accuracy is, an FEA engineer would refine the mesh as long as the analysis shows improved
results. However, the time is also an important factor to find a perfect mesh for a model.
Figure 7-16 shows a model with its boundary and loading conditions and Figure 7-17 compares
the data gathered from various analyses run on this model. In this figure X cordinate represents
the element count and the Y cordinate represents the Total Deformation evaluated.
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Eterner Count
Figure 7-16 Model with boundary and Figure 7-17 Graph showing the relationship
loading conditions between element count and deformation

The graph in Figure 7:17 shows the deformation results achieved from an analysis. The X
axis represents the number of elements in the model and Y axis represents the Deformation
obtained against a particular element count. As you can see that when the element count is
9900, the value of Deformation achieved is 2.45 E-07. As the number of elements increases, the
deformation also increases. Note that the maximum value of Deformation is achieved where
the element count is 11,500. Hence, it is obvious that meshing the component beyond this
point is not required. Meshing the model further contributes to the increase of the runtime

of the analysis.

TUTORIALS

In this tutorial, you will create the model of a rectangular plate with three holes, refer
to Figure 7-18, Next, you will open the Meshing window and then generate a mesh with a

Relevance of 0. The dimensions of the model are shown in Figure 7-19.
(Expected time: 30 min)

The following steps are required to complete this tutorial:

a. Open ANSYS Workbench window and add the Mesh coraponent system.
b. Create the model.

Generating Mesh - I

Generate a mesh for the model.
Create section views. )
¢.  Save the project and exit ANSYS Workbench.
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Figure 7-18 Rectangular plate with Figure 7-19 Dimensions of the model
three equispaced holes Jor Tutorial 1

Opening ANSYS Workbench and Adding the Geometry Component
System

Before you start the tutorial, it is important that you first open ANSYS Workbench and
then add a component system to the Project Schematic window.

L. Star.t an ANSYS Workbench session and then add the Mesh component system to the
Project Schematic window.

2. Create a new folder with the name c07 at the location
CAANSYS_WB. Now, open the ¢07 folder and then create
a sub folder in it with the name Tut01.

Geometlry " i

3. Save the project with the name c07_ansWB_tut01 in this
folder. )

‘Flate with holes
4. Rename the Mesh component system as Plate with holes,
as shown n Figure 7.90, Figure 7.20 The Plate with
holes component system

Creating the Mode!

Af{t:ir 211 new project is created, you need to open the DesignModeler window to create the
model.

1. Double-click on the Geometry cell; the DesignModeler window along with the ANSYS
Workbench dialog box is displayed.

2. Select the Millimeter radio button and then choose OK in the ANSYS Workbench dialog
box to apply millimeter as the unit.

3. In the DesignModeler window, select XYPlane from the Tree Qutline to specify it as the

sketching plane.
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4. Orient the plane normal to the viewing
direction by using the Look At tool.

5. (Choose the Sketching tab to invoke the

Sketching mode. {
i Ht .
6. Create a rectangle and dimension it, as shown : n
in Figare 7-21. IRz

7. Change HI to 50 and V2 to 5 in the Details
View window. Next, extrude the sketch to the
depth of 100 by using the Extrude tool.

Figure 7-21 Rectangle created on the XY

I
8. Switch to the Modeling mode and then change prane

the view to Isometric. Figure 7-22 shows the Isometric view of the Base Plate.

9. Create a new plane on the top face of the extruded feature and orient the view normal to
the viewing direction.

10. Switch to the Sketching mode and draw three circles on the top face of the plate. For
dimensions of the holes refer to Figure 7-19.

11. Extrude the sketch in such a manner that material is removed from the base plate, as
shown in Figure 7-23.

Figure 7-23 Creating three holes using

Figure 7-22 Creating a new plane on
the Extrude tool

the top face of the Base Plate

12. Exit the DesignModeler window to return to the Workbench window.

Generating Mesh for the Plate

Now, you need to go to the Meshing window to generate the mesh for the Base Plate.

1. Double-click on the Mesh cell in the Plate with holes component system and wait for
sometime; the Meshing window is displayed. Also, you will notice that Mesh is displayed
in the Tree Outline with a yellow thunderbolt attached to it, indicating that this field needs
t0 be satisfied.

Generating Mesh - I w9

Note

In this tuterial, you will use the default settings provided in ANSYS Workbench
a mesh.

Jor generating

2. Click on Mesh in the Tree Outline and then right-click to display the shortcut menu.

3. Choose the Generate Mesh option from the shortcut menu displayed; the ANSYS
Workbench Mf:sh Status window is dispiayed. After sometime, the ANSYS Workbench
Mesh Status window disappears and the mesh is generated, refer to Figure 7-24,

Note

Note that & green tick mark is displayed next to Mesh in the Tree Outline indicating that this
field is satisfied. ‘

Creating Section Views

A_fter Fhe mesh is generated in the Graphics screen, you need to create section view to
visualize the element types created.

L. F]hc?ose the New Section Plane tool from the Graphics toolbar; the Section Planes window
ts displayed, as shown in Figure 7-25.

Figure 7-24 Mesh generated for the model — Figure 7-25 The Section Planes window displayed

2. Right-click in the Graphics screen and then choose View > Top from the shortcut menu
displayed; the view of the model is set to Top.

Now, you need to create a section such that the section plane cuts the three holes and the
plate.

3. Move the cursor to a position similar to the one shown in Figure 7-26.
4. Click, hold, and drag the cursor to a position similar to the one shown in Figure 7-27

and then release; the model is sectioned, as shown in Figure 7-28. Also, the 8lice Plane
1 check box is selected and is displayed in the Section Planes window.

Note that slice planes are used to section a model.
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15t postion of

the Gursar . 2nd posiion of
fhe cursor

Figure 7-26 First position of the cursor for Figure 7-27 Second position of the cursor
creating section planes Jor creating section planes

5. To have a better view of the model and its elements, change the view to Isometric as shown
in Figure 7-29.

I i frais

Figure 7-28 Sectioned model Figure 7-29 Isometric view of the model

Note

1. To add more slice planes, choose the New Section Plane button again and then create o
slicing plane in the Graphics screen by following the steps explained earlier in this tutorial.
When you do so, more nodes will be added to the Section Planes window.

2. To view the complete model again and temporarily hide the section plane, clear the check box
corresponding to the Slice Plane 1 in the Section Planes window.

3. You can also permanently delete the section plane created. To do so, select the Slice
Planel in the Section Planes window and then choose the cross (X) button displayed in the
toolbar of the window; the Stice Planel is deleted and the model retrieves its complete view.

6. Close the Mesh window; the Workbench window is displayed.

Saving the Project and Exiting the Workbench Window
After meshing is done, you need to save the project again and exit the Workbench
window.

1. Choose the Save button from the Standard toolbar to save the project.

2. Close the Workbench window.

Generating Mesh - 1
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In this tutorial, you will download the c07 _ansWB (ut02 zip from www cac;fczm

] , d the ¢07_ N . . com and extrac

It to save the cO?_ansWB__tutow?‘zgs file in the project folder. After extracting, import t[fer?gf

fxle into ANS:YS Workbench. Next, you will generate a mesh and then optimize the model for

turther use. The model after importing into ANSYS Workbench is shown in Figure 7-30,
(Expected time: 45 min)

Figure 7-30 Model for Putorial 2
‘The following steps are required to complete this tutorial:

Download the part file and import it into ANSYS Workbench.
Generate a mesh for the model.

Create the section of the model.

Optimize the model.

Create a symmetrical model.

Change global mesh control settings.

Save the project.

UCER N O~ T e B = i

Downleoading the Part File and Importing it into the Workbench
Before you start the tutorial, you need to download the part file and import into ANSYS
Workbench.

1. Create a folder with the name Tut02 at the location C-IANSYS _WBic07.

2. Download the file c07_ansWB_tut02.2ip from www.cadcim.com. The complete path for
downloading the file is:

Textbooks > CAE > ANSYS > ANSYS Workbench 14.0: A Tutorial Approach > Injrut Files

After the file is downloaded, extract it to save the c07_ansWB_tut02.igs file at the location
CAANSYS_WBIcOT\Tut02.
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8.

10.

After extracting the file, you need to open ANSYS Workbench and import the file into it.

Open ANSYS Workbench 14.0.

Add the Static Structural analysis system to the Project Schematic window.

Right-click on the Geometry cell of the Static Structural analysis system; a shortcut menu
is displayed.

Choose the Import Geometry option; a flyout is displayed, refer to Figure 7-31.

From this fiyout, choose the Browse option, refer to Figure 7-31; the Open dialog box is
displayed.

2 @ EngineeringDate v i

& i '
&8 Model k = s s
5 @. Senp i Jmport Geomerrs : ?\E@ ! Brovise, l\ SR
& Selution B3 Duplicate :O?mmtﬁz,_M;shTut.‘Igs
F G Resuls . Transfer DataFromMew Bl 07 tuth2 MeshTutigs
T atetlc Structurd | Transfer Data To New ' hilgs
% Update @ Angle Bracket, CATPart
i Refresh .
Resat
ﬁE Rename
Propertes

Figure 7-31 Choosing the Browse option from the flyout

Browse to the location CAANSYS WBc07\Tiut02 and then select cﬂ7_ansWB__tu.t02.igs.
Next, choose the Open button from the Open dialog box; the file is imported into the
Workbench window.

Notice that a green tick mark is placed corresponding to the Geometry ce}l in the Static
Structural analysis system, indicating that the geometry for the model is imported into
ANSYS Workbench.

Choose the Save tool from the Standard toolbar; the Save As dialog box is displayed.

Browse to the location C:IANSYS_WBic07\Tut02 and save the project with the name
¢07_ansWB_tutG2.

Generating a Mesh for the Model

1.

After the file is imported, you need to generate mesh of the imported geometry.

Double-click on the Model cell in the Static Structural analysis system; the Mechanical
window is displayed.

Generating Mesh - 1 . 7-13

Note :
A yellow thunderbolt symbol is attached to Mesh in the Tree Outline indicating that there is 5,
mesh attached fo the geometry.

Now, you will first generate 2 mesh using the default settings and later use the advanced
meshing tools to generate a better mesh,

2. Orient the model by using the tools available in the Graphics toolbar, refer to
Figure 7-30. '

3. Select Mesh from the Tree Outline; the torresponding options are displayed in the Details
of “Mesh” window, as shown in Figure 7-32.

,,.
Dafaults
Physics Preferencs Wachenical

Relevance Center Coarse

i1 Ftemant Size Defaulh
Initiat Size Seed Active Assembly i
smoothing wiedium
Transitlon Fast ;
Span Angle Center Coarse

Minimum Edge Length {0umm 700 iy
HEE| Inflation

B3| Pateh Conforming Opifons

Triangte Surface Mesher | Pragram Contralied

§iER| Advanced
Defeaturing

a7

Based on the requirement of analysis, you need to select an option from the Physics Preference
drop-down list in the Details of “Mesh” window. By default, Mechanical is selected in this
drop-down list, refer to Figure 7-32. The other
options in this drop-down list are Electromagnetics, & Froject

CFD, and Explicit. B [ Model {A3)

,,@ Geomelry

H s Cosrdinate Systems
A2 Connactions

Leave the other options set as default to

generate a mesh based on the default values e Tnset .. b
assigned by the software, 3} Find Thin Sections ©. % ¢
: =4 Find Gaps snd Contacts ™.
4. Right-click on Mesh in the Tree Outline; <f Update - -
a shortcut menu is displayed, as shown in - — m——
- ST
il - S NG 7
Figure 7-33. ——i = =
Qj Clear Genaratad Qata

5. Choose the Generate Mesh option from the o Rename - .

shortcut menu, refer to Figure 7-33; the ANSYS
Workbench Mesh Status window is displayed.

Figure 7-33 Choosing the Generate Mesh
aption
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After sometime, the ANSYS Workbench Mesh Status window 13 closed and the mesh view
of the model is displayed in the Graphics screen, as shown in Figure 7-34.

Figure 7-34 The mesh view of the model

Note
The mesh preview is displayed in the Graphics screen as long as Mesh is selected in the

Tree Qutline. On selecting any other entity in the Tree Outling, the mesh preview will not be
displayed.

A green tick mark is placed corresponding to Mesh in: the Tree Outline which indicates that
the mesh for the model is created successfully. Note that while generating a mesh for a model,
it is important to understand the effect it causes on the number of elements and nodes that
are created as a result of the meshing process. It is recommended that you keep a note of the
number of elements that are created after generating each mesh. You can repeat meshing
operation to achieve better results. :

To get the details about the number of elements and nodes

created after the model is discretized, expand the Statistics Patch Canforming Options
node in the Details of “Mesh” window, refer to Trizngle Surface . | Program Con..t - {3
Fi 7 3 5 . T Advanced
gure /-32. Defeaturing
TR
After the mesh is generated, the number of elements will [l

7] Flements

be 1497 and number of nodes will be 3048. You can use
this data later to compare the effectiveness of the mesh. =
: Figure 7-35 The Statistics
Note node in the Details of “Mesh”
The values displayed in the Statistics node of the Details window

of “Mesh” window may vary in your system.

Creating the Section View
The quality of mesh is not viewed while working on a flat surface. It is generally viewed at
curved and cylindrical faces. In this tutorial, you will view the quality of mesh by creating
a section of the model.

Generating Mesh - I .
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1. Orient the model by using the tools in the Graphics toolbar, as shown in Figure 7-35

2. Invoke the New Section Plane tool from the Standard toolbar; the Section Planes

window is displayed. @l

3. Place the cursor at the position shown in Figure 7-36.

Figure 7-36 The oriented view of the model
4. Next, click and drag the cursor downward; the meshed model is sectioned, as shown in
Figure 7-87.

5. Use the tools available in the Graphics toolbar to orient the view of the model to Isometric,
as shown in Figure 7-38.

Figure 7-37 View after the model is sectioned Figure 7-38 Isometric view of the sectioned
mode]

6. Now, clear the Slice Plane 1 check box in the Section Planes window to view the complete
meshed view of the model, refer to Figure 7-34.

When the automatic method is used for meshing, different algorithms are applied at different

locations of the model, depending upon its complexities. The meshing generates hexahedrals,
sweep, or tetrabedrons depending upon the model.
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7.

Notice three small holes on the meshed model. Now, if you try to create 2 finer mesh on
this model. the number of elements will increase, which in turn, will increase the runtime
of analysis. To decrease the runtime of the analysis, you can fill the holes in the model by

using the tools available in the DesignModeler window.

Exit the Mechanical window; the Workbench window is displayed.

Optimizing the Model

Figure 7.39 Partial view of the model with
the faces selected for fill operation

After the mesh is generated, you need to remove the irregularities in the model by using
the DesignModeler window. .

In the Workbench window, double-click on the Geometry cel}; thé DesignModeler
window is displayed. Make sure you set the units to millimeter in the ANSYS Workbench
dialog box.

Choose the Generate tool from the Features toolbar to generate the model . ./ Generate
in the Graphics screen.

Choose the Fill tool from the Tools menu; Filll is attached to the Tree Outline.
Also, the corresponding options are displayed in the Details View window and
you are prompted to select surfaces of the cavity to fill.

In the Details View window, select the Faces selection box to display the Apply and Cancel
buttons.

Press CTRL and select the three faces of the lower groove and three small holes, as shown
in Figure 7-39.

Choose the Apply button in the Faces selection box; 6 is displayed in the Faces selection
box.

Choose the Generate tool from the Features toolbar to create the fill feature; the preview
of the fill is displayed in the Graphics screen, as shown in Figure 7-40.

Facesto pe
selected

Figure 7-40 Preview of the fill feature
displayed in the Graphics screen

Generating Mesh - 1
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15.
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Next, choose the Boolean tool from the Create menu: Booleanl with a yellow thunderhol
is attached to the Tree Outline. Also, the corresponding options are displayed in the
Details View window. And, you are prompted to select tool bodies for the operation.

Notice that in the Details View window, the Apply and Cancel buttons are displayed in
the Tool Bodies selection hox.

Se;lect the fll feature created, refer to Figure 7-41.

Now, hold the CTRL key and thgn select the main body, as shown in Figure 7-42,

Figure 7-41 Selecting the fill feature Figure 7-42 Selecting the main body

Select Unite from the Operation drop-down list in the Details View window, if not already
selected.

Choose the Apply button in the Tool Bodies selection box; 2 Bodies is displayed in the
Tool Bedies selection box, indicating that two bodies are selected for the operation.

Next, choose the Generate tool from the Features toolbar; the fillbody and .55 .-
. - - » " r t
the main body merge into a single body, as shown in Figure 7-43,  Genetate

Figure 7-43 The single body created after uniting two solid bodies
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Figure 7-43 shows the model with the three holes and the groove cut removed. Now, you
can generate an effective mesh on it.

Creating a Symmetricai Model o | N
The model is symmetrical in nature, therefore to save processing time, you will cut it into

two portions.

1. Right-click in the Graphics screen and then choose View > Back View from the shortcut
menu displayed to orient the model, refer to Figure 7-44. '

9. Choose the Symmetry tool from the Tools menu; Symmetryl is attached to the Tree
Qutline; the corresponding options are displayed in the Details View window. Also, you
are prompted to select the symmetry plane, and. ~

3. In the Details View window, select the Symmetry Planel selection box to display the
Apply and Cancel buttons, if not already displayed.

4, Next, click on YZPlane in the Tree Outline to select the YZ plane as the section plane,

5. Choose the Apply button available in the Symmetry Planel selection box; the YZ plane
is selected as the plane for symmetry creation.

6. Choose the Generate tooi; the symmetrical half of the model is generated, _, . -
. 2 Generate
as shown in Figure 7-45. _Lw____i

U9 Look At
&} Select All £ Lett View
:;’ Generate 5 Top View
| (B Bottom View. i
Figure 7-44 Choosing the Bach View option Figure 7-45 Isometric view of the symmetrical
Jrom the shoricut menu model

7. Exit the DesignModeler window.

Setting Global Mesh Controls
In this section, you will set global mesh controls for meshing in the Details of “Mesh”
window. Next, you will change the global mesh control settings to create an effective
mesh,

I. Open the Mechanical window by double-clicking on the Model cell of the Static
Structural analysis system; the ANSYS Workbench message box is displayed with the
message Upstream data has been modified since it was last read. Would you like to
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read the upstream data?, as shown in Figure 7-46. Choose Yes from this message box;
the Mechanical window iy displayed.

Upstrearn dats has been modified since it was last read, Would you like

to read the upstream data?

Figure 7-46 The ANSYS Workbench message box
2. Orient the model using the tools available in the Graphics toolbar, refer to Figure 7-34.

Note
As the symmetrical model was created in the DesignModeler window, Symmetry will be added

to the Tree Outline of the Mechanical window. Also, Named Selection will be displayed in
the Tree Outline.

3. Select Mesh in the Tree Outline; the Mesh contextual toolbar is displayed. Also, the Details
of “Mesh” window is displayed.

4. Toview the mesh created for the model, choose the Update button available in the Mesh
contextual toolbar.

5. Inthe Details of “Mesh” window, expand
the Sizing node.

Defauits

mEE

Siiny
6. In the Sizing node, select the On: ﬁ”‘*‘#“; e e e
Proximity option from the Use Advance Relevance Conter oft
Size Function drop-down list, as shown T Element Size On: Proximity and Curvatun
. . . - Qn: Curvature
in Figure 7-47. The default selection in Tnitial Size seed RRE
this drop-down list is Off. Smaathing

i

Figure 7-47 Selecting the On: Proximity option

This option is used to generate fine mesh for from the Use Advanced Size Function drop-down lst

the model that has small details like fillets
and curves.

7. Enter 2 in the Num Cells Across Gap edit box in the Details of “Mesh” window.

Note
You can also use the spinner available in the Num cells Across Gap edit box to set the value.

The Num Cells Across Gap edit box is available only when the On: Proximity and Curvature
or On: Proximity option is selected in the Use Advanced Size Function drop-down list, refer
to Figure 7-48. The value in this edit box signifies the minimum number of cells that will be
available in small gaps while meshing. The default value in this edit box depends on the value of



7-20 ANSYS Workbench 14.0: A Tutorial Approach

relevance set for the meshing. When 0 is specified in the Relevance edit box, the default value
in this edit box is 3. You can enter any number between 1 to 100 in the Relevance edit box.

Defaults

5| sEing
Use Advanced Size Function | O Proximity
Retevance Center Coarse
[pitial Size Seed Active Assembly
Smoothing Medium
Transition Fast
Span Angle Center Coarse
[} Proximity Accuracy 0.5
¥ 5 I
(1 Min Size Default (6.4252.06517)

Figure 7-48 The Details of “Mesh” window with
the Num Cells Across Gap edit box highlighted

Figure 7-49 shows a model meshed with the Use Advanced Size Function set to Off. The
number of nodes created when this drop-down list is set to Off is 1924 and the number of
elements is 971. Figure 7-50 shows the same model with the Use Advanced Size Function set
to On: Proximity, The number of nodes and elements when this option is selected is 17,610
and 10848, respectively.

Also, observe the size of elements at the fillets in Figures 7-49 and 7-50. You will notice that
component shown in Figure 7-50 has more number of elements as compared to the model
shown in Figure 7-49. Also, the model in Figure 7-30 has finer elements at curves and fillets.

Reduged glement
size

Figure 7-49 Section of the meshed model Figure 7-50 Section of the meshed model
created with the Use Advanced Size Function with the Use Advanced Size Function set to
set to Off On: Proximity

8. Choose the Update tool frqm the Mesh contextual too.lbar.; the mf:sh is - -4 Update
generated with all other options set to default, as shown in Figure 7-51.

9. Now, invoke the New Section Plane tool from the Standard toolbar. E@
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10. Orient the model using the tools available in the Graphics toolbar,

Figure 7-32. as shown in

i

s

e
AT

T

Figure 7-51 The mesh generated Figure 7-52 Oriented view of the model

11. Move the cursor to the location shown in Figure 7-53,

12. Now, click and drag the cursor upward; the sectioned view of the meshed model is displayed.
Next, change the view to Isometric, as shown in Figure 7-54.

Figure 7-53 Cursor position Figure 7-54 lsometric view of the sectioned
model

13. ¥rom the Section Planes window, choose the Show Whole Elements button; whole
elements are displayed in the model, as shown in Figure 7-55.

8459 ()

Figure 7-55 Partial view of the model displaying whole elements along the section plane
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Depending upon the accuracy and time allotted for analyzing this particular component,
the mesh quality is decided. For example, if you set the value in the Num Cells Across Gap
edit box to 4, more cells will be created around curved surfaces, refer to Figure 7-56. The
table given next shows the number of elements and the Equivalent Stress generated when
different values are specified in the Num Cells Across Gap edit box under the boundary and
loading conditions shown in Figure 7-57. Depending upon the severity of the analysis and
time permitted to run it, you can choose a procedure to mesh the model. When you need to
achieve extremely accurate results, you need to generate very small elements around curved
faces and fillets. '

Two elemnents across

cupvalure Fowo

]
-

Conatrained 74

]

Figure 7-56 Elements avound curved surfaces  Figure 7-57 Boundary and loading conditions

Values in the Num cells Number of elements Equivalent Stress
Across Gap edit box
Default (3) 20388 2.550 E8
1 1865 1.843 E8
2 9105 2.130 E8
6 204769 5214 E8
10 911274 ' 4.735 £8

Generally depending upon the requirement of the results, a mesh can be generated by
changing the default mesh control settings. However, when better results and more user
defined mesh is needed, you can introduce various mesh controls that are available within
ANSYS Workbench. By using mesh controls, you can control types and shapes of elements,
set mesh types, and so on.

14. Exit the Mechanical window.

Save the Project
After the Mechanical window is closed, you now need to save the project and exit the
Workbench window.

1. Save the project and exit the Workbench window.
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In this tutorial, you will first download the c07_ansWB_tui03.zip file from www.cadcim.com. After
downloading the file, you will extract it and save the ¢07_ansWB_tut03.igs file into the specified
folder. Next, you will create an effective mesh for the model. To simplify the model, you wilt
create a half section of the model. Figure 7-38 shows the model and Figure 7-59 shows the
symmetrical half of the model. Use an appropriate method to refine the mesh.

(Expected time: 2 hy)

Figure 7.58 Model for Tutorial 3 Figure 7-59 Section view of the model
displaying its indricate features
The following steps are required to complete this tutorial:

Download and import the geometry into ANSYS Workbench.
Generate mesh

Optimize the model.

Create the symmetrical Model.

Generate mesh of the sectioned model.

Create a section to visualize mesh quality.

Inserting Local Mesh Controls.

Save the Project and Exit ANSYS Workbench.

Fes ™o pp oW

Downloading and importing the Geometry into ANSYS Workbench
Before starting the tutorial, you need to download the file ¢07_ansWB_tut03.zip from
www.cadeim.com and then extract it to save the ¢07_ansWB_tut03 4gs file.

1. Create a folder named Tut03 at the location C:\ANSYS WBIcO7.

2. Download the igs file c07_ansWB_twt03.zip from www.cadcim.com. The complete path for
the file to be downloaded is:

Texthooks > CAE > ANSYS > ANSYS Workbench 14.0: A Tutorial Approach > Input Files

After downloading the zip file, extract it and save the ¢07_ansWB_nut03 igs file at location
CAANSYS_WB\cO7\Tut03.

8. Start ANSYS Workbench 14.0 from the Start menu; the Workbench window is displayed.
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4. Add the Static Structural analysis system to the Project Schematic window.

5. Right-click on the Geometry cell of the Static Structural analysis system and then choose
Import Geometry > Browse from the shortcut menu displayed, as shown in Figure 7-60;
the Open dialog box is displayed.

4 Hew Geometry—
QU s ea s s SULE
§ |3 Soktion Q oupleate B co7_tuna MeshTutios
7 I Reaults 0 Trorafur DataFromben v 1T 007 _tu0d MashTubig
“totie Strugkurd: - Tranafer Data To pew r 8 his
ot TR sege bt catran
& Refresh )
Rezst
E Reneme
Pooperbes
Quidk Helpy

Figure 7-60 Choosing the Browse option from the shortcut men

6. Browse to the location C:ANSYS_WBic07\Tut03 and then select ¢G7_ansWB_tut(2.igs.
Next, choose the Open button from the Open dialog box; the file is imported into the
Workbench window. Also, 2 green tick mark Is
placed corresponding to the Geometry cell in the
Static Structural analysis system indicating that a
geometry is specified for the analysis.

[214F EngnestngDate v 4
s Gegmebry v ‘!

@
7. Inthe Workbenchwindow, choose the Savebutton; s |@ sew [, 700 "0
the Save As dialog box is displayed. : l: z“a“ﬁ: Transfer Data FromMews
i E5L
L Transfer Date To Naw 3
8 In this dialog box browse to the location Stetic Struct G e
CAANSYS _WB\c07\Tii03 and then save the project A aefesh
with the name ¢07_ansWB_tut03. Clear Generated Dats
) Reset
Generating a Mesh for the Model i Renane
Once the file is imported, you now need to assign o
a material to it and then generate a mesh. Quicktely

Figure 7-61 Choosing the Edit option

. Richecli . tic St
1. Right-click on the Model cell in the Static Structural from the shorteut menu

analysis system and then choose Edit from the
shortcut menu displayed, as shown in Figure 7-61; the Mechanical window is displayed.

2. In the Mechanical window, right-click on Mesh in the Tree Outline; a shortcut menu is
displayed. Also, the Details of “Mesh” window is displayed.

3. Choose the Generate Mesh tool from the Graphics toolbar, to generate a
mesh with default settings provided by ANSYS Workbench, refer to
Figure 7-62.

1} Generate Mash
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4. Inthe Details of “Mesh” window, expand the Statistics node to view the number of nodes
and elements in the model:

After generating the mesh by using the default mesh control settings, the approximate
number of elements and nodes generated in the model will be 95500 and 150000
respectively, refer to Figure 7-63. '

Skring -
inflation :

o]

Assembly Meshing

5
Advanced
Defeaturing
Statistics
[} Hodes ERARE
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Mesh Metric Mone
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Figure 7-63 The Details of “Mesh” window
with the Statistics node expanded

Figure 7-62 Meshed model

Note
The number of elements and nodes tn your system may vary from this tutorial.

You will also notice small features in the model such as holes, chamfers, fillets, and so o1, 45
shown in Figure 7-64. The mesh generated using the default settings, generates elements
for the small features in the model. This increases the element count that inturn increases
the computing time. For an effective analysis, you need to reduce the complexities in the

model. Filling the holes and deleting the chamfers and filets will make the model more
simpler.

5. Exit the Mechanical window; the Workbench window is displayed.

Small
Fillat =

Small Hole Fillet

Tiny Chamter Thin Gaps

Figure 7-64 Small features available in the model

Optimizing the Model

After generating the mesh using the default settings, you need to optimize the model.
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I. Inthe Project Schematic window, double-click on the Geometry cell; the DesignModeler
window along with the ANSYS Workbench dialog box is displayed.

2. Inthe ANSYS Workbench dialog box, select the Millimeter radio button and then choose
the OK button: to specify millimeter as the unit. Also, the DesignModeler window is
activated.

$. In the Tree Outline, the Importl node is attached with a yellow thunderbolt indicating
that you need to generate the geometry to proceed further. :

4. Now, choose the Generate button in the Features toolbar; the model is
displayed in the Graphics screen. Also, a green tick mark is displayed before
Importl in the Tree Outline,

e
nT 4 1
37 Generate

(624

Change the view to Isometric.

You will notice that there are six holes on the front of the model, as shown in Figure 7-65
and they need to be eliminated.

ik

Figure 7-65 Holes on the front of the model

6. Choose the Fill tool from the Tools menu; Filll with a yellow thunderbolt is Eil
added in the Tree Outline. Also, the corresponding options of the Fill tool :
are displayed in the Details View window and you are prompted to select faces that form
holes or cavities.

The Fill tool is used to fill depression lines, uneven surfaces, dents, and holes in the model.
To create a fill feature, you need to select surrounding surfaces in such a manner that a frozen
or dead material is Ailled in the selected area.

7. Make sure that By Cavity option is selected in the Extraction Type drop-down list in the
Details View window.

The By Cavity option is selected by default in the Details View window. This option is used
to create fills around selected surfaces. The By Cavity option is used with solid bodies only.
ANSYS will display a warning if this option is used for surfaces.

Generating Mesh - [ : 7-27

You can select the By Caps option from the Extraction Type drop-down list for the
Computational Fluid Dynamics analysis. On selecting this option, a replica of the fluid is
created in an enclosure. You can use this option for both solids and surfaces.

8. In the Details View window, expand the Details of Filll node, if it is not already
expanded.

9. Click on the Faces selection box to display the Apply and Cancel buttons, if they are not
already displayed.

10. Now, choose the Face tool from the Select toolbar, @

11, Now, select all the holes on the front face of the model by using the CTRL key, as shown
in Figure 7-66.

12. In the Details View window, choose the Apply button to confirm the selection; 6 is displayed
in the Faces selection box.

13. After the holes are defined, choose the Generate tool; the fills are created [z
X . . i ’ A G t
in holes, as shown in Figure 7-67. + HEnee

N S S

Figure 7-66 Holes to be selected Figure 7-67 Fills created
After creating the fills, you need to merge these fills with the main body.
14. Choose the Boolean tool from the Create menu; Booleanl is added to the

Tree Outline. Also, the corresponding options of the Boolean tool are
displayed in the Details View window.

Ec&gie&n

The Boolean tool is used to unite, subtract, and intersect existing bodies.

15. Select the Unite option from the Operation drop-down list of the Details View window,
if it is not already selected, as shown in Figure 7-68.

The Unite option is used for merging solid bodies.
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16. Click on the Tool Bodies selection box; the Apply and Cancel buttons are displayed.

17. Select the six fills created, as shown in Figure 7-69.

Eﬂ Details of Booleanl

Boolean IBuolearﬁ

[
Towt Bodies

subtract
Intersect

Figure 7-68 Selecting the Unite option Figure 7-69 Selecting the holes with the fills
from the Operation drop-down list

18. Next, select the main body, as shown in Figure 7-70, and then click on the Apply button
to confirm selection. The Tool Bodies selection box now displays 7 Bodies. Also, the color
of the model changes to cyan.

19. Choose the Generate tool from the Features toolbar; the fills in the holes and the main
body merge into a single body and the holes with the fills are no more visible, as shown
in Figure 7-71.

Figure 7-70 Selecting the main body Figure 7-71 Model after merging the holes
with the main body

Now, you need to create fills for the holes of smaller diameter.
20. Invoke the Fill tool again from the Tools menu; Fill2 is attached to the Tree Outline.

21. Select all the holes of smaller diameter, as shown in Figures 7-72.

22. Now, choose the Apply button from the Faces selection box; 8 is displayed in the Geometry
selection box. :
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23. Make sure that the By Cavity option is selected in the Extraction Type drop-down list in
the Details View window. Next, choose the Generate tool from the Features toolbar: the
fills are created in the selected cavities, }

Figure 7-72 Holes selected for fill operation

zgft;r the fills are created, you need to merge them with the main body to create a single
ody.

24. Choose the Boolean tool from the Create menu; Boolean? is attached to the Tree
Outline.

. Select the holes on which filis were created and then select the main body. Next, choose

the Apply button from the Tool Bodies selection box; 9 Bodies is now displayed in the
Tool Bodies selection box,

26. Choose the Generate tool from the Features toolbar to generate the features.

The mode! after filling the holes and merging them with the main body is shown in
Figures 7-73 and 7-74.

Figure 7-73 Back View of the model afier Figure 7-74 Front View of the model afier
holgs are filled and then merged with the holes are filled and then merged with the
main body main body

After optimizing the holes, you now need to look into some other details in the models.



7-30 ANSYS Workbench 14.0: A Tutorial Approach

There are slots on the top of the model and these slots contain small fillets o_f 1 mum
radius. Removing these small details will help improve the topology for meshing and
will reduce the element count. There are four slots on the top of the model, as shown in
Figure 7-75.

97. Invoke the Face Delete tool from the Create menu; FDeletel with a yellow & Face Delete
thunderbolt is attached to the Tree Outline.

28. Select the fillets present on the slot, as shown in Figure 7-76, and then choose the Apply
button in the Faces selection box. On doing so, 4 is displayed in the Faces seI.ecuon box.
which indicates that four faces have been selected for the Face Delete operation.

Figure 7-75 Slot with fillets displayed Figure 7-76 Selecting fillets

99. Choose the Generate tool available in the Features toolbar; the fillets on the selected slot
are deleted. Also, a green tick mark is placed before FDeletel in the Tree Outline.

30. Similarly, by using the Face Delete tool, delete the fillets available on the other three slots
in the model.

After the fillets are removed from the slots
present in the model, you now need to
fill the slots to simplify the geometry.

Facesto
31. Choose the Fill tool from the Tools menu; select

Fill3 is attached to the Tree Qutline.

32. Select the Faces selection box to display
Apply and Cancel buttons, if they are
not already displayed.

3%. Select the five faces of the slot, as shown
in Figure 7-77.

R G

Figure 7-77 Faces selected for the fill feature

%4. Similarly, select all other faces of the
remaining slots.
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R

35. Now, choose the Apply button from the Faces selection box; 20 is dispiayed in the Faces
selection box.

36. Right-click on the Graphics screen; a shortcut menu is displayed. Next, {T;T\‘
! -5 Lienerate
choose Generate from it to create the fill feature,

Now, you need to unite the fills with the main body.

37. Choose the Boolean tool from the Create menu; Boolean3 is attached to the Tree Qutline.
Also, a yellow thunderbolt is displayed before Boolean3 in the Tree Outline.

38. Select the slots on which fills are created and then select the main body.

39. In the Details View window, choose Apply from the Tool Bodies selection box; 5 Bodies
is displayed in the Tool Bodies selection box.

40. Choose the Generate tool to merge the fills in the slots and the main body as one
component.

Next, you will fill the groove in the model, as shown in Figure 7-78,

41. Use the tools available in the Graphics toolbar to zoom closer to the groove cut on the
cylindrical part of the model.

42. Choose the Fill tool from the Tools Menu; Fili4 is attached to the Tree Qutline.

43. In the Details View window of the Fill tool, select the Faces selection box to display the
Apply and Cancel buttons.

44. Now, select the faces shown in Figure 7-79.

Faces selected
for creating fill

Groove to
be filled

i

Figure 7-78 Groove to be filled Figure 7-79 Selecting fuces

45. Now, choose the Apply button from the Details View window; 3 is displayed in the Faces
selection box.
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46. Choose the Generate tool from the Features
toolbar; the fill feature is created and a
green tick mark is placed before Fill4 in the
Tree Outline.

47. Similarly, fill all the grooves in the
cylindrical feature of the model, as shown

in Figure 7-80.

Note
1. Tb hawe access to all the faces of the groove,

use the tools available in the Graphics Figure 7-80 Groouves to be filled highlighted in
toolbar. green '

2. T create a fill between two walls of varying height, select the wall wpto which you want to
create the fill feature.

3. In the Tree Outline, Fill5 represents all the fills created in Step 47.

48. Now, after the grooves on the cylindrical features are filled, merge them with the main
body by using the Boolean tool from the Create menu.

Next, you have to delete small fillets and chamfers to make the model simpler, as shown
in Figure 7-81.

40. Use the Delete Faces tool from the Create menu to delete small fillets and chamfers in
the model, refer to Figure 7-81.

The model after optimization should look like the one shown in Figure 7-82.

Chamifers io be’
removedd

Fillats to be
removed

Figure 7-81 Fillets and chamfers to be Figure 7-82 Model afler optimization
removed
Creating the Symmetrical Model

Note that the model is symmetrical in nature. Therefore a symmetrical half can be created
to increase the efficiency of meshing. Itwill decrease the element count and also improves

visibility of the model.
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L. Invoke the Symmetry tool from the Tools menu; Symmetryl gets attached

to the Tree Outline and you are prompted to select a symmetry plane. 4k Symriistry

2. Click in the Symmetry Planel selection box to display the Apply and Cancel buttons, if
they are not displayed by default. ’

3. In the Tree Outline, select YZPlane; a preview of the plane is displayed in the Graphics
screen, as shown in Figure 7-83.

4. Choose the Apply button from the Symmetry Planel selection box.

Now, you will generate the symmetrical half of the model.

o

Choose the Generate tool from the Features toolbar; the half section of the —
model is created, as shown in Figure 7-84, % Generate

6. Close the DesignModeler window; the Workbench window is displayed.

Figure 7-83 Preview of the plane for creating Figure 7-84 Half-section of the model
the section of the model

Generating Mesh of the Sectioned Model
After the model is optimized, you need to generate mesh for the optimized model.

L. In the Project Schematics window of the Workbench window, right-click on the Model
celland then choose the Refresh tool from the shortcut menu; the project is updated with
the optimized geometry data.

2. Double-click on the Model cell of the Static Structural analysis system to open the
Mechanical window,

3. In the Tree Outline, right-click on Mesh; a shortcut menu is displayed
» righ ; yed, .o
Chgose the Update option from it to generate the mesh with default M
settings; the mesh is generated on the sectioned model, as shown in
Figure 7-85.
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The element count after generating the mesh
with default settings is 5572. Note that the
mesh generated in this model will not be
uniform.

Note

If all the imperfections or minute details are
removed, the element count in your system unll
display 5572. However, if your model 1s not
optimized accurately like the model shown in .
Figure 7-85, the element count may vary in

your case. Figure 7-85 Mesh generated on the sectioned
model ‘

Creating a Section to Visualize Mesh

Quality o
To have a better visibility of the volume cells, you need to visualize the model through a
section plane. '

1. Right-click in the Graphics screen and then choose View > Left from the shortcut menu
displayed; the model is oriented as shown in Figure 7-86.

9 Choose the New Section Plane tool from the Standard toolbar; the Section Planes f%‘@
window is displayed on the left of the Graphics screen. :

3. In the Graphics screen, place the cursor as shown in Figure 7-86 and drag it in such a
manner that the section of the model is created, as shown in ¥igure 7-87.

Figure 7-86 The model after orientation Figure 7-87 Sectioned model

4. Choose the Show Whole Elements button from the Section Planes window to visualize
the volume cells, as shown in Figure 7-88.

5. Now, choose the Show Whole Elements button from the Section Planes window again
to turn the visibility of the volume cells off.

The visualization of volume cells will help you understand the effect of generating a better
mesh later in this tutorial.
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Figure 7-88 Volume cells created on the mesh with default settings

Inserting Local Mesh Controls
Now, you will generate a mesh by using the local mesh control settings.

An effective mesh can be generated by changing the settings for a particular zone or region of
the model. These settings are also known as local mesh control settings. The various local mesh
control tools can be accessed from the Mesh Control drop-down in the Mesh contextual toolbar,
as shown in Figure 7-89. These options can also be accessed from the shortcut menu displayed
when you right-click on the Mesh node in the Tree Outline, as shown in Figure 7-90,

G, Mesh Control g_i i Metric Grag
&) Method - b B

B, Mesh Group: S o 15 @ Method.
At st - e
B Siirigr. - "{';3 v 3 Update Lo BsEng
*&_Coqtafgs‘rz.ing e ¥l <4 Generste Mesh W, Contact Szing ‘
A Refinernent /A ! £ Refinément. ) -7
— * Praview » -
B Mapped Face Meshing * o | B8 Mapped Face Meshing
208 : 3 ’@Matthl
@ M.atch antrol : S L. 37 Create Pinch Controls " - ) eh Lonteo
] pineh - o R f2s) Finch
A nflation " - i Clear Generated Deta. - . £ Inflation.
SharpAngle ¢ 6% Renams. .- o S
39 Gap Tool - - Start Recording
Figure 7-89 Options in the Mesh Control Figure 7-90 Various local mesh control
drop-doum options in the shortcul menu

. Right-click on the Mesh node in the Tree Qutline; a shortcut menu is displayed, refer to
Figure 7-90.

2. Next, choose Insert > Method from the shortcut menu, refer to Figure 7-90; Automatic
Method with a question symbol is added under the Mesh node in the Tree Qutline. Also,
the Details of “Automatic Method” window is displayed.

There are various methods that can be used to create a mesh. First, by specifying the shape
of elements. Second, by using an algorithm. The algorithms are listed in the Method option
available in the Mesh Control drop-down of the Mesh contextual toolbar. When a method
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control is inserted into a mesh, it appears as a new instance under the Mesh node in the Tree
Outline.

3. In the Details of “Automatic Method” window, click on the Geometry selection box to
display the Apply and Cancel buttons.

4. Choose the Body tool from the Select toolbay, if it is not already chosen. @

5. Select the model and then choose the Apply button in the Geometry selection box; the
Geometry selection box dispiays 1 Body in the selection box.

6. In the Method drop-down list, select the Tetrahedrons option, as shown in Figure 7-91;
the Algorithm drop-down list is displayed below the Method drop-down list. Also, the
Details of “Automatic Method” window is replaced by the Details of “Patch Conforming
Method” window.

The Tetrahedrons method is used when all the elements required are tetrahedral. This method
is applied only in case of solid bodies

L
[} Scope

Scoping Method Geometry Selection

Geometny 1 Body
[)] Definition

MuitiZone

Figure 7-91 Selecting the Tetrahedrons option
from the Method drop-down list

7. In the Details of “Patch Conforming Method” window, select the Patch Independent
option from the Algorithm drop-down list, as shown in Figure 7-92; the Patch Conforming
node is replaced by Patch Independent. Also, the Details of “Patch Conforming Method”
window is replaced by Details of “Patch Independent Method” window.

8. Inthe Details of “Patch Independent Method”

h Conforming Method® < Method ¥
window, expand the Advanced node and '

specify .004 in the Max Element Size edit
box.

When the Patch Independent algorithm is used,
smaller elements are created at regions of higher
importance. Similarly, it creates larger elements at
regions of less importance. Using this algorithm
the model is discretized in an effective way.

Scoping Method

Geomatry Selection

Gapmeatry

1 Body

W

{efinition

Suppressed

Mo

Method

Tetrahedrons

4 Patch Conforming
nfarmin

AT ;&aﬁ&r@%@

w

Figure 7-92 Selecting the Patch Independent
option from the Algorithm drop-doun list
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9. In the Minimum Size Limit edit box, enter .003.

The Minimum Size Limit edit box is displayed only when Yes is selected in the Curvature
and Proximity Refinement drop-down list. Specify a value in this edit box to prevent the
software to create elements of smaller size than the specified value.

16. Now, enter 2 in the Num Cells Across Gap edit box.
" Note

Depending on the requirement, different parts and bodies in a system can have different
algorithms.

11. Accept all other default options in the Details of “Mesh” window and then . - 4 Update
choose the Update button from the Mesh contextual toolbar; the mesh for -
the model is created, as shown in Figure 7-93.

Figure 7-94 shows the sectioned view of the mesh displaying the volume cells.

Figure 7-94 Sectioned view of the
specified settings model displaying volume elements

Figure 7-93 Mesh generated with the

12. Exit the Mechanical window; the Workbench window is displayed.

Save the Project and Exit ANSYS Workbench
After generating the mesh, you need to save the project and exit the ANSYS Workbench
session.

1. Save the model by choosing the Save button from the Standard toolbar; the $[ Save
model is saved with the name ¢07_ansWB_tut)3.

2. Exit the Workbench window to end the ANSYS Workbench session.
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Answer the following questions and then compare them to those given at the end of this
chapter:

1. When a new method is applied on the model, Automatic Method is displayed under the
Mesh node in the Tree Qutline. (T/F)

2. There are two algorithras available for a Tetrahedron method. (T/F)

3. The Patch Independent option is selected by default in the Algorithm drop-down list
(T/F)

4. Tn ANSYS Workbench, you cannot view the wireframe mode of the model. (T/F)

5. All the options available under the Mesh Control drop-down in the Mesh contextual
toolbar are global mesh control options. (T/F)

6. By default, the By Cavity option is selected in the Extraction Type drop-down list in: the
Details View window while creating fill features of surfaces. (T/F)

7. The tool is used to generate a mesh for a model,

8. When you do not specify any method for generating a mesh in ANSYS Workbench, by

default, the method is selected.
9. You can create the section views of a mesh by using the tool.
10. The tool is used to create a symmetry of the model.

Answer the following questions:

1. The tools available in the Mesh contextual toolbar are also available m the shortcut menu
displayed when you right-click on Mesh in the Tree Qutline. (T/F)

2. You can control the sizing of the mesh by using the options available in the Details of
“Mesh” window. (T/F)

3. For complex models, tetrahedrals elements are generated. (T/F)

4. You can view the total number of elements in the Statistics node in the Details of “Mesh?
window. (T/F)

5. You can rename Mesh available in the Tree Qutline. (T/F)
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6. By default, ANSYS Workbench generates the mesh with and

: L . models
wherever possible, but genérates in more complicated areas,

7. Which of the following tools is used to change the size of elements in a particular region

of a model?
{a) Refinement (b) Mapped Face Meshing
~ {c) Pinch {d) Generate Mesh
8. Which of the following methods is used to introduce Patch Independent algorithm into
meshing.
(2) Hex Dominant (b) Automatic
(c) Sweep (¢) Tetrahadrons

EXERCISE
Exe

Openr the project created in Exercise 1 of Chapter 5. You will first open the file and save it with
the name ¢07_ansWB_Exr(1. The model and its dimensional values are given in Figures 7-95
through 7-98. Share the model with a Static Structural analysis system and then generate a

megh for the model with the defauls settings. Next, change the global and local mesh settings
as given below: {Expected time: 1 hr)

Global mesh control settings:
Use Advanced Sizing Function set to Proximity
The Number of cells Across Gap should be 4

Local mesh contro} settings
Introduce Refinement at the small duct at the front of the model.

Figure 7-95 Model for Exercise 1 Figure 7-96 Top view of the model with the

hidden lines suppressed for clarity
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Sectian A—A

Figure 7-97 Lefi side view of the model with Figure 7-98 Sectioned view of the model
the hidden lines suppressed for clarity

* Understand contacts.’
* Generate mesh for surface

Answers to Self-Evaluation Test
1.7 2.7, 3. F 4. T, 5. F 6. F, 7. Generate Mesh, 8 Automatic, 9. New Section Plane,
10. Symmetry
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In the previous chapter, you used some of the tools land g}obal and l‘ocal mesh control set.tir%gs
to generate a mesh. Also, you used various tools available in the DesignerModeler to optimize
a mode). In this chapter, you will use some more tools and more g_lobal and local mesh control
settings for generating a mesh. Also, you will use tools and options to generate meshes for
assemblies and surface models.

TUTORIALS

In. ;his ‘tutorial, ydu will generate a mesh for the model shown in Figure 8-1 and then agply
face sizing controls on all the curved faces of the model. This can be acce§sed.by downloading
the zip file c08_ansWB_tut01.zip from www.cadcim.com and then extracting it to the desired

folder.

Figure 8-1 Isometric view of the model for Tutorial 1

The.following steps are required to complete the tutorial:

Download the part file.

Start a new project and import the file in ANSYS Workbench.
Set global mesh controls and generate the mesh.

Set locat mesh controls and generate the mesh.

Refine the mesh.

Save the project.

mo a0 o

Downloading the Part File
Before starting the tutorial, you need to create two folders and download the file from

www.cadcim.com.
1. Create a new folder with the name ¢08 at the location C:\ANSYS_WB.
9. Next, create another folder named as Tut01 at the location CAANSYS_WBIcUS.

3. Download the file ¢08 ansWB_tut0@.zip from www.cadcim.com. The complete path to
download the file is as follows:

Texthooks > CAE > ANSYS > ANSYS Workbench 14.0: A Tutorial Approach > Input Files

Generating Mesh - II 8.3

After downloading, extract the zip file to save the igs part file c08_ansWB_tut0] .igs at the
location C:AANSYS WB\c08\Tut0 1.

Importing the File in ANSYS Workbench

After downloading the file from www.cadcim.com, you need to import the file into ANSYS
Workbench.

1. Start ANSYS Workbench to display the Workbench window.

2. In the Workbench window, add the Modal analysis system into the Project Schematic
window.

3. Right-click on the Geometry cell of the Modal analysis system to display a shortcut
menu.

4. Choose the Import Geometry option from the shortcut menu; a flyout is displayed.
5. From this flyout, choose the Browse option; the Open dialog box is displayed.

6. Browse to the location CAANSYS_WBIc08\Tut0] and then open c08_ansWB_tut01.igs; a
green tick mark is placed in the Geometry cell of the Modal analysis system indicating
that the geometry is specified for the analysis.

7. In the Workbench window, choose the Save button from the Standard toolbar; the Save
As dialog box is displayed. '

8. In this dialog box, browse to the location CANSYS_WB\c08\Tut01 and then save the
project with the name c08_ansWB_tut01.

Setting Global Mesh Controls and Generating Mesh

After the file is imported, you need to set the global mesh control settings to generate a
mesh.

1. In the Project Schematic window, double-click on the Model cell; the Mechanical window
along with the model is displayed, refer to Figure 8-2.

Note
The orientation of the model in Figure 8-2 has been. changed for better visibility of the model,

2. Select Mesh in the Tree Outline; the Details of “Mesh” window is displayed, refer to
Figure 8-3.

3. Inthe Details of “Mesh” window, expand the Defaults node, if it is not already expanded.
4. Enter 50 in the Relevance edit box,

5. Next, expand the Sizing node, if it is not already expanded.
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Notice that very small fillets and holes are displayed in the model. To generate a mesh
to suit the model with rounds, fillets, and curves, you need to change the global mesh
control settings.
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Figure 8-2 The Mechanical window with the engine mount model displayed in it

6. Select the Om: Proximity option from the Use Advanced Size Function drop-down list.

7. Specify 0.5 in the Proximity Accuracy edit box, if it is not already specified.

| Defavlls
Phyrics Preference
Cifieidance
3 Siring

8. Specify 2 in the Num Cells Across Gap edit box.

Thiedhanicar
0

9. Specify 4 in the Proximity Min Size edit box. e painiad s ey G Hanky
' Aelenoe Center iGeaae
il bied 7 Thdbie besematy

i Mediin
Fast
Coar

10. Specify 6 in the Max Face Size edit box.

Hut Cafs Aeeass Gap e
Praximity Min 5zt 4.8 mm

11. Next, specify 9 in the Max Size edit box, refer to

. disy Face Size - &3 mm
Flgure 8-8. gz agwm
Gk g a5
o tdeimum Egge Length LASEE I m, . i

12 Right-click on Mesh in the Tree Qutline to display a

shorteut menu. Figure 8-3 Partial view of the

Details of “Mesh”™ window

13. Next, choose the Generate Mesh option from the shorwcut menu; the mesh with the
specified global control settings is generated, as shown in Figure 8-4.

Note
1. The number of elements and nodes after generating the mesh are 38,550 and 73,691,
respectively.

2. It is always important to keep a track of the number of elements so that you can later compare
the quality of the mesh with the element count and decide whether you need to further refine
the mesh.
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Figure 8-4 Mesh generated with global
mesh control settings

Setting Local Mesh Controis and Generating a Mesh
Global mesh controls ave the settings that are applied to the whole component considered
for meshing. However, if required, you can generate mesh of varying refinement on
different regions by setting the local mesh controis.

1. Choose the Sizing tool from the Mesh Control @m hlesh Controf «
drop-down in the Mesh contextual toolbar, as shown in —
Figure 8-5; Sizing is added under the Mesh node in the % Niethc}d HIEI
Tree Outline. Also, a question symbol is attached to Sizing %, Wesh Group
indicating that values for this field are yet to be satisfied. iﬁﬁ T

",

Note M, Contact: iZing -
You can also choose the Sizing option from the shortcut menu A% Refinernent
that is displayed when you right-click on Mesh in the Tree I s
Outline. Figure 8-5 Partial view of the
Mesh Control drop-down

2. Select Sizing from the Tree Outline, if it is not already
selected; the Details of “Sizing” window is displayed. Also, the Apply and Cancel buttons
are displayed in the Geometry selection box indicating that you need to select the faces,
edges, or bodies to be sized.

3. Choose the Face toel from the Select toolbar. @

4. Select all the cylindrical faces, as shown in Figure 8-6. Next, choose the Apply button from
the Geometry selection box in the Details of “Sizing” window; 62 Faces is displayed in
the Geometry selection box, indicating that 62 faces have been selected for sizing.

Notice that in the Tree Outline, Sizing is replaced by Face Sizing. Also, the Details of
“Face Sizing” window is displayed below the Tree Outline.

Note
The number of faces selected for face sizing may vary as there ave many small cylindrical faces
in the model. Therefore, you need to be very careful while selecting the faces.
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Figure 8-6 Selecting cylindrical faces in the component

In the Details of “Face Sizing” window, expand the Definition node, if it is not already-

expanded.

In the Type drop-down list, make sure that the Element Size option is selected. Next,
specify .002 as the element size in the Element Size edit box.

Choose the Update tool from the Mesh contextual toolbar; the mesh with local mesh
control is generated, as shown in Figure 8-7.

Note that the total number of elements in this case is 42,781 which is more than 38,550.
Also, if you compare Figures 8-4 and 8-7, you will notice that even though the element
count does not seem to grow very fast nurmerically, the actual number of elements in the
model has increased, refer to Figure 8-7.

Create a section view of the model and change the view to Isometric, as shown in Figure 8-8.

Rt
0.41$ 125

Figure 8-7 Mesh generated with local settings  Figure 8-8 Sectioned isometric view of the model
with the elements displayed

You can have a close look at the shape and sizes of the elements by using the tools available
in the Graphics toolbar. You will notice that the sizes of elements have changed. You can also
compare the mesh result of Figure 8-9 with that of Figure 8-4 to note the difference.

Exit the section view.
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Figure 8-9 Partial view of the sectioned model
with a closer look at the elements formed

Refining the Mesh

After changing the {nesh locally by introducing sizing into it, you can further refine the
mesh wherever required by using various mesh controls available under the Mesh Control
drop-down in the Mesh contextual toolbar.

Right-click on the Mesh node to display a shortcut menu.

Choose Insert > Refinement from the shortcut menu; Refinement is added EE&. Refinement
under the Mesh node in the Tree Outline, with a question symbol attached '
to it.

Select the Refinement node to display the Details of “Refinement” window.

Refinement is applied to edges, faces, and vertices. It cannot be applied to the whole body.
It is a local mesh control and by applying it to a face, edge, or vertex, you can further reduce
the size of the elements. After applying refinement control to a face, edge, or vertex, if you
del‘ete Refinement from the Tree Cutline, the mesh of that particular region will be restored
to its previous state.

4.

In the Details of “Refinement” window, expand the Definition node, if it is not already
expanded.

In the Definition node, specify 1 in the Refinement edit box, if it is not already
specified.

Select the Geometry selection box in the Scope node of the Details of “ Refinement”
window; the Apply and Cancel buttons are displayed.

From the Select toolbar, choose the Face tool to select faces to refine.
Select the face shown in Figure 8-10. Next, choose the Apply button from the Geometry

selection box in the Details of “Refinement” window; 1 Face is displayed in the Geometry
selection box indicating that 1 face has been selected to apply refinement.
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In this tutorial, you will generate mesh for different components of the Bench Vice
assembly created in Tutorial 2 of Chapter 6. Figure 8-12 shows the Bench Vice assermbly.
‘The model is not considered for any analysis. However, you need to add Static Structural
analysis system to the Project Schematic window just for a better understanding
of the process of generating mesh for assemblies, (Expected time: 2 hy)

Figure 8-10 The face to be selected

9. From the Mesh contextual toolbar, choose the Update tool to generate the , :
mesh with more local mesh controls applied. Figure 8-11 shows the partial 3/ Update
view of the model with the mesh generated and refine control applied on
it

Figure 8-12 Bench Vice Assembly
The following steps are required to complete this tutorial:

Transilion Area a. Open the existing project.
b. Generate mesh for the assembly component.
c. Introduce local mesh controls.
d. Save the project.
"\ | Opening the Existing Project
Refined Face Before starting the tutorial, you need to open the c06_ansWB_tut03 file from the
. CMNSYS_WB\e06\Tut03 folder and then save it with a new name.
Figure 8-11 Mesh generated on the face with refinement :
control applied on it : L. Start ANSYS Workbench to display the Workbench window.
10. Close the Mechanical window; the Workbench window is displayed. : 2. Choose the Open button from the Standard toolbar; the Open dialog box
: is displayed.
You will notice that the face where refinement was applied has refatively smaller element
size as compared to the other areas of the model. 3. Browse to the location: C:\ANSYS_WBic061Tut03 and open o
the ¢c06_ansWB_tut03 file; the Static Structural analysis T
Saving the Model systemn is displayed in the Project Schematic window. o Erginesring Data "
. Ty )
Aft hing th del, you need to exit the Mechanical window and save the . i
€r meshing the mo youn X echant ' 4. TDwouble-click on the name field of the Static Structural _3' ) Gecmety “/ &
project. . . . 4|0 Model ay
analysis system and rename it to Bench Vice Assembly, as S8 o ~
. . etup ¥
1. In the Workbench window, choose the Save button to save the model with the name shown in Figure 8-13. P P 7 :
08 _ansWB_tut01. 3
CHo_ansTrD 5. In the Workbench window, choose the 8ave As button from A 7 4

9. Txit the Workbench window to end the session. the Standard toolbar to invoke the Save As dialog box,

Figure 8-13 Renaming the
6. In this dialog box, browse to the folder CAANSYS_WBIc08  analysis sysiem to Bench Vice
and then create the folder named as Tut02 in it. Assembly
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7. Next, browse to the Tut02 folder and then save the project with the name
c08_ansWB_tut02.

Setting Contacts and Generating Mesh

Now, you need to set the contacts among the components and also generate mesh for all
the components of the assembly.

1. Double-click on the Model cell of the Bench Vice Assembly analysis system; _the
Mechanical window is displayed.

9. Expand the Connections node to display the Contacts node, as shown in Figure 8-14.

3. Rxpand the Contacts node under the Connections node to display the list of contacts
available for the assembly, as shown in Figure 8-15.

- A Contacts

------- o ., Contact Region

------- .+ B, Contact Region 2

g » B, Contact Redion 3

@] Project S » B Contz{"Region 4
= Model (A4) 1 I B Contact Region 5

' 2,8 Geometry o .+ B, ContactRegion 6

S e i s .
-1 Comirtegyeene T GontactRegion 7

3 » s
..... B Contacts | I w,;ﬁl,\ Contact Region 3
il Mesh - B Cantact Region 9
?G___{ $~t'§tic5tmctural(A5) ef."@& Contact Region 10
é v, ;E% ‘;’;L"ﬁis Seﬁgs R B Contarct Region 11
P KT » .
i Solution Infarmaton ""'"w"ﬁn Contact Reg?m 12
. e B Contact Regior 13

Figure 8-14 The initial Tree Outling in the  Figure 8-15 Partial view of the Contacts
Mechanical window node under the Connections node

4. Right-click on the Contacts node and then choose the Rename Based on Definition option
from the shortcut menu displayed; the contacts are renamed, refer to Figure 8-16.

Note

1. When you expand the Contacts node in the Tree Ouiline, the default names of the contacts
are displayed as Contact Region, Contact Region 2, and so on depending upon the mumber of
contacts. When you right-click on any name and then choose the Rename Based on Definition
option from the shortcut meny displayed, the names of the contacts will change according to
the type of contact specified in the Details window. Also, the names of the components will be
displayed.

2. In the Tree Outline, expand the Geometry node; the list of componenis in the assembly is
displayed. To rename a component, right-click on it in the Tree Outling; a shorteut menu is
displayed. From this shortout menat, choose Rename; the name of the component gets highlighted.
Enter a new name to rename it.
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Whenever you import an assembly into ANSYS Workbench, the contact situation arises, This
is because when an assembly is imported, all the relations among various components of
the assembly are converted into contacts. These contacts are then displayed in the Contacts
node under the Connections node in the Tree Outline. If you have provided names to all the

components of the assembly, the corresponding names and the contact type will be displayed
under the Gontacts node.

After you renamed all the contact regions based on the names of the components, you
will observe that the type of contact applied among the components is bonded.

5. Select Bonded - Slider Guide To Slider Base from the Contacts node, as shown in

Figure 8-16; the Details of “Bonded - Slider Guide To Slider Base” window is displayed,
as shown in Figure 8-17.

v & e Te Shide
B, Bended -Knob To Handle
v Sco
- B, Bonded - Knob To Handle & pe e -
-« , ", Bonded - Handle To Spindie Scraw saESIanT o Geometry Selection
----- '8, Frictionat - Sider Guide o Stder Base - .
v Fr y
-, B, Bondad - Slider Guide To Base Contact 1Face
..... R s e e Target 1 Face
B, Borwled - Slider Guide To ¢ ; A e A
v B Y P
s B, Bordad - Slider Base To Slider —————COﬂtaCt Bodies e =
""“V:ﬂ« Frictional - Sider Base To Base Target Bodies
-y B Bonded - Spindle Screw To Slider =i Definifi
«“q‘ Frictonal ~ Spindie Screw To Base = nition
- W, Frictional - Sider Ta Base Type l Bonded

Figure 8-16 Selecting Bonded - Slider Figure 8-17 Partial view of the Details of
Guide To Slider Base from the Contacts node “Bonded - Slider Guide To Slider Base” window

When a contact is selected from the Tree Outline, the assembly becomes transparent,
except the components that form the contact, refer to Figure 8-18. The surfaces in contact
are assigned a particular color in the Graphics screen to distinguish the components and
surfaces under consideration. In Figure 8-18, notice that the surface of the Slider Guide
that is in contact with the surface of the Slider Base is highlighted in red in the Graphics
screen. Similarly, the corresponding surface of the Slider Base is marked in blue, as shown
in Figure 8-19.

6. Inthe Details of “Bonded - Slider Guide To Slider Base” window, expand the Definition

node if it is not already expanded.

7. In this window, select the Frictional option from the Type drop-down list; some more

options are added to the Advanced node. Also, the name of the contact in the Tree Outline
is updated to Frictional- Slider Guide To Slider Base.

8. Specify 0.6 as the coefficient of friction in the Friction Coefficient edit box in the Definition

node.

Note

The coefficient of friction is considered to be 0.6 between the mild steel and gray cast iron
surfaces.
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Figure 8-18 Partial view of the model displaying Figure 8-19 Puartial view of the assembly

the surface of the Slider Guide displaying the color assigned to the Slider Base -

9. Similarly, edit all the contacts in the Tree Outline. For reference, use the data in the
Table 8-1.

Table 8-1 Various contact definitions

Contact Between Contact to be Placed | Coefficient
of Friction
Slider Guides To Base Bonded
Screws "To Slider Guide Bonded
Enobs To Handle Bonded
Handle to Spindle Screw Bonded
Slider Base to Slider Bonded
Slider Base To Base Frictional 0.6
;l;f:r Guides To Slider Frictional 0.6
Screws 'To Slider Base Bonded
Spindle Screw To Slider Bonded
Spindle Screw To Base Frictional 0.6
Serew To Spindle Screw Bonded
Slider to Base Frictional 0.6
Screws To Slider "~ Bonded
Screws To Base * Bonded
Screws To Slider Guide Bonded

Natice that, a yellow thunderbolt symbol is attached to Mesh in the Tree Outline, refer
to Figure 8-14, which indicates that a mesh of the assembly has to be generated. To do
so, follow the procedure explained next.
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10. Right-click on Mesh in the Tree Outline; a shortcut menu is displayed.

11. Choose the Generate Mesh option from the shortcut menu; mesh is generated
according to the default settings. The mesh generated is shown in
Figure 8-20.

3;4 Ger!erate iash

Noﬁe that there are approximately 7000 elements generated by using the default
settings.

Note .
1. Tb check the quality of the mesh, you can use the tools available in the Graphics toolbay.

2. In ANSYS Workbench, there are many ways by which you can improve the mesh quality.
Setting the global mesh controls help you generate a mesh that would be same for all the instances
of mesh generation. However, local mesh controls help yow achieve better quality of mesh where
needed. There are many tools available to refine the mesh in a particular region.

Figure 8-21 shows the partial view of the assembly with the mesh generated.

Figure 8-20 Mesh generated for the assembly ~ Figure 8-21 Purtial view of the model showing
the mesh generated

12. Select the Mesh node in the Tree Outline; the Details of “Mesh” window is displayed.

13. In the Details of “Mesh” window, expand the Defaults node in the Details of “Mesh”
node, if it is not already expanded, and then specify 20 in the Relevance edit box.

14. In the Details of “Mesh” window, expand the Sizing node, if it is not already expanded.

15. Select the On: Proximity option from 5| 3#ing

o

the Use Advanced Size Function S ,' el S off v
drop-down list, as shown in Figure 8-22; Relevance Center of
a list of options are added to the Details (7] Etement Size On: Proximity ang Curva?
of “Mesh” window. Initial Size Sead

smoothing 19m: Fixed i

16. Specify 2 in the Num Cells Across Gap

edit box under the Sizing node. Figure 8-22 Selecting the On: Proximity option

fromthe Use Advanced Size Function drop-doun list
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17.

18,

19.

20.

21.

Choose the Update tool from the Mesh contextual toolbar; the mesh is generated with
changed global mesh controi settings, as shown in Figure 8-23.

Figure 8-23 Mesh generated with changed global mesh control settings

Note

The default value in the Num Cells Across Gap edit box available in the Sizing node is 3.
In this tutorial, you have specified the value 2, which means that ANSYS will maintain 2 cells
across thin regions of the model, refer to Figure 8-23. The approximate number of elements
generated will be 65000.

You will notice that the mesh generated with changed global mesh control settings is
finer than the previous mesh, refer to Figure 8-20. As the Bench Vice assembly is used
to hold objects, therefore the main concentration of stresses should be on the Base and
the Slider. As a result, these two components should have a better mesh as compared to
other components such as the Handle, Knobs, and so on where the effect of the pressure
applied is comparatively less.

Based on the results obtained from the current mesh, you can apply a mesh method or
any other local mesh controls to get better resuits. As the Base and the Slider are the main
components in this assembly, you will apply the Patch Independent algorithm to these
components only.

Choose the Method tool from the Mesh Control drop-down in the Mesh contextual
toolbax, as shown in Figure 8-24; Automatic Method is attached with a question symbol,
under Mesh in the Tree Qutline, as shown in Figure 8-25. Also, the Details of Automatic
“Mesh” window is displayed.

In the Details of “Automatic Method” window, click on the Geometry selection box to
display the Apply and Cancel buttons, if they are not already displayed.

Press and hold the CTRL key and select the Base and the Slider in the Graphics screen;
they turn green.

In the Details of “Automatic Method” window, choose the Apply button in the Geometry
selection box; the Base and the Slider components are specified as the geometries on which
Patch Independent algorithm is applied. Also, 2 Bodies is displayed in the Geometry
selection box indicating that 2 bodies have been selected for the operation.
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|ﬁ?l Mesh Control + | netetric dryy
: il

‘
“% Mesh Gmup
@.\ S!zmg e
. Conta_dﬂizing :
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&) Project
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& Match Control :
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Figure 8-24 Choosing the Method option Figure 8-25 The Automatic Method node
from the Mesh Control drop-doum under the Mesh node

22. Expand the Definition node in the Details of “Automatic Mesh” window and then select

the Tetrahedrons option from the Method drop-down list, as shown in Figure 8-26; the

Algorithm drop-down list is displayed with the Patch Conforming option selected by
default.

23. Select the Patch Independent option from the Algorithm drop-down list, as shown in

Figure 8-27; Automatic Method is replaced by Patch Independent in the Tree Outline.
Also, the Details of “Patch Independence” window is displayed.

Figure 8-26 Selecting the Tetrahedrons option
from the Method drop-down list

. Choose the Update button from the Mesh

Detsi o
[~} Scope oty is) _'-::: k3
Scoping Method Geomatry Selection E3f Scope
Gaomatry 7 Bodies Scoping Method Geometry Selaction
[5}| Definition Geametry 2 Bodies
Supprésse = Definition
‘o ﬁ;%; T Automatic R Supprassed Mo
& Nedes ta! . Methpd Tetrahedrons
et R ARt e A SR Patch Confarming -
I;i;);g;)mmant Elemant Ml(iSld::Nades Pateh Conforming
MultiZone

Figure 8-27 Selecting the Patch Independent
option from the Algorithm drop-down list

To have a better idea of the effects of
meshing using the Patch Independent
algorithm, you need to generate a mesh
with the default settings in the Details of
“Patch Independent” window.

contextual toolbar to update the mesh
with the Patch Independent algorithm;
the mesh with Patch Independent
algorithm is generated, as shown in Figure 8-28 Mesh generated with default algorithm
Figure 8-28. settings
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Note
1. You canmot preview a mesh by using the Preview Mesh tool when the Patch Independent
algorithm is selected in the Algorithm drop-down list.

2. Approximate number of elements generated is 93000.

25. Choose the Body tool from the Select toolbar and then select the Base and the
Shider components from the Graphics screen.

96. Right-click on the Base component in the Graphics screen and then choose Hide All
Other Bodies from the shortcut menu displayed; all the components of the assembly,
except the Base and the Stider components become invisible.

27. Right-click on the Graphics screen and then choose View > Top from the shortcut menu
displayed; the model is oriented, as shown in Figure 8-29.

28. Choose the New Section Plane tool from the Standard toolbar; the Section planes fg
window is displayed on the left of the Graphics screen.

29. In the Graphics screen, place and drag the cursor in such a manner that the section is
created, as shown in Figure 8-30.

e

Figure 8-29 Top view of the model Figure 8-30 Section created

30. Orient the model using the tools available in the Graphics toolbar, refer to Figure 8-31.
When you create a slice plane, the cells are visible through the sectioned plane. You can
turn on or off the display of the cells using the Show Whole Elements toggle button in the

Section Planes window. The model after turning off the display is shown in Figure 8-32.

31. Select Patch Independent under the Mesh node in the Tree Outline; the Details of “Patch
Independent” window is displayed.

32. In this window, expand the Advanced node, if it is not already expanded.

33. In the Max Element Size edit box, replace the default value by 6.

The Max Element Size edit box is used to specify a value for the maximum size of the element
in a2 model, The default value in this edit box depends on whether an option other than

Off is selected in the Use Advanced Size Function drop-down list in the Details of “Mesh”
window.
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Figure 8-31 Sectioned model with whole Figure 8-32 Elements displayed through the section
elements displayed plane and with the Show Whole Elements toggle
button turned off ‘

34. Enter 30 in the Feature Angle edit box.

35. Specify 2 as the minimum size of the elements
in the Min Size Limit edit box.

36. Specify 3 in the Num Cells Across Gap edit
box, if it is not already specified.

L Min Size Limit 5
37. Select the On option from the Mesh Based || |k tum Celts Across Gap 3
. . [ Curvature
Defeaturing drop-down list under the | Cueeture Normal Angle gefautt
Ad d d ? 7 3.83: th | | Smeoth Transitien Gn
vanced node, refer to Figure 8-33; the Cravh et Eprmm

Defeaturing Tolerance edit box is displayed. - A —t— e

Figure 8-33 Selecting the On option from the

38. Enter 0.5 as the tolerance value in the Mesh Based Defeaturing drop-down list

Defeaturing Tolerance edit box.
39. Select the On option from the Smooth Transition drop-down list.

Note

Make sure that the Yes option is selected in the Curvature and Proximity Refinement
drop-down list of the Advanced node.

40. Select and then right-click on the Base in the Graphics screen; a shortcut menu is
dispiayed.

41. Choose Show All Bodies option from this shortcut menu; all the bodies are displayed in
the Graphics screen.

42. In the Section Planes window, clear the Slice Planel check box; the complete view of the
model is restored, refer to Figure 8-34.

43. Choose the Update tool from the Mesh contextual toolbar; the mesh is generated with
the local mesh control settings, as shown in Figure 8-34.
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Figure 8-85 shows the Details of “Patch Independent” window, after specifying all the
parameters. The element count after generating the mesh is 1,830,000, which is more than
the previous element count of 95,000.

R Rl et s MaRed T T TR
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Figure 8-34 Mesh generated with the Patch Figure 8-35 The Details of
Independent method applied to the Base and “Patch Independent” window
the Shider

The local mesh controls are introduced when further refinement of meshing is needed. The
decision of applying local sizing controls depends upon the accuracy of the results required
and time allotted for the pre-processing of components.

introducing More Local Mesh Controls

After the Patch Independent algorithm is applied to ), Mesh Controt = | ghi¥enic Gra
the Base and the Slider, you may need to further refine @1 Method -
the mesh in the areas where the quality of the mesh is B Meth Gmup :

not achieved as per the requirement.

R . . . 15' Contact Slzfng
1. Select the Mesh node in the Tree Outline to display the £ Refinerient

Details of “Mesh™ window and the Mesh contextual

#H Mapped Face Meshing

toolbar. iR Match Control
9. Choose Mesh Control > Sizing from the Mesh |2 """
2. oose Mesh Contro 1zing Irom the Mes £ Inflstion

contextual toolbay; refer to Figure 8-36; Sizing is added
under the Mesh node. Also, the Details of “Sizing”
window is displayed and you are prompted to select 1 Gap Tool
faces, edges, or bodies to apply sizing controls.

B8 Sharp Angle

Figure 8-36 Choosmg the Sizing

. tool from the drop-doum
When you select a face or many faces to apply sizing

control, the number of faces and the area of the selected faces are displayed in the status bar.
Also, when sizing is applied to a face, the ransition of faces to adjoining faces will be smooth.

You can select vertices, edges, faces, and bodies to apply sizing.
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3.

14

10.

11.

From: the Select toolbar, choose the Face tool to select faces for sizing.

Note
Sizing controls can also be applied to
edges, vertices, and bodies.

Face of the Base to be
selectad

Face of the Slider to be
selected

In the Details of “Sizing” window, select
the Geometry selection box to display
the Apply and Cancel buttons, if they
are not already displayed.

Next, press and hold the CTRL key and
then select the faces of the Base and
the Slider cornponents in the Graphics
screen, refer to Figure 8-87,

Figure 8-37 Selecting faces to apply sizing

Choose the Apply button from the
Geometry selection box in the Details of
“Sizing” window; 2 Faces is displayed in the Geometry selection box, indicating that the
two faces are selected to apply face sizing to. Also, in the Tree Outline, Sizing is replaced
by Face Sizing with a green tick mark on it,

Select Face Sizing in the Tree OQutline, if it is not already selected; the Details of “Face
Sizing” window is displayed.

Expand the Definition node in the Details of “Face Sizing” window, if it is not already
expanded.

Select the Element Size option from the Type drop-down list in the Definition node of
the Details of “Size” window, if it is not selected by default.

In the Element Size edit box, enter 4 as the element size to be applied on the faces of the
Base and the Slider, Also, make sure that the Soft option is selected from the Behavior
drop-down list inn the Definition node.

Note

Remember that the element size limit that is specified in global settings is between 2 mm to 8 mm.
If you specify an element size of 2 mm in the Element Size edit box of the Details of “Face
Sizing” window, the element size will remain strictly to 2 mmn wherever possible.

Choose the Update tool from the Mesh contextual toolbar; the mesh is .5 Undat
generated, as shown in Figure 8-38. LP—E—J

Note that the element count after the mesh is generated is 1,50,000, which is more than
the previous element count of 1,30,000.
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Figure 8-38 Mesh generated afler sizing

12. Close the Mechanical window.

Saving the Model
After meshing the model, you need to exit the Mechanical window and save the model
in the specified folder.

1. Choose the Save button from the Standard toolbar to save the project.

2. Exit the Workbench window.

In this tutorial, you will create the surface model shown in Figure 8-39. The dimensions and views
of the model are shown in Figures 8-40 and 8-41. After creating the model, you will
generate a mesh for the surface model. The boundary and loading conditions are shown in
Figure 8-42. Also, to understand the importance of geometry optimization, you will run a
static structural analysis, optimize the model, and then evaluate the results.

(Expected time: 3 hr)
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Figure 8-39 Model for Tutorial 3 Figure 840 Front view of the model
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Figure 8-41 Top view of the model Figure 8-42 Boundary and loading
' conditions for the model

The following steps are required to complete the tutorial:

Start ANSYS Workbench and add an analysis system.”
Create the base feature.

Create the hole feature.

Generate the mesh.

Set global and local mesh control settings.

Modify the geometry.

Set the boundary and loading conditions.

Set the results.

Optimize the results.

Save the project.

Trrpe e oo g

Starting ANSYS Workbench and Adding the Static Structural Analysis
System

First, you need to start ANSYS Workbench and then add an analysis system to the
Project Schematic window.

1. Choose All Programs > ANSYS 14.0 > Workbench 14.0 from the Start menu; the
Workbench window is displayed.

After invoking the Workbench window, you need to add an appropriate analysis system
or the component system to the Project Schematic window.

2. Expand the Analysis Systems node and drag the Static Structural analysis system to the
Project Schematic window; the Static Structural analysis system is added to the Project
Schematic window.

Note
The selection of an analysis system depends on the type of analysis you want to perform.

3. Rename the Static Structural analysis system to Surface_Mesh.

4, In the Wbrkbench window, choose the Save button from the Standard toolbar; the Save
As dialog box is displayed.
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5. In the Save As dialog box, browse to the location CAANSYS_WBi\c08.

6. In this location, create a folder with the name Tut03 and then choose the Open button
from the Save As dialog box.

7. Save the project with the name C08_ansWB_Tut03 at the location CANSYS_WBIc08)
Tut03.

Creating the Base Feature
After you have finished adding the analysis system, you now need to create the model
using the DesignModeler window.

1. Inthe Project Schematic window, double-click on the Geometry cell of the Surface_Mesh

analysis systemn; the DesignModeler window along with the ANSYS Workbench dialog
box is displayed.

2. Inthe ANSYS Workbench dialog box, select the Millimeter radio button and then choose
the OK button; the unit is now set to millimeters.

Note that the default plane selected in the DesignModeler window is the XY plane. Since
the sketch is to be created on the XY plane, therefore you need not specify the plane before
creating the sketch.

3. Choose the Look At tool from the Graphics toolbar; the XY plane is oriented 0
normal to the viewing direction. 1

4. Create the sketch on the XY plane, as shown in Figure 8-43. For dimensions, refer to
Figure 8-40, '

S SO _..L .........

Pigure 8-43 Fully constrained shetch
on the XY Plane

5. Change the view to Isometric by using the ISO toel from the Graphics toolbar.

6. Choose the Extrude tool from the Features toolbar; the Sketching mode is closed and
the Modeling mode is invoked. Also, Extrude 1 is attached to the Tree Outline and the
corresponding Details View window is displayed.
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10.

Click on the Geometry selection box in the Details View window; the Apply and
Cancel buttons are displayed. As there is only one sketch in the Graphics screen, it gets
automatically selected for the extrude operation.

Select Sketchl under the XYPlane node in the Tree Outline, if it is not already selected.

Next, choose the Apply button from the Geometry selection box to specify the sketch for
extrusion.

In the Details View window, specify 30 as the length of extrusion in the FD1, Depth (>0),
edit box, refer to Figure 8-44.

Choose the Generate tool from the Features toolbar; the sketch is extruded, as shown in
Figure 8-45. ‘

el

3 Details of Extrudel
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Figure 8-44 The FDI, Depth (>0) edit
box in the Details View window

Figure 8-45 Extruded surface model

A surface model created in 31} modeling software does not exist practically in the real world.
'Io use a surface model, you need to convert it into a 3D model by providing it a thickness in
the DesignModeler window. In case the surface model is modeled in any other CAD package,
you can give it a thickness in the same package where it was modeled. Otherwise, you can
import it to ANSYS and then provide it a thickness while generating a mesh.

In ANSYS, the surfaces are modeled with plate/shell elements. You can consider generating
a mesh with plate/shell elements i the thickness of the plate is in a ratio of 10:1 with the
smallest dimension of the model.

Creating the Hole Featnke

After the model is created, you need to create the hole feature on the top surface of the
model,

1. Choose the Face tool from the Select toolbar and then select the top face of the model.

2. Next, choose the New Plane tool from the Active Plane/Skeich toolbar to create a new
plane on the selected face; the preview of the new plane is displayed on the model, as
shown in Figure 8-46.
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3. Choose the Generate tool from the Features toolbar; the plane is generated.

4. Choose the Look At tool from the Graphics tooibar to orient the model normal to your
viewing direction.

5. Create a circle on the top face of the plane. For dimensions, refer to Figure 8-42.

6. Next, choose the Extrude ool and then create a circular cut, as shown in Figure 8-47.

Figure 8-46 Preview of the work plane Figure 8-47 Circular cut created on the top face of
- the model

7. Exit the DesignModeler workspace; the Workbench window is displayed.

Generating the Mesh

After creating the hole feature, you need to generate an effective mesh for it.

1. In the Project Schematic window, double-click on the Model cell of the Surface_Mesh
analysis system to display the Mechanical window.

Note
Make sure that Metric (mm, kg, N, S, mV, mA} is selected as the unit in the Units menic of

the Menu bar,

9. Expand the Geometry node in the Tree Outline; Surface Body is displayed with a quéstion
symbol attached to it, indicating that immediate action is required.

3. Select Surface Body in the Tree Qutline; the Details of “Surface Body” window is
displayed. Also, the surface body is displayed in green in the Graphics screen.

4. 1In the Details of “Surface Body” window, expand the Definition node, if it is not already
expanded, as shown in Figure 8-48.

"The Thickness edit box in the Details of “Surface Body” window is displayed in yellow,
indicating that there is no vahie attached to it.
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5. Enter 0.2 in the Thickness edit box.

6. Right-click on Mesh in the Tree Outline and then choose the Generate
Mesh option from the shortout menu displayed; the mesh with defaule ¥ SenerateMesh
global mesh control settings is generated, as shown in Figure 8-49.

-
i Suppressed Mo
StHfness Sehavior Flenible
Coordinate System Dafault Coordinate System
Reference Temperatuze | By Environment
C] Thiekness . Mmmioon .
Fhickness Mode Refresh-on Update . :
Offset Type Midete

LA Material

: Asslgnment Stracturat Steel
Nenlinear Effacts Yes
Thermal Sirain Effects | Yes

Figure 8-48 The Details of “Surface Body” Figure 8-49 Mesh generated with default
window global mesh control settings

It is always recommended to generate mesh with
ANSYS default settings. This helps in

understanding the behavior of the elements with & E:fafmz - -
respect to the model. wysncs reference Mechanical
™l Ralevance 0
) . . i N Sizing
7. Select Mesh in the Tree Quiline; the Details A |Use Advanced Size Function | OFf
of “Mesh” window is displayed, as shownin  [{ [Relevance Center Coarse
Figure 8-50. 4 L] Element size Default
Initial Size Seed Active Assembiy
Notice that in the Sizing node of the Details im“’_t:i”g Medium
. N . 1 Fust
of “Mesh” window, Off is selected in the Use et i
Adva d Si F " d d 1 Span Angle Center Coarse ik
nce 1z¢ Functon drop-aown st Minimum Edge Length 78540 mm - | e [

Also, the Element Size edit box displays

Default in it. For better results, you need 1o g o e
N o y F 8-50 The Details of “Mesh”
change few setrings in the Details of “Mesh™ rgure ¢ Details of “Mesh” window

window.

Note

After the defoult material is selected for the analysis, you now need to change the material of
the surface model to aluminium alloy. You can access this material from the materials Librory
in the Engineering Data Sources window.

8. Assign the aluminium alloy material to the model in the Mechanical window.

9. Update the mesh of the mode! by using the Update tool from the Mesh contextual toolbar;
the mesh is now updated, refer to Figure 8-49.
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Setting the Global and Local Mesh Controls
In the previous section, you had created the finite element model with default global mesh
control settings. Now, you will change these settings for the model.

1. Asthere is a circular cutout and a bend in this model, you need to have finer mesh around
the curves. To do so, select the On:Proximity option from the Use Advanced Size Function
drop-down list in the Details of “Mesh” window.

2. Specify 4 in the Num Cells Across Gap edit box.

3. Enter 0.04 in the Proximity Min Size edit box.

4. FEnter 0.6 as the size of the element in the Max Face
Size edit box.

Leave all other options as set to default.

(&34

Choose the Update button from the Mesh
contextual toolbar; the mesh is updated, as shown
in Figure 8-51.

Depending upon the requirement of the analysis such 5 gure 8-51 Mesh generated for the
as the time required to run the analysis and accuracy

expected out of the analysis, you may need to introduce
local mesh control for a particular region or for the complete body.

model

After spemiymg the global mesh control settmgs the next step is to apply local mesh
control settings to the model.

7. Right-click on Mesh in the Tree Outline and then choose Insert > Method from the
shortcut menu displayed; Automatic Method is added under the Mesh node with a question
symbol attached to it, Also, the Details of “Automatic Method” window is displayed, as
shown in Figure 8-53.

8. Click on the Geometry selection box to display the Apply and Cancel buttons,
Note

The Geometry selection box in this window is highlighted in yellow, indicating that the geomelry
to be considered for a method control is yet to be selected.

4. Choose the Body tool from the Select toolbar and then select the body, as shown in Figure 8-52.

10. Choose the Apply button from the Geometry selection box; the body is selected for
applying the method. Also, a green tick mark is placed before Automatic Method in the
Tree Outline.
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Notice that, Quadrilateral Dominant option is displayed in place of Automatic Method
in the Method drop-down'list in the Details of “Automatic Method” window,

The Quadrilateral Dominant option is selected by default in the Method drop-down list. This
option is used for surface bodies only. When the Quadrilateral Dominant option is selected,
the body is meshed with free quadrilaterals. Also, the Element Midside Nodes and Free
Face Mesh Type drop-down lists are displayed, refer to Figure 8-53. You can use the options
available in these drop-down lists to control element shapes and sizes in a geometry.

11. In the Method drop-down list, select the Triangles option, refer to Figure 8-54; the
Automatic Method in the Tree Outline is replaced by All Triangles Method, as shown in
Figure 8-35.

Ell Scope
Scoping Method Geometry Selaction
; Geametry 1 Body
[} Defintifon
' Suppressed No :
Method Quadrilaterat Dominart
Elzment Midside Modes | Use Giobal Setting :
Free Face Mesh Type Quad/Tr

Figure 8-52 Selected surface body in the Figure 8-53 The Details of “ Automatic
Graphics screen Method” window

K

angles Method” - Miethod . & & Pt
Scope B (B Model {ad)
Scoping Method Geometry Selection : B “@ Geomelry
P " . s, Coordinate Systems
eametry 1 Body W Mesh

! Definition o KGR Al Triangles Method

Suppressed o hafm] Static Structural (A5}
o T e : JE% Analysis Settings
i o o g =R ».{_‘] Solution (AG)
Etement Midside Nodes Onlaterai Doman : g §] Solution Information
Uniform Quad

Figure 8-54 Selecting the Triangles option from Figure 8-55 The All Triangles Method
the Method drop-down list displayed i the Tree Outline

12. Choose the Update button from the Mesh contextual toolbar; the meshis - Update
updated, as shown in Figure 8-56. 4

Notice that the total number of elements created in this model are 8064.

13. Exit the Mechanical window; the Workbench window is displayed.
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Optimizing the Geometry
In Figure 8-41, you can notice that to apply load on
the model, you first need to create the patch on the
circular hole.

1. In the Workbench window, double-click on the
Geometry cell of the Surface_Mesh analysis system;
the DesignModeler window is displayed.

2. Choose the Surface Patch tool from the Tools menu;
SurfPatchl is added to the Tree Qutline. Also, the
corresponding Details View window is displayed
and you are prompted to select a loop of edges to
create the patch.

Pigure 8-56 Mesh generated with all
3. Next, select the Patch Edges selection box in the fraingular elements
Details View window to display the Apply and
Cancel buttons, if they are not already displayed.

4. Select the circular edge, as shown in Figure 8-57.
5. Choose the Apply button to confirm the selection; the edge turns blue and 1 is displayed

in the Patch Edges selection box, indicating that one loop has been selected for applying
the patch.

6. Choose the Generate tool from the Features toolbar to generate the surface patch, as
shown.in Figure 8-58.

Figure 8-57 Partial view of the model with Figure 8-58 Fatch created around the
the circular edge selected selected edge

7. Exit the DesignModeler window to display the Workbench window.

Setting the Boundary and Loading Conditions
After the patch is created, you now need to set the boundary and loading conditions for
the model.
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1. In the Workbench window, choose the Update Project tool from the Standard toolbar;
the model is updated to the current state,

2. In the Surface_Mesh analysis system, double-click on the Model cell; the Mechanical
window is displayed.

3. In the Tree Outline, right-click on the Static Structural node. Next, choose Insert >
Fixed Support from the shortcut menu displayed; Fixed Supportis added under the Tree
Outline. Also, the Details of “Fixed Support”® window is displayed with the Geometry
selection box displaying the Apply and Cancel buttons.

4. Choose the Face tool from the Select toolbar, if it is not already chosen and then @ I
select the surface, as shown in Figure 8-59.

Note

1. You can restrict the movement of a model in all divections by applying Fixed support to it.
You can apply Fixed support to edges, faces, and vertices.

5. Next, choose the Apply button from the Geometry selection box in the Details of “Fixed
Support” window; the face is selected 1o apply fixed constraint.

6. Right-click on the Static Structural node again and then choose Insert > Force from the
shortcut menu displayed; Force is added under the Static Structural node in the Tree
Outline. Also, the corresponding Details View window is displayed.

Force is known as the rate of change of momentum, In ANSYS Workbench, you can apply
Force load by using the Environment contextual toolbar.

7. In the Details View window, select the Geometry selection box to display the Apply and
the Cancel buttons, if they are not already displayed.

8. Choose the Face tool from the Select toolbar and then select the patched surface,
as shown in Figure 8-60. Next, choose the Apply button in the Geometry selection @
box; 1Face is displayed in the Geometry selection box,

Figure 8-59 Selecting the face to apply Figure 8-60 Selecting the face to apply Force
Fixed support load
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9. 1n the Details View window, enter 250 in the Magnitude edit box to specify the magnimude
of force.

10. Select the Direction selection box to display the Apply and Cancel buttons.

11. Select the edge of the model, as shown in Figure 8-61 and then choose the Apply button;
the Force load of 250 N is applied on the selected edge.

Figure 8-61 Selecting the edge for specifying the
direction of force load

Setting the Results
After the boundary and loading conditions are specified in the Mechanical window, you
need to define the results.

1. Righeclick on the Solution node in the Tree Outline to display a shortcut menu,

9. 1In this shortcut menu, choose Insert > Deformation > Total; Total Deformation is added
under the Solution node.

3. Right-click on the Solution node again and then choose Insert > Stress > Equivalent
(von-mises) from the shortcut menu displayed; Equivalent Stress is added under the
Solution node in the Tree OQutline.

Notice that Total Deformation and Equivalent Stress added under the Solution node are
displayed with yellow thunderbolts which indicates that results are not evaluated yet.

4. Choose the Solve tool from the Standard toolbar; the ANSYS Workbench Solution
Status dialog box is displayed and after sometime, a green tick mark is placed before
Total Deformation and Equivalent Stress in the Tree Outline, indicating that they are
evaluated.

5. Select Total Deformation in the Tree Outline; the corresponding contours are displayed
in the Graphics screen, as shown in Figure 8-62.
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6. $e§ect Equivalent Stress in the "Tree Outline; the corresponding contours are displayed
in the Graphics screen, as shown in Figure 8-63.

AaSurtuce Merh
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Figure 8-62 Total Deformation contours in Figure 8-63 Equivalent Stress contours in
the model the model

The foﬂo:wing table describes the maximum and minimum value for the Total Deformation
and Equivalent Stress induced in the model.

S.No. Parameter Min. Value Max. Value
Total Deformation 0 4.3% mm
2 Equivalent Stress 0 151.37 MPa

After the values are found, thfe nextstep is to optimize the results by modifying the meshing
parameters. In the next section, you will optimize the model for better results,

Optimizing the Results

To 9ptimize the modei for better results, you need to change the global and local mesh
settings.

1. In the Mechanical window, select the Mesh node in the Tree Qutline; the Details of
“Mesh” window is displayed.

2. In the Details of “Mesh” window, expand the Sizing node, if it is not already expanded.

3. Enter 2 in the Num Cells Across Gap edit box.
4. Enter 0.3 in the Proximity Min Size edit box.
5. Enter 0.9 in the Max Face Size edit box.

6. Choose the Solve tool from the Standard toolbar to generate the mesh and update the

results in the Solution node,
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7. Next, select Total Deformation from the Tree Outline to display the contours in the
Graphics screen.

8. Similarly, select Equivalent Stress from the Tree Outline; the stress contours are displayed
in the Graphics screen.

The following table describes the maximum and minimum values for the Total Deformation
and Equivalent Stress induced in the model.

S.No. Parameter Min. Value Max. Value
1 Total Deformation 0 4.8%Mm
2 Equivalent Stress 0 139.5 MPa

Notice that when the optimized model is meshed the element count has decreased. On
comparing the data available in the tables given previously in this section, you will find
that there is not much difference in the Total Deformation achieved when the optimized
model is used. However, there is a fall in Equivalent Stress value when the element count
decreases. Therefore, to save the processing time and keep the model simple, you need
to use the optimized model.

9. Exit the Mechanical window; the Workbench window is dispiayed.

Saving the Nodel

1. Choose the Save button in Standard toolbar to save the project with the name
c08 _ansWB_tut03.

9. Choose File > Exit to close the Workbench window.

Answer the following questions and then compare them to those given at the end of this
chapter:

1. Assoon as surface body is selected as the geometry to be meshed, the Automatic Method
is replaced by Quadrilateral Dominant in the Tree Outline. (T/F)

9. TIn software terms, a surface body is the one which has zero thickness. But, practically such
surface bodies do not exist. (T/¥)

8. You can either provide a thickness to the surface models in the respective CAD packages
or you can provide a thickness to the models in ANSYS Workbench. (T/F)
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4. You can set the global mesh control settings in the Details of “Mesh” window. (/R

5. The procedure to create a finite element model for a surface body is same as the
model. (T/F) Y as that of a 3D

Answer the following questions:

1. You may not need to provide a thickness to the model, if it is already given in the CAD
package. (T/F)

2. The Tetrahedral method is not available while meshing a very thin model. {T/F)

8. Once the body is selected for generating a mesh, ANSYS Workbench decides if the body
is to be treated as a thin model or a 3D model. (T/F)

4. You can modify the names of the components in an assembly while meshing them. (T/F}

b.  You can continue to refine the mesh for a component, even if the results obtained from
the analysis are same for each refinement done. (T/F)

6. %; parameters of a geometry can be viewed in the Status bar when they are selected.
)

7. 'To insert a method, choose the Method tool from the drop-down in the Mesh
contextual toolbar.

8. The Look At tool is available in the toolbar.

EXERCISE

Download the zip file ¢c08_ansWB_exr01.zip from www.cadcim.com. Extract the file
cQS_ansWB_eerI J4gs and then generate a mesh for the bonnet model of a car, as shown in
Figure 8-64. Use an appropriate method to generate a localized mesh at the rounds of the
mode]. (Expected time: 1 hr)

‘The complete path for the file is:

Texthooks > CAE > ANSYS > ANSYS Workbench 14.0: A Tudorial Approach > Input Files
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Figure 8-64 The model for Exercise 1

Answers to Self-Evaluation Test
1.T2.17,3.1,4.T, 5.7

Chapter 9

Static Structural

After completing this chapter, you w:ﬂ be able to:
* Create the Static Striictural analyszs system.

* Apply boundary. condztums._ L

* Apply different types of constmmts. s

* Apply different loads available in ANSYS Workbench
* Generate the result of an analyszs
* Generate report of an analysis.-

Analysis
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INTRODUCTION TO STATIC STRUCTURAL ANALYSIS

The Static Structural analysis is one of the important analyses in ANSYS Workbench. }t
is available as Static Structural analysis system under the Analysis System toolbox in
the Toolbox window. This system analyses the structural corponents for displacements
(deformation), stresses, strains, and forces under different loa‘dipg cgnémmm. The loads in
this analysis system are assumed not to have damping characteristics (time dependent). Steady
loading and damping conditions are assumed in this type of analysis system.

To start a new Static Structural analysis system, double-click
on Static Structural in the Analysis Systems toolbox in

the Toolbox window; the Static Structural analysis system 12| @ EngneeringDate ' 4
will be added to the Project Schematic window, as shown 2 (@ seomeny v 4
in Figure 9-1. To start an analysis, first you need to specify 4| € Modsl ; 4
the geometry on which the analysis is to be done. To do so, |3 & sebp ¥
you can import the geometry from an external CAD & | &g solution f P
package, or you can create the geometry in the AN SYS’s D Ress P,

DesignModeler software. After the model is specified for Static Structural
an analysis, you need to double-click on the Model cell of
the Static Structural analysis system to open the Mechanical
window, as shown in Figure 9-2. In this window, you can
specify the parameters and run the analysis.

Figure 9-1 The Static Structural
analysis system added to the Project
Schematic window
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Figure 9-2 The Mechanical window

As discussed in previous chapters, analysis can be carried out in three major steps:
pre-processing, solution, and post-processing. The tools required to carry out these steps are
discussed next.

Static Structural Analysis . 9.3

Pre-Processing

The pre-processing of an analysis system involves specifying the material, generating a mesh,
and defining boundary conditions.

Note

Tools and options wsed to specify the material and generate mesh has been already discussed in

the previous chapter. In this chapter you will learn about the tools used for defining boundary
condition.

In ANSYS Workbench, the various tools related to boundary conditions are available in the

Environment contextual toolbar, which is displayed when you select the Static Structural node
in the Tree Outline, refer to Figure 9-3.

Tenvironment P Inertial » S Loads @k Supports v -0 Conditions v B Direct FE + I &
Figure 9-3 The Environment contextual toolbar

In order to provide a support to the model, you need to choose the required tool from
the Supports drop-down. Similarly, to add a load, choose the desired tool from the Loads
drop-down in the Environment contextual toolbar. Also, when you choose any tool from the

Environment contextual toolbar, the corresponding entity is placed under the Static Structural
node in the Tree Qutline.

Note

While performing an analysis, you can display the Environment contextual toolbar by selecting
the respective analysis node in the Mechanical window.

The main purpose of an analysis is to evaluate the results. After the boundary condition is set
and loads are applied, you need to specify the desired outcomes of the analysis. In ANSYS
Workbench, you can analyze various parameters such as deformation, stresses, strains, and
so on. 1o do so, you need to specify the results required and then evaluate them. You can use
the tools available in the Solution contextual toclbar to specify results, refer to Figure 9-4.
Alternatively, right-click on the Solution node in the Tree Qutline and then use the desired
option from the shortcut menu displayed.

| Solution @, Deformation = B, Strain v & Strass ~ @ Energy v | B Lineatized Stress »

Figure 9-4 The Solution contextual toolbar

In order to evaluate deformations, stresses, strains, and so on, choose the desired options from
the drop-downs available in the Solution contextual toolbar.

Solution

In an analysis, after pre-processing (meshing, specifying material, and specifying boundary
condition) is done, the next step is to solve the analysis. In ANSYS Workbench, you will use the
Solve tool from the Standard toolbar to run the solver. The solver runs in the background of
a software and acquires results of an analysis, based on the specified boundary conditions.
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Post-Processing _ o
After the analysis is complete, you need to generate the report in the Mechanical window. To

do s0, choose the Report Preview tab from the bottom of the Graphics screen, as shown in
Figure 9-5; the ANSYS Report generation in progress message is d1sp1ayed‘on the screen, as
shown in Figure 9-6. After sometime, this message vanishes and the report is generated.

Geometry { Print Preview Report Preview / Repori generation in progress..,

Please wiait while the system oaracts all nacassary p:‘q;ec: infzration.
Buting this process, plaass mfinia fram all prajact intsraction.

Figure 9-5 Choosing the Report Preview  Figure 9-6 The Report generation in progess...
tab from the Graphics Screen message

TUTORIALS

E

In this tutorial, you will create the model of a cantilever beam, as shown in Figurfa 9«7'. The
dimensions to create the model and its boundary and loading conditions are also given in Fhe
same figure. Run a Static Structural analysis on the model and evaluate the Total Deformation
and the Directional Deformation. Determine Directional Deformation along the X, Y, and Z
axes. After evaluating the results, interpret them. (Expected time: 3 hr)

iy

250 10 i
i ! 50 1
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Figure 9-7 The cantilever beam with dimensions and boundary and loading conditions

The following steps are required to complete this tutorial.

a. Start a new project and create the model.
b. Generate the mesh.

Static Structural Analysis ' 9.5
¢ Set the boundary and loading conditions.

d. Solve the model. '

e. Duplicate the existing analysis system.

f. Interpret results.

g. Save the project.

Starting a New Project and Creating the Model
The first step is to start a new project in the Workbench window.

1. Start ANSYS Workbench.

2. Choose the Save button from the Standard toolbar; the Save As dialog box
is displayed.

[ save |

3. In this dialog box, enter c09_ansWB_Tut01 in the File name field and then save the file
in the location: C:IANSYS_WB\09\Tut01] :

4. Double-click on Static Structural in the Toolbox window; the Static Structural analysis
systemn is added in the Project Schematic window.

[&1)

Rename the Static Structural analysis system to Cantilever.

6. Inthe Cantilever analysis system, double-click on the Geometry cell; the DesignModeler
window along with the ANSYS Workbench dialog box is displayed.

7. In the ANSYS Workbench dialog box, set the unit to millimeter. Now, create the model
on the XY plane, as shown in Figure 9-8,

Figure 9-8 Model created on the XY plane

8. Exit the DesignModeler window to display the Workbench window.

Generating the Mesh :

After the model is created in the DesignModeler window, you need to generate the mesh
for the model in the Mechanical window.

1. Inthe Project Schematic window, double-click on the Model cell in the Cantilever analysis
system; the Mechanical window is displayed.
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9. Select Mesh in the Tree Outline to display the Details of “Mesh” window.

3. In the Details of “Mesh” window, expand the Sizing node, if it is not already expanded.
Also, notice that Default is displayed in the Element Size edit box.

The Element Size edit box is used to specify the size of an element. The element size specified
in this edit box is according to the size of the geometry. However, this edit box will not be
visible when the On: Proximity and On: Proximity and Curvature options are selected from
the Use Advanced Size Function drop-down list. When Default is displayed in the Element
Size edit box, it indicates that a default value, based on the size of the geometry, is already
specified by the software.

4. Choose the Generate Mesh tool from the
Mesh drop-down in the Mesh contextual
toolbar; the mesh is generated, as shown in
Figure 9-9.

In Figure 9-9, notice that there are 20
elements laid along the length and 4 elements
laid along the width of the component. As
the component is 250 mm long and 30 mm
wide, the size of the elements is 12.5 mm  Figure 9-9 Mesh generated with default mesh
hexahedrals. controls

5. Expand the Statistics node in the Details of “Mesh” window to dispiay the total number
of elements created. On doing so, you will find that the total number of elements created
is 80.

Setting the Boundary and Loading s

Conditions Gl ;
After the mesh is generated, you need to set the |
boundary and loading conditions under which the
analysis will be performed.

E, Remote Disp%acerﬁent.' :
H Velocity

1. Select the Static Structural node in the Tree Outline; | % Impedance Boundary
the Details of “Static Structural” window is displayed. %ﬁﬂ Frﬁdfuniegs Support
Also, the Environment contextual toolbar is displayed, '

%, Compression Only Support
refer to Figure 9-3. “ e

&, Cylindrical Support® .

9. 1n the Environment contextual toolbar, choose the | P& Sirnply Supported: -
Fixed Support tool from the Supports drop-down, refer & Fited Rotatiore
to Figure 9-10; Fixed Support is attached to'the Tree |6 Elastic Support
Quitline. Also, the Details of “Fixed Support” window e R
is displayed.

Figure 9-10 Choosing the Fixed
Support tool from the Supports
drop-down
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Note

1. The Environment contextual toolbar is displayed according to the corresponding analysis
system node selected in the Tree Ouiline.

2. The options available in the Supports drop-down can also be accessed by using the shortcut
meny displayed on right-clicking on the Static Structural node.

3. Select the Geometry selection box in the Scope node of the Details of “Fixed Support”
window to display the Apply and Cancel buttons, if they are not already displayed.

4. Choose the Face tool from the Select toolbar to select the face to apply fixed
support. Next, select the face of the model; the face turns green, as shown in .
Figure 9-11.

5. Choose the Apply button in the Geometry selection box to confirm the selection of the
face for Fixed support; the color of the face turns violet and a flag is attached to the face,
as shown in Figure 9-12.

Figure 9-11 Fuce selected Figure 9-12 The vivlet color face of the model
displaying the Fixed support

After the boundary is defined for the model, you need to define

. Co . @ Loads v Bk Supports v %1
the load for which the analysis is to be carried out. - b2 -

L Pressure -

. . . . . pi 2
6. Select the Static Structural node in the Tree Outline to display Pipe Pressure

' o g
the Environment contextual toolbar w Hydrostatic pmsm

e -
@ Remmote Fdfbe 0
@ Benring foad.'" e
;)nfj Bolt Preténsinn'_.': PR
9, ?‘q{'cn'r_i'iént_f":"_' e g
1 Generaiized Plaive Steain - -
&, E;_En&P'réS_sufa."_ L
By Thermal Condition: -

) Pipe Ternpeiature . .
fq‘g“s Join_tt.dad SR o L
E, Fluid Solid Interface
) Detonation Point.

7. Inthis toolbar, choose the Loads button to display a drop-down,
as shown in Figure 9-13.

8. Choose the Force tool from this drop-down; Force is attached
under the Static Structural node in the Tree Qutline. Also, the
Details of “Force” window is displayed.

Force is known as the rate of change of momentum. In ANSYS
Workbench, you can apply Force load by choosing the Force tool
from the Loads drop-down.

Figure 9-13 The Loads
drop-doum
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9. Inthe Details of “Force” window, select the Geometry selection box to display the Apply
and Cancel buttons, if they are not already displayed.

10. Choose the Edge tool from the Select toolbar to select an edge from the Graphics 3
screen.

11. In the Graphics screen, select the edge, just
opposite to the face on which you have applied
the Fixed support, refer to Figure 9-14.

12. Choose the Apply button from the Geometry "
selection box in the Details View window; the
edge is selected for applying the Force load.

Note
In this tutorial, the direction of application of

load is downward. Figure 9-14 Selecting the edge for applying
a Force Load

18, Select the Magnitude edit box and then enter
500 as the magnitude of Force load.

The Magnitude edit box is used to specify the magnitude of a vector quantity.

14. Select the Direction selection box to display the Apply and Cancel buttons. Next, select
the edge of the model, as shown in Figure 9-15.

The Direction selection box is used to specify the direction of a vector quantity.

15. Choose the Flip toggle button available in the Graphics screen, refer to Figure 9-16, to
specify the direction of load as downward.

20810e-814, 0. N

Edge to Select

Figure 9-15 Selecting the edge o specify Figure 9-16 Choosing the Flip button
the direction for applying the load from the Graphics screen
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16. Choose the Apply button in the Direction selection box in the Details of “Force” window,

Now, the preprocessing part is complete. Next, you need to work on the solution part of
the analysis.

Solving and Post-Processing the Finite Element Model

After the boundary and loading conditions are specified for the analysis, you need to evaluate
the results that are of importance in the case of a particular analysis. You can view the response
of the model under the given boundary and loading conditions. The various results that can
be evaluated are: Deformation, Stress, Strain, Energy, and Linearized Stress.

To evaluate the results in this analysis, follow the procedure explained next.

1. Selectthe Solution node in the Tree Qutline; the Solution contextual toolbar is displayed,
refer to Figure 9-4. Also, the Details of “Solution” window is displayed, refer to Figure 9-17.

P

=

5! Adaptive Mesh Refinement
A | Max Refinement Loops 1.

Refinement Depth 2,
= information 7
1 |status | Solve Required. ||

Figure 9-17

Note

The tools available in the Solution contextual toolbar can also be accessed by using the Solution
node. T do so, right-click on the Solution node; a shortcus menze will be displayed. Next, choose
the Insert option from it; a flyout will be displayed showing various options. You can specify
the parameters to evaluate by using the corresponding option in this flyout.

2. Choose the Total tool from the Deformation
drop-down in the Solution contextual toolbar, as
shown in Figure 9-18; Total Deformation is attached

under the Solution node. Also, the Details of “Total d .
Deformation” window is displayed. % Total Velotity
3. Choose the Directional tool from the Deformation ~ D'rgCt'-ﬂ-ﬂa-l-'V-&}Uﬂff e

drop-down; Directional Deformation is attached to EE%:L Total Acceleration .
the Tree Outline. Aiso,.the Details of “Directional ¥ Directional Acceleration -
Deformation™ window is displayed.

Figure 9-18 Choosing the Total tool
A body is called to be deformed if its shape is changed from the Deformation drop-doun

temporarily or permanently. The temporary change of
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shape is known as elastic deformation and a permanent change of shape is known as plastic
deformation. In ANSYS Workbench, You can determine deformation in terms of Total and

Directional Deformations.

"Total Deformation is the total change of shape in a given working condition. You can view the
Total Deformation induced in any component by using the Total tool from the Deformation
drop-down in the Solution contextual toolbar. Directional deformation is the total change
of shape in a particular axis, due to given working conditions. You can view Directional
deformation by using the Directional tool from the Deformation drop-down in the Solution
contextual toolbar.

Total Deformation is the summation of all directional deformations produced in a certain
region of the model. The following equation describes the Total Deformation:

if

Deformation in the X-axis Ux
Deformation in the Y-axis Uy
Deformation in the Z-axis Uz

Then Total Deformation U will be given as follows:

U= (U2+U2+UH"

4. In the Details of “Directional Deformation” window, expand the Definition node, if it
is not already expanded, refer to Figure 9-19.

Notice that, in the Orientation drop-down list, the default selection is X axis, which means
the Directional Deformation shown in the Graphics screen is only with respect to X axis. In
Finite element modeling where the processing period is small, you can view the Directional
Deformation with respect to the ¥ and Z axes in the same Mechanical window.

5. Select Y Axis from the Orientation drop-down list, refer to Figure 9-19.

6. Next, choose the Solve tool from the Standard toolbar; the Directional -4 Solve
Deformation with respect to the Y axis is displayed in the Graphics screen. d

Figure 9-20 shows the default view of the finite element model with the Directional
Deformation with respect to Y axis.

You can change the default scale of the results by selecting the required option from the
Scale drop-down list that is displayed on the right of the Result area in the Result contextual
toolbar, as shown in Figure 9-21.
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B: Dir Deformation ¥ Axis
Diractional Defarmation
Type: Birectional Detormationt¥ Ads)

Hrit: mm
Global Coordinate Sysem
Times L
T 3 - - 172072012 3:04 Pt
Scoping Method ‘Geometny Sefection
Geametry Al Bodias o0
| Definition

Display Tims

Figure 9-19 Selecting ¥ Axis from the Figure 9-20 Directional Deformation with respect
Orientation drop-down list to Y axis

7. Se‘:iect X Axis from the Orientation drop-down list to evaluate the Directional Deformation
with respect to the X axis only.

8. N.ext, choose the Solve tool from the Standard toolbar to view the Directional Deformation
with respect to the X axis, refer to Figure 9-22.

& Cantllever

Direcianal Defommstion

Type: Directionat Defornstan(d Axis}
Unik mm

Glokal Caordinate System

Timg: 1

WL 1R P

Result » mm 0142474 Max 7
o ﬁ 4,0083035

20023597
30014158
3.060047193
B30047183
-G.a0M158
$.0023597
8.8033085

1.0 [Frue Scale}

2.1 [0.5% Autal
4.2 [Auto Scale)
8.3 {2x Auta)
2 [5x Autg)

Figure 9-21 The Scale drop-down list with  Figure 9-22 Directional Deformation with
the Undeformed option selected respect to X axis

Now, if you again have to view the results of the Directional Deformation along with Y-aixs,
you have to follow all the steps again, this would result in more processing time as taken
carlier. Therefore, it is recommended the to create a duplicate of the exiting sytem, so
that you can view the result again at any time without following any steps.

Duplicating the Cantilever Analysis System
Instead of changing the orientation of the axes to find Directional Deformation, you can
duplicate an existing system from the Workbench window.

L. Switch from the Mechanical window to the Workbench window.
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2. In the Project Schematic window,
right-click on Static Structural in the

Cantilveve.r analysis system; a shortcut = & trgnecrigonts o Refresh
menu is displayed. STH e ¥ Update
cometry . s
% In this shortcut menu, choose the 4|88 Modd e Duplte
Duplicate option, as shown in Figure 9-23; ._5" G setip S Replace With s
the Copy of Cantilever analysis system 6.6 Solution A Clear Generated Data
is created in the Project Schematic 7@ Ress M} Delete
window. T cantilever Rename
" Properties

4, Rename the Gopy of Cantilever analysis
system to Cantilever 2. Figure 9-23 Choosing Duplicate option from
the shortcut menu
5. Double-click on the Model cell of the
Cantilever 2 analysis system; another Mechanical window is opened.

Note
1. The newly created analysis system has all the characteristics that the original analysis system

had.

2. After the Cantilever analysis system is duplicated, two Mechanical windows are opened,
namely, Cantilever - Mechanical and Cantilever 2 - Mechanical.

6. In the Mechanical window of the Cantilever 2 analysis system, select Directional
Deformation from the Tree Outline to view the Details of “Directional Deformation”

window.
7. In this window, expand the Definition node, if it is not already expanded.

8. Next, select Y Axis from the Orientation drop-down list, refer to Figure 9-19; a yellow
thunderbolt is displayed before the Solution node.

9. Choose the Solve tool from the Standard toolbar to solve the analysis for the Directional
Deformation along the Y axis; a green tick mark is placed before the components under
the Solution node in the Tree Qutline, indicating that all the results are evaluated.

10. Select Directional Deformation in the Tree Outline; the corresponding deformation along
the Y axis is displayed in the Graphics screen, refer to Figure 9-20.

Now, you have two separate windows to analyze Directional Deformation along the X
axis and Directional Deformation along the Y axis. Similarly, you can create a copy of the
existing analysis system and analyze the data with respect to the Z axis.

Figure 9-24 shows the Directional Deformation along the Z axis.
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C: Cantlleve: 3

Directionat Defermation

Type: Directional Deformatian(? Buxis
Unit: mn

Globet Coord'nata Systern

Feme; 1

2142012 18:28 A

e 0.092318 Max
e benrn

0.810214
~0.010383
-0.830833
+0.851363
-0.471381L
-0.092417 Min

Figure 9-24 Directional Deformation along the
Z axis

As discussed earlier, it is convenient to analyze results in sepérate windows, Therefore, in case
of large fmite element models, you can validate data for different combinations by c;pening
a new x_mndow using the Duplicate tool. Figure 9-25 shows the Project Schematic window
displaying three analysis systems wherein, Cantilever 2 and Cantilever 3 analysis systems have
been d‘uplicated from the Cantilever analysis system. Note that, Cantilever 2 and Cantilever 3
analysis systems are used to determine Directional Deformations along the Y and Z axes.

2 @ Engneerng Data +* s & Engineerin bata ‘g & Engineering Dats v~
3|08 Geometry a 3 Gesmetry ay 3]0 ceometry v o
3 & Model v L@ Mode! v 4 4@ vodel v .
518 sewp < 4l 58 sewp v . 5 @ Sehip v
5 Sokstion v 4 8 8! solution v 4 5 Sclution v ‘;7
M@ v G@Rens TV @ e v
 Contilever U Cantilevarz T ey

Figure 9-25 The Project Schematic window with the copied analysis systems

interpreting the Resuits
After the analysis is finished, the next important step is to understand the evaluated results.

In this tutorial, you have evaluated deformation so far. Now, it is required to check if the
evaluated resulss fall under the permissible limit or not.
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1. Select Total Deformation under the Solution node in the Tree Outline, as shown in
Figure 9-26; the Total Deformation of the cantilever is displayed in the Graphics screen,
as shown in Figure 9-27. Also, the corresponding Legend is displayed in the Graphics
screen.

Bl [ todel (84)

H B: Cantilever 2
Lo Totst Defarenstion
E",E ./% Gaom?ﬁ'y Type: Totel Defarmation
2%, Coordinate Systems tnttomem
h Fima 1
A Mes Y0 35 e

- A=} Static Structural (85}

Jm Analysis Sethings
), Fined Suppart
L Force

B A& Sohstion (66}
-/GJ Solution Information

Figure 9-26 Selecting the Total Deformation Figure 9-27 ‘Total Deformation displayed in
node the Graphics Screen

The Legend has colors arranged in a band from top to bottom. Depending upon the
type of analysis and the parameters evaluated, each color will indicate a different value.
Figure 9-28 shows a typical Legend displayed when Total Deformation is selected from the
Tree Outline.

The blue color in the Legend indicates the minimum value of Total Deformation. In
this case, it displays 0 which means there is no deformation at that region, as shown in
Figure 9-29,

A: Cantilever

Tatal Deformation
Typs: Total Deformation
Units pnime

Tirne: 1

L/25/20102 L1456 A

30603 Max Waximum
37202 Total
Deformaticn

2.3802

0,34063 Minimum Total Deformation

Figure 9-28 The Legend Figure 9-29 Color contours displaying the result

The value that is displayed next to each color is the Total Deformation in the region which
is depicted by that particular color in the model. The blue color in the model represents the
lowest value of the Total Deformation, whereas the red color denotes the maximum value of
the Total Deformation.
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Note

1o vigw the color contours in the model, you need to select the desired node in the Tree
Cutline.

2. Select Total Deformation in the Tree Outline, if it is not already selected.

3. Right-click on the Graphics screen and then choose View > Right from the shortcut menu
displayed to orient the model, as shown in Figure 9-80.

Meximum Totpl
Deformation Region

Minimum Total
Deformation Region

Figure 9-30 The view of the model on choosing the
Right option from the shortcut menu.

4. Select the Show Undeformed WireFrame option from the Edges drop-down list in -
the Result contextual toolbar to visualize the extent of the deformed shape, as
shown in Figure 9-31; the undeformed wireframe model is displayed along with the
deformed model in the Graphics screen, as shown in Figure 9-32.

Undeformed
wireframe view
of the modal

i~ F | i 0D | BProbe
Mo WireFrame -~ -

i L e
Shcrw deformned Modet -~ - Demé?]tig fr?aé)e;
| ' ade
BB Show Elements
Figure 9-31 Selecting Show Undeformed Figure 9-32 Deformed and wndeformed views of
WireFrame from the Edges drop-down list the model

To view the transparent mode of the model, select the Show Undeformed Model option
from the Edges drop-down list, refer to Figure 9-31. Similarly to show the elements that
are created after meshing in the deformed shape of the model, select the Show Elements
option from the Edges drop-down list, refer to Figure 9-31. Figure 9-88 shows the
undeformed model when the Show Undeformed Model option is selected. Figure 9-34
displays the elements when the Show Elements option is selected.
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Transparent
undeformed shape
of the model

Figure 9-33 Displaying the undeformed model  Figure 9-34 Elements displayed when the
when the Show Undeformed Model option is  Show Elements option is selected
selected .

5. TFxit the Cantilever - Mechanical window.

Saving the File
After all the actions are performed and the desired solution is achieved, you need to save
the model.

1. 1In the Workbench window, choose the Save button from the toolbar to save
the project.

9. Exit the Workbench window to end the session.

In this tutorial, you will create two holes on the back planar face of the model created in
Tutorial 2 of Chapter 3. Figures 9-35 and 9-36 show the dimensions for the holes. The material
to be applied on the model is Stainless Steel. Next, you will run the analysis under two conditions
and evaluate the Total Deformation, Directional Deformation, Equivalent Stress, Maximum
Principal Stress, and Minimum Principal Stress. (Expected time: 1 hr)

Case [
Provide Fixed support at the circular holes and apply a Force load of 30N at the end of the
model, as shown in Figure 9-37.

Case II

Provide Displacement support along one of the axes of the holes and allow displacement
axially only. Movements along any other directions must be restricted. The applied Force in
this case is 30 N. ‘

The following steps are required to compiete this tutorial:

Open the existing project and save it with a different name.
Edit the model and add an analysis system.

Add the material to the Engineering Data workspace.
Assign the material and generate the mesh.

IS
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e. Specify the boundary conditions.
f. Solve the analysis and analyze the results.
g Duplicate the model and set the boundary condition for Case I1.
h. Solve the model and interpret the results.
i, Save the project.
-R6
A
7 A —
- !
i l : ‘ @10
Tooll | | e
e S
iR I éo
ot N (el
| 15
i | |
10
b2}
F;'gure .9-35 Side view of the model showing the Figure 9-36 Back view of the model showing
dimensions of the holes dimensions of the holes

Figure 9-37 Applied boundary conditions

Opening the Existing Project
In this tutorial, you wili use the model created in Tutorial 2 of Chapter 3. To use the
model, first you need to open it in the Workbench window and then save it with a different
name.

1. Choose the Open button from the toolbar; the Open dialog box is = Gpar]

displayed. e

2. Browse to the location C:IANSYS WBicO3\Tui02,
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Double-click on ¢03_ansWB_Tut02 to open it.
Choose the Save As button and then browse to the location CAANSYS_WB\c09.

Create a new folder with the name Tut02 and save the project file with the name
¢09_ansWB_Tut02.

Editing the Model and Adding an Analysis System

As per the requirement of the tutorial, you need to create two holes at the back face of
the model to provide space for fasteners, and then add an analysis system to it.

Double-click on the Geometry cell of the Spring Plate component systém to start the
DesignModeler window.

Right-click in the Graphics screen to display a shortcut menu and then choose View >
Left View from it to display the left face of the model where holes are o be created.

Choose the Faces button from the Select toolbar and then select the left face of @I
the model, refer to Figure 9-38.

Create a new plane on the selected face by using the New Plane tool from the Active
Plane/Sketch toolbar, refer to Figure 9-38.

Draw two circles each of diameter 10. For other dimensions, refer to Figures 9-35 and
9-36.

Figure 9-38 New plane created on the lefl face of the model
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8. In the Workbench w'mdcm{, add a new Static Structural analysis system in the Project
Schematic window.

9. Drag the Geometry cell from the Spring Plate corﬁponent system and drop in the
Geometry cell of the Static Structural analysis system to share the created geometry, refer
to Figure 9-39.

X . &% Engneering Data  + al

Spring Plats 3 hsﬁare A2
4 @ Mad% 2 " |
5@ setwp ? 4
-1 Soiition =B
7@ Reauls ?

‘Static Structaral
Figure 9-39 Dragging the Geometry cell to the Static Structural analysis system

10. In the Project Schematic window, rename the Static Structural analysis system to Spring
Plate.

Adding the Material to the Engineering Data Workspace

After creating the holes in the model, you now need to apply the material to it. The
material to be applied is Stainless Steel,

1. Double-click on the Engineering Data cell of the Spring Plate analysis system; the
Engineering Data workspace is displayed in the Workbench window.

2. Choose the Engineering Data Sources toggle button from the Standard toolbar;
the Engineering Data Sources window is added to the Engineering Data
workspace.

3. Inthe Engineering Data Sources window, select the General Materials library to display
the Outline of General Materials window.

4. In the Outline of General Materials window, choose the plus symbol (55) corresponding
to Aluminium Alloy; the material is added to the Engineering Data in the Outline window

6. Create two holes from the circles by using the Extrude tool.

7. Now, exit the DesignModeler window to display the Workbench window.

of the Engineering Data workspace.

Again, choose the Engineering Data Sources toggle button from the Standard toolbar to
switch to the default view of Engineering Data workspace,
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Note
In the Outline window, Aluminium Alloy is lisied in the Contents of Engineering Data
column.

6. Choose the Return to Project button from the Standard toolbar to display the Project
Schematic window.

Specifying a Material and Generating Mesh

The next step is to specify the material and generate a mesh.

1. Inthe Spring Plate analysis system, double-click on the Meodel cell to open the Mechanical
window.

9. In the Mechanical window, expand the Geometry node in the Tree Outline.

%. Select the Solid node under the Geometry

node to display the Details of “Solid” [T sreue e
; | Definition
WlHdOW. [} Suppressed No

Stiffness Behavior Flexible

. . Coordinate System Default Coordinate Sy5...
ad 4% 2]
4" Iﬂ the Deialis Of SOhd Wll’ldOW, Reference Tempearature | By Environmaent

expand the Material node to display the

™
il

=t Material
AT

: . : PO e Sainless Steet [
Assignment drop-down hist. aintorthecs (15 e
Thermal Strain Effecks !Ye%
5. Select the Structural Steel option from  [F|Sosndng fex
. . (F]] Properties
the Assignment drop-down list, refer  glGmie

to Figure 9-40, to apply structural steel

material to the component. Figure 9-40 Selecting the Structural Steel option

from the drop-down list

6. Right-click on the Project node in the Tree Outline and then choose the Rename option
from the shortcut menu displayed, refer to Figure 9-41; the Project node is highlighted
in the Tree Outline,

7. Enter Spring Plate as the new name of the node; the Projéct node is renamed as Spring
Plate, as shown in Figure 9-42.

- i (&) Spring Plate
% Solve - TR E : | B Flodel (B4)
S Geometry
B} 3, Coordinate Systems

;% Mash

(-] Static Structural (85)
Figure 9-41 Choosing the Rename option Figure 9-42 The Project node renamed as
Jfrom the shortcut menu Spring Plate

8. Select Mesh in the Tree Outline to display the Details of Mesh window.
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10.

I

12.

In the Details of “Mesh” window, expand the Sizing node

Cif it
expanded. If it is not already

Select the‘On: Proximity option from the Use Advanced Size Function drop-down list
as shown in Figure 9-43; the Details of “Mesh” window is modified. ’

Enter 2 in the Num Cells Across Gap edit box of the Details of “Mesh” window,

Choose the Generate Mesh tool from the Mesh drop-down in the
Mesh contextual toolbar; the mesh is generated, as shown in
Figure §-44.

5 e ey : Tl On: Prowimity R
Releval enter off
Tnitial Size Seed On: Pravimity and Curva
- On: Curvature
smaoothing O ey
TrARitian {On

Figure 9-43 Selecting the On: Proximity option  Figure 9-44 Mesh generated with the

from the Use Advanced Size Function drop-down  On: Proximity option chosen

list

Specifying the Boundary Conditions

After you mesh the model, it is required to specify the boundary and loading
conditions.

In the Mechanical window, select the Static Structural node from the Tree Outline; the

Details of ““Static Structural” window is displayed along with the Environment contextual
toolbar.

Choose the Fixed Support tool from the Supports drop-down in the g
Environment contextual toolbar; Fixed Support is added under the
Static Structural node. Also, the Details of * Static Structural” window is displayed.

Fixed Support

Click on the Geometry selection box to display the Apply and Cancel buttons.

Choose the Face tool from the Select toolbar to enable selection of faces.
Select two circular faces of the holes on the model, as shown in Figure 9-45. Next, choose

the Apply bution in the Geometry selection box; the selected faces turn purple indicating
that Fixed support is applied, refer to Figure 9-486.
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Faces 10 be selacted
for applying constraintz

Figure 9-45 Fuces to be selected for Figure 9-46 Model after the boundary conditions
applying constraints are applied

6. Choose the Force tool from the Loads drop-down in the Environment contextual too’ibar;
Force is added under the Static Structural node in the Tree Outline. Also, the Details of
“Force” window is displayed.

7. Click on the Geometry selection box to display the
Apply and Cancel buttons, if they are not already
displayed.

8. Next, select the circular face on the right of the model,
as shown in Figure 9-47.

9. Choose the Apply button from the Geometry selection
box; the cylindrical face turns red indicating that the
Force load is applied.

10. In the Details of “Force” window, expand the
Definition node, if it is not already expanded.

11. Select Vector from the Define By drop-down list, if it Figure 9-47 Selecting the circular
1$ not already selected. face of the model

12. In the Details of “Force” window, click on the right arrow next to the Magnitude edit
box; a flyout is displayed.

13. Choose Constant from the fiyout, if it is not already chosen, as shown in Figure 9-48.

The Constant option is chosen when the force applied remains constant with respect to
time.

14. In the Magnitude edit box, enter 30.

15. Click on the Direction selection box to display the Apply and Cancel buttons.
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As the application of force under consideration is vertically downward, you need to define
the direction by selecting edges for the force vector.

i6. Select any vertical edge on the model, as shown in Figure 9-49, to specify the direction of
force application.

)i Scope

Staping Method i Geometry Selection
Geomatry |1 Face

= Definition

Tope [Foree n e
Deting Vecto!

i O.N{mmped} - DT 1Y)
Diredion © . .. | Click to Define. 2.
Suppressad No

. Tabular (fime)
2 Fuietion

Figure 9-48 Choosing the Constant option  Figure 9-49 Selecting the edge to specify the
direction

17. Next, choose the Apply button from the Direction selection box; a downward force is
specified for the analysis. '

After you have selected the edge for specifying the direction, you can flip the direction
specified by choosing the Flip button available in the Graphics screen.

Solving the FE Model and Analyzing the Results
After the boundary and load conditions are specified for the model, you need to solve
the analysis. After solving, you will get the Total and Directional Deformations due to the

given condition. Also, you will get Equivalent Stress, Maximum Principal, and Minimum
Principal Stresses.

1. Select the Solution node in the Tree Outline; the Solution contextual toolbar is displayed.
Also, the Details of “Solution” window is displayed.

2. Choose the Total tool from the Deformation drop-down of the Solution contextual toolbar;
Total Deformation is added under the Solution node.

3. Now, choose the Directional tool from the Deformation drop-down; Directional
Deformation is added under the Solution node.

Note
1. In this tutorial, the Divectional Deformation has been calculated with vespect to the X axis.

2. 1o find Directional Deformation along the other two axes, you need to insert more instances
of Directional Deformation by using the Deformation drop-down in the Solution contextual
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toolbar. Next, you need to change the axes by selecting the required option from the Orientation
drop-down in the Details of “Directional Deformation” window.

4. Choose the Equivalent (von-mises) tool from the Stress drop-down in the Solution
contextual toolbar;

The Equivalent or von-mises stress is the criteria by which the effect of all the directional
stresses acting at a point is considered This helps in finding out whether the model will fail

or bear the stress at that particular point.

5. Choose the Maximum Principal option from the Stress drop-down in the Solution
contextual toolbar; Maximum Principal is added under the Solution node.

6. Choose the Minimum Principal option from the Stress drop-down in the Solution
contextual toolbar; Minimum Principal is added under the Selution node.

7. Choose the Solve tool from the Standard toolbar; the parameters are evaluated.

8. In the tree Outline, seiect Total Deformation to visualize the results; the deformed model
is shown in the Graphics screen, as shown in Figure 9-50.
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Figure 9-50 Total Deformation in the model

9. In the Details of “Total Deformation” window, expand the Results node, if it is not already
expanded. Note that the maximum and minimum deformations displayed are 1,139 mm
and 0 mm, respectively. ‘

The maximum and minimum values of Total Deformation can also be obtained from the
Legend displaying the color bands in: the Graphics screen.

10. Select all other parameters from the Solution node; the respective view is displayed in
the Graphics screen. The table given next lists all the results obtained from the analysis.
Also, Figures 9-51 to 9-54 show the corresponding graphical representation of values
obtained.
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Parameter Max. Value Min. Value
Total Deformation 1.139 mm | 0 mimn
Directional Deformation 0.022172 mm -0.95177 mm
Equivalent Stress (von-mises) 89.825 MPa 8.45 €-006 MPa
Max. Principal Stress 99.782 MPa -26.978 MPa
Min. Principal Stress 25.588 MPa -100.93
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Figure 9-51 Directional Deformation along
the X axis
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Figure 9-53 Maximum Principal Stress

1. Close the existing Mechanical window; the Workbench window is displayed.

Setting the Boundary condition for Case ii Analysis System

Figure 9-54 Mivimum Principal Stress

After you retrieve the results of the Case I analysis system, you now need to work for case II.

In the Spring Plate analysis system of the Project Schematic window, right-click on Static

Structural; a shortcut menu is displayed.

¥rom this shortcut menu, choose the Duplicate option, as shown in Figure 9-55; the Copy

of Spring Plate analysis system is created in the Project Schematic window.
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Figure 9-55 Choosing the Duplicate option

5. Double-click on the name field of the Copy of Spring Plate analysis system and then

specify Case I as the name of this analysis system;

4. Double-click on the Model cell of the Case II analysis systemn; Mechanical window of this

analysis systen is displayed.

Note

of the Spring Plate analysis system.

5. Right-click on Fixed Support in the Tree Outline;
a shortcut menu is displayed.

6. Choose the Suppress option from the shortcut menu
displayed, as shown in Figure 9-56; a cross icon (,(E,)
is placed on the left of Fixed Support in the Tree

Outline, indicating that this support is not available .

for analysis anymore.

7. Select the Static Structural node in the Tree Outline
to display the Environment contextual toolbar.

&. Choose the Displacement tool from the Supports
drop-down in the Environment contextual toolbar,
as shown in Figure 9-57; Displacement is added
under the Static Structural node in the Tree

it is renamed as Case II.

As the Case IT analysis system is an exact copy of the Spring Plate analysis system, all the
contents of the Mechanical window of the Case IT analysis system are exactly the same as that

43 Spring Plate
B (5 Model (C4)
G-, A Grometry
W.f::. Cogrdinate Systems
~ AL Mash
& /@] Static Structural (C5)
«é} Analysis Setiings

W B puplicate & -
Copy. -
& Cut.

i
¥ Dalete
db Rename

Figure 9-56 Choosing the Suppress
option from the shortcut meny

Outline. Also, the Details of “Displacement” window is displayed.

Displacement support is similar to the Fixed support but has partially restrained degrees of

freedom.

G, In the Details of “Displacement” window, select the Geometry selection box to display
the Apply and the Cancel buttons, if they are not displayed already.
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Figure 9-57 Choosing the Displacement
tool from the Supports drop-down

10. Choose the Face tool from the Select toolbar, .
11. Select both the circular faces, refer to Figure 9-58,

12, Nefct, choose the Apply button from the Geometry selection box in the Details of
“Displacement” window; 2 Faces is displayed in the Geometry selection box.

Notice that, with the inclusion of Displacement support in the analysis system, a local coordinate
system icon is placed in the model, as shown in Figure 9-59. This coordinate system will help
you to control the displacement of the support along a certain axis,

Irn this tutorial, you will restrict the movement of the component along the Y and Z axes,
whereas a displacement of 2 mm is allowed along the X axis. .

13. In the Details of “Displacement” window, expand the Definition node, if it is not already
expanded.

14. Enter 2 in the X-Component edit box; an arrow is placed in the model , refer to Figure 9-59,
indicating that the displacement is possible only along positive X axis.

Figure 9-58 Selecting the circular fuces Figure 9-59 Coordinate system placed in the model
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There are three edit boxes displayed when the Components option is selected in the Define
By drop-down list. To allow movement of the component along a particular axis, specify a
value in the corresponding edit box.

15. Similarly, enter 0 in both the Y-Component and Z-Compenent edit boxes.

Note
The direction of the arrow is a resultant of all the values specified in the X, ¥, and Z axes.

Solving the Analysis and Interpreting the Resuft
After you finish setting the boundary conditions, you now need to solve it in order to get
results. The parameters specified under the Solution node of this system are same as that
of Spring Plate analysis system. ‘

1. Choose the Solve tool from the Standard toolbar. ; green tick mark is placed . 4 Sryhye
before the respective results under the Selution node in the Tree Outline. < =7

2. Exit the Mechanical window for the Case II analysis system.
After solving both the analysis systems, it is required to understand the data.

3. In the Project Schematic window, double-click on the Model cell in the Spring Plate
analysis system; the Mechanical window is displayed.

4. In the Mechanical window, select the Total Deformation node available under the
Solution node in the Tree Outline; the respective Legend is displayed in the Graphics
screen. Also, the deformed shape of the model is displayed in the Graphics screen, refer
to Figures 9-60. '
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Figures 9-62 and 9-63 show the Total Deformation and Equivalent Stress for the Cage 17

analysis system.
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Figure 9-60 Total Deformation for the Spring  Figure 9-61 Equivalent Stress for the

Plate analysis system
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In the Tree Outline, select Total Deformation; the corresponding Legend is displayed in
the Graphics screen.

Similarly, select ali other nodes available under the Solution node in the Tree Outline to
display their corresponding Legends and effects on the model.

Figures 9-60 and 9-61 display the Total Deformation and Equivalent Stress for the Spring
Plate analysis system.

Exit the Mechanical window corresponding to the Spring Plate analysis system; the
Workbench window is displayed.

In the Case II analysis system, double-click on the Model cell to start the Mechanical
window.

In the Tree Outline, select the Total Deformation node; the corresponding Legend is
displayed.

Figure 9-62 Total Deformation for Case Il Figure 9-63 FEquivalent Stress Sfor Case IT
analysis system analysis system

10. Similarly, select all other nodes available under the Solution node in the Tree Qutline to

display their corresponding Legends and effects on the model.

The results obtained from both the analysis systems are shown in the table given next.

Description Spring Plate Case 11
Analysis System Analysis System
Total Deformation Max: 1.139 mm Max:  2.2439 mm
Min: 0. mm Min: 11736 mm
Directional Deformation Max: 0.22172 mm Max: 2.2217 mm
(Along X axis) Min: -0.95177 mm Min:  1.0482 mm
Equivalent Stress Max: 89.825 MPa Max: 89.825 MPa
Min:  8.4513e-006 MPa Min:  1.3297e-004 MPa
Max. Principal Stress Max: 99.782 MPa Max: 99.776 MPa
Min:  -26.978 MPa Min:  -26.98 MPa
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Description Spring Plate Cal'se II
Analysis System Analysis System
i inci Max: 25.588 MPa Max: 25.585 MPa
Viin Frincipal Suress Min:  -100.93 MPa Min: -100.93 MPa

Note . . .
The tabular format is very helpful in jotting down the data of various iterations of the same

amalysis with different settings. With the help of tabular data generated from various itemtio?zs n
ANSYS Workbench, you can also save the preprocessing time, refer to Chapter 7 for details.

The above table shows the Maximum Total Deformation of the model when it is provided
Fixed supportis 1.139 mm, whereas the Maximum Total Deformation-wht.en Displacement
support is provided is 2.2439 mrma. In both the analyses, the load applied is same; the only
difference is the way the support is applied. However, the more dlsplace{nent is observed
in the Case II analysis system as the cylindrical faces can move to a distance of 2 mm
along the X axis.

The Maximum Equivalent (von-mises) Stress developed is 89.825 MPa in both the analysis
systems.

The Minimum Equivalent (von-mises) stress developed in the Spring Plate and Case I
analysis systems are 8,45 E-6 MPa and 1.33 E-4 Mpa, respectively.

11. Exit the Mechanical window to display the Workbench window.

Saving the Project
You have already saved the project with the name ¢09_ansWB_Tut02, therefore now you
just need to save your work.

1. Choose the Save button from the Standard toolbar to save the project.

2. Next, exit the Workbench window to close the session.
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In this tutorial, you will first download the zip file c09_ans WB_tul03.zip from www.cadcim.com ang
then extract it to the specified folder. After extracting, add a Static Structural analysis system
to the Project Schematic window and import the file into ANSYS Workbench. Next, you will
apply Bearing load at the cylindrical faces of the model and Fixed support at the top planar
face of the model. Figure 9-64 and Figure 9-65 show the model with the cylindrical surfaces
annotated for applying Bearing Load and Fixed support respectively. You will also apply
the Gray Cast iron material to the model. Next, you will solve the analysis to evaluate Total
Deformation, Directional Deformation along Y axis, Equivalent Shear Stress, and Equivalent
Elastic Strain. ' (Expected time: 40 min)

Fixad support -

Fauas for applying bearing
ioad

Figure 9-64 Component with surfaces selected Figure 9-65 The top face of the model selected
for applying Bearing Load Jor applying Fixed support

The following steps are required to complete this tutorial:

Download the part file and import it into workbench.
Generate a mesh and apply boundary and loading conditions.
Edit the material and start the Mechanical window

Solve the analysis and compare the results.

Save the project and exit Workbench.

o n o

Downloading and importing the File into Workbench
Before you start the tutorial, you need to download the c09_ansWB_tut03.zip file from
www.cadcim.com and then import it into ANSYS Workbench. Next, you need to import
this file to ANSYS Workbench.

1. Create a folder with the name Tut0$ at the location CAANSYS_WB\C09.

2. Download the zip file c09_ansWB_tut03.zip from the www.cadcim.com. The complete path
of the file is :

Textbooks > CAE > ANSYS > ANSYS Workbench 14.0: A Tutorial Approach > Inpnt Files

After downloading, extract the zip file and save the c09_ans WEB_tut03.4gs file at the location
C:ANSYS_WB\CO9\Tut03.
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4. Start the ANSYS Workbench session.

4, In the Workbench window, add the Static Structural analysis system to the Project
Schematic window.

5. Right-click on the Geometry cell of the Static Structural analysis system to display a
shortcut menu, ‘

6. Choose Import Geometry > Browse from the shortcut menu; the Open dialog box is
displayed. :

7. 1n the Open dialog box, browse to the location C:IANSYS_WB\0917ut03 and then select
c09_ansWB_tut03.igs. Next, choose the Open button from the Open dialog box; the file
is imported into the Workbench window. Also, a green tick mark is placed corresponding
to the Geometry cell in the Mesh component system.

8. Choose the Save button from the Standard toolbar; the S8ave As dialog box is
displayed.

9. In this dialog box, browse to the location C:IANSYS_WBIc09\Tit03 and then save the
project with the name c09_ansWB_tut03.

Assigning the Material, Generating Mesh, and Specifying the Boundary
condition
Once the file is imported, you now need to assign a material to it and then generate a
mesh. To do so, follow the procedure explained next.

1. Inthe Engineering Data workspace, add Gray Cast Iron material to the Engineering Data
and return to the Project Schematic window.

2, In the Project Schematic window, double-click on the Model cell of the Static Structural
analysis system; the Mechanical window is displayed.

3. In the Mechanical window, assign: the Gray Cast Iron material to the model.

4. Choose the Generate Mesh tool from the Mesh contextual toolbar to  Generate Mesh
generate a mesh with the default global mesh control settings.

Figure 9-66 shows the Details of “Mesh” window with the default global mesh control
settings and Figure 9-67 shows the mesh generated for the model by using the default
global mesh control settings.

Notice that the total elements created with the default global mesh control settings 1s
1000.
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Figure 9-66 The Details of “Mesh” window Figure 9-67 Mesh generated with default global

10.

11.

mesh. control settings

Select the Static Structural node in the Tree Outline to display the Environment contextual
toolbar.

Choose the Fixed Support tool from the Supports drop-down in the & Fixed S
Environment contextual toolbar; Fixed Support, with a question symbol Hed Support
(), is attached to the Static Structural node in the Tree Qutline.

Choose the Face tool from the Select toolbar to select a face for applying Fixed
support. .

Select the Geometry selection box in the Details of “ Fixed Support” window to display
the Apply and Cancel buttons, if they are not already displayed.

Select the top face of the model in the Graphics screen to apply Fixed support, refer to
Figure 9-68,

Choose the Apply button in the Geometry selection box; the Fixed support is applied on
the selected face of the component.

In the Environment contextual toolbar; choose the Bearing Load tool
from the Loads drop-down; Bearing Load, with a question symbol

(2%9,), is attached to the Static Structural node in the Tree Outline. Also, the Details of
“Bearing Load” window is displayed.

B, Bearing Load

Bearing Load is applied when it is required to apply variable load on a cylindrical surface.

Notice that in the Details of “Bearing Load” window, the Geometry selection box is
selected by default. Also the Apply and Cancel buttons are displayed.

12. In the Graphics screen, select the cylindrical face of the model, as shown in Figure 9-69.
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I3

14.

Face Selamed for Applying the
Bearing Load

Figure 9-68 Fuce selected for applying the
Fixed constraint

Figure 9-69 Face selecied for applying
the Bearing Load

Choose the Apply button from the Geometry selection box; the color of the selected face
turns red indicating that the face has been selected for applying the Bearing Load.

After the face is selected for applying the load, the magnitude of the load needs to be
specified.

Next step 1s to specify the direction of the load. In the case of Bearing loads, note that the
direction of the load should always be radial to the cylindrical surface. The most common
practice while specifying the direction of any vector quantity is to select an edge in the
model in the Graphics screen. In case, there is no such edge available in the model along
which a direction can be specified, you need to specify a vector quanuty in the Graphics
screen by providing data for its X, Y, and Z components. For example, in this tatorial, you
need to specify the direction of the 10N Bearing Load along negative Y axis (-'Y). But as
you can notice, there are no edges that are along the Y axis. Therefore, in order to specify
a direction in this model, you need to specify the X, Y, and Z components.

In the Details of “Bearing Load” window, select the Components option from the Define
By drop-down list, refer to Figure 9-70; the components of Details of “Bearing Load”
window are modified and Coordinate System drop-down list is displayed in it along with
the X Component, Y Component, and Z Compenent edit boxes, refer to Figure 9-71.

. Enter 0 in the X Component, -10 in the Y Component and 0 in the Z Component edit

boxes; a red arrow is displayed on the selected surface, as shown in Figure 9-72. Also, a
green tick mark is placed before Bearing Load in the Tree Outline.

Notice that the direction of the load is now radial and hence it is correct to define the
direction by selecting the Components option from the Define By drop-down list.

The magnitude of load applied on each cylindrical surface is 10 N.
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Figure 9-70 Options in the Define By Figure 9-71 The options in the Details
drop-dowm list of “Bearing Load” window

Choose the Bearing Load tool from the Loads drop-down in the Environment contextual

toolbar; the Bearing Load 2 node is attached to the Static Structural node in the Tree
Outline,

Select the Geometry selection box in the Details of “Bearing Load” window to display
the Apply and Cancel buttons.

Select the second cylindrical surface of the component and then choose the Apply button
to specify this cylindrical face as the face to apply Bearing Load.

In the Details of “Bearing Load” window, select the Components option in the Define
By drop-down list, refer to Figure 9-70; the components of this window are modified
and the Coordinate System drop-down list is displayed along with the X Component, Y
Component, and Z Component edit boxes, refer to Figure 9-71.

In the Y Component edit box, specify -10 as the component of the Bearing Load vector.
The direction and magnitude of the load is specified, refer to Figure 9-72.

A Static Structural
Bewring Load 2
Time: Ls
62012 1Lz 4

Baaring

Bearing

Figure 9-72 Resulting direction of the loads

After the mesh is generated and the loading and boundary conditions are specified, you
need to specify the parameters to evaluate and then solve the analysis.
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Analyzing the Results

Now, you will analyze the component for Total and Directional Deformation and Maximum
Von-mises Stress and Strain.

Select the Solution node in the Tree Qutline; the Solution contextual toolbar is
displayed.

Choose the Total tooi from the Deformation drop-down in the Solution contextual toolbar;
the Total Deformation node is attached to the Selution node in the Tree Qutline.

Similarly, using the Directional Deformation, Von-mises Stress and Von-mises Strain
tools from the drop-downs available in the Solution contextual toolbar, you can insert
the corresponding results. The Tree Outline after the results are added is shown in
Figure 9-73.

Notice that there are yellow thunderbolt symbols attached to the results in the Solution
node in the Tree Qutline. Also, there is a thunderbolt attached to the Static Structural
node. These yellow thunderbolts indicate that the

solution is incomplete and you need to solve the B Frorec
s . B B Model (a4}
model in order to achieve results. B & Geemay

#h- 3y, Coordinate Systems

i S Mesh

Choose the Solve tool from the Standard toolbar; 17 Static Strictural (A5)

the ANSYS Workbench Solution Status window ! j:%\ Sl St
is displayed. Wait for sometime, the results are | "“3; Bearing Load

. . : : -/, Bearng Load 2
evaluated against the given boundary and loading f 672 Satution (36)

A2 Total Defarmation
A8 Diractional Deformation
A Erutvalent Strass
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Conditions. Sehation Information

Figure 9-74 shows the model when the Total -
Deformation node is selected in the Tree Outline
and Figure 9-75 shows the model when the
Equivalent Stress node is selected in the Tree
Outline.

Figure 9-73 Tree Outline afler the
results are added
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Figure 9-74 Total Deformation of the model Figure 9-75 Equivalent Stress of the model
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Select the Directional Deformation node in the Tree Qutline; the respective Directional

De{ormation of the model is displayed in the Graphics screen, Also, the Details of
“Directional Deformation® window is displayed.

.In the Details of “Directional Deformation” window, expand the Definition node, if it
1s not already expanded.

In the Deﬁnitiion ngde, the default selection in the Orientation drop-down is X axis,
Select the Y axis option from this drop-down list; a yellow thunderbolt is displayed before

Directional Deformation in the Tree Outline, indicating that the solution has changed
and you need to update the results.

Right-click on the Solution node in the Tree Outline; a shortcut menu is displayed.

Choose Evaluate All Results from the shorteut menu displayed; a green tick mark is

displayed before the Directional Deformation node in the Tree Outline, indicating that
the result files are updated.

Select the. Directional Deformation node in the Tree outline to display the Directional
Deformation along the Y axis, as shown in Figure 9-76.
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Figure 9-76 Directional Deformation along the Y axis

"The table displayed next displays all the values obtained from the analysis.

Parameter Max. Value Min. Value
Total Deformation 2.05 E-005 mm {0 mm
Directional Deformation

(¥ axis) 2.2 E-008 mm -2.03 E -005 mm
Equivalent Stress 115 Mpa 6.7 E-005 MPa

Equivalent Elastic Strain | 1.09 £-009 mm/mm 8.98 E-10 mm/mm

11. Exit the Mechanical window; the Workbench window is displayed.
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Saving the Project and Exiting Workbench ‘ .
After you have evaluated all the results, you now need to save the file before you exit the
ANSYS Workbench session. To do so, follow the procedure explained next.

1. Choose the Save button from the Standard toolbar to save the project.

2. Exit the Workbench window.

Answer the following questions and then compare them to those given at the end of this
chapter:

1. You cannot apply Fixed support on cylindrical surfaces. {T/F)
9. In ANSYS Workbench, you can apply support on muitiple surfaces. (T/F)

3. You can apply a support only by using the options in the Environment contextual toolbar.

(T7F)
4. You can rename a load in the Tree Qutline. (17F)
5. The Von-mises Stress is the resultant of stresses along all the axes. (T/F)

6. The Bearing Load applies the same load throughout the cylindrical surface on which it
is apphied. (T/F)

7. The tool is used to determine the Equivalent Stress.

8. When the Equivalent (von-mises) tool is chosen from the Stress drop-down in the Sohftion
contextual toolbar is added under the Solution node in the Tree

QOutline.

9. You can specify the exact direction of application of the Bearing and 'aiong an a%is by
selecting the option from the Define By drop-down list in the Details of

“Bearing Load” window.

10. The Legend is a band of to differentiate different areas of results in an

analysis system.
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Answer the following questions:

L. You can apply the Fixed support to a component by using the Fixed Support tool from
the Supports drop-down in the Environment contextual toolbar. (1/F)

2. By applying Fixed support to a part, you can restrict its few degrees of freedom. (T/F)

3. The Environment contextual toolbar is displayed when the analysis node is selected in
the Tree Qutline. (T/F) '

4. In a Static Structural analysis, the deformation can only be achieved along the X axis.
(T/F)

5. Which of the following parameters can be evaluated by using the Deformation drop-down
in the Environment contextual toolbar?

{(a) Directional {b) Method
{¢) Force (d) Bearing Load
6. The options in the toolbar are used to apply supports and loads

in any analysis.

7. Youcan clear all the analysis settings and results by choosing the option
from the File menu in the Mechanical window.

8. To view the wireframe mode of a model, choose View > from the View
menu in the Mechanical window.

EXERCISE

Download the zip file c09_ansWB_exr01 zip file from wuww.cadcim.com. After downloading, extract
the zip file to save the igs part file in the project. The model displayed in the Mechanical
window, after it is downloaded and imported into ANSYS Workbench, is shown in Figure 9-80.
Next, apply the Stainless Steel material to the model. Evaluate the Equivalent Stress, Total
Deformation and the Directional Deformation for the given material and boundary conditions.
Evaluate the same results by changing the material to Aluminium Alloy. The side faces of the
plate are fixed and a downwanrd force of 450 N is applied on the edge of the circular cutout,
refer to Figure 9-77. Figure 9-78 shows the schematic representation of the boundary and
loading conditions. (Expected time: 1 hr)

The complete path for downloading the file is :

Textbooks > CAE > ANSYS > ANSYS Workbench 14.0: A Tutorial Approach > Ingrut Files
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— Fixed Faces -
/ Force Load of 45(N
. bbb 6

Fia i

Figure 9-77 Model with the Fixed constraint Figure 9-78 Schematic representation of
and the Force load applied on it boundary and loading conditions

Download the c09_ansWB_exr02.zip file from www.cadcim.com. Alter downloading, extract it
to save the igs part file at the desired location. Figure 9-79 shows the model displayed in the
Mechanical window, After it is downloaded and imported into ANSYS Workbench, apply the
Aluminium Alloy material to it. Next, evaluate Total Deformation, Directional Deformation,
and Equivalent Stress for the given boundary conditions. (Expected time: 40 min)

Figure 9-80 shows the model with boundary and loading conditiouns.

The magnitude of the Force load applied is 250 N.

Figure 9-79 Model for Exercise 2 Figure 9-80 Boundary conditions on the
model

Answers to Seif-Evaluation Test

1.£ 2. T 3.5 4.7, 5. T, 6. £, 7. Equivalent (von-Mises), 8. Equivalent Stress 9. Component,
10. colors

Modal Analysis

* Analyze the model for of-;iimizd'tié
* Understand modes and mode shapes. .
* Generate mode shapes. ‘
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INTRODUCTION TO MODAL ANALYSIS

“The modal analysis is used to calculate the vibration characteristics such as natural frequency and
mode shape (deformed shapes) of a structure or a machine component. The output of the
modal analysis can be further used as input for the harmonic and transient analyses.

For example, Figure 10-1 shows a cantilever beam, attached to a system vibrating at a certain
frequency. It is important for the designer to find out whether the beam will sustain the
vibrations induced by the machine to which it is connected.

1 foved Suppoe

Figure 10-1 Cantilever beam model

When the cantilever vibrates, various shapes are attained at certain frequencies. The shape
of the component corresponding to a frequency is known as mode shape. The mode shape
is a graphical representations of the deformation attained due to vibration. The main aim
of the modal analysis is to find whether the natural frequency of the component is closer to
the vibrations induced in the component. In this example, with this cantilever, the maximum
aumber of modes found is six. Figures 10-2 through 10-5 display the various mode shapes of
first, second, 3rd, and 5th modes, respectively. ‘

Note
The magnitude of deformation provides an approximate idea about the deformation in the

model.

e

Rt

Figure 10-2 Mode shape for the Ist mode Figure 10-3 Mode shape for the 2nd mode
e P T T -~
Figure 10-4 Mode shape for the 3th mode Figure 10-5 Mode shape for the 5th mode
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If the natural frequency of a system is very close to the excitation frequency, the component
can get into resonance and fail. Therefore, to avoid the resonance, you need t’o strengtgen the
component on the basis of the mode shape. However, sometimes strengthening the component
may not be possible due to the design limitations. Also, in actual practice, the displa?ement
produced at resonance may not be infinite due to the presence of damping. Therefore, vou
neegl to calculate the response of a system under the time/frequency based Ioads. If the s;:rzss/
strain/displacement response is less than the permissible limit, the component will not be
required to strengthen or redesign.

PERFORMING THE MODAL ANALYSIS

The Modal analysis is performed to find out the natural frequencies of a model. You can find
outllm};:wlre than one natural frequency of a model depending upon the degrees of freedom
available.

The following steps are involved to perform a Modal analysis:

Set the analysis preference.

Create or import the geometry into ANSYS Workbench.

Define element attributes (element types, real constants, and material properties).
Define meshing attributes.

Generate a mesh for the model.

Specify the analysis type, analysis options, and apply loads.

Obtain the solution.

Review the results.

oo ap o

Most of these steps have already been discussed in previous chapters.

Adding Modal Anal_ysis System to ANSYS Workbench

To perform a Modal analysis in ANSYS Workbench, you need to add the Modal analysis
system from the Analysis Systems toolbox in the Toolbox window to the Project Schematic
window, refer to Figure 10-6.

Engineering Daty

EF# Gaomatry
B Model

2
3
P
YBN @ Setp
8
7

; Solution

BT IR

Figure 10-6 Fartial view of the Project Schematic window with
the Modal analysis system added to it
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Starting the Mechanical Window

To start the analysis, double-click on the Model cell of the Modal analysis system to display
the Mechanical window, refer to Figure 10-7. The components of the Mechanical window
displayed by using the Model cell of the Modal analysis system are similar to the components
of the Mechanical window displayed by using the Static Structural analysis system.

7 =
WT&@“}@{@@;&@&@@;&aa‘naa:mr

icas '@ﬁ;‘\’wdmmn UM tdgeColoting ¥ 0% < av > x™ A P I Thiden Aanotations B Shw Mest 3 Show Coptiinate Systems
dry | @0Vitest Teaclogy | B3 Symmety | & Remote Point G Connections | %3 Mash Numberng i £ setion Comatinton | E8Named 58

e il Conrdnate Systers
G ) Wash

-9 Solution (A5)
e 47 Sebution Information
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Figure 10-7 The Mechanical window with the Modal node displayed in the Tree Outline

In the Mechanical window, you can set the number of modes or natural frequencies you need
to find. Figure 10-8 shows the Tree Qutline of the Mechanical window.

_@ Project
Bl @] Model (Ad)
----- T Geometry
[ 3k, Coordinate Systems
‘‘‘‘‘‘‘ ¥ 5 Mesh
B Modal (A5}
,,,J’Y."Ei" Pre-Stress (Mone}

;_"jl Analysis Settings

5% Solution (A6}
Lo Solution Information

Figure 10-8 Analysis Settings selected in the Tree Outline

Specifying Analysis Settings

After generating mesh for the model, it is required to specify the settings needed to run the
Modal analysis. To do so, select Analysis Settings displayed under the Modal node in the Tree
Outline, refer to Figure 10-8; the Details of “Analysis Settings” window will be displayed. In
this window, specify a value in the Max modes to Find edit box to display the various mode

Modal Analysis 10-5

shapes. A limit can be assigned to the search of mode shape display by selecti

the Limit Search to Range drop-down list. On doing so, tEe Rar}igeyM}i}nimelf:;nagnYde;{ifrg
Maximum edit boxes will be displayed. Specify the values for the minimum and maximu%n
frequencies in these edit boxes to find mode shapes of the mode] within that specified range
Sglec{ the Yes option from the Damped drop-down list in the Details of “Analysis Settings’;
window to apply damping on a model, refer to Figure 10-9. The default selection in the
Damped drop-down list is No. As a resuit, ANSYS Workbench will not consider the system to

be damped. In such cases, the analysis is known as damped modal analysis where the mode
shapes and natural frequencies are complex.

3| Solver Controls

Damped No .
Sabvar Type Program Controlled
£ Rotordynamics Controls

Quiput Controls

£} Analysis Data Management

Figure 10-9 model created features

After the analysis setup is done, you need to solve the model. You can do so by choosing the
Solve tool from the Standard toolbar in the Mechanical window. After the model is solved, vou
need to plot the mode shapes. The procedure to plot the mode shapes is explained next.

Plotting the Deformed Shape (mode shape)

You can plot the mode shape (deformed shape) at each mode. However, before plotting the
deformed shape, you need to specify the mode in the Graph window. To create the mode
shapes, select the Solution node in the Tree Outline; the Graph and Tabular Data windows
will be displayed in the Graphics screen, as shown in Figure 10-10 and 10-11.

Mode F;' Frequency [Hz]
c 20T e 002
R A LT
SR e el SR e i
e T
Cr DEBBE
RN B oL R B

-~ Create Mode Shape Results

Figure 10-10 The Graph window Figure 10-11 The Tabular Data window
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Now, right-click in the Graph window to display a shortcut menu and then choose Select
All from it. Right-click again in the Graph window and then choose the Create Mode Shape
Results option from the shortcut menu; the modes are added under the Modal node. Based
on the number specified in the Max Modes to Find edit box, the number of modes are created
with the names Total Deformation, Total Deformation 2, . . . Total Deformation 6. Select
the required mode from the Solution node to visualize the corresponding mode shape in the
Graphics screen. ~

TUTORIALS

In this tutorial, you will create the model of a cantilever, as shown in Figure 10-12. The
dimensions of the model are given in Figure 10-13. You will generate the mesh with default
global mesh control settings and find six natural frequencies and their respective mode
shapes. The material used is Structural Steel. (Expected fime: 30 min)

The following steps are required to complete this ttorial:

Create a new project.

Create the model.

Generate the mesh,

Specify the boundary conditions.
Solve the analysis.

Retrieve the analysis results.
Play the animation.

Save the model.

o3 o oo ot

Figure 10-12 Model for Tuorial 1

i ; ) (N :,,f’f:":;:
5 _

Figure 10-13 Dimensions of the cantilever beam
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Creating a New Project
Before starting the tutorial, it is important to create a new project and save it

L. Start ANSYS Workbench session and then add the Modal analysis system to the Project
Schematic window.

2. In the Project Schematic window, rename the Modal analysis system to as Cantilever.

3. Choose the Save button from the Standard toolbar; the Save As dialog box is @ Save
displayed. :

4. Create a new folder with the name ¢10 at the location NS YS_WB. Open the c10 folder
and then create another foider in it with the name Tat01.

5. In this folder, save the project with the name cl0_ansWB_tui01,

Creating the model

After creating the project, you now need to work in the DesignModeler to create the
model.

1. Double click on the Geometry cell; the DesignModeler window along with the ANSYS
Workbench dialog box is displayed.

2. Select the Millimeter radio button in the ANSYS Workbench dialog box and then choose
the OK button to specify millimeter as the unit for creating the sketch,

3. In the DesignModeler window, select
XYPlane from the Tree Outline to specify
it as the sketching plane. Next, orient the
view normal to the viewing direction.

4. Invoke the Sketching mode. Next, create a |
rectangle and then dimension it, as shown | |
in Figure 10-14. For dimensions of the 1

model, refer to Figure 10-13. o i

5. Change H1 to 20 and V2 to 5 in the Details

View window. .
Figure 10-14 Rectangle created on the

6. Switch to the Modeling mode and then XY plane
change the view to Isometric, refer to Figure 10-12.

7. Extrude the sketch to a depth of 150 mm. The model after extrusion is shown in
Figure 10-12.
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Generating the Mesh for the Model

Now, you need to generate the mesh of the model.

Double-click on the Model cell in the Cantilever analysis system and waiF for sometime;
the Mechanical window is displayed. Also, you will notice that in the Outline wmdo.w, the
Mesh node is displayed in the Tree Outline with a yeliow thunderbolt attached to it.
Click on Mesh in the Tree Qutline; the Details of “Mesh” window is displayed.

In the Details of “Mesh” window, expand the Sizing node, if not already expanded.

In the Sizing node in the Details of “Mesh” window, enter 2.5 in the Element Size edit
box.

Right-click on Mesh in the Tree Outline and then choose the Preview > Slurf‘ace Mesh
from the shortcut menu displayed; the preview of the mesh for the model is displayed.

Choose the Generate Mesh tool from the Mesh drop-down in the Mesh 3} Generste Mesh
contextual tooibar; the mesh is generated, as shown in Figure 10-15.

Setting the Boundary Conditions

3.

Figure 10-15 Mesh generated for the model

After the mesh is generated, you need to set the boundary conditions under which the
analysis is to be performed.

Right-click on Modal node in the Tree Outline and then choose Insert > ?‘ixed Support
from the shortcut menu displayed; Fixed Support with a question symbol is adde:d undf?r
the Modal node in the Tree Qutline. Also, the Details of “Fixed Support” window is
displayed. '

In the Details of “Fixed Support” window, click on the Geometry cell to display the
Apply and Cancel buttons, if not already displayed.

Select the side face of the model, as shown in Figure 10-16.

s

Faces lor applying Fixad
suppat

Figure 10-16 Fuce selected for applying
Fixed support
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4. Next, choose the Apply button from the Geometry selection box in the Details of “Fixed

Suppert” window; Fixed support is applied to the selected face.

Solving the Modal Analysis

[&13

After specifying the boundary conditions in the Mechanical window, you need to set the
variables to define the results and solve the analysis.

Select Analysis Settings under the Modal node in the Tree Qutline; the Details of “Analysis
Settings” window is displayed.

In the Details of “Analysis Settings” window, expand the Options node, if it is not already
expanded.

Enter 6 in the Max Modes to Find edit box, if not already specified by default. Also

make sure that No is selected in the Limit Search to Range drop-down list, refer to
Figure 10-17.

Maxod
Limit Sesrch to Range { Mo
=l Solver Contrals

Dramped 1]
Salver Type Pragram Controlled
) Rotordynamicts Controls
Cutput Controls
[ Analysis Data Management
L —— - )
Figure 10-17 The Details of “4Analysis Settings”
window

Expand the Solver Centrols node in the Details of “Analysis Settings” window, if it is
not already expanded.

In the Damped drop-down list, select the No option, if not already selected.

Right-click on the Selution node in the Tree Outline and then choose the :’j Brlve
Solve option from the shortcut menu displayed; the analysis is solved. '

Select the Solution node in the Tree Outline; the Graph and Tabular Data windows are
displayed, refer to Figure 10-18.

Note

1. [f the Graph and Tabular Data windows are not displayed automatically, choose the Graph

tab from the lower left corner of the Graphics screen, refer to Figure 10-19; the Graph and
Tabular Data windows will be displayed.
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2. You need to select the Solution node in the Tree Outline to view the contents of the Graph
window.

5000 0 G {om) z"/d\ﬁ p
74
.
[0 A
7L T — A
2]
5000, - )
2000, HAES
o, ! ! 616,
t 2 ES 4 H 6 ;g‘;""ﬁ 5 :
© . [ NoMesszgesT - Mo Selactian - - [Matrie (mm, kg, 8, 5. mV, mA] Degrees radls g4

Figure 10-18 Partial view of the Mechanical window displaying the Graph and Tabular
Data windows

Retrieving Analysis Resultis
After the analysis is solved, you need to find the mode shapes.

1. Right-click in the Graph window, a shortcut menu is displayed.

2. Choose Select All from this shortcut menu to select all the data available in the Graph
window, as shown in Figure 10-19.

3. After the columns in the Graph window are selected, right-click again to display a shortcut
menu.

i f Q@ seFams v 25ttty

it Sefectan
Lmam ToRuage .
A

W8, | 0G|
N T
Figure 10-19 The Graph window Figure 10-20 Chovsing the Create Mode Shape

Results from the shorteut menu displayed

4. Choose the Create Mode Shape Results option from the shortcut menu displayed,
refer to Figure 10-20; Total Deformation resules are added under the Solution
node in the Tree Outline with the names: Total Deformation, Total Deformation
2, - - - Total Deformation 6. Also, you will notice that there are yellow thunderbolts
attached to each one of them indicating that these resuits need to be evaluated.

Modal Analysis . 10-11

The number of modes under the Solution node depend upon the value specified in the Max
Modes to Find edit box in the Details of “Analysis Settings” window.

5. Right-click on the Solution node again and then choose the Evaluate All Results from
the shortcut menu displayed; all the six results are ready to be viewed.

6. Select Total Deformation under the Solution node in the Tree Outline; the first mode is
displayed in the Graphics screen, as shown in Figure 10-21.

7. Select Total Deformation 2 under the Solution node; the second mode shape is displayed
in the Graphics screen, as shown in Figure 10-22,

The corresponding Legends of the mode shapes are also displayed in the figures.

A: Cantifever s Cantitewer

Toral Deformation Totel Deformation 7
Type: Totel Deformation Type: Totsf Defarmation
Fraguency: 182,35 Bz Frequlencys 147,06 Hr
Unit: mam Unit: rm

/2872017 L3 P HIBAL2 1230 P

1937 Max

e 184.58 Max

Figure 10-21 First mode shape Figure 10-22 Second mode shape

8. Similarly, select other results from the Solution node to view the corresponding mode
shape in the Graphics screen.

Figure 10-23 shows the Tabular Data window. The three columns in this window display
the serial number, mode, and frequency of the model,

¥ Frequency [Ha]
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Playing and Saving the Animation
After retrieving the results, you will now play the animation.

1. Select Total Deformation in the Solution node in the Tree Outline; the Graph window is
displayed

2. Choose the Play button available in the Animation area of the Graph window; the
animation with respect to the furst mode shape is played in the Graphics screen.

Note N
| You can set the duration of the animation by specifying a value in the Duration edit box of

Animation area. Also, you can set the frame rate by specifying o value in the Frames edit
box. A

3. Similarly, select Total Deformation 2 from the Tree Qutline and play the animation for
the second mode shape.

4. Choose the Export Video File button from the Animation area of the Graph window; the
Save As dialog box is displayed.

5. Browse to the location C:A\ANSYS _WBIcI10\Tut01.

6. Enter mode 1 in the File name edit box in the Save As dialog box and then choose the
Save button to save the video.

7. Similarly, export the animated video files of all the remaining modes to the desired
location.

8. Exit the Mechanical window; the Workbench window is displayed.

9. Choose the Save button from the Standard toolbar to save the project with l
the name c/0_ansWB_tut01.

Save. !

10. Close the ANSYS Workbench session.

Download the file ¢10_ansWB_tut02.zip from www.cadcim.com and Import it into ANSYS
Workbench. After importing the file, apply Aluminium Alloy material to the model. Next,
apply Fixed support to the cylindrical portion of the model and perform a modal analysis.
Figure 10-25 shows the model with the Fixed support applied to the cylindrical face.
(Expected time: 30 min)

The path of the file is as follows:

Textbooks > CAE > ANSYS > ANSYS Workbench 14.0: A Tutorial Approach > Input Files

Modal Analysis 10-13

A Connecling Rod
Fixed Suppert
Frequenay: N/A
3/6/2612 18:24 AW

Frerdt Support

Figure 10-24 Model for Tutorial 2 Figure 10-25 Fixed support applied to the model

The following steps are required to complete this tutorial:

Create a new project.

Download and import the file.

Apply the material and generate mesh for the model.
Apply boundary condition.

Solve the analysis.

Retrieve analysis results.

Analyze the data.

Play the animation and save the video file.

Save the project and close the ANSYS Workbench session.

MUEGR e a0 o

Creating a New Project
Before you start the tutorial, create a new project and save it.

1. Startan ANSYS Workbench session and then add the Modal analysis system to the Projeet
Schematic window.

2. Choose the Save button from the Standard toolbar; the 1

Save As dialog box is displayed.

2 & Enginsering Data "

3. Browse to the location C:ANSYS_WBIc10 and then |3 |G Geometry P 4

create a new folder with the name Tut02 in it 48 model =
4. In the Bu02 foider, save the project with the name 5§ sewp ? 4

C10_ansWB_tut02 at the location CIANSYS_WBic10.  i&. Solution ?
5. In the Project Schematic window, rename the ?@ R&sulmw”;‘ ,“;

Modal analysis systerz to Connecting Rod, refer to Connecting Rod

Figure 10-26. Figure 10-26 The Connecting

Rod analysis system
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Downloading and importing the File

To run an analysis for the Connecting Rod, you need to download the zip file and then
extract the zip file to the specified folder.

Download the file ¢10_ansWB_tut01.zip from www.cadeim.com. The path for the file is:
Texthooks > CAE > ANSYS > ANSYS Workbench 14.0: A4 Tutorial Approach > Input Files

After downloading the zip file, extract it to save the c10_ansWB_tut01 1gs file at the location
CAANSYS_WBIe10\Fut02. :

In the Connecting Rod analysis system, right-click on the Geometry cell and then choose
Import Geometry > Browse from the shortcut menu displayed; the Open dialeg box is
displayed.

In the Open dialog box, browse to the location CAANSYS_WBic10\Tiut02 and open the
file c10_ansWB_tut01.4gs; a green tick mark is displayed before the Geometry cell in the
Connecting Rod analysis system, indicating that the geometry is satisfied for the analysis.

Applying Material and Generating a Mesh

After the model is imported into the Connecting Rod analysis systera, you will apply
material to it and then generate mesh for the model.

In the Project Schematic window, double-click on the Engineering Data cell of the
Connecting Rod analysis system to display the Engineering Data workspace.

Choose the Engineering Data Sources toggle button from the Standard toolbar; - [FE’
the Engineering Data Sources window is added to the Engineering Data
workspace.

Select the General Materials library from the Engineering Data Sources window; the
Qutline of General Materials window is displayed.

Choose the plus (&5 ) symbol displayed next to the Aluminium Alloy material in the
Outline of General Materials window; the material is added to the Engineering Data.

Choose the Return to Project button from the Standard toolbar; the Project Schematic
window is displayed. ‘

Choose the Update Project button from the Standard toolbar to update the project.
After the material is added to the Engineering Data workspace, you need to go to the

Mechanical window and then apply the material to the model. After applying material,
generate mesh for the model. To do so, follow the procedure explained next.

Modal Analysis
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7.

16,

Double-click on the Model cell of the Connecting Rod analysi ‘ :
A : ys1s system in the P
Schematic window; the Mechanical window is displayed. roject

Figure 10-27 shows the Tree Outline in the Mechanical window. Notice that green tick

marks are placed before all the components except Mesh, indicating that mesh has to be
generated.

Expand the Geometry node in the Tree Outline to display Part 1. Next, select Part 1
under the Geometry node; the Details of “Part 17 window is displayed.

In the Details of “Part 1" window, expand the Material node and then choose Aluminium
Alloy from the Assignment flyout; Aluminium Alloy material is applied to the model.

Rig_ht—ciici{ on Mesh in the Tree Outline and choose the Generate Mesh  ©} Generate Mesh
option from the shorteut menu displayed; the mesh is generated with

the default global mesh control settings, as shown in Figure 10-28. Notice that the Details
of “Mesh” window is displayed below the Tree Outline.

B 1§ Model {a4)
2B Geometry
1/ 5 Part 1
B s2b Coordinate Systems
8 Mesh

HModal (A%)
b 720 Pre-Siress (Mong)
,/:{'ﬂ Analysis Settings
S, Fixed Support
5/ ET)

“egd K1 Solution Information

Figure 10-27 The Tree Ouiline displayed in Figure 10-28 The meshed model with default

the Mechanical window

1.

12

13,

14.

global mesh control settings

Notice that after generating the mesh of the model, the total element count is 4552, You
can also notice that the quality of the mesh is not fine around the circular regions in the
model. The next step is to discretize the model in such a manner that a smooth transition
will be achieved around the circular edges.

Expand the Sizing node in the Details of “Mesh” window, if not already expanded.

In the Details of “Mesh” window, select the On: Proximity option from the Use Advanced
Size Function drop-down list.

Enter 2 in the Num Cells Across Gap edit box in the Sizing node in the Details of “Mesh”
window.

Choose the Update tool from the Mesh contextual tooibar; the ANSYS Workbench Update
Model Sta}tus message box is displayed. After sometime, this message box is closed and
the mesh is generated with changed settings, as shown in Figure 10-29.
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i irni i imately 68,300 which is a
The total element count with the optimized mode% is approxima , ‘
E}t f;nmre than the previous count of 4532, The specified giobfal mesh control settings are
justified due to the complexity of the geometry and the required accuracy of the results.

Figure 10-29 Mesh generated with the changed settings

Note . .
Depending wpon the complexity and type of model, you can insert more local mesh control setiings

to generate o fine mesh.

Applying the Boundary Conditions N
pgxfyter gle model is meshed, you need to apply the boundary conditions to the model.

1. Select the Modalnode in the Tree Outline to display the Environment contextual toolbar.

2. Inthe Environment contextual toolbar, choose Supports > Fixed‘SupPort; §), Fixed Support
Fixed Support is added under the Modal node in the Tree Outline ‘vysth a
question mark attached to it. Also, the Details of “Fixed Support” window is displayed.

3. In the Details of “Fixed Support” window, select the Geometry selection box to display
the Apply and Cancel buttons, if not already displayed.

4. Now, choose the Face tool from the Select toolbar and then select the cylindrical
face of the model, as shown in Figure 10-30,

5. Choése the Apply button in the Geometry selection box; 1 F-fzce is displayed in the
Geometry selection box. Also, a green tick mark is placed before ‘leed Support under the
Modal node in the Tree Outline indicating that Fixed support is applied on the model.

Solving the Modal Analysis ‘ _
Aftegthe boundary conditions are specified in the Mechanical window, you need to define
the results to be evaluated and solve the finite element model.

1. Select Analysis Settings in the Modal node from the Tree Outline; the Details of “Analysis
Settings™ window is displayed.
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Face to be selected for
applying Fixed support

Figure 10-30 Cylindrical face selected for applying
Fixed support

2. In the Details of “‘Analysis Settings” window, enter 6 in the Max modes to Find edit box,
if it is not already specified.

3. From the Limit Search to Range drop-down list, select the Yes option; the Range
Maximuam and Minimum edit boxes are displayed.

4. Enter 500 Hz and 160000 Hz in the Range Minimum and Range Maximum edit boxes,
respectively.

5. Next, choose the Solve tool from the Standard toolbar; the analysis is solved. Also, the
Graph and Tabular Data windows are displayed.

Retrieving Analysis Resuits
After the model is solved, you need to find the mode shapes.

1. Select the Solution node in the Tree Qutline; the Graph and the Tabular Data windows
are displayed, refer to Figure 10-31,

2. Right-click in the Graph window, a shortcut menu is displayed, as shown in Figure 10-31.

3. Choose Select All from this shortcut
menu to select the data available in the
Graph window. s

5600, -

4. Next, right-click again to display the
shortcut menu, refer to Figure 10-31. 200
0.

5. Choose the Create Mode Shape Results ' Py Sefect All
option from the shorteut menu; the Toral \ Messagis, Graph || Zoom To Renge
Deformation results are added under — ~—=TSSmmcmmmn
the Selution node in the Tree Outline Figure 10-31 The shortcut menu displayed in the
Graph window
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with the names: Total Deformation, Total Deformation 2, - - - Total Dgfoyma.tion 6. Also,
there are yellow thunderbolt symbols attached to each one of them, indicating that you

need to evaluate them.
Right-click on the Solution node o display a shortcut menu.

Next. choose the Evaluate All Results option from the shortt?ut menu; the ANSYS
Worlébench Solution Status message box is displayed for sometime and the results are
evaluated. Also, green tick marks are placed before Total Deformation results under the

Solution node in the Tree Outline.

Select Total Deformation under the Solution node in Fhe Free Qutline; the first mode
shape is displayed in the Graphics screen, as shown in Figure 10-32.

Similarly, select Total Deformation 2 from the Tree Outline; the second mode shape is
displayed in the Graphics screen, as shown in Figure 10-33.

A Cennecting Rad
Tota! Beformatien 2
Type: Totat Defarmation
frequencys 26722 Mz
Unit ram

e Connecting Rod
Totsl Deformation
Type: Towl Beformation

Frequency; $48.87 Hz
Unit: rom
28I 202 M

2/23/2012 302 PM

Figure 10-32 First mode shape Figure 10-33 Second mode shape

Figure 10-34 shows the Tabular Data window. Table given next displays the. maximuim
and minimum values of the deformation in mode shapes and corresponding natural

frequencies.
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Natural Minimum Maximum
S.N. | Mode Shape Frequency (Hz) Deformation (mm} | Deformation (mm)

{ | fistmode 048.87 0 969.24
shape
second mode

2 shape 2672.2 0 258.44

g |thirdmode | og0q 0 $90.61
shape

' fourth mode : )

4 shape 4261.3 0 283 .46

p o |Dfthmode o0, 0 999.14
shape :

g |Sxthmode o004 0 981.01
shape '

Note that Minimum Deformation in all the cases is 0 because the model is constrained

with a Fixed support at one end and there is no deformation near the constrained face of
the model.

Analyzing the Data

There are six mode shapes for this model and the natural frequency result of the model
ranges between 948.87 Hz and 8893.8 Hz.

1. Select Total Deformation from the Tree Outline to display the first mode shape in the
Graphics screen, as shown in Figure 10-35.

2. Similarly, select Total Deformation 2, Total Deformation 4, and Total Deformation 6 to
display the corresponding mode shapes.

Figures 10-36, 10-37, and 10-38 display the second, fourth, and sixth mode shapes,
respectively,

Figure 10-35 First mode shape Figure 10-36 Second mode shape
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Figure 10-37 Fourth mode shape Figure 10-38 Sixth mode shape

Playing the Animation

8.

Now you need to animate the behavior of the model.

Select Total Deformation under the Solution node from the Tree Outline in the Mechanical
window; the first mode shape is displayed in the Graphics screen, refer to Figure 10-32. Also,
the Graph and Tabular Data windows corresponding to the first mode are displayed.

Choose the Play button available in the Animation area in the Graph window; the
animation corresponding to the first mode shape is played in the Graphics
screen.

Choose the Export Video File button from the Animation area of the Graph
window; the Save As dialog box is displayed. e

Browse to the location C:IANSYS_WBI10\Tut02

Enter Mode 1 in the File name edit box of the S8ave As dialog box and then choose the
Save button to save the video of the animation in the specified location.

Next, select Total Deformation 2 from the Tree Outline and play the animation for the
second mode shape.

Save the animations for second to sixth mode shape with the names Mode 2, - - - Mode 6
in the same folder.

Exit the Mechanical window; the Workbench window is displayed.

Save the Project and Closing the ANSYS Workbench Session

1.

2.

Choose the Save tool from the Standard toolbar; the model is saved. @ Save

Exit the Workbench window.

Modal Analysis

In this tutorial, you will investigate the vibration characteristics of a motor cc;;:r com

manufactured in Structural Steel. The cover is fastened at four bolt holes to a device o Ex? lifint
at 1200 Hz. Download the model from www.cadcim.com and give it a thickness of }1) Qa oy
Figure 10-39 shows the model of the motor cover component. (Expected time: 3l0 :f:)

The following steps are required to complete this tutorial:

Download and import the geometry into Workbench .

Generate a mesh and specify boundary conditions.
Solve the analysis.

Retrieve the results.

Analyze the data.

Play and save the animation.
Save the project.

meme o o

Figure 10-39 Model for Tutorial 3

Downioadiszg the Part File and Importing It Into the Workbench
Before starting the tutorial, you have to download the file c07_ansWB 102 zip file from
wwuw.cadcim.com. Next, import the file into ANSYS Workbench, -

1. Create afolder with the name Tut03 at the location C: ANSYS_WBIc10.

2. Elovxfnload the file ¢07_ansWB_tut02.zip from www.cadeim.com. The complete path for the
e is:

Textbooks > CAE > ANSYS > ANSYS Workbench 14.0: A Tuiorial Approach > Input Files

Next, extract the zip file to save the ¢10 ansWB tut03.ics file i ;
Cosys Topiert. _ _ ags file in the folder

3. Open ANSYS Workbench.
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a.

Add the Modal analysis system to the Project Schematic window.

Right-click on the Geometry cell of the Modal analysis system and then choose New
Geometry > Browse from the shortcut menu displayed; the Open dialog box is
displayed.

Browse to the location CrANSYS WBicl0\Tut03 and then select ¢I0_ansWB_tut03.1gs.
Next, choose the Open button from the Open dialog box; the file is imported into the
Workbench window. Also, a green tick mark is placed corresponding to the Geometry
cell in the Modal analysis system. -

Choose the Save button from the Standard toolbar; the Save As dialog box is
displayed. :

Save the project with the name ¢10_ansWB_tut03 at the location
CAANSYS_WBcl 0\ Tut(3.

In the Project Schematic window, renarne the Modal analysis system to Motor_Cover.

Generating the Mesh

After the geometry is imported, you need to apply thickness and then generate mesh for
the model.

Double-click on the Model cell of the Motor_Cover analysis system; the Mechanical window
along with the Attach Status message box is displayed. After sometime, the Attach Status
message box disappears and the model is displayed in the Graphics screen.

Notice that the model is a surface and

therefore, you need to add thickness to it. & Graphics Properties
= Definition

In the Tree Outline of the Mechanicgal [ Suppressed o
Window} exPand the Geometry nOde zzf;?di?af:?:é::n ;E::;:: Coordinate System
and then select Part 1.displa}red‘ init; the e Te:]pmture S Eronmant
Details of “Part 17 window is displayed. T

'Thickness KMu;ile " Refresh on Update- 7.
In the Details of “Part 17 window, Ofeet Type Wiiddie
expand the Definition node, if not | Matertal
already expanded. Assignment Strucurat Steel

Nonlinear Effects Yes e

Enter 1.2 in the Thickness edit box to ' o ”. )
provide a thickness of 1.2 mm to the Figure 10-40 The Details of “Part 1 window
model, refer to Figure 10-40.

Select Mesh in the Tree Outline; the Details of “Mesh” window is displayed.

Expand the Sizing node in the Details of “Mesh™ window, if not already expanded.

Modal Anaiysis
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10.

11

12.

13.

14.

15.

Select On: Proximity and Curvature from the Use Advanced Size Function drop-down
list under the Sizing node. -

Enter 1.50 in the Min Size edit box, refer to Figure 10-41.

Choose the Generate Mesh option from the Mesh drop-down in the Mesh contextual
toolbar; mesh is generated, as shown in Figure 10-42.

e
Defaylts
Physics Preference jMechanica!
"] Relevance o
1| Sixing
Use Advenced Size Funetion | On: Proximity and Cunvature
Relévance Center wMedium -
Initiat Slze Sead Attive Assembly
$mgothing Medium
Span Angle Center Coarse —
[73 Curvature Normal Angle | Default (0.0 % &
[} Prostimity Acquracy 65 _J
U] Mum Cells Adross Gap | Diefauit 3
Mo Size 150 mm
i | Proximity bin Size Defauit {2.53180 mm}
7% Max Face Size Default 128590 mm}
£ Growin Rate Defaulk :
 {nBrimur £dge Lngth I mm. e

Figure 10-41 The Detuils of “Mesh™ Figure 10-42 Mesh generated with the
window changed global mesh control settings

Expand the Statistics node in the Details of “Mesh” window to display the element count.
Notice that the total number of elements after generating the mesh is 1110.

To achieve a fine mesh along the curved faces, you need to provide local mesh controls
to the geometry.

Right-click on Mesh in the Tree Outline and then choose
Insert > Method from the shortcut menu displayed;
Automatic Method is added under the Mesh node with
a question symbol attached to it. Also, the Details of
“Automatic Method” window is displayed.

In the Details of “Automatic Method” window, select
the Geometry selection box to display the Apply and
Cancel buttons, if not already displayed.

Select the model in the Graphics screen, as shown in
Figure 10-43.

Figure 10-43 The pari selected

Choose the Apply button in the Details of “Automatic  ;, 17, Graphics screen

Method” window; the model is selected.

In the Details of “Automatic Method” window, select the Uniform Quad/Tri option from
the Method drop-down list, refer to Figure 10-44; the Details of “Automatic Method”
window is replaced by the Details of “Uniform Quad/Tri Method” window.
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16. In this window, enter 1.50 in the Element Size edit box.

17. Choose the Update tool from the Mesh contextual toolbar; the ANSYS Workbench Update
Status model message box is displayed. After sometime, the mesh is generated with the
applied local mesh control settings, as shown in Figure 10-45.

Eli Scope
Seoping Method Geometry Selection
Geaometry 1 Body
= pefinition
Suppressed Mo .
i Quadrilateral Bominant e
s - -
Eiemant Midside Nodes | Quadrifateral Dominant
Free Face Mesh Type ol -

UnifmmOuad

Figure 10-44 Selecting the Uniform Quad/Tri Figure 10-45 Mesh generated with the
option from the Method drop-down list applied local mesh control settings

i8. Select the Mesh node in the Tree Outline to display the Details of “Mesh” window.
19. Expand the Statistics node in the Details of “Mesh” window to display the element count.

Notice that the total number of elements after generating the mesh is 14815,

Applying Boundary Conditions ~
After the surface model is meshed, you need to apply the boundary conditions for the
model. The model is fixed to the motor with the help of bolts. Therefore, you need 1o
provide Fixed support at the bolt holes.

1. Select the Modal node in the Tree Outline; the Environment contextual tooibar is
displayed.

9. Inthe Environment contextual toolbar, choose the Fixed Support tool from the Supports
drop-down; Fixed Support with a question symbol attached to it, is added under the Modal
node in the Tree Outline. Also, the Details of “Fixed Support” window is displayed.

3. In the Details of “Fixed Support” window, select the Geometry selection box to display
the Apply and Cancel buttons, if not already displayed.

4. Choose the Edge tool from the Select toolbar to select the edges for applying @ ‘
Fixed Support. e

5. Select the edges of the holes provided for Fixed supports, as shown in Figure 10-46.
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Note
b select all edges of the holes, you need to use the CTRL hey.

i Edges tobe
selected

Figure 10-46 Edges of the bolt holes selected
Jor applying Fixed support

6. C‘hoose the Apply button in the Geometry selection box in the Details of “Fixed Support”
window; the Fixed support is applied to the four holes. Also a green tick mark is placed

before Fixed Support in the Tree Outline, indicating that Fixed support is applied on the
model.

Solving the Modal Analysis

After the boundary conditions are defined in the Mechanical window, you now need to
set the variables for the analysis and then define the results.

1. Select Analysis Settings from the Modal node in the Tree Outline; the Details of “Analysis
Settings™ window is displayed.

2. In the Details of “Analysis Settings” window, enter 8 in the Max modes to Find edit

box.

3. Next, choose the Solve tool from the Standard toolbar; the analysis is solved. Also, the
Graph and Tabular Data windows are displayed, as shown in Figure 10-47.

Ba R
ade {[v Frequency [Hz]
1343, ) N S T

16400, =
750, -

500,
250,
o

Figure 10-47 The Graph and Tabular Data windows

o3 g fen fun e s fne fm

F S Ry
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Retrieving Analysis Results

After the analysis is solved, you need to find the mode shapes.

Select the Solution node in the Tree Outline; the Graph and the Tabular Data windows
with all their contents are displayed, refer to Figure 10-47.

Right-click in the Graph window; a shortcut menu is displayed, refer to Figure 10-47.

Choose Select All from this shortcut menu to select all the data available in the Graph
window.

Right-click in the Graph window again and then choose the Create Mode Shape Results

option from the shorteut menu displayed; Total Deformation results are added under the

Solution node in the Tree Cutline with the names: Total Deformation, Total Deformation
9, - - - Total Deformation 8. Also, vellow thunderbolts are attached to each one of them,
indicating that they need to be evaluated.

Right-click on the Solution node and then choose the Evaluate Ail Results option from
the shortcut menu displayed; the ANSYS Workbench Solution Status message box is
displayed and the results are evaluated. Also, green tick marks are placed before the Total
Deformation results added under the Solution node in the Tree Outline.

Select Total Deformation under the Solution node in the Tree Outline; first mode shape
is displayed in the Graphics screen, as shown in Figure 10-48.

Similarly, select Total Deformation 2 from the Tree Outline; second mode shape is
displayed in the Graphics screen, as shown in Figure 10-49.

Each mode shape represents a frequency value. Figure 10-50 shows the Tabular Data
window displaying the natural frequencies of different mode shapes.

108.80 (e 2.6 5008 18005 trnen)
¥ L
%500 o] 2580 15.83

Figure 10-48 First mode shape displayed Figure 10-49 Second mode shape displayed
in the Graphics screen in the Graphics screen
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Tode F Frequenty [Hzl

T
2 3007
e
L 66646
S IR T
S FR0IT

f@mwmmhmmt—k

B SRR i e

Figure 10-50 The Tabular Data window displaying
the natural frequencies of different mode shapes

Table shown next displays the deformation in mode shapes and their corresponding
natural frequencies. g

S.N, | Mode Shape :Z?;::Incy (Hz) Deformation (mm)
i first mode shape 331.16 145.87
2 second mode shape 390.07 145.98
3 third mode shape 666.39 97.204
4 fourth mode shape 666.46 97.289
5 fifth mode shape 760.77 167.92
6 sixth mode shape 760.77 167.92
7 seventh mode shape 1069.2 65,972
8 eigth mode shape 1343 170.79

The Minimum Deformation in all the cases is 0 because the model is constrained with
the help of bolts and there is no deformation near the constrained edges of the model.

Analyzing the Data

After the results are generated and mode shapes are displayed, it is advisable to compare
the data with an analysis of a model that is more optimized.

In the Project Schematic window, right-click on the Modal analysis system; a shortcut
menu is displayed.

Choose Duplicate from the shortcut menu, as shown in Figure 10-51; a copy of the Modal
analysis system is added to the Project Schematic window, refer to Figure 10-52.
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1
3 z:i':: ; 2P Engineering Date a! '_g@ EngineeringDats v 4
6B wodel B0 . 3 1188 Geomelry v 4 3 |l Geometry v 4
W st | 4| v Ca |5]@ e v 4
}——S;)Iutzyo Clear Generated Data 5|6 setp v o4 5 G5 setup 7 4
(7@ Rewdl W Delete & Solution v AE & Solution A
C 0 HEE Reene @ Reis ] 7@ Reais 7
Properties Madal Modal 2
Figure 10-51 Choosing the Duplicate Figure 10-52 A copy of the Modal analysis system
option from the shovtcut menu added in the Project Schematic window

3. Rename the newly created analysis system to Modal 2, refer to Figure 10-52.

Notice that Setup, Solution, and Results cells in the Modal 2 analysis system have yellow
thunderbolts attached to them indicating that they need to be updated.

4. Double-click on the model cell of the Modal 2 analysis system in the Project Schematic
window; the Mechanical window for Modal 2 analysis system is displayed.

5. In the Tree Outline, expand the Geometry node and then select Part 1 in it; the Details
of “Part 1” window is displayed.

Note
Make sure that the unit system selecled is mm, Kg, N, s, m¥, mA in the Units menu.

6. In the Details of “Part 17 window, expand the Definition node and then enter 2 in the
Thickness edit box; the thickness of the surface model changes to 2mm.

7. Select the Mesh node in the Tree Outline to display the Details of “Mesh” window.

8. In this window, expand the Sizing node and then enter 1.8 in the Min Size edit box.

9. Expand the Mesh node in the Tree outline to display the Uniform Quad/Tri Method.
Select Uniform Quad/Tri Method to display the Details of “Uniform Quad/Tri Method”

window.

10. In the Details of “Uniform Quad/Tri Method” window, expand the Definition node and
then enter 1.5 in the Element Size edit box.

11. Choose the Update tool from the Mesh contextual toolbar; the mesh is generated with
changed settings and a green tick mark is displayed before the Mesh node in the Tree
Outline.

Figure 10-53 shows the mesh generated with changed settings.
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Figure 10-53 Mesh generated with changed settings

12. Now, choose the Solve tool from the Standard toolbar; the ANSYS Workbench Solution
Status box is displayed. After sometime this box is closed and the analysis is solved and

green tick marks are placed before the Total Deformation results available under the
Solution node in the Tree Outline.

13. Select Total Deformation from the Solution node to display the first mode shape in the
Graphics screen, as shown in Figure 10-54.

i4. Similarly, sc?lect Total Deformation 6 under the Solution node in the Tree Qutline; the
corresponding mode shape is displayed in the Graphics screen, refer to Figure 10-55.

Br Wodal 2 B: Modal 2
Total Defommation Totat Detarmation §
Type: Total Deformation Type: Totai Deformation

Frequency; 541,41 Mz frequency: 1260.%

180.00

Figure 10-54 First mode shape when Total — Figure 10-55 Sixth mode shape when Total
Deformation is selected under the Solution node  Deformation 6 is selected under the Solution node

The following table displays the results obtained from the Modal 2 analysis system.

S.N. | Mode Shape Natural Minimum' Maximum
Frequency (Hz) Deformation (mm) | Deformation (mm)
first mode '
! shape 547.41 0 118.08
second mode
2 shape 632.89 0 113.08
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g |thirdmode 4509 0 79.814
shape

g |fourthmode 1,04, 0 79.818
shape

5 |Afthmode 40605 0 198.41
shape

6 |sxthmode 19605 0 128.41
shape

7 seventh mode 1609.4 9 51.0.
shape
eigth mode ,

8 2226.3 0 132.59
shape

In this tutorial, the model is assumed to be attached to a motor which runs at a frequency
of 1000 Hz. Therefore, it is important to analyze whether the model survives the induced
frequency. If desired result is not obtained from the analysis, you can optimize the model.
To do s0, vou can change the material, vary the thickness of the component, and so on.
Next, run the analysis to evaluate results again and then compare the results obtained
with the previously obtained data.

Playing the Animation
After the results are generated, you can play the animation to know how the model behaves.

1. Select Total Deformation in the Solution node in the Tree Outline; the Graph window
is displayed with the Animation area displayed m it.

9. 1In the Animation area of the Graph window, enter 20 in the Frames edit box and 4 in
the Duration edit box.

3. Choose the Play button from the Animation area in the Graph window; the
animation with respect to the first mode shape is played in the Graphics screen.

4. Choose the Export Video File button from the Animation area of the Graph window; the
Save As dialog box is displayed.

5. Browse to the location C-IANSYS_WBicl 0\Tut03 and enter mode 1 in the File name
input box in the Save As dialog box and then choose the Save button to save the
video of the animation in the specified location.

6. Select Total Deformation 2 under the Solution node in the Tree Outline; second mode
shape is displayed in the Graphics screen.

7. Play the animation for the second mode shape.

8. Save the animation as discussed earlier.
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9. Play all the animati b ird r 0 ot
f;he?n. nimations from third mode shape to eigth mode shape and then save

10. Exit the Mechanical window; the Workbench window is displayed.

Saving the Project

Now, you need to save the project.

2. Exit the Workbench window.

A;su;er the following questions and then compare them to those given at the end of this
chapter:

1. Modal analysis determines the vibration characteristics of a structural component. (T/F)

2. When a damper is added to a component, the damped modal analysis is carried out. {T/F)

3. Only natural frequencies are determined in a Modal analysis. (T/F)

4. Modal analysis determines the r ; i
esponse of a structure to the vibrations that i
dependent. (T/F) e tme

5. To start a Modal analysis in ANSYS Workbench, vou first need to run ;
3 { .
analysis. (T/F} ¥ € I a Static Structural

6. In Dynamic analysis, the load or field conditions vary with time. (T/F)

7. When the.nat_ural frequency of a system is very close to the operating conditions or close
to the excitation frequency, resonance may be induced in the component. (T/F)

8. When the intensity of the stress exceeds the elastic limit, the material looses its
property.

Answer the following questions:
1. The number of modes to be extracted should be less than the number of DOFs. (T/F)

2. In Modal analysis, you can find the stresses induced in the model . (T/F)
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3. In the stepped boundary condition, the defined force/moment is applied to the model at
each frequency. (T/F}

4. 1f the loading is removed after exceeding the elastic limit, the geomtry will not retain its
original shape. (T/F)

5. You cannot find more than 6 mode shapes in the Modal analysis. (1/F)

6. For every , there is a corresponding mode shape displayed in the Graphics
screer. ;

EXERCISES

the project with the name ¢10_ansWB_exr01 at the location C:\ANSYS_WBleIO\Exr01. Add
the Modal analysis system to the project and then perform the Modal analysis. Apply Fixed
support to the inner cylindrical faces of the holes. Number of modes to be found are 8.

(Expected time: 30 min)
The model for Exercise 1 is shown in Figure 10-56.

Open the project titled ¢04_ansWB_tut02 from the location CAANSYS_WB\c041Tui02. Save
the project with the name ¢10_ansWB_exr02 at the location CAANSYS_WBiclO\Exr02. Add
the Modal analysis system to the project and then perform the Modal analysis. Apply Fixed
support to the inner cylindrical faces of the holes. Number of modes to be found are 6.

(Expected time: 30 min)
"The model for Exercise 2 is shown in Figure 10-57.

Figure 10-56 Model for Exercize Figure 10-57 Model for Exercize 2

Answers to Self-Evaluation Test
1.TL2.1.5.F4.T5.F 6.1, 7. T, 8 elastic

Chapter 11

Thermal Analysis

* Understand the Mechanica interface used for Thermal analysis.
* Understand different terms used in Thermal analysis.. -
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INTRODUCTION TO THERMAL ANALYSIS

Before a model is set for production, it passes through several stages. Thermal analysis is one
of them and plays an important role in product development, Various products such as engines,
refrigerators, heat exchangers, and so on are designed based on the results of this analysis.

Thermal analysis is used to determine the temperature distribution and related thermal
quantities in the model. In this analysis, all heat transfer modes, namely conduction, convection,
and radiation are analyzed. The output from a thermal analysis can be the following:

Temperature distribution,
Amount of heat loss or gain.
Thermal gradients.
Thermal fluxes.

e 08 RO e

This analysis is used in many engineering industries such as automobile, piping, electronic, power
generation, and so on. In ANSYS Workbench, two types of thermal analysis can be carried
out, namely Steady-State and Transient Thermal analysis.

The following are the basic steps required to perform the thermal analysis:

Set the analysis preference.

Create or import solid model.

Define element attributes (element types, real constants, and material properties).
Mesh the solid model.

Specify the analysis type, analysis options, and the loads to be applied.

Solve the analysis problem.

Post-process results.

iIMPORTANT TERMS USED IN THERMAL ANALYSIS

Before conducting thermal analysis, you should be familiar with the basic concepts and
terminologies of thermal analysis. Following are some of the important terms used in thermal
analysis: '

B 1o

[ B e P

Heat Transfer Modes

Whenever two bodies having different temperatures come in contact, then the heat
transfer takes place from the body of higher temperature to the body of lower temperature.
There are three modes of heat transfer: Conduction, Convection, and Radiation.

Conduction
Conduction is the process of heat transfer between bodies in contact. For example, hold an

iron rod on a flame and then wait for sometime; the iron rod will be heated and you will feel
the heat on your palm.
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Convection

Convection is the process of heat transfer in which the medium of heat transfer is a Auid. For

exaxr‘{ple, heating up water using an electric water heater is a good example of heat convection
In this case, water takes heat from the heater. -

Radiation

Radiation is mode of heat transfer in which the heat is transferred through space. Heat from
sun is a perfect example of this mode of heat transfer.

Thermal Gradient
The thermal gradient is the rate of change in temperature per unit depth in a material,

Thermal Flux

dGﬂO{eé by q. ’ :

Buik Temperature

It is the temperature of a fluid flowing outside the material. It is denoted by 7b. The Bulk
temperature is used in convective heat transfer.

Film Coefficient
It is a measure of the heat transfer through a fluid film.

Emissivity
The emissivity of a material is the ratio of ener i '

- gy radiated by the material to the ener
radiated by a black body at the same temperature, Emissivity is the measure of a materia%z

ability to absorb and radiate heat. It is denoted by ¢. Emissivity is a numerical value without
any unit. For a perfect black body, ¢ = 1. For any other material, ¢ < 1.

Stefan-Boltzmann Constant

Tb;: Stefan-Boltzmann constant is: a physical constant and defines the power per unit area
emitted by a black body as a function of its thermodynamic temperature. It is denoted by s.

Thermal Conductivity

t d

Specific Heat

The specific heat is the amount of heat required per unit mass to raise the temperature of the
body by one degree Celsius. It is denoted by c.
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TYPES OF THERMAL ANALYSIS

In ANSYS Workbench, two types of thermal analysis can be carried out, namely Steady-State
Thermal analysis and Transient Thermal analysis.

Steady-State Thermal Analysis

In the Steady-State Thermal analysis, the thermal load does not vary with time and remains
comstant throughout the period of application. This analysis considers only steady loads
and does not consider any thermal load that varies with time. In the Steady-State Thermal
analysis, the system is studied under steady thermal loads with respect to time. These thermal
loads include convection, radiation, heat flow rates, heat fluxes (heat flow per unit area), heat
generation rates (heat flow per unit volume), and constant temperature boundaries.

The Steady-State Thermal analysis may be either linear or noxnlinear, with respect to material

properties that depend on temperature. The thermal properties of most of the materials do
vary with temperature, therefore the analysis usually is nonlinear. Including radiation effects
or temperature-dependent convection in a model also makes the analysis nonlinear.

The steps to solve a problem related to the Thermal analysis are the same as that of the
structural analysis, except a few steps such as selecting the element type, applying the load,
and postprocessing resuits.

Transient Thermal Analysis

Transient Thermal analysis, the application of thermal loads is time dependent. Most of the
engineering applications need Transient thermal analysis, such as engine blocks, pressure
vessels, nozzies, piping systems, and so on. The process of solving the Transient thermal
analysis problem is the same as that of the Steady-state thermal analysis. The only difference
between these two analyses is that in Transient Thermal analysis, the load applied on a body
is the function of time.

In the Transient Thermal analysis, the system is studied under varying thermal loads with
respect to time. You can get the temperatures varying with time, thermal gradients, and
thermal fluxes in a Transient thermal analysis.

The Transient Thermal analysis takes more time compared to other analyses types. It is
necessary to understand the basic mechanism of the problem to reduce the time involved in
getting its solution. For example, if the problems contain nonlinearity, then you first need
to understand how they affect the response of structures by doing the Seady-State Thermal
analysis.
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TUTORIALS

In t.hls tz{torlal,'you will open the existing project c04_ansWB_{ut02. Next, you will save the
project with a different name and run the Steady-State Thermal analysis on the model shown
in Figure 11-1 to find out the effect of temperature on the whole body of the model. Also, you
will evaluate the Total Heat Flux and the Directional Heat Flux with respect to the X gig.

The parameters required to run the analysis are given next. (Expected time: 43 min)

Boundary Conditions:

Apply the Temperature load of 80 °C on the front flat face of the model, as shown in
Figure 11-2.

{xpply the Convection load on the inner faces of the model, as shown in Figure 11-3. The
inner faces are exposed to air. The ambient temperature is 22 °C,

Material:
Structural Steel (Default)

B:Case 1
Termperature
Time: 1,5
3152012 %30 Ak

Temperature: $6,°C

Faces for
apgiying
Conweclion
load

B:Case
Convictian
Time Ls

Face for appiying HIS/6L2 930 Am

Temperature foad
Convection: 22. *C, L24a-885 Wram ¢

Figure 11-2 Face for applying the Figure 11-3 Faces for applying the
Temperature load Conuvection load
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The following steps are required to complete this tutorial:

Open an existing project and save it with a different name.
Change the unit and generate the mesh.

Apply thermal boundary conditions

Analyze the results.

Save the project and exit ANSYS Workbench.

Opening an Existing Project and Saving it with a Different Name

First, you need to start ANSYS Workbench and then open the existing project.

Start ANSYS Workbench and then open the file ¢04_ansWB_fut02 'from the iocgtion
CAANSYS WBI041Tiut02. Notice that the Geometry component system is already available
in the Project Schematic window.

Choose the Save As button from the Standard toolbar; the Save As dialog box is displayed.

In this dialog box, browse to the location C:\ANSYS_WB and create a folder with the name
cll.

Browse to the ¢l 1 folder and then create a folder with the name Tut01 in it.
In the Tut01 folder save the project with the name c1i_ansWB_tut01.

Now you need to add the Steady-State Thermal analysis systern into the Project Schematic
window. '

In. the Warkbench window, double-click on the‘Steac?y—State Thermal analysis system
under the Analysis Systems toolbox in the Toolbox window.

Rename the Steady-State Thermal analysis system to Case 1, refer to Figure 11-4.

i
Gaomaty HE) Share A2 N
M
56 setp 1
{6 {68 solution P .
716 Pesits P .

caset
Figure 11-4 The Geometry component system
and the Case 1 analysis system

Drag the Geometry cell from the Geometry component system “mto the Geometry cell
of the Case 1 analysis system, refer to Figure 11-4; the geometry is shared.

Thermal Analysis
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9. Double-click on the Model. cell of the Case 1 analysis system; the Mechanical window is

displayed.

Changing the Units and Generating the Mesh

After the Mechanical window is displayed, you need to set the units for the analysis and
generate the mesh for the model.

In the Mechanical window, Choose the Metric (mm, kg, N, s, mV, mA) option from the
Units menu in the Menu bar

In the Tree Outline, right-click on Mesh to display a shortcut menu.

Choose the Generate Mesh option from the shortcut menu; the mesh with default settings
is generated, refer to Figure 11-5.

Naotice that the number of elements in the model after generating the mesh is 2339, For
better results, you need to generate a mesh that is finer than the one already generated.

Select Mesh from the Tree Qutline; the Details of “Mesh” window is displayed.

In the Details of “Mesh” window, expand the Sizing node.

Select the On: Proximity option from the Use Advanced Size Function drop-down list;
the content of the Details of “Mesh” window is modified.

Enter 4 in the Proximity Min Size edit box. Similarly, enter 8 and 9 in the Max Face Size
and Max Size edit boxes, respectively.

Choose the Update tool from the Mesh contextual toolbar; the mesh is

generated with the modified settings, refer to Figure 11-6. v ”F*F‘afe

Figure 11-5 Mesh generated with the default Figure 11-6 Mesh generated with the modified
seltings settings

Note that the number of elements in this mesh is 66,500. This number is very large as

compared to the element count that was achieved in the mesh generated with the default
mesh control settings,
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Note
As the Structwral Steel material is applied by default, you can skip the steps used for assigning
material fo the geometry.

Applying Thermal Boundary Conditioens

After the model is meshed, you now need to apply the boundary condition for the
analysis.

Select the Steady-State Thermal node in the Tree Outline to display the Environment
contextual toolbar. §

From the Environment contextual toolbar, choose the Temperature tool;
Temperature is added under the Steady-State Thermal node. Also, the
Details of “Temperature” window is displayed.

B Yemperature ]

In the Details of “Temperature” window, select the
Geometry selection box to display the Apply and Cancel
buttons, if they are not already displayed.

Select the front face of the model, as shown in Figure 11-7.

Choose the Apply button from the Geometry selection
box in the Details of “Temperature” window; the face
is selected for applying the Temperature boundary
condition.

Figure 11-7 Selecting the front
In.the Details of “Temperature” window, specify 80 in face for applying Temperature load
the Magnitude edit box. ‘

Select Temperature from the Steady-State Thermal node in the Tree Outline; the Graph
and Tabular Data windows are displayed, as shown in Figures 11-8 and 11-9.

Tinvie {5

Figure 11-8 The Graph window displayed on
selecting Temperature from the Steady-State
Thermal node in the Tree Outline

Figure 11-9 The Tabular Data window
displayed on selecting Temperature from the
Steady-State Thermal node in the Tree Outline

Thermal Analysis
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Notice that in Figures 11-8 and 11-9, the total time taken for applying the Thermal

18 Ccon Vel

Choose the Convection tool from the Environment contextual toolbar; Convection is

added under the Steady-State Thermal node. Also, the Details of “Convection”

is displayed. window

In the Details of “Convection” window, select the G i if it i
\ eometry selection box, if it
already selected; the Apply and Cancel buttons are displayed).l e

10. Select the inner faces of the model, refer to Figure }1-10.

It

12,

13.

Figure 11-10 Selecting inner faces for
applying the Convection load

In the Details of “Convection” window,

choose the Apply button; the faces are ; Scope
fpec;nfzed for applying the Convection Scaping Metnog Geometry Selection
oad. Geometry 3 Faces
=] Definition
¥ A ) | Convaction
Now, choose the Import option from ST o i o e )
the Film Coefficient drop-down, refer _.i Amblent Semperature | 22. 'C {amped) (/53 Import
3 s q 7
to Figure 11-11; the Import Convection — =
Data dialog box is displayed, as shown in
Flgure 11-12. [:'M Constant
Tabular- -
In the Import Convection Data window, L....Fanction

selgct the Stagnant Ail' - Horizontal Cyl  Figure 11-11 The Import option chosen
radio button, refer to Figure 11-12. from the Film Coefficient drop-down
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15. Select Convection from the Steady-State Thermal node in the Tree Outline; the Graph
and Tabular Data windows are displayed, as shown in Figures 11-14 and 11-15,

Figure 11-14 shows the graph for distribution of Convection Coefficient with respect to
emperature with Stagnant Air - Horizontal Cyl considered as the film of the fiuid. This graph
shows that as the Temperature increases, the Coefficient of Convection also changes.

- -5.13380-2

W = e e o s e e e e e

5 s ; e Temperature ['C} f¥ Convection Coefficiznt {W/mmiC] %
|5

1.24e-006

%,g Can\.rec.tion Gats to Import:’ “

i
{7y Stagnant Alr - Simpified Case
] Stagnant Air « Verticat Planesl s
ir « Verticat Planes? : e
: N i" Ve:tcaipl nes ¥ ; A4BES 30, 50, 7%, 11488
[ . 2 : ]
L | Stagnant Air - Ve l-cé ‘ : i Tempersture §°C)
| |y Stagnant Water - Simplified Cate - E

-
in
2

&

i
B
&

Cenvection Cocfflcient [Wimm

2 ER o+ Figure 11-14 The Graph window displayed Figure 11-15 The Tabular Date window
- b on selecting Convection from the Steady- displayed on selecting Convection under the
State Thermal node in the Tree Outline Steady-State Thermalnode in the Tree Outline

Figure 11-12 The Stagnant Air - Horizontal Cyl radio buiton selected ._ Analyzing the Results
- from the Import Convection Data window _3 After the thermal boundary conditions are applied, it is now important to analyze the
. behavior of th del wit} tothe b iti ied.
Ihe Stagnant Air - Hortzontal Gyl radio button i selcted when the surrounding air is ehavior of the model with respect to the boundary conditions applied

considered to be stagnant. '_ - I, Right-click on the Solution node in the Tree Outline to display a shortcut menu.

14. N.ext, choose the OK button from the Import Convection Data dialog box to exit the : 2. Trom this shortcut menu, choose Insert > Thermal > Temperature; Temperature is

window and apply the changes. i added under the Solution node in the Tree Outline. Also, the Details of “Temperature”

—_— window is displayed.
Notice that the Details of “Convection” window is also modified, as shown in Figure 11- 13.

Also, a green tick mark is placed before Convection added under the Steady-State g‘he;mal 8. In this window, select the Geometry selection box to display the Apply and Cancel
node in the Tree Outline, indicating that the Convection boundary condition has been buttons.
applied.
4. Choose the Body tool from the Select toolbar and then select the model, as shown @ (
& scope in Figure 11-16. .
Seoping Method Geametey Selection .
Seanay S 5. Choose the Apply button from the Geometry selection box in the Details of “Temperature”
#]| Definition B . Pp y . . Y - P
e Convection. . - window; 1 Body is displayed in the Geometry selection box.
Fitm Coafficient Tabular Data .
Coefficient Type Average Film Tempera.. Note
-1 Ambient Temperature | 22. °C_(rampad) ST . .
Suppressed ) 1o understand the temperature distribution better in complex models, you need to insert more
et Data For Film Caetficient Temperature parameters at different regions of the model and then evaluate them.
=} Tabular Data
Independent Varlable | Temperature : i ‘ |
& graph Controls . 6. Choose Thermal > Temperature from the Solution contextual toolbar; Temperature 2 is
X-AGs I Temperature

J added under the Solution node in the Tree Qutline. Also, the Details of “Temperature 2"
E: window is displayed.

Figure 11-13 The Details of “Convection” window after the changes are made
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10.

11.

12.

Tn the Details of “Temperature 2” window, select the Geometry selection box to display
the Apply and Cancel buttons.

Choose the Face tool from the Select toolbar and then select the cylindrical face
of the model, as shown in Figure 11-17.

Figure 11-16 Body selected Figure 11-17 Face selected

Choose the Apply button from the Details of “Temperature 2” window; 1 Face is displayed
in the Geometry selection box in the Details of “Temperature 2” window.

Choose the Solve tool from the Standard toolbar; the ANSYS Workbench
Solution Status message box is displayed and the temperature distribution
for the Temperature 2 boundary condition is displayed in the Graphics screen.

< } Sohve

Select Temperature under the Solution node in the Tree Qutline; temperature distribution
in the model is displayed in the Graphics screen, as shown in Figure 11-18.

Similarly, select Temperature 2 under the Solution node in the Tree Outline; tl’_lf:
temperature distribution in the model is displayed in the Graphics screen, as shown in
Figure 11-19.

Figure 11-19 Temperature distribution

Figure 11-18 Temperature distribution
across the selected face

across the whole body

Thermal Analysis- . 11-13

The table given next shows the data generated from the analysis so far.

8. No. Parameter Max Value Min Value
Temperature 80 °C 76.3 °C
2 Temperature 2 79.8 °C 77.5°C

Note that the temperature in the region where the Temperature boundary condition is
applied is higher as compared to the regions farther from it. The region marked red shows
the maximum temperature and the region marked blue shows the minimum temperature in
the model. Similarly, the other colors display different values of temperature distribution
in the model.

13. Select the Selution node in the Tree Outline to display the Solution contextual toolbar.

14, Choose Total Heat Flux from the Thermal
drop-down in the Solution contextual toolbar, as
shown in Figure 11-20; Total Heat Flux with a e :
vellow thunderbols is added under the Solution %a___pe;?éj feitia ne

| Solution || @y Thermal + | Gy Probe v | @
i Temperature.” e

. A . = GRS
node in the Tree Outline. Also, the Details of =N 6, Directional Heat Flox.. «
“Total Heat Flux” window is displayed. e

I g Error

15. In the Details of “Total Heat Flux” window, select Figure 11-20 Choosing Total Heat Flux

the Geometry selection hox to display the Apply from the Thermal drop-doun
and Cancel buttons,

16. Choose the Body tool from the Select toolbar and then select the model, refer to I

Figure 11-16. 5

17. Choose the Apply button from the Geometry selection box in the Details of “Total Heat
Flux” window; 1 Body is displayed in the Geometry selection box.

18. Smuilarly, choose Directional Heat Flux from the Thermal fiyout in the Selution contextual
_toolbar; Directional Heat Flux with a yellow thunderbolt is added under the Solution node
in the Tree Qutline. Also, the Details of “Directional Heat Flux” window is displayed.

Note

In this tutorial, the Dirvectional Heat Flux is calculated along the X axis. However, you can
determine the Directional Heat Flux along the Y or Z axis by selecting the required aption from
the Orientation drop-down list in the Details of “Directional Heat Flux” window.

19. Choose the Solve tool from the Standard toolbar; the ANSYS Workbench Solution
Status window is displayed. Notice that a tick mark is placed before Total Heat Flux and
Directional Heat Flux in the Tree Outline,

20. Select Total Heat Flux from the Solution node in the Tree Outline; the corresponding
contours displaying the distribution of heat flux are displayed in the Graphics screen, as
shown in Figure 11-21.
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21, Similarly, select Directional Heat Flux from the Solution node in the Tree Outline; the
corresponding contours displaying the distribution of heat flux along the X axis are
displayed in the Graphics screen, as shown in Figure 11-22.

Biusa
TatlHeat Flux
Type: Tatal Heat Flue
UnieWm!

Tirnc: L

3R Y PN

it Wi
Globat Coordinste Syt
Time:

AT B35 BN

Figure 11-21 Total Heat Flux for the Figure 11-22 Divectional Heat Flux
whole body along the X Axis for the whole body

The table given next displays the results obtained for the Total Heat Flux and Directional
Heat Flux.

S. No. Parameter Max Value Min Value
‘ (W/mm?) (W/mm?)
Total Heat Flux 005199 3.4511E-10
2 Directional Heat Fhux (X Axis) | 0.0003929 -0.0041547

It is obvious from the above results that the Total Heat Flux is maximum in the region
where the model is marked red and minimum where it is marked blue. Each color contour
depicts 2 value and can be seen in the Legend in the Graphics screen.

22. Exit the Mechanical window to display the Workbench window.

Saving the Project and Exiting ANSYS Workbench
After analyzing the results, save the entire project and exit ANSYS Workbench.

1. Choose the Save button from the Standard toolbar to save the project with the name
already specified.

2. Close the Workbench window to exit the ANSYS Workbench session.

Thermal Analysis . : i1-15

e R

In this tutorial, you will open the existing project ¢04_ansWB_tut03 which is a piston model
shown in Figure 11-23. Next, you will perform the Transient Thermal analysis on the piston
model. You will assume the initial temperature of the system before combustion to be 29 °C.
The temperature of the model at the time of combustion is 2000 °C. Consider the system
to be water cooled. You will evaluate the Temperature distribution on the body and also the
Total Heat Flux for the complete model. (Expected time: 45 min)

Figure 11-23 The model for Tutorial 2

The following steps are required to complete this tutorial:

Open the existing project and save it with a different name.
Generate mesh for the model.

Set boundary conditions.

Set analysis results.

Analyze the results.

Save the project and exit ANSYS Workbench.

me a0 o

Opening the Existing Project and Saving it with a Different Name
First, you need to start ANSYS Workbench, open the existing project, and then save it
with a different name.

L. Start ANSYS Workbench to display the Workbench window.

2. Choose the Open button from the Standard toolbar; the Open dialog box is displayed.

3. In this dialog box, browse to the location CIANSYS WBlc04\Tut03 and then open the
project c04_ansWB_jut03. Notice that the Piston component system is displayed in the

Project Schematic window.

4. Choose the Save As button from the Standard toolbar; the Save As dialog box is
displayed.
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5. In this dialog box, browse to the location CANSYS_WBic1l and then create a folder with
the name Tut02.

6. Browse to the Tut02 folder and save the project with the name ¢11_ansWB_tut02 in it.

After the project is saved with a new name, you need to add the Transient Thermal analysis
system into the project.

7. In the Workbench window, double-click on the Transient Thermal analysis system in the
Analysis Systems toolbox in the Toolbox window; the Transient Thermal analysis system
is added in the Project Schematic window.

8. Drag the Geometry cell from the Piston component system into the Geometry cell of the
Transient Thermal analysis system, refer to Figure 11-24. The geometry is now shared
for the Transient Thermal analysis.

@ Engineering Data
@0 Geometry

@ Modal

& setun

Safution

@ Rcsull’sw‘

Transient Therma!

{2700 eomery v 4;—\.
. Pistan :

BRI AN AN
TN T DN S LN N

R R R R S IO

Figure 11-24 The Piston component system
. and the Transient Thermal analysis system

g. Néx.t, double-click on the Model cell of the Transient Thermal analysis system; the
Mechanical window is displayed.

Generating Mesh for the Model

After the Mechanical window is displayed, you need to generate mesh for the model.

}. Make sure Metric (mm, kg, N, s, mV, mA) is selected from the Units menu in the Menu
bar,

9. In the Tree Outline, right-click on Mesh to display a shortcut menu. Figure 11-25 shows
the default Tree Qutline in the Mechanical window.

3. Choose Generate Mesh from the shortcut menu; the ANSYS Wor.'i_tbench Mesh Status
box is displayed. After sometime, this box is closed and the mesh with default settings is
generated, as shown in Figure 11-26.

Thermal Analysis 11-17

B R

Project
B (3] Model (84)

----- /5 Geometry

vz}ﬁi Coordinate Systems
Lo AR Mash
B ? Transient Thermal (B5)
: ,,ﬁe Initial Temperature
‘,}_’ﬂ Analysis Satings
?@E Temperabure
2 Solution (85)

B ¥} Solution information

G

Figure 11-25 The default Tree Outline in Figure 11-26 Mesh generated on the model
the Mechanical window with defawlt settings

Note that, the number of elements in this case is 3,660. Now, you need to refine the mesh.
You can do so by inserting localized mesh controls in various regions of the model or by
changing the global variables in the Details of “Mesh” window.

4. Select Mesh from the Tree Outline to display the Details of “Mesh” window.

5. In the Details of “Mesh’ window, expand the Sizing node, if not already expanded.

6. Select On: Proximity from the Use Advanced Size Option drop-down list; the Details
of “Mesh” window is modified.

7. Enter 6 in the Proximity Min Size edit box.
8. Enter 8 in the Max Face Size edit box.
9. Enter 12 in the Max Size edit box.

10. Choose Update from the Mesh contextual toolbar; the mesh is updated, as shown in
Fgure 11-27.

Notice that the total number of elements created after generating the mesh is approximately
28000, which is more than the previous element count.

Applying Boundary Conditions
After the piston model is meshed, you need to apply the boundary condition under which

the thermal analysis will be performed. Note that you need to add Temperature load on
the cylindrical face of the model,

1. Right-click on the Transient Thermal node in the Tree Outline and then choose Insert
> Temperature from the shortcut menu displayed; Temperature is added with a question
symbol attached to it under the Transient Thermal node.
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2. Select Temperature under the Transient Thermal n ode, the Details of “Temperature” 10. Choose the Apply button from the Geometry selection box in the Details of “Convection®
window is displayed. _ window; 13 Faces is displayed in the Geometry selection box, as shown in Figure 11:31,

$. 1Inthe Details of “Temperature” window, click on the Geometry selection box to display ' i
the Apply and Cancel buttons, if they are not already displayed. :

4. Select the head of the piston, as shown in Figure 11-28, and then choose the Apply bution

from the Geometry selection box in the Details of “Temperature” window to specify the ém?”“g Method fe‘;m"“t'y S2lection
. - sometry 3 Faces
f the model for applying the Temperature load. :
dome face 0 ppiying P | Definition
Type Convection - . .

[} Film:Coeffident - 10, WmmA~C (step -,
[T Ambient Temperature | 22, *C {step applied}
Suppressed Ng

Figure 11-30 Selecting all the outer faces for  Figure 11-31 13 Paces displayed in the
applying Convection load Geometry selection box

11. Next, choose the right arrow displayed next to the Film Coefficient edit box in the Details
of “Convection” window; a flyout is displayed.

12. In this fiyout, choose the Import option, as shown in Figure 11-32; the Import Convection

Figure 11-27 Mesh generated with Figure 11-28 Face selected for applying Data dialog box is displayed.
changed global variables Temperature load
5. Inthe Tabular Data window displayed on the bottom of  FlFEH = S B[ scope
the Graphics screen, enter 2000 under the Temperature ,gtepg "W'?emperatufe °cl i Zﬁ::?;emd f; :;nciry ==
[°C] column in the corresponding to the row in the |1[i. 25 ‘ l Defiton
Time column where 1 is displayed, refer to f 1 2600, pe o JComeedion
Figure 11-29. R D"#Ambie;t Tamperatui\e‘ g;fém(r:te:a::ahed £ Iort...
Supprassed No :
6. Also, enter 25 under the Temperature [°C] column in Figure 11-29 The Tabular Data :
the row that corresponding to the row in the Time [s] window [ Constant
column where 0 is displayed, refer to Figure 11-29. Taboiar. .
Furiction

The Temperature load is now specified. Next, you need to define the Convection load in '
the system. Figure 11-32 Choosing the Import option from

the Film Coefficient flyout

7. Select the Transient Thermal node in the Tree Outline to display the Environment 13. In this dialog box, select the Stagnant Water - Simplified Case radio button, refer to
contextual toolbar. Figure 11-33, and then choose the OK buiton to close the dialog hox and apply the film
coefficient; 1.2e-003 W/mm?® °C (step applied) is displayed in the Film Coefficient edit

8. Choose the Convection tool from this toolbar; Convection with a question symbol is added box in the Details of “Convection” window.

under the Transient Thermal node in the Tree Qutline.

3. Choose the Face tool from the Select toolbar and then select all the outer faces of the
piston, refer to Figure 11-30.




11-20

ANSYS Workbench 14.0: A Tutorial Approach

Dats Sourcer

i M

.“ﬂ Cnnvedlon Data to Import.
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& Stagnant Air - Vertical Planest
) Stagnant Air - Vertical Planes2
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Figure 11-33 The Import Convection Data dialog box with the Stagnant Water - Simplified Case

radio button selected

The Stagnant Water - Simplified Case
radio button is used when the convection
is assumed to take place through stagnant
water.

Setting Analysis Results
After the Temperawre and Convection
loads are applied, you need to specify
the parameters which you want to
evaluate.

1. Drag Temperature from the Transient
Thermal node in the Tree Outline
and drop itin the Solution node, refer
to Figure 11-34, Reaction Probe is
added to the Selution node.

& (& Moﬂel (B4)
- « 1 Geometry

i, Coordinate Systems

-",@a Mesh

‘- Tra nsient Thermal (B5)
! T—ﬁ initiaf Temperature

/:.‘;1 Analysm Settings

: _,@g Convectian
R B
- A33 SelutiorFricrmation
/% Reaction Probe

Figure 11-34 Dragging and dropping Temperature

from the Transient Thermal node into the Solution nade
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Reaction Probe allows the user to find the reaction
of a boundary condition at a certain point and at
a certain instance of time. In thermal analysis, you  }F|Definition

can use probes to display reaction {or the boundary Tpe Readion: S
conditions such as Convection, Temperature, and Location Methad Ec’“”da“’ Condition
Radiation. Figure 11-35 shows the Details of

SHREE G A Temparature

i ) N Suppressad FEE

“Reaction Probe” window with the Boundary oatone - {Canvedtion
o ) h ; plions

Condition drop-down list displayed. In this | GiaTme [End Time

drop-down list, the Temperature option is  {|mResuits

selected by defauit. You can also select Convection = Maximum Value Over Time

in this tutorial. The options in the Boundary | [ Heat b

Condition drop-down listare displayed basedonthe | Mirimurm Vatie Over Time

boundary conditions present under the Transient It
Thermal node in the Tref: ’C)uthne‘ Note t‘ha't if Figure 11-35 The Details of “Reaction
there was a boundary condition named Radiation
under the Transient Thermal node, the Radiation

option would be displayed in the Boundary Condition drop ~down list.

Prabe” window

2. Right-click on the Solution node in the Tree Qutline; a shortcut menu is displayed.

3. In this shortcut menu, choose Insert > Thermal > Temperature; Temperature is added
under the Solution node.

4. Similarly, right-click on the Sohution node again to display the shortcut menu and then choose
Insert > Thermal > Total Heat Flux; Total Heat Flux is added under the Selution node.

5. Choose the Solve tool from the Standard toolbar; the ANSYS Workbench Solution Status
window is displayed. After sometime, the ANSYS Workbench Solution Status window is
closed and a green tick mark is displayed before the results in the Solution node in the
Tree Outline indicating that the analysis has been solved.

6. Select Temperature under the Solution node in the Tree Outling; the Details of
“Temperature” window is displayed, as shown in Figure 11-36. Also, the temperature
contours are displayed in the Graphics screen, as shown in Figure 11-37.

8; Transient Fhermal

Ternperabure
52 Types Temnpatiture
DESHLE 4 i Lini 'C
Seoping Method Gaomediy Selection. Timer L

Geomatly [AH Bodies 267202 234 P
1 Definition

fype Tempdeatara 0 0l

By Time

Display Tima Last

Cateulate Time History [ Yas
Identifier i
Supprassad Ma

= Results.
] Minimum F22,°C 00 e
] Maximum {2000, 3G i e

e

Figure 11-36 . The Details of “Temperature” Figure 11-37 The color contours displayed
window in the Graphics screen
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Notice that the Graph window shows the graphical representation of the data available of the piston is maximum because the Temperature boundary condition is applied o5 it - -
in the Tabular Data window. Figures 11-38 and 11-39 show the Graph and Tabular Data _ ‘ and the component has attame.d maximum temperature in this region. The effect of this -
windows, respectively. temperature on the farther regions is minimurm, refer to Figure 11-41. In this model, the .

maximum temperature is 2000 *C and the minimum temperature is 22 °C.

B: Transient Ther mal
Ternperature

Type: Temperature
inie *C

Time: 1

32642013 2:16 PM

Time 5[0 Mirimam G} Hgsmom [-C)
3 i

v 1 SeciAute | 5
059526
-"‘f

,.
5 g
8

sy

20800 Max
1750.2
1560.4
1340.7
11208
s0L11
661.33
461,56
24178

22 Min

Figure 11-42 The Legend
displaying the temperature

9. Choose the New Section Plane tool from the Standard toolbar; the Section Planes E@ = distribution across the model
window is displayed. '

B
B
§E ] EEE ‘a;aa i mim Fy Mr—"

A4
S s " Jabulss Data |

Figure 11-38 The Graph window Figure 11-39 The Tabular Data window
with the distribution of temperature over time

7. Right-click in the Graphics screen; a shortcut menu is displayed.

8. Choose View > Top from this shortcut menu; the view is changed, as shown in Figure 11-40.

11. Click on Total Heat Flux under the Solution node in the Tree Outline; the Details of

_ . « v 4 g
10, Create a section of the model, refer to Figure 11-41 and then choose the ISO ball at : ’ Total Heat Flux w1lndow 13 c.hspiayed, as §hown in. Figure 11‘_43- Also, the contours of
the bottom right corner of the Graphics screen; the model is positioned, as shown in : Total Heat Flux are displayed in the Graphics screen, refer to Figure 11-44.
Figure 11-41. : o ) . )
Notice that when the contours are displayed in the Graphics screen, the Graph and
Bt s Tabular Data windows are also displayed below this screen, as shown in Figures 11-45 and
eMperature
Tyse: Temperature l 1 "‘46
Unit; "¢
Time: t
3262012 12:53 PM i C: Transient Thermal
: 2-{300 Hax 5] S2ope . %’x?zzi‘;‘e’:t Fhax
1res.2 Seoping Mathed t Ganmefiy Selection .- 1o nit Wimm®
=t 1568.4 Geomelsy Al Badies Tiree: L
13807 £ Definition SALLAOLL 3512 PN
LIS Type : Totdd Heat Flak 35200
s ChE A - o
451’56 Ditplay Time sLast 454
. Caleuttaty Tame History | ves EED
24138 Taerii T 461
i Hdentitier L 15633
Supprasted Mo Fk LTSS
fon Paint Resulls | Yok
Figure 11-40 The Top view of the model Figure 11-41 Isometric view of the sectioned B Lit61e30n
model 1] minimum 131610008 Wime® o !
1L BB wWmm o s P
Figure 11-41 shows the color contours that indicate the distribution of temperature along "
various regions of the model. Red color contour displays the region with the maximum Figure 11-43 The Details of “Total Heat Figure 11-44 Contours of the Total Heat
temperature, whereas blue color contour shows the region with minimum temperature. Flux” window Flux displayed on the model

The other colors represent various temperatures that lie within the maximum (red contour)
and minimum (blue contour) temperatures. The color contours and their respective
values can be seen in the Legend, refer to Figure 11-42, The temperature on the dome
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Figure 11-45 The Graph window displaying the  Figure 11-46 The Tabular Data window
result in graphical format ‘
Note that the Thermal analysis of 2 piston plays an important role in understanding the, :
behavior of the component under the thermal loading conditions. Figure 11-47 The Heat Sink model
. 75
7.5
19. Close the Mechanical window; the Workbench window is displayed. 5
Saving the Project and Exiting ANSYS Workbench 4
Now you need te save the project. o
{. In the Workhench window, choose the Save button to save the project with the name |
cll _ansWB_tut02.
100

9 Close the Workbench window to exit the ANSYS Workbench session.

Figure 11-48 The Top and Front views of
the Heat Sink with dimensions

5

In this tutorial, you will create the 3D model of the Heat Sink shown in Figure 11-47. The

dimensions and views of the model are given in Figure 11-48. After creating the model, you will Starting ANSYS Workbench and Creating the Model

run a Steady-State Thermal analysis on it. Finally, you will evaiuate the Temperature distribution First, you need to start ANSYS Workbench and then create the model.

for the whole component and also the Total Heat Flux for the component on the basis of the

boundary conditions given next. (Expected time: 45 min) 1. Start ANSYS Workbench to display the Workbench window.

Boundary Conditions: 2. Add the Steady-State Thermal analysis system to the Project Schematic window.

Heat Flow: 19 W : 3. Choose the Save button from the Standard toolbar; the Save As dialog '
Convection or: Heat Sink walls with film coefficient 13 : displayed. ’ ve As dialog box s

Convection on Heat Sink floor with fitm coefficient 7.5
4. Browse to the location C:AANSYS_WBic!! and then create a sub folder with the name

The following steps are required to complete this tutorial: ' Tut03.
a. Start ANSYS Workbench and create the model. 5. Browse to the Tut03 folder and save the project with the name c¢11_ansWB_tut03 in this
b, Generate mesh and apply boundary conditions to the model. folder. . -
¢.  Specify results and solve the FEA model,
d. Analyze the results. 6 In the Project Schematic window, double-click on the Geometry cell of the Steady-State
e.

Save the project and exit ANSYS Workbench. Thermal analysis system; the DesignModeler window is displayed.
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7. In the DesignModeler window, draw a sketch on the XY plane, refer to Figure 11-49.

i : ' &} Project
“"1 f"iiﬁé”}.?- & & Model (a4)

.y
el My Gy i fr F——t E R g fr e G ‘/ GEGm?b’V
K i : - s Coordinate Systems

Eiq Steady-State Thermal (A%}
i . JT..,?,P Inifial Temperature

V3 : Pyl Analysis Settings

i EI*?@ Solution (A5}

V2 teung{ ¥ Sclution Information
: : . :
Figure 11-50 Selecting Mesh in the Tree Figure 11-51 Mesh generated on the model
i Outline
— oot Bt M o] Qpeeedll  Bh—fli
: 6. Expand the Statistics node in the Details of “Mesh” window to display the total number
e © of elements created. -
b Notice that the total number of elements created after generating the mesh are

approximately 25000. After the model is meshed, you now need to specify the boundary
conditions.

Figure 11-49 Sketch for creating the model

7. Right-click on the Steady-State Thermal node in the Tree Outline and then choose Insert
> Heat Flow from the shortcut menu displayed, refer to Figure 11-52; Heat Flow is added
under the Steady-State Thermal node in the Tree Outline. Also, the Details of “Heat
Flow” window is displayed, as shown in Figure 11-53.

8. Extrude the sketch to a distance of 100 mm to create the model, refer to Figure 11-47.

9. Exit the DesignModeler window to display the Workbench window.

Generating the Mesh and Specifying the Boundary Conditions bl L acouing.
After the model is created, you need to mesh the model and also specify the thermal 1 Solve, S @ Teniperture
boundary conditions. The Heat Sink extracts the heat from the devicc? it is attached to by 2 Clear Generated Data gg_ Convection T T
conduction, and then dissipates the heat through the fins by convection. So you need to b Reaive @s ?dla;on s P i Seiection
. - 3 “F . R Meat ow ! o .
apply Heat Flow at the bottom face of the model. Also, you will apply Convection on the 53 Opan Sotor P Dy~ | oty ad 1 I
floor and walls of the Heat Sink. . i &t e L Type Heat Flow 077
®‘“ ; st G ) Detine As Heat Flow
. w Internal Heat Generation | ] .
1. In the Project Schematic window of the Workbench window, double-click on the Model s - qu Mlgsr;::de (:‘.ow framped)
cell of the Steady-State Thermal analysis system; the Mechanical window is displayed. L Commands - _ pe

. . . i " Fi 11-52 The shorteut displ ohi-clicks Figure 11-53 The Details of “Heat
9. Select Mesh in the Tree Qutline, as shown in Figure 11-50, to display the Details of “Mesh gure ¢ shortcut menu displayed on right-clicking sur ¢ Details of “Hea

= on the Steady-State Thermal node in the Tree Outline Flow” window
window. ‘
‘ N . ‘ 8. In the Details of “Heat Flow” window, select the Geometry selection box to display the
3. In the Details of “Mesh” window, expand the Sizing node to display its contents. Apply and Gancel buttons.
4. Under this node, enter 2.5 in the Element Size edit box. 9. Next, select the bottom flat face of the Heat Sink in the Graphics screen, as shown in

Figure 11-54.
5. Choose the Generate Mesh tool from the Mesh drop-down of thwe Mesh . Gonerate Mesh
contextual toolbar; the mesh is generated, as shown in Figure 11-51. 10. Choose the Apply button in the Geometry selection box, refer to Figure 11-55; the color

of the bottom face is changed to purple indicating that Heat Flow has been applied to
this face:
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Figure 11-54 Selecting the bottom face of

the Heat Sink to apply Heat Flow

ction

Cancel |

=1 Defimﬁa
Type Heat Pl o0
Define As Heat Flow

] Magnitude. {0, W [ramped}

Suppressed

Mo

Figure 11-55 Choosing the Apply button
from the Details of “Heat Flow” window

Notice that an arrow pointed upward is displayed at the bottom face of the model, as

shown in Figure 11-56. This indicates that the direction of heat flow is upward.

11. Tn the Details of “Heat Flow” window, enter 13 in the Magnitude edit box, refer to

Figure 11-57.

£l Scope N
Scoping Method | Geometry Selection
Geamstry 1 Face

=] Definition
Type Heat Flow:: "
Define As Heat Flow

T 130w [ramped) T

%ﬁ;ﬁesséd ' Mo

Figure 11-56 The arrow indicaling the

direction of Heat Flow

Figure 11-57 The Details of “Heat Flow” window
displayed with all the parameters specified

After applying Heat Flow on the model, you need to specify Convection where the heat

will be dissipated.

Thermal Analysis , 11-29

15. In the Film Coefficient edit box of the Details of “Convection” window, enter 6E-6, refer

Figure 11-58 Fuces selected for applying Convection

16.

17.

18.

w Figure 11-59.

i Scope
Szoping Mathaod Geometry Setection
Geomatry 9 Faces

=l Befinition
Type |_!,':or_wjettic'n_ S

- 6.6.008 W/mm*<C,.. v
[[] Ambient Temperature | 22, °C jramped)
Suppressed Ne

Paces w be seloctad

Figure 11-59 The Details of “Convection”
window displaying the parameters specified in it

Leave the other options in the Details of “Convection” window as set by default. The
convection is now specified for the floor of the Heat Sink. In this tutorial, it is considered
that the convection at the HAoor is less as compared to the convection on the walls of the

fins. The?refore you need to specify a different film coefficient for the walls of the fins for
Convection load,

Right-click on the Steady-State Thermal node in the Tree Outline and then choose
Insert > Convection from the shortcut menu displayed; Convection 2 is added under the
Steady-State Thermal node. Also, the Details of “Convection 2” window is displayed.

Click on the Geometry selection box to display the Apply and Cancel buttons, if they are
not already displayed.

Select all the surfaces of the fins, refer to Figures 11-60.

Note
1. Use the tools available in the Graphics
toolbar to rotate the model.

12. Right-click on the Steady-State Thermal node in the Tree Outline and then choose

13.

14,

Insert > Convection from the shortcut menu displayed; Convection is added under the
Steady-State Thermal node. Also, the Details of “Convection” window is displayed.

In the Details of “Convection” window, click on the Geometry selection box to display
the Apply and Cancel buttons, if they are not already displayed.

Select the top face (excluding the fin surface} of the Heat Sink, as shown in Figure 11-58
and then choose the Apply button in the Geometry selection box; 9 Faces is displayed
in the Geometry selection box indicating that 9 faces are selected on which Convection
is to be applied.

2. Make sure that the Face tool is selected from
the Select toolbar to select faces of the fins.

19. Choose the Apply button in the Geometry
selection box; the faces are specified for
applying Convection.

20. In the Details of “Convection 2” window, Figure 11-60 Selecting the faces of the fins
enter 12E-6 in the Film Coefficient edit box to specify the film coefficient.
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Specifying Results and Solving the FEA model

After all the boundary conditions are specified, you need to specify the outcomes of the
analysis. .

1. Right-click on the Solution node in the Tree Outline and then choose Insert > Thermal
> Temperature from the shorteut menu displayed, refer to Figure 11-61; Temperature
with a yellow thunderbolt symbol is added under the Solution node in the Tree Qutline.
Also, the Details of “Temperature” window is displayed.

By Termperature: s 00

%, Te{al'ﬂéa‘t’_'ﬂ'gg.} B .
G, Directional Heat Flux .

-

" Probe .

7Y Clear Generated Data -
W Reriame:- SRS

B Coblra‘_'iﬁat'eSysi:ems'_-_ oy

8, Error, -

= OF":“"’."S&’M_E{ Fites D‘”éﬂow.'-" - 13- User Defined Result

@_Co'mmapﬂ's R

Figure 11-61 The shorteut menu displayed by right-clicking on the Solution node

9. Right-click again on the Solution node in the Tree Outline and then choose Insert >
Thermal > Total Heat Flux from the shortcut menu displayed, refer to Figure 11-60;
Total Heat Flux is added under the Solution node. Also, the Details of “Total Heat Flux”
window is displayed.

Now, ali the parameters are specified and the next step is to solve the FEA model.

3. Choose the Solve tool from the Standard toolbar; the ANSYS Workbench -4 Solve |-
Solution Status box is displayed. .:’.....U

Notice that after sometime, the ANSYS Workbench Solution Status box gets closed and
the analysis is solved.

4. Right-click again on the Solution node in the Tree Outline and then choose Insert > Probe
> Temperature from the shortcut menu displayed, refer to Figure 11-62; Temperature
Probe with a question symbol is added under the Solution node. Also, the Details of
“Temperature Probe” window is displayed.

& _Clﬁ'af'Generate'd.'{}at'é' SR o Sy Termperature
T Heat Flux -«
a]___b Rename AL, " Coordinate Systems ¥ E‘;R o u_
Ll eaction
= O"f" Solver Files Directory T, UserDefined Résuit® . | €y Radiation
B Commands- 7 E

Figure 11-62 Selecting the Probe option from the shoricut menu
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To find out the result at a particular point, edge, face, or complete body, use the Probe tools.

By using these tools you can find the maximum or minimum values of a result at the specified
location.,

5.

In the Details of “Temperature Probe” window, select the Geometry selection box to

display the Apply and Cancel buttons, as shown in Figure 11-63, if they are not already
displayed.

Choose the Face tool from the Select toolbar and then select the top-face of the @ f
fins in the Graphics screen, as shown in Figure 11-64.

s

FH Definition
Type Temperature oo
Location Method | Geometry Selection
& Appy | Cancel
X Ceardinate Sr Tt T

¥ Coordinate
Z Coordinate e
Suppressed Mo

: =i Options
E Display Time EEnd Time Tt

Figure 11-63 The Details of “Temperature Figure 11-64 Selecting a face of the fin

Probe” window in the Graphics screen

7. Choose the Apply button from the Geometry selection box; 1 Face is displayed in the
Geometry selection box indicating that the model is selected for a temperature probe
now. Leave all other parameters as set by default in the Details of “Temperature Probe”
window.

8. Right-click on the Solution node again z.md then choose Evaluate 4 Eﬂ\f"a.ft:!_at:é';ﬂiii_?e'f.':'u'it's_'
All Results from the shortcut menu displayed to complete the .
temperature probe.

9. Inthe Details of “Temperature Probe” window, expand the Maximum Value Over Time

node; the Temperature edit box displays 31.416 ° C as the maximum temperature at the.
selected face. T

Analyzing the Resulis

After the model is solved, you need to check the results specified in earlier section. =

Select Temperature under the Solution node in the Tree Qutline; the Cerrespondmg o
Legend and the temperature contours are displayed in the Graphics screen, as shown in -
Figures 11-65 and 11-66. B
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Az Steady-S5tate Thermal
Temperature

Type: Ternperature

Unit: *C

Time: 1

§/7/2012 10:45 AaM

Figure 11-65 The Legend showing Figure 11-66 The contours displayed on the model
the values of temperature distribution

In the Legend, the red color shows the maximum value of temperature attained in
the model, which is $2.82 °C. Similarly, the blue color displays the minimum value
of temperature in the model, which is 31.414 °C. The other colors display various
teraperatures attained in the model for the given boundary conditions.

Similarly, select Total Heat Flux displayed under the Solution node; the corresponding
Legend and the contours on the model are displayed, as shown in Figures 11-67 and
11-68, respectively.

A1 Steady-State Thermai
Total Heat Flux

Type: Total Heat Flux
Unit Wernm®

Tirng: 1

S/T/2012 10:33 AM

w 0.0033142 Max

B.002856%

L 025988
18022411

0.05:8934

= onises

4.001168

o 1.00085033

1.00045253

9,4933e-5 Min

Figure 11-67 The Legend showing Figure 11-68 The contours displayed on the model
the values of heat flux distribution

3. Close the Mechanical window to display the Workbench window.

Saving the Project and Exiting ANSYS Workbench
After evaluating all the results, you need to save the project.

Choose the Save button from the Standard toolbar; the model is saved with the name
cll _ansWEB_tut03.

Exit the Workbench window to close the ANSYS session.
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Answer the following questions and then compare them to those given at the end o

fthis =

ryout ..

chapter:

1. In ANSYS Workbench, only the Steady-State Thermal analysis system is used to car
all types of thermal analyses. (T/F)

2. 'The Steady-State Thermal analysis system is used to carry out a thermal analysis where
c_onditions do not change over time. (T/F)

3. In Thermal analysis, only thermal degrees of freedom of the elements are considered.
(T/F)

4. You can insert the boundary conditions for a thermal analysis by using the tools available
in the Environment contextual toolbar. (T/F)

5. A probe is used to evaluate results only along the edges of the geometry. (T/F)

6. You can apply different Convection loads at different regions of the model. (T/F)

7. You can import various film coefficients in ANSYS Workbench. (T/F}

8. To apply Convection on any surface, you need to define the in the Details of
“Convection™ window.

9. You can insert Temperature load by choosing the tool in the Environment

contextual toolbar.

10. The unit of heat flow is

Answer the following questions:

1.

2.

To insert a Temperature load, select the Temperature option by using the shortcut menu
which is displayed when you right-click on the analysis system node in the Tree Outline,
(T/¥)

To view terperature distribution over a body or surface, choose the Temperature option
from the shortcut menu which is dispiayed when you right-click on the Solution node.
(T/F)

The minimum and maximum values obtained from an analysis are displayed in the Legend
and also in the corresponding Details View window. (T/F)
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4. By defauls, the color in the Legend represents the maximum value. (17F)
5. In ANSYS Workbench, you can carry thermal analysis for time-dependent loads as well. (1/F)

6. You can add the Transient Thermal analysis to the Project Schematic window from the
Analysis Systems toolbox in the Workbench window. (1/F)

7. 1In'Transient Thermal analysis, the loads are time-dependent. (I/F)

EXERCISE

ownload the c11_ansWB_exr01.zip file from www.cadcim.com and then extract it to save the
11 ansWB_exr01.igs file in the project folder. Next, run the Steady-State Thermal analysis on
the model. Consider a hot fluid of film coefficient 1200 W/m? K at 450 °C is running inside
the pipe. Find out the effect of thermal loading on the bracket attached to it. Figure 11-69
shows the model for Exercise 1. (Expected time: 45 min)

Figure 11-69 Model for Exercise 1

Answers to Self-Evaluation Test
1.¥7,2.T738.T,4. T, 5. F, 6. T. 7. T, 8. Film Coefficient, 9. Temperature, 10. Watt

Index

A

Active Plane / Sketch toolbar 3-6, 3~31’

Add Material option 5-17, 5-26
Algorithm drop-down list 7-36, 8-15
All Triangles 8-27
Analysis options 11-2
Analysis Preference 11-2
Analysis Settings 10-4, 10-9
Analysis Systems toolbox 2-5, 6-8
Analysis Type 11-2
Animation area 10-12
ANSYS Workbench

dialog box 3-3, 3-31
ANSYS Workbench Mesh

Status 7-9, 7-13
Arc by 3 Points tool 5-5, 5-36
Arc by Center tool 5-8
Arc by Tangent tool 3-32, 3-35
Archiving 2-15
As Thin/Surface? drop-down list 3-39
Assigament drop-down list 6-21, 9-20
Auto constraints 3-12
Automatic Method 7-35, 8-14
Axis selection box 4-13, 4-17, 4-21

B

Back View 7-18

Base Face selection box 4-28, 5-27
Base Object selection box 4-5, 4-30
Base Plane selection box 5-23
Bearing Load tool 9-33

Blend drop-down 3-25

Body tool 7-36, 8-26

Boolean ool 7-17, 7-27, 7-29, 7-32
Both - Asymmetric option 5-26, 5-28

Both - Symmetric option 3-19, 3-24
Box Select option 5-39

Bulk Modulus 1-14, 6-11

Bulk Temperature 11-3

By Cavity option 7-26, 7-29

C

Centroid option  4-7

Chamfer 3-43

Channel Section 4-6

Circle tool 3-43, 4-14, 5-20

Circular option 4-16, 5-12, 5-15
Clear Selection option 3-43, 3-47
Coincident 3-14

Coincident tool 4-24

Component Systems toolbox 2-7, 3-8
Compressive Stress 1-13
Compressive Yield Strength 6-3, 6-19
Concentric tool 3-51

Concept menu 4-5, 4-30
Conduction 11-2

Connections nede $-10, 8-11
Constant 9-22

Constrains toolbox 3-14

Contact region 8-10

Contacts node 8-10, 8-11

Contents of Engineering Data 6-9, 6-15
Convection tool 11-9

Copy tool 5-39

Create menu 4-16

Creep 1-15

Cross Section property 4-7

Custom Systems toolbox 2-8

Cut Material option 3-55,4-13

D

Damped drop-down list 10-5, 10-9
Data Source 6-53, 6-18
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Defayit mesh 7.2
Default plane 3-43
Defaults node 3-3, 8-13
Defeaturing Tolerance edit box 8-17
Definition node 8-6, 8-7
Deformation drop-down -9, 9-10
Degrees of Freedom 1-4
Delete Faces toot 7-32
Density 6-9, 6-19
Derive From 6-10
Design Assessment 2-5
Design Exploration toolbox 2-8
DesignModeler 6-17
Details of “ Refinement” 8-7
Details of “ Static Structural™ 9-21
Details of “Analysis Settings” 10-4,
Details of “Automatic Mesh™ 8-15
Details of “Automatic
Method™ 7-35, 7-36
Details of “Bearing Load” 9-33
Details of “Convection” 11-9,
Details of “Directicnal
Deformation” 9-9,
Details of “Directional
Heat Flux” 11-13
Details of “Displacement” 9-26
Details of “Face Sizing” 8-3, 8-6, §-19
Details of “Foree” 9-7, 9-22
Details of “Mesh”™ 7-5
Details of “Patch Conforming
Method” 7-36
Details of “Patch Independent
Method” 7-36
Details of “Refinement” 8-7
Details of “Size” 8-19
Details of “Sizing” 8-5
Details of “Solid” 6-16
Details of “Solution” 9-9
Details of “Static Structural” 9-6
Details of “Surface Body™ 8-24
Details of “Temperature” 11-8
Details of “Total Deformation” 9-9
Details of “Total Heat Flux”
window 11-13

Details of “Uniform Quad/Tri
Method” 10-23

Details of Solid window 6-16

Details View window 3-6

Dimension toolbox 4-29

Dimensions node 3-17, 3-38

Dimensions toolbox 3-15, 3-22

Direction 3-19

Direction drop-down list 3-19, 3-24

Direction selection box 8-30

Directional Deformation 9-11, 9-12

Directional Heat Flux 11-5, 11-13

Directional tool 9-9, 9-10, 8-23

Displacement support 9-27

Displacement tool 9-26

Display Plane tocl 5-7

Draw Cursor 3-21

Draw toolbox 3-11, 3-21,

Duplicate option 9-12

E

Edge Selection cursor 4-7

Edge tool 9-7

Edit Library column  6-6

BEdit Name/Value option 4-12

Edit option 62

Elastic Limit 1-13

Element Midside Nodes 8-27
Element Size option 8-6, 8-19
Element Types 11-2

Elements 1-4

Emissivity 11-3

End / Use Plane Origin as Handle 3-37
End option 3-45

End/Set Paste Handle 3-47
End/Use Default Paste Handle 3-47
Engineering Data 6-7, 6-14, 6-21
Engineering Data cell 2-21, 6-2

Engineering Data Source toggle button 6-20

Engineering Data Sources window 6-4,
Engineering Data workspace 6-2,
Environment contextual toolbar 9-3
Equal Length constraint 3-15, 3-30
Equal Length tooi 3-14, 3-36

Equal Radius constraint 3-37

Index

1.3

Equal Radius tooi 3-37
Equivalent (von-mises) tool 9-24
Equivalent Stress 7-22
Evaluate All Results 9-37, 10-11
Export Video File button 10-12
Extend 3-45
Extent Type drop-down list 3-55
Extent Type edit box 3-24
Extraction Type drop-down

list 7-26, 7-29
Extrude tool 3-18

F

Face Delete tool 7-30

Face Selection cursor 5-15

Face Sizing 8-19

Face too] 8-29

Faces selection box 7-16

Factor of Safety 1-13, 1-14

Feature Angle edit box 8-17

Features toolbar 3-20, 4-5, 4-12

File menu 4-30

Fill tool 7-16

Fillet tool 3-45, 5-8

Film Coefficient 11-3

Fix Guide Line 5-42

Fixed Radius 3-25, 3-26, 3-56

Fixed Support tool 96, 9-21, 9-33

Fiip toggle button 9-8

Force tool 9-7, §-22

Frames edit box 10-12

Free Face Mesh Type drop-down
lists 8-27

Friction Coefficient edit box 8-11

From Face option 5-27

G

General Materials 6-18, 6-19
General tool 3-15, 3-22
Generals Library 6-14
(ienerate button 3-57
Generate Mesh tool 7-24, 9-6
Generate tool 823, 8-24
Geometry cefl 10-14, 10-22

Geometry component

system 3-8, 3-30
Geometry edit Box 4-20, 4-21
Geometry node 6-21
Geometry selection Box 7-28
Getting Started window 2-3
Global mesh controls 8§13
Graph window 10-5, 10-6, 11-8
Graphics screen 7-9, 7-14
Graphics toolbar 3-17, 4-4
Graphics window 3-6, 3-10, 4-4, 4-5
Gray Cast Iron 6-19

H

Harmonic Response 2-6

Heat transfer modes 11-2
Hide All Other Bodies 8-16
Hide Sketch option 3-21, 3-33
Hooke’s law 1-13

Horizontal tool 3-14

I

IC Engine 2-6
Ignore axis check box 3-49
Iraport Convection Data

dialog box 118, 11-10
Import Geometry 6-18
Import option 11-9
Insert option 9-9
inward Thickness (>0} 3-39
ISO ball 3-18, 3-23, 3-38, 3-34
SO wol 4-12, 4.14
Isometric view 7-8
Isotropic elasticity 6-10
Isotropic material 1-15

L

Lateral strain 1-14
Left view 9-18
Legend 7-4

Limit Search t¢ Range

drop-down list 10-5, 10-9, 10-17

Line Body 4-7
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Line by 2 Tangents tool 3-34
Line element -5

Line tool 3-11, 3-32, 3-46
Lines from Sketches tool 4-5
Loads drop-down 9-3, 9-7
Local mesh controls 8-13
Lock At tool 3-10, 6-14,7-8

M

Magnitude edit box 9-8, 9-22

Material node 10-15

Max Element Size edit box 7-36

Max Face Size 11-7

Max Modes to Find 10-6, 10-9, 10-11

Max Size edit box 8-4

Max. Principal Stress 9-25

Mechanical window 6-11,7-2

Menu Bar 2-10

Mesh Based Defeaturing
drop-down 8-17

Mesh cell 2-23, 7-2

Mesh component system 7-2, 7-6

Mesh contextual toolbar 7-19, 8-5

Mesh Control drop-down 7-33, 8-3

Mesh drop-down 9-6, 9-21

Mesh node 7-35, 7-36

Meshing window 7-2, 7-3

Method drop-down list 7-36, 8-15

Method 100l 8-14

Millimeter radio button 3-31, 3-43

Min Size Limit edit box 8-17

Min. Principal Stress 9-25

Modal analysis system 8-3, 10-4

Modal node 10-6, 10-8

Mode shape 10-26

Model cell 10-4, 10-8, 10-15

Model View 3-6

Maodel View/Print Preview 3-6

Modeling Mode 3-4, 4-20

Madify Toolbox 3-45, 4-24

N

Name edit box 4-12

Named Selection 7-19

Natural Frequency 10-2

New Geometry option 3-3

New Plane tocl 5-23, 5-26

New Section Plane tool 7-9, 7-15

New Sketch tool 3-13, 5-16, 5-27
Num Cells Across Gap 7-19,8-13

0

Offset tool 3-45
On: Proximity 7-20, 7-19
Open dialog box 10-14, 10-22
Operation drop-down list 3-24, 3-55
Options dialog box 3-4
Orientation drop-down list 9-10, 9-11
Outline of General Materials

window 9-19, 10-14
Qutline window 10-8

P

Paste at Plane Origin 5-34, 5-37
Physics Preference drop-down list 7-13
Play bitten 10-12

Poisson’s Ratio 1-14

Polyline tool 3-46

Print Preview tab 3-6

Profile selection box 5-22, 5-23
Profiles node 5-41

Project node 9-20

Q

Quadrilateral Dominant option 8-27
Quick Help 2-29

R
r and f edit boxes 5-34

redit box 5-34, 3-37, 5-39
Radiation 11-2, 11-3

Index

i-5

Radius edit box 5-9

Radius tool 3-44

Random Vibration 2-6

Range Minimum 10-5
Rectangle tool 3-21, 3-22
Rectangular option 5-12
Refinement edit box 8-7
Refresh Project button 6-11
Refresh tool 7-33

Relevance 7-5

Rename option 9-20

Replicate tool 3-47, 3-48
Results cell 2-23

Return to Project button 6-11, 6-15
Reversed option 3-19,4-15
Revolve tool 4-12, 4-20

Rotate by -r Degrees option 3-48
Rotate by r Degrees option 3-34, 5-37
Rotate edit box 4-8

Rotate tool 3-27

Ruler 3-6

S

Save button 3-8, 3-28
Save dialog box 6-6
Scale by factor f 5-39
Scope node 9.7
Section Planes window §-16, 8-17
Select Individual Profile option 5-40
Select Mode drop-down list 5-39
Select toolbar 4-8, 4-14
Shear Stress 1-13
Show Whole Elements
button 7-21, 7-34
Sizing node 7-19
Sizing tool 8-3
Sketching mode 3-4
Sketching Toolboxes 4-27
Sketching Toolboxes window 3-11, 3-14
Skin/Loft tool 35-40
Solid node 9-20
Solution contextual toolbar 9-3, 9-9
Solution node 10-5, 10-6
Solve tool 10-5, 11-12, 11-13

Static Structural

analysis system 6-8, 6.9
Static Structural node 8-29
Statistics node 10-24
Status Bar 3-11, 3-14
Steady-State Thermal

analysis 2.7, 11-4
Stiffness matrix 1-4
Strain i-13
Strength 1-12
Stress 1-12
Supports drop-down 10-24
Sarface Patch too] 8-28
Surfaces From Sketches tool 4-30
Sweep tool 5-22
Symmetric tool 3-30

T

Tabular Data window 10-5, 10-9
Tangent Line tool 3-34
Temperature tool 11-8
Tetrahedrons option 7-36
Thermal analysis 11-2

Through All option 4-13

Time Dependent 9-2

Title bar 3-28

To Faces option 5-35

To Surface option 3-55

Tool Bodies selection box 7-17, 7-28
Toolbox Customization window 2-8
Toolbox window 10-3

Total Deformation 9-9, 9-23
Total Heat Fiux 11-13

Total tool 9-9, 9.23

Transient Structural 2-7
Transient Thermal 2-7

Tree Qutline 9-3, 9-5,

Triad 3-6, 3-23

Triangles Option 8-27

Trim tool 3-49,4-24, 4-26

Type drop-down list 4-28
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U

Ultimate Strength 1-13
Unit coluran 6-4
Unite 7-17

Units 2-17

Update tool 7-20

v

Value field 6-10, 6-11
Vertical tool 3-14
Volume element 1-6

W

Engineering Data Sources window 10-14
Workbench Window 7-23

Wireframe 5-29

Workbench Dialog Box 4-19

Workbench Window 2-4

X

X Component 9-34
X-Component edit box 9-27
XYPlane 3-5

XYPlane node 8-23

Y

Y axis 9-12

Y Component 9-34

Young's modulus 1-13
Young’s modulus property 6-11
YZPlane 5-8, 5-23

Z

Z Component edit box 9-34
Zoom to Fit tool 5-22
ZXPlane 5-21

Other Publications by CADCIM 'I'echnoioéiés o

The following is the list of some of the publications by CADCIM 7|

www.cadcim.com for the complete listing.

ANSYS Textbook
* ANSYS 11.0 for Designers

Autodesk Inventor Texthooks

*» Autodesk Inventor 2012 for Designers
* Autodesk Inventor 2011 for Designers
¢ Autodesk Inventor 2010 for Designers

Solid Edge Textbooks

¢ Solid Edge ST4 for Designers
* Solid Edge ST3 for Designers
* Solid Edge ST?2 for Designers

NX Textbooks

* NX 8 for Designers
* NX 7 for Designers
* NX 6 for Designers

SolidWorks Textbooks
* SolidWorks 2012: A Tutorial Approach
* SolidWorks 2012 for Designers

* Learning SolidWorks 2011: A Project based Approach

* SolidWorks 2011 for Designers
* SolidWorks 2010 for Designers

CATIA Textbooks

* CATTA V5R21 for Designers
* CATIA V5R20 for Designers
* CATIA V5R19 for Designers

Creo Parametric and Pro/ENGINEER Textbooks

* Creo Parametric 1.0 for Designers
* Pro/ENGINEER Wildfire 5.0 for Designers
» Pro/ENGINEER Wildfire 4.0 for Designers

“echnologies. Please'\}isi{'_ pas
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Other Publications by CADCIM Technologies 3
Autodesk Alias Textbooks Fusion Textbook -
s Learning Autodesk Alias Design 2012 . ' ¢ The eyeon Fusion 6.3: A Tutorial Approach

* Learning Autodesk Alias Design 2010
' Computer Programming Textbooks

AutoCAD LT Textbooks aE * Learning Oracle 11g
+ AutoCAD LT 2012 for Designers - * Learning ASENET AJAX
» AutoCAD LT 2011 for Designers & * Learning Java Programming
_ ' * Learning Visual Basic. NET 2008
AutoCAD Electrical Textbooks * Learning C++ Programming Concepts
» AutoCAD Electrical 2012 for Electrical Control Designers f * Learning VB.NET Programming Concepts

s AutoCAD Electrical 2011 for Electrical Control Designers
Paper Craft Book

EdgeCAM Textbooks ' ¢ Constructing 3-Dimensional Models: A Paper-Craft Workbook
» EdgeCAM 11.0 for Manufacturers
* EdgeCAM 10.0 for Manufacturers | AutoCAD Textbooks Authored by Prof. Sham Tickoo and Published by

Autodesk Press

Autodesk Revit Architecture Textbooks * AutoCAD: A Problem-Solving Approach: 2013 and beyond

* Autodesk Revit Architecture 2012 for Architects and Designers N * AutoCAD 2012: A Problem-Solving Approach
» Autodesk Revit Architecture 2011 for Architects and Designers * AutoCAD 2011: A Problem-Solving Approach
* AutoCAD 2010: A Problem-Solving Approach
Autodesk Revit Structure Textbooks - ¢ Customizing AutoCAD 2010
° Exploring Autodesk Revit Structure 2012 '
* Exploring Autodesk Revit Stracture 2011 Textbooks Authored by CADCIM Technologies and Published by Other
: Publishers

AutoCAD Civil 3D Texthooks
s AutoCAD Civil 8D 2012

3D Studic Max and VIZ Textbooks
* AutoCAD Civil 3D 2009 for Engineers

* Learning 3ds Max: A Tutorial Approach, Release 4
Goodheart-Wilcox Publishers (USA)

AutoCAD Map 3D Texthooks g * Learning 3D Studio VIZ: A Tutorial Approach
* Exploring AutoCAD Map 3D 2012 Goodheart-Wilcox Publishers (USA)
* Exploring AutoCAD Map 3D 2011 ' * Learning 3D Studio R4: A Tutorial Approach

Goodheart-Wilcox Publishers (UUSA)
3ds Max Design Textbooks

» Autodesk 3ds Max Design 2012: A Tutorial Approach .. 3ds Max Textbook

* Autodesk 3ds Max Design 2011: A "Tutorial Approach * 3ds Max 2008: A Comprehensive Guide (Serbian Edition)
: Mikro Knjiga Publishing Company, Serbia

3ds Max Textbooks

* Autodesk 3ds Max 2012: A Comprehensive Guide SolidWorks Textbooks

» Autodesk 3ds Max 2011: A Comprehensive Guide ] * SolidWorks 2008 for Designers (Serbian Edition)
» Autodesk 3ds Max 2010: A Comprehensive Guide Mikro Knjiga Publishing Company, Serbia

: * SolidWorks 2006 for Designers (Russian Edition)
Maya Textbooks 2 Piter Publishing Press, Russia
. Ati'odes% Maya 2012: A Comprehensive Guide * SolidWorks 2006 for Designers (Serbian Edition)
» Autodesk Maya 2011: A Comprehensive Guide . Mikro Knjiga Publishing Company, Serbia _
» Character Animation: A Tutorial Approach * SolidWorks 2006 for Designers {Japanese Edition)

Mikio Obi, Japan
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NX Textbooks

s NX 6 for Designers {Korean Edition)
COmsolutions, South Korea

« NX 5 for Designers (Korean Edition)
Onsolutions, South Korea

Pro/ENGINEER Textbooks

« Pro/ENGINEER Wildfire 4.0 for Designers (Korean Editior)
HongReung Science Publishing Company, South Korea

+ Pro/ENGINEER Wildfire 3.0 for Designers (Korean Edition)
HongReung Science Publishing Company, South Korea

AutoCAD Textbooks
o AutoCAD 2006 (Russian Edition)
Piter Publishing Press, Russia
o AutoCAD 2005 (Russian Edition)
Piter Publishing Press, Russia
« AutoCAD 2000 Fondamenti (Italian Edition}
o AutoCAD 2000 Tecniche Avanzate {Italian Edition)
o AutoCAD 2000 (Chinese Edition)

Coming Soon from CADCIM Techmnologies
« Autodesk Inventor 2013 for Designers

s AutoCAD LT 2013 for Designers

» Customizing AutoCAD 2013

.» AutoCAD Plant 3D 2013 for Designers

s AutoCAD MEP 3D 2013 for Designers

o Autodesk Simulation Mechanical 2012 for Designers
« Autodesk Softimage 2013: A Tutorial Approach

s The Foundry NukeX 6.3: A Tutorial Approach

» Adobe Flash Professional CS6: A Tutorial Approach
o Autodesk Revit Architecture 2013 for Architects and Designers
+ Exploring AutoCAD Map 3D 2013

+ Exploring AutoCAD Civil 3D 2013

» Exploring Autodesk Revit Structure 2013

o Autodesk Revit MEP 2013: A Tutorial Approach

Online Training Program Offered by CADCIM Technologies
CADCIM Technologies provides effective and affordable virtual online training on
various software packages including Computer Aided Design, Manufacturing, and
Engineering (CAD/CAM/CAE), animation, architecture, GIS, and computer
programming languages. The training will be delivered ‘live’ via Internet at any time,
any place, and at any pace to individuals, students of colleges, universities, and CAD/
CAM/CAE training centers. For more information, please visit the following link:
hitp:/fwww.cadcim.com




